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Introduction

The OpenModelica system described in this document has both short-term
and long-term goals:


	The short-term goal is to develop an efficient interactive
computational environment for the Modelica language, as well as a
rather complete implementation of the language. It turns out that
with support of appropriate tools and libraries, Modelica is very
well suited as a computational language for development and
execution of both low level and high level numerical algorithms,
e.g. for control system design, solving nonlinear equation
systems, or to develop optimization algorithms that are applied
to complex applications.


	The long-term goal is to have a complete reference implementation
of the Modelica language, including simulation of equation based
models and additional facilities in the programming environment,
as well as convenient facilities for research and experimentation
in language design or other research activities. However, our
goal is not to reach the level of performance and quality
provided by current commercial Modelica environments that can
handle large models requiring advanced analysis and optimization
by the Modelica compiler.




The long-term research related goals and issues of the OpenModelica
open source implementation of a Modelica environment include but are not
limited to the following:


	Development of a complete formal specification of Modelica,
including both static and dynamic semantics. Such a specification
can be used to assist current and future Modelica implementers by
providing a semantic reference, as a kind of reference
implementation.


	Language design, e.g. to further extend the scope of the
language, e.g. for use in diagnosis, structural analysis, system
identification, etc., as well as modeling problems that require
extensions such as partial differential equations, enlarged scope
for discrete modeling and simulation, etc.


	Language design to improve abstract properties such as
expressiveness, orthogonality, declarativity, reuse,
configurability, architectural properties, etc.


	Improved implementation techniques, e.g. to enhance the performance
of compiled Modelica code by generating code for parallel
hardware.


	Improved debugging support for equation based languages such as
Modelica, to make them even easier to use.


	Easy-to-use specialized high-level (graphical) user interfaces
for certain application domains.


	Visualization and animation techniques for interpretation and
presentation of results.


	Application usage and model library development by researchers in
various application areas.




The OpenModelica environment provides a test bench for language design
ideas that, if successful, can be submitted to the Modelica Association
for consideration regarding possible inclusion in the official Modelica
standard.

The current version of the OpenModelica environment allows most of the
expression, algorithm, and function parts of Modelica to be executed
interactively, as well as equation models and Modelica functions to be
compiled into efficient C code. The generated C code is combined with a
library of utility functions, a run-time library, and a numerical DAE
solver.


System Overview

The OpenModelica environment consists of several interconnected
subsystems, as depicted in Figure 1.


[image: _images/systemoverview.png]

Figure 1 The architecture of the OpenModelica environment.
Arrows denote data and control flow.
The interactive session handler receives commands and shows results from evaluating commands and expressions that are translated and executed.
Several subsystems provide different forms of browsing and textual editing of Modelica code.
The debugger currently provides debugging of an extended algorithmic subset of Modelica.



The following subsystems are currently integrated in the OpenModelica
environment:


	An interactive session handler, that parses and interprets commands
and Modelica expressions for evaluation, simulation, plotting,
etc. The session handler also contains simple history facilities,
and completion of file names and certain identifiers in commands.


	A Modelica compiler subsystem, translating Modelica to C code, with
a symbol table containing definitions of classes, functions, and
variables. Such definitions can be predefined, user-defined, or
obtained from libraries. The compiler also includes a Modelica
interpreter for interactive usage and constant expression
evaluation. The subsystem also includes facilities for building
simulation executables linked with selected numerical ODE or DAE
solvers.


	An execution and run-time module. This module currently executes
compiled binary code from translated expressions and functions,
as well as simulation code from equation based models, linked
with numerical solvers. In the near future event handling
facilities will be included for the discrete and hybrid parts of
the Modelica language.


	Eclipse plugin editor/browser. The Eclipse plugin called MDT
(Modelica Development Tooling) provides file and class hierarchy
browsing and text editing capabilities, rather analogous to
previously described Emacs editor/browser. Some syntax
highlighting facilities are also included. The Eclipse framework
has the advantage of making it easier to add future extensions
such as refactoring and cross referencing support.


	OMNotebook DrModelica model editor. This subsystem provides a
lightweight notebook editor, compared to the more advanced
Mathematica notebooks available in MathModelica. This basic
functionality still allows essentially the whole DrModelica
tutorial to be handled. Hierarchical text documents with chapters
and sections can be represented and edited, including basic
formatting. Cells can contain ordinary text or Modelica models
and expressions, which can be evaluated and simulated. However,
no mathematical typesetting facilities are yet available in the
cells of this notebook editor.


	Graphical model editor/browser OMEdit. This is a graphical
connection editor, for component based model design by connecting
instances of Modelica classes, and browsing Modelica model
libraries for reading and picking component models. The graphical
model editor also includes a textual editor for editing model
class definitions, and a window for interactive Modelica command
evaluation.


	Optimization subsystem OMOptim. This is an optimization subsystem
for OpenModelica, currently for design optimization choosing an
optimal set of design parameters for a model. The current version
has a graphical user interface, provides genetic optimization
algorithms and Pareto front optimization, works integrated with
the simulators and automatically accesses variables and design
parameters from the Modelica model.


	Dynamic Optimization subsystem. This is dynamic optimization using
collocation methods, for Modelica models extended with
optimization specifications with goal functions and additional
constraints. This subsystem is integrated with in the
OpenModelica compiler.


	Modelica equation model debugger. The equation model debugger shows
the location of an error in the model equation source code. It
keeps track of the symbolic transformations done by the compiler
on the way from equations to low-level generated C code, and also
explains which transformations have been done.


	Modelica algorithmic code debugger. The algorithmic code Modelica
debugger provides debugging for an extended algorithmic subset of
Modelica, excluding equation-based models and some other
features, but including some meta-programming and model
transformation extensions to Modelica. This is a conventional
full-feature debugger, using Eclipse for displaying the source
code during stepping, setting breakpoints, etc. Various
back-trace and inspection commands are available. The debugger
also includes a data-view browser for browsing hierarchical data
such as tree- or list structures in extended Modelica.






Interactive Session with Examples

The following is an interactive session using the interactive session
handler in the OpenModelica environment, called OMShell - the
OpenModelica Shell. Most of these examples are also available in the
OMNotebook with DrModelica and DrControl UsersGuideExamples.onb as well as the testmodels in:

>>> getInstallationDirectoryPath() + "/share/doc/omc/testmodels/"
"«OPENMODELICAHOME»/share/doc/omc/testmodels/"





The following commands were run using OpenModelica version:

>>> getVersion()
"OMCompiler v1.27.0-dev.202+g0e2053de263"






Starting the Interactive Session

Under Windows, go to the Start Menu and run OpenModelica->OpenModelica Shell
which responds with an interaction window.

Under Linux, run OMShell-terminal to start the interactive session at the prompt.

We enter an assignment of a vector expression, created by the range
construction expression 1:12, to be stored in the variable x. The value
of the expression is returned.

>>> x := 1:12
{1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 11, 12}







Using the Interactive Mode

When running OMC in interactive mode (for instance using OMShell) one
can make load classes and execute commands.
Here we give a few example sessions.


Example Session 1

>>> model A Integer t = 1.5; end A; //The type is Integer but 1.5 is of Real Type
{A}
>>> instantiateModel(A)
""
"[<interactive>:1:9-1:23:writable] Error: Type mismatch in binding t = 1.5, expected subtype of Integer, got type Real.
"







Example Session 2

If you do not see the error-message when running the example, use the command getErrorString().

model C
  Integer a;
  Real b;
equation
  der(a) = b; // der(a) is illegal since a is not a Real number
  der(b) = 12.0;
end C;





>>> instantiateModel(C)
""






Error

[<interactive>:5:3-5:13:writable] Error: Argument 'a' of der is not differentiable.








Trying the Bubblesort Function

Load the function bubblesort, either by using the pull-down menu
File->Load Model, or by explicitly giving the command:

>>> loadFile(getInstallationDirectoryPath() + "/share/doc/omc/testmodels/bubblesort.mo")
true





The function bubblesort is called below to sort the vector x in
descending order. The sorted result is returned together with its type.
Note that the result vector is of type Real[:], instantiated as
Real[12], since this is the declared type of the function result. The
input Integer vector was automatically converted to a Real vector
according to the Modelica type coercion rules. The function is
automatically compiled when called if this has not been done before.

>>> bubblesort(x)
{12.0, 11.0, 10.0, 9.0, 8.0, 7.0, 6.0, 5.0, 4.0, 3.0, 2.0, 1.0}





Another call:

>>> bubblesort({4,6,2,5,8})
{8.0, 6.0, 5.0, 4.0, 2.0}







Trying the system and cd Commands

It is also possible to give operating system commands via the system
utility function. A command is provided as a string argument. The
example below shows the system utility applied to the UNIX command cat,
which here outputs the contents of the file bubblesort.mo to the output
stream when running omc from the command-line.

>>> system("cat '"+getInstallationDirectoryPath()+"/share/doc/omc/testmodels/bubblesort.mo' > bubblesort.mo")
0





function bubblesort
  input Real[:] x;
  output Real[size(x,1)] y;
protected
  Real t;
algorithm
  y := x;
  for i in 1:size(x,1) loop
    for j in 1:size(x,1) loop
      if y[i] > y[j] then
        t := y[i];
        y[i] := y[j];
        y[j] := t;
      end if;
    end for;
  end for;
end bubblesort;





Note: The output emitted into stdout by system commands is put into
log-files when running the CORBA-based clients, not into the visible GUI
windows. Thus the text emitted by the above cat command would not be
returned, which is why it is redirected to another file.

A better way to read the content of files would be the readFile command:

>>> readFile("bubblesort.mo")
function bubblesort
  input Real[:] x;
  output Real[size(x,1)] y;
protected
  Real t;
algorithm
  y := x;
  for i in 1:size(x,1) loop
    for j in 1:size(x,1) loop
      if y[i] > y[j] then
        t := y[i];
        y[i] := y[j];
        y[j] := t;
      end if;
    end for;
  end for;
end bubblesort;





The system command only returns a success code (0 = success).

>>> system("dir")
0
>>> system("Non-existing command")
127





Another built-in command is cd, the change current directory command.
The resulting current directory is returned as a string.

>>> dir:=cd()
"«DOCHOME»"
>>> cd("source")
"«DOCHOME»/source"
>>> cd(getInstallationDirectoryPath() + "/share/doc/omc/testmodels/")
"/var/lib/jenkins/ws/OpenModelica_PR-15165/build/share/doc/omc/testmodels"
>>> cd(dir)
"«DOCHOME»"







Modelica Library and DCMotor Model

We load a model, here the whole Modelica standard library, which also
can be done through the File->Load Modelica Library menu item:

>>> loadModel(Modelica, {"3.2.3"})
true





We also load a file containing the dcmotor model:

>>> loadFile(getInstallationDirectoryPath() + "/share/doc/omc/testmodels/dcmotor.mo")
true






Note

Notification: dcmotor requested package Modelica of version 3.2.2. Modelica 3.2.3 is used instead which states that it is fully compatible without conversion script needed.





It is simulated:

>>> simulate(dcmotor, startTime=0.0, stopTime=10.0)
record SimulationResult
    resultFile = "«DOCHOME»/dcmotor_res.mat",
    simulationOptions = "startTime = 0.0, stopTime = 10.0, numberOfIntervals = 500, tolerance = 1e-6, method = 'dassl', fileNamePrefix = 'dcmotor', options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = ''",
    messages = "LOG_SUCCESS       | info    | The initialization finished successfully without homotopy method.
LOG_SUCCESS       | info    | The simulation finished successfully.
",
    timeFrontend = 0.21893404500000002,
    timeBackend = 0.00398201,
    timeSimCode = 0.0010813930000000002,
    timeTemplates = 0.00245832,
    timeCompile = 0.237516741,
    timeSimulation = 0.007253170000000001,
    timeTotal = 0.47131075800000005
end SimulationResult;






Note

Notification: dcmotor requested package Modelica of version 3.2.2. Modelica 3.2.3 is used instead which states that it is fully compatible without conversion script needed.





We list the source code of the model:

>>> list(dcmotor)
model dcmotor
  import Modelica.Electrical.Analog.Basic;
  Basic.Resistor resistor1(R = 10);
  Basic.Inductor inductor1(L = 0.2, i.fixed = true);
  Basic.Ground ground1;
  Modelica.Mechanics.Rotational.Components.Inertia load(J = 1, phi.fixed = true, w.fixed = true);
  Basic.EMF emf1(k = 1.0);
  Modelica.Blocks.Sources.Step step1;
  Modelica.Electrical.Analog.Sources.SignalVoltage signalVoltage1;
equation
  connect(step1.y, signalVoltage1.v);
  connect(signalVoltage1.p, resistor1.p);
  connect(resistor1.n, inductor1.p);
  connect(inductor1.n, emf1.p);
  connect(emf1.flange, load.flange_a);
  connect(signalVoltage1.n, ground1.p);
  connect(ground1.p, emf1.n);
  annotation(
    uses(Modelica(version = "3.2.2")));
end dcmotor;





We test code instantiation of the model to flat code:

>>> instantiateModel(dcmotor)
class dcmotor
  parameter Real resistor1.R(quantity = "Resistance", unit = "Ohm", start = 1.0) = 10.0 "Resistance at temperature T_ref";
  parameter Real resistor1.T_ref(quantity = "ThermodynamicTemperature", unit = "K", displayUnit = "degC", min = 0.0, start = 288.15, nominal = 300.0) = 300.15 "Reference temperature";
  parameter Real resistor1.alpha(quantity = "LinearTemperatureCoefficient", unit = "1/K") = 0.0 "Temperature coefficient of resistance (R_actual = R*(1 + alpha*(T_heatPort - T_ref))";
  Real resistor1.v(quantity = "ElectricPotential", unit = "V") "Voltage drop of the two pins (= p.v - n.v)";
  Real resistor1.i(quantity = "ElectricCurrent", unit = "A") "Current flowing from pin p to pin n";
  Real resistor1.p.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin";
  Real resistor1.p.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into the pin";
  Real resistor1.n.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin";
  Real resistor1.n.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into the pin";
  final parameter Boolean resistor1.useHeatPort = false "=true, if heatPort is enabled";
  parameter Real resistor1.T(quantity = "ThermodynamicTemperature", unit = "K", displayUnit = "degC", min = 0.0, start = 288.15, nominal = 300.0) = resistor1.T_ref "Fixed device temperature if useHeatPort = false";
  Real resistor1.LossPower(quantity = "Power", unit = "W") "Loss power leaving component via heatPort";
  Real resistor1.T_heatPort(quantity = "ThermodynamicTemperature", unit = "K", displayUnit = "degC", min = 0.0, start = 288.15, nominal = 300.0) "Temperature of heatPort";
  Real resistor1.R_actual(quantity = "Resistance", unit = "Ohm") "Actual resistance = R*(1 + alpha*(T_heatPort - T_ref))";
  Real inductor1.v(quantity = "ElectricPotential", unit = "V") "Voltage drop of the two pins (= p.v - n.v)";
  Real inductor1.i(quantity = "ElectricCurrent", unit = "A", start = 0.0, fixed = true) "Current flowing from pin p to pin n";
  Real inductor1.p.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin";
  Real inductor1.p.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into the pin";
  Real inductor1.n.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin";
  Real inductor1.n.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into the pin";
  parameter Real inductor1.L(quantity = "Inductance", unit = "H", start = 1.0) = 0.2 "Inductance";
  Real ground1.p.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin";
  Real ground1.p.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into the pin";
  Real load.flange_a.phi(quantity = "Angle", unit = "rad", displayUnit = "deg") "Absolute rotation angle of flange";
  Real load.flange_a.tau(quantity = "Torque", unit = "N.m") "Cut torque in the flange";
  Real load.flange_b.phi(quantity = "Angle", unit = "rad", displayUnit = "deg") "Absolute rotation angle of flange";
  Real load.flange_b.tau(quantity = "Torque", unit = "N.m") "Cut torque in the flange";
  parameter Real load.J(quantity = "MomentOfInertia", unit = "kg.m2", min = 0.0, start = 1.0) = 1.0 "Moment of inertia";
  final parameter enumeration(never, avoid, default, prefer, always) load.stateSelect = StateSelect.default "Priority to use phi and w as states";
  Real load.phi(quantity = "Angle", unit = "rad", displayUnit = "deg", fixed = true, stateSelect = StateSelect.default) "Absolute rotation angle of component";
  Real load.w(quantity = "AngularVelocity", unit = "rad/s", fixed = true, stateSelect = StateSelect.default) "Absolute angular velocity of component (= der(phi))";
  Real load.a(quantity = "AngularAcceleration", unit = "rad/s2") "Absolute angular acceleration of component (= der(w))";
  final parameter Boolean emf1.useSupport = false "= true, if support flange enabled, otherwise implicitly grounded";
  parameter Real emf1.k(quantity = "ElectricalTorqueConstant", unit = "N.m/A", start = 1.0) = 1.0 "Transformation coefficient";
  Real emf1.v(quantity = "ElectricPotential", unit = "V") "Voltage drop between the two pins";
  Real emf1.i(quantity = "ElectricCurrent", unit = "A") "Current flowing from positive to negative pin";
  Real emf1.phi(quantity = "Angle", unit = "rad", displayUnit = "deg") "Angle of shaft flange with respect to support (= flange.phi - support.phi)";
  Real emf1.w(quantity = "AngularVelocity", unit = "rad/s") "Angular velocity of flange relative to support";
  Real emf1.tau(quantity = "Torque", unit = "N.m") "Torque of flange";
  Real emf1.tauElectrical(quantity = "Torque", unit = "N.m") "Electrical torque";
  Real emf1.p.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin";
  Real emf1.p.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into the pin";
  Real emf1.n.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin";
  Real emf1.n.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into the pin";
  Real emf1.flange.phi(quantity = "Angle", unit = "rad", displayUnit = "deg") "Absolute rotation angle of flange";
  Real emf1.flange.tau(quantity = "Torque", unit = "N.m") "Cut torque in the flange";
  protected parameter Real emf1.fixed.phi0(quantity = "Angle", unit = "rad", displayUnit = "deg") = 0.0 "Fixed offset angle of housing";
  protected Real emf1.fixed.flange.phi(quantity = "Angle", unit = "rad", displayUnit = "deg") "Absolute rotation angle of flange";
  protected Real emf1.fixed.flange.tau(quantity = "Torque", unit = "N.m") "Cut torque in the flange";
  protected Real emf1.internalSupport.tau(quantity = "Torque", unit = "N.m") = -emf1.tau "External support torque (must be computed via torque balance in model where InternalSupport is used; = flange.tau)";
  protected Real emf1.internalSupport.phi(quantity = "Angle", unit = "rad", displayUnit = "deg") "External support angle (= flange.phi)";
  protected Real emf1.internalSupport.flange.phi(quantity = "Angle", unit = "rad", displayUnit = "deg") "Absolute rotation angle of flange";
  protected Real emf1.internalSupport.flange.tau(quantity = "Torque", unit = "N.m") "Cut torque in the flange";
  parameter Real step1.height = 1.0 "Height of step";
  Real step1.y "Connector of Real output signal";
  parameter Real step1.offset = 0.0 "Offset of output signal y";
  parameter Real step1.startTime(quantity = "Time", unit = "s") = 0.0 "Output y = offset for time < startTime";
  Real signalVoltage1.p.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin";
  Real signalVoltage1.p.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into the pin";
  Real signalVoltage1.n.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin";
  Real signalVoltage1.n.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into the pin";
  Real signalVoltage1.v(unit = "V") "Voltage between pin p and n (= p.v - n.v) as input signal";
  Real signalVoltage1.i(quantity = "ElectricCurrent", unit = "A") "Current flowing from pin p to pin n";
equation
  emf1.internalSupport.flange.phi = emf1.fixed.flange.phi;
  step1.y = signalVoltage1.v;
  signalVoltage1.p.v = resistor1.p.v;
  resistor1.n.v = inductor1.p.v;
  inductor1.n.v = emf1.p.v;
  emf1.flange.phi = load.flange_a.phi;
  ground1.p.v = emf1.n.v;
  ground1.p.v = signalVoltage1.n.v;
  inductor1.p.i + resistor1.n.i = 0.0;
  emf1.p.i + inductor1.n.i = 0.0;
  load.flange_b.tau = 0.0;
  emf1.flange.tau + load.flange_a.tau = 0.0;
  emf1.internalSupport.flange.tau + emf1.fixed.flange.tau = 0.0;
  signalVoltage1.p.i + resistor1.p.i = 0.0;
  signalVoltage1.n.i + emf1.n.i + ground1.p.i = 0.0;
  assert(1.0 + resistor1.alpha * (resistor1.T_heatPort - resistor1.T_ref) >= 1e-15, "Temperature outside scope of model!");
  resistor1.R_actual = resistor1.R * (1.0 + resistor1.alpha * (resistor1.T_heatPort - resistor1.T_ref));
  resistor1.v = resistor1.R_actual * resistor1.i;
  resistor1.LossPower = resistor1.v * resistor1.i;
  resistor1.T_heatPort = resistor1.T;
  resistor1.v = resistor1.p.v - resistor1.n.v;
  0.0 = resistor1.p.i + resistor1.n.i;
  resistor1.i = resistor1.p.i;
  inductor1.L * der(inductor1.i) = inductor1.v;
  inductor1.v = inductor1.p.v - inductor1.n.v;
  0.0 = inductor1.p.i + inductor1.n.i;
  inductor1.i = inductor1.p.i;
  ground1.p.v = 0.0;
  load.phi = load.flange_a.phi;
  load.phi = load.flange_b.phi;
  load.w = der(load.phi);
  load.a = der(load.w);
  load.J * load.a = load.flange_a.tau + load.flange_b.tau;
  emf1.fixed.flange.phi = emf1.fixed.phi0;
  emf1.internalSupport.flange.tau = emf1.internalSupport.tau;
  emf1.internalSupport.flange.phi = emf1.internalSupport.phi;
  emf1.v = emf1.p.v - emf1.n.v;
  0.0 = emf1.p.i + emf1.n.i;
  emf1.i = emf1.p.i;
  emf1.phi = emf1.flange.phi - emf1.internalSupport.phi;
  emf1.w = der(emf1.phi);
  emf1.k * emf1.w = emf1.v;
  emf1.tau = -emf1.k * emf1.i;
  emf1.tauElectrical = -emf1.tau;
  emf1.tau = emf1.flange.tau;
  step1.y = step1.offset + (if time < step1.startTime then 0.0 else step1.height);
  signalVoltage1.v = signalVoltage1.p.v - signalVoltage1.n.v;
  0.0 = signalVoltage1.p.i + signalVoltage1.n.i;
  signalVoltage1.i = signalVoltage1.p.i;
end dcmotor;






Note

Notification: dcmotor requested package Modelica of version 3.2.2. Modelica 3.2.3 is used instead which states that it is fully compatible without conversion script needed.





We plot part of the simulated result:


[image: _images/dcmotor.svg]
Figure 2 Rotation and rotational velocity of the DC motor





The val() function

The val(variableName,time) scription function can be used to
retrieve the interpolated value of a simulation result variable at a
certain point in the simulation time, see usage in the BouncingBall
simulation below.



BouncingBall and Switch Models

We load and simulate the BouncingBall example containing when-equations
and if-expressions (the Modelica keywords have been bold-faced by hand
for better readability):

>>> loadFile(getInstallationDirectoryPath() + "/share/doc/omc/testmodels/BouncingBall.mo")
true





>>> list(BouncingBall)
model BouncingBall
  parameter Real e = 0.7 "coefficient of restitution";
  parameter Real g = 9.81 "gravity acceleration";
  Real h(fixed = true, start = 1) "height of ball";
  Real v(fixed = true) "velocity of ball";
  Boolean flying(fixed = true, start = true) "true, if ball is flying";
  Boolean impact;
  Real v_new(fixed = true);
  Integer foo;
equation
  impact = h <= 0.0;
  foo = if impact then 1 else 2;
  der(v) = if flying then -g else 0;
  der(h) = v;
  when {h <= 0.0 and v <= 0.0, impact} then
    v_new = if edge(impact) then -e*pre(v) else 0;
    flying = v_new > 0;
    reinit(v, v_new);
  end when;
end BouncingBall;





Instead of just giving a simulate and plot command, we perform a
runScript command on a .mos (Modelica script) file sim_BouncingBall.mos
that contains these commands:

>>> writeFile("sim_BouncingBall.mos", "
  loadFile(getInstallationDirectoryPath() + \"/share/doc/omc/testmodels/BouncingBall.mo\");
  simulate(BouncingBall, stopTime=3.0);
  /* plot({h,flying}); */
")
true
>>> runScript("sim_BouncingBall.mos")
"true
record SimulationResult
    resultFile = \"«DOCHOME»/BouncingBall_res.mat\",
    simulationOptions = \"startTime = 0.0, stopTime = 3.0, numberOfIntervals = 500, tolerance = 1e-6, method = 'dassl', fileNamePrefix = 'BouncingBall', options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = ''\",
    messages = \"LOG_SUCCESS       | info    | The initialization finished successfully without homotopy method.
LOG_SUCCESS       | info    | The simulation finished successfully.
\",
    timeFrontend = 9.44026e-4,
    timeBackend = 0.001723184,
    timeSimCode = 4.82152e-4,
    timeTemplates = 0.002086263,
    timeCompile = 0.232991354,
    timeSimulation = 0.0068885280000000005,
    timeTotal = 0.24516694400000003
end SimulationResult;
"





model Switch
  Real v;
  Real i;
  Real i1;
  Real itot;
  Boolean open;
equation
  itot = i + i1;
  if open then
    v = 0;
  else
    i = 0;
  end if;
  1 - i1 = 0;
  1 - v - i = 0;
  open = time >= 0.5;
end Switch;





>>> simulate(Switch, startTime=0, stopTime=1)
record SimulationResult
    resultFile = "«DOCHOME»/Switch_res.mat",
    simulationOptions = "startTime = 0.0, stopTime = 1.0, numberOfIntervals = 500, tolerance = 1e-6, method = 'dassl', fileNamePrefix = 'Switch', options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = ''",
    messages = "LOG_SUCCESS       | info    | The initialization finished successfully without homotopy method.
LOG_SUCCESS       | info    | The simulation finished successfully.
",
    timeFrontend = 7.92522e-4,
    timeBackend = 0.04739426,
    timeSimCode = 4.3229900000000003e-4,
    timeTemplates = 0.001872203,
    timeCompile = 0.222318637,
    timeSimulation = 0.006415192,
    timeTotal = 0.279277
end SimulationResult;





Retrieve the value of itot at time=0 using the
val(variableName, time) function:

>>> val(itot,0)
1.0





Plot itot and open:


[image: _images/switch.svg]
Figure 3 Plot when the switch opens



We note that the variable open switches from false (0) to true (1),
causing itot to increase from 1.0 to 2.0.



Clear All Models

Now, first clear all loaded libraries and models:

>>> clear()
true





List the loaded models - nothing left:

>>> list()
""







VanDerPol Model and Parametric Plot

We load another model, the VanDerPol model (or via the menu File->Load
Model):

>>> loadFile(getInstallationDirectoryPath() + "/share/doc/omc/testmodels/VanDerPol.mo")
true





It is simulated:

>>> simulate(VanDerPol, stopTime=80)
record SimulationResult
    resultFile = "«DOCHOME»/VanDerPol_res.mat",
    simulationOptions = "startTime = 0.0, stopTime = 80.0, numberOfIntervals = 500, tolerance = 1e-6, method = 'dassl', fileNamePrefix = 'VanDerPol', options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = ''",
    messages = "LOG_SUCCESS       | info    | The initialization finished successfully without homotopy method.
LOG_SUCCESS       | info    | The simulation finished successfully.
",
    timeFrontend = 7.50875e-4,
    timeBackend = 7.58389e-4,
    timeSimCode = 2.2774600000000002e-4,
    timeTemplates = 0.001361568,
    timeCompile = 0.22462674500000002,
    timeSimulation = 0.007057774,
    timeTotal = 0.234840814
end SimulationResult;





It is plotted:

>>> plotParametric("x","y")






[image: _images/VanDerPol.svg]
Figure 4 VanDerPol plotParametric(x,y)



Perform code instantiation to flat form of the VanDerPol model:

>>> instantiateModel(VanDerPol)
class VanDerPol "Van der Pol oscillator model"
  Real x(start = 1.0, fixed = true);
  Real y(start = 1.0, fixed = true);
  parameter Real lambda = 0.3;
equation
  der(x) = y;
  der(y) = lambda * (1.0 - x * x) * y - x;
end VanDerPol;







Using Japanese or Chinese Characters

Japenese, Chinese, and other kinds of UniCode characters can be used
within quoted (single quote) identifiers, see for example the variable
name to the right in the plot below:

[image: _images/bb-japanese.png]


Scripting with For-Loops, While-Loops, and If-Statements

A simple summing integer loop (using multi-line input without evaluation
at each line into OMShell requires copy-paste as one operation from
another document):

>>> k := 0;
>>> for i in 1:1000 loop
  k := k + i;
end for;
>>> k
500500





A nested loop summing reals and integers:

>>> g := 0.0;
>>> h := 5;
>>> for i in {23.0,77.12,88.23} loop
  for j in i:0.5:(i+1) loop
    g := g + j;
    g := g + h / 2;
  end for;
  h := h + g;
end for;





By putting two (or more) variables or assignment statements separated by
semicolon(s), ending with a variable, one can observe more than one
variable value:

>>> h; g
1997.4500000000003
1479.0900000000001





A for-loop with vector traversal and concatenation of string elements:

>>> i:="";
>>> lst := {"Here ", "are ","some ","strings."};
>>> s := "";
>>> for i in lst loop
  s := s + i;
end for;
>>> s
"Here are some strings."





Normal while-loop with concatenation of 10 "abc " strings:

>>> s:="";
>>> i:=1;
>>> while i<=10 loop
  s:="abc "+s;
  i:=i+1;
end while;
>>> s
"abc abc abc abc abc abc abc abc abc abc "





A simple if-statement. By putting the variable last, after the
semicolon, its value is returned after evaluation:

>>> if 5>2 then a := 77; end if; a
77





An if-then-else statement with elseif:

>>> if false then
  a := 5;
elseif a > 50 then
  b:= "test"; a:= 100;
else
  a:=34;
end if;





Take a look at the variables a and b:

>>> a;b
100
"test"







Variables, Functions, and Types of Variables

Assign a vector to a variable:

>>> a:=1:5
{1, 2, 3, 4, 5}





Type in a function:

function mySqr
  input Real x;
  output Real y;
algorithm
  y:=x*x;
end mySqr;





Call the function:

>>> b:=mySqr(2)
4.0





Look at the value of variable a:

>>> a
{1, 2, 3, 4, 5}





Look at the type of a:

>>> typeOf(a)
"Integer[5]"





Retrieve the type of b:

>>> typeOf(b)
"Real"





What is the type of mySqr? Cannot currently be handled.

>>> typeOf(mySqr)





List the available variables:

>>> listVariables()
{b, a, s, lst, i, h, g, k, currentSimulationResult}





Clear again:

>>> clear()
true







Getting Information about Error Cause

Call the function getErrorString() in order to get more information
about the error cause after a simulation failure:

>>> getErrorString()
""







Alternative Simulation Output Formats

There are several output format possibilities, with mat being the
default. plt and mat are the only formats that allow you to use the
val() or plot() functions after a simulation. Compared to the speed of
plt, mat is roughly 5 times for small files, and scales better for
larger files due to being a binary format. The csv format is roughly
twice as fast as plt on data-heavy simulations. The plt format allocates
all output data in RAM during simulation, which means that simulations
may fail due applications only being able to address 4GB of memory on
32-bit platforms. Empty does no output at all and should be by far the
fastest. The csv and plt formats are suitable when using an external
scripts or tools like gnuplot to generate plots or process data. The mat
format can be post-processed in MATLAB [http://www.mathworks.com/products/matlab]
or Octave [http://www.gnu.org/software/octave/].

>>> simulate(... , outputFormat="mat")
>>> simulate(... , outputFormat="csv")
>>> simulate(... , outputFormat="plt")
>>> simulate(... , outputFormat="empty")





It is also possible to specify which variables should be present in the
result-file. This is done by using POSIX Extended Regular Expressions [http://en.wikipedia.org/wiki/Regular_expression].
The given expression must match the full variable name
(^ and $ symbols are automatically added to the given regular
expression).

// Default, match everything

>>> simulate(... , variableFilter=".*")





// match indices of variable myVar that only contain the numbers using
combinations

// of the letters 1 through 3

>>> simulate(... , variableFilter="myVar\\\[[1-3]*\\\]")





// match x or y or z

>>> simulate(... , variableFilter="x|y|z")







Using External Functions

See Chapter Interoperability - C and Python for more information about calling functions in other
programming languages.



Using Parallel Simulation via OpenMP Multi-Core Support

Faster simulations on multi-core computers can be obtained by using a
new OpenModelica feature that automatically partitions the system of
equations and schedules the parts for execution on different cores using
shared-memory OpenMP based execution. The speedup obtained is dependent
on the model structure, whether the system of equations can be
partitioned well. This version in the current OpenModelica release is an
experimental version without load balancing. The following command, not
yet available from the OpenModelica GUI, will run a parallel simulation
on a model:

>>> omc -d=openmp model.mo







Loading Specific Library Version

There exist many different versiosn of Modelica libraries which are not
compatible. It is possible to keep multiple versions of the same library
stored in the directory given by calling getModelicaPath(). By calling
loadModel(Modelica,{"3.2"}), OpenModelica will search for a directory
called "Modelica 3.2" or a file called "Modelica 3.2.mo". It is possible
to give several library versions to search for, giving preference for a
pre-release version of a library if it is installed. If the searched
version is "default", the priority is: no version name (Modelica), main
release version (Modelica 3.1), pre-release version (Modelica 3.1Beta 1)
and unordered versions (Modelica Special Release).

The loadModel command will also look at the uses annotation of the
top-level class after it has been loaded. Given the following package,
Complex 1.0 and ModelicaServices 1.1 will also be loaded into the AST
automatically.

package Modelica
  annotation(uses(Complex(version="1.0"),
  ModelicaServices(version="1.1")));
end Modelica;






Note

Notification: Automatically loaded package Complex 4.1.0 due to uses annotation from Modelica.

Notification: Automatically loaded package ModelicaServices 4.1.0 due to uses annotation from Modelica.





>>> clear()
true





Packages will also be loaded if a model has a uses-annotation:

model M
  annotation(uses(Modelica(version="3.2.1")));
end M;






Note

Notification: Automatically loaded package Modelica 3.2.1 due to uses annotation from M.

Notification: Automatically loaded package Complex 3.2.1 due to uses annotation from Modelica.

Notification: Automatically loaded package ModelicaServices 3.2.1 due to uses annotation from Modelica.





>>> instantiateModel(M)
class M
end M;





Packages will also be loaded by looking at the first identifier in the path:

>>> instantiateModel(Modelica.Electrical.Analog.Basic.Ground)
class Modelica.Electrical.Analog.Basic.Ground "Ground node"
  Real p.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin";
  Real p.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into the pin";
equation
  p.i = 0.0;
  p.v = 0.0;
end Modelica.Electrical.Analog.Basic.Ground;






Note

Notification: Automatically loaded package Complex 4.1.0 due to uses annotation from Modelica.

Notification: Automatically loaded package ModelicaServices 4.1.0 due to uses annotation from Modelica.

Notification: Automatically loaded package Modelica default due to usage.







Calling the Model Query and Manipulation API

In the OpenModelica System Documentation, an external API (application
programming interface) is described which returns information about
models and/or allows manipulation of models. Calls to these functions
can be done interactively as below, but more typically by program
clients to the OpenModelica Compiler (OMC) server. Current examples of
such clients are the OpenModelica MDT Eclipse plugin, OMNotebook, the
OMEdit graphic model editor, etc. This API is untyped for performance
reasons, i.e., no type checking and minimal error checking is done on
the calls. The results of a call is returned as a text string in
Modelica syntax form, which the client has to parse. An example parser
in C++ is available in the OMNotebook source code, whereas another
example parser in Java is available in the MDT Eclipse plugin.

Below we show a few calls on the previously simulated BouncingBall
model. The full documentation on this API is available in the system
documentation. First we load and list the model again to show its
structure:

>>> loadFile(getInstallationDirectoryPath() + "/share/doc/omc/testmodels/BouncingBall.mo");
>>> list(BouncingBall)
model BouncingBall
  parameter Real e = 0.7 "coefficient of restitution";
  parameter Real g = 9.81 "gravity acceleration";
  Real h(fixed = true, start = 1) "height of ball";
  Real v(fixed = true) "velocity of ball";
  Boolean flying(fixed = true, start = true) "true, if ball is flying";
  Boolean impact;
  Real v_new(fixed = true);
  Integer foo;
equation
  impact = h <= 0.0;
  foo = if impact then 1 else 2;
  der(v) = if flying then -g else 0;
  der(h) = v;
  when {h <= 0.0 and v <= 0.0, impact} then
    v_new = if edge(impact) then -e*pre(v) else 0;
    flying = v_new > 0;
    reinit(v, v_new);
  end when;
end BouncingBall;





Different kinds of calls with returned results:

>>> getClassRestriction(BouncingBall)
"model"
>>> getClassInformation(BouncingBall)
("model", "", false, false, false, "/var/lib/jenkins/ws/OpenModelica_PR-15165/build/share/doc/omc/testmodels/BouncingBall.mo", false, 1, 1, 23, 17, {}, false, false, "", "", false, "", "", "", "", "")
>>> isFunction(BouncingBall)
false
>>> existClass(BouncingBall)
true
>>> getComponents(BouncingBall)
{{Real, e, "coefficient of restitution", "public", false, false, false, false, "parameter", "none", "unspecified", {}}, {Real, g, "gravity acceleration", "public", false, false, false, false, "parameter", "none", "unspecified", {}}, {Real, h, "height of ball", "public", false, false, false, false, "unspecified", "none", "unspecified", {}}, {Real, v, "velocity of ball", "public", false, false, false, false, "unspecified", "none", "unspecified", {}}, {Boolean, flying, "true, if ball is flying", "public", false, false, false, false, "unspecified", "none", "unspecified", {}}, {Boolean, impact, "", "public", false, false, false, false, "unspecified", "none", "unspecified", {}}, {Real, v_new, "", "public", false, false, false, false, "unspecified", "none", "unspecified", {}}, {Integer, foo, "", "public", false, false, false, false, "unspecified", "none", "unspecified", {}}}
>>> getConnectionCount(BouncingBall)
0
>>> getInheritanceCount(BouncingBall)
0
>>> getComponentModifierValue(BouncingBall,e)
"0.7"
>>> getComponentModifierNames(BouncingBall,"e")
{}
>>> getClassRestriction(BouncingBall)
"model"
>>> getVersion() // Version of the currently running OMC
"OMCompiler v1.27.0-dev.202+g0e2053de263"







Quit OpenModelica

Leave and quit OpenModelica:

>>> quit()







Dump XML Representation

The command dumpXMLDAE dumps an XML representation of a model, according
to several optional parameters.

dumpXMLDAE(modelname[,asInSimulationCode=<Boolean>]
[,filePrefix=<String>] [,storeInTemp=<Boolean>] [,addMathMLCode
=<Boolean>])

This command dumps the mathematical representation of a model using an
XML representation, with optional parameters. In particular,
asInSimulationCode defines where to stop in the translation process
(before dumping the model), the other options are relative to the file
storage: filePrefix for specifying a different name and storeInTemp to
use the temporary directory. The optional parameter addMathMLCode gives
the possibility to don't print the MathML code within the xml file, to
make it more readable. Usage is trivial, just:
addMathMLCode=true/false (default value is false).



Dump Matlab Representation

The command export dumps an XML representation of a model, according to
several optional parameters.

exportDAEtoMatlab(modelname);

This command dumps the mathematical representation of a model using a
Matlab representation. Example:

>>> loadFile(getInstallationDirectoryPath() + "/share/doc/omc/testmodels/BouncingBall.mo")
true
>>> exportDAEtoMatlab(BouncingBall)
"The equation system was dumped to Matlab file:BouncingBall_imatrix.m"





% Adjacency Matrix
% ====================================
% number of rows: 6
IM={{4,1},{6,{'if', 'true','==' {4},{},}},{{'if', 'true','==' {3},{},}},{2},{5,{'if', 'edge(impact)' {4},{2},}},{3,5}};
VL = {'h','v','flying','impact','v_new','foo'};


EqStr = {'impact = h <= 0.0;','foo = if impact then 1 else 2;','der(v) = if flying then -g else 0.0;','der(h) = v;','when {h <= 0.0 and v <= 0.0, impact} then v_new = if edge(impact) then (-e) * pre(v) else 0.0; end when;','when {h <= 0.0 and v <= 0.0, impact} then flying = v_new > 0.0; end when;'};


OldEqStr={'class BouncingBall','  parameter Real e = 0.7 "coefficient of restitution";','  parameter Real g = 9.81 "gravity acceleration";','  Real h(start = 1.0, fixed = true) "height of ball";','  Real v(fixed = true) "velocity of ball";','  Boolean flying(start = true, fixed = true) "true, if ball is flying";','  Boolean impact;','  Real v_new(fixed = true);','  Integer foo;','equation','  impact = h <= 0.0;','  foo = if impact then 1 else 2;','  der(v) = if flying then -g else 0.0;','  der(h) = v;','  when {h <= 0.0 and v <= 0.0, impact} then','    v_new = if edge(impact) then -e * pre(v) else 0.0;','    flying = v_new > 0.0;','    reinit(v, v_new);','  end when;','end BouncingBall;',''};








Summary of Commands for the Interactive Session Handler

The following is the complete list of commands currently available in
the interactive session hander.

simulate(modelname) Translate a model named modelname and simulate
it.


simulate(modelname[,startTime=<Real>][,stopTime=<Real>][,numberOfIntervals

=<Integer>][,outputInterval=<Real>][,method=<String>]

[,tolerance=<Real>][,fixedStepSize=<Real>]

[,outputFormat=<String>]) Translate and simulate a model, with
optional start time, stop time, and optional number of simulation
intervals or steps for which the simulation results will be computed.
More intervals will give higher time resolution, but occupy more space
and take longer to compute. The default number of intervals is 500. It
is possible to choose solving method, default is “dassl”, “cvode”, gbode and
“euler” are also available. Output format “mat” is default. “plt”
and “mat” (MATLAB) are the only ones that work with the val() command,
“csv” (comma separated values) and “empty” (no output) are also
available (see section Alternative Simulation Output Formats).



plot(vars) Plot the variables given as a vector or a scalar, e.g.
plot({x1,x2}) or plot(x1).

plotParametric(var1, var2) Plot var2 relative to var1 from the
most recently simulated model, e.g. plotParametric(x,y).

cd() Return the current directory.

cd(dir) Change directory to the directory given as string.

clear() Clear all loaded definitions.

clearVariables() Clear all defined variables.

dumpXMLDAE(modelname, ...) Dumps an XML representation of a model,
according to several optional parameters.

exportDAEtoMatlab(name) Dumps a Matlab representation of a model.

instantiateModel(modelname)Performs code instantiation of a
model/class and return a string containing the flat class definition.

list() Return a string containing all loaded class definitions.

list(modelname) Return a string containing the class definition of
the named class.

listVariables() Return a vector of the names of the currently defined
variables.

loadModel(classname) Load model or package of name classname from
the path indicated by the environment variable OPENMODELICALIBRARY.

loadFile(str) Load Modelica file (.mo) with name given as string
argument str.

readFile(str) Load file given as string str and return a string
containing the file content.

runScript(str) Execute script file with file name given as string
argument str.

system(str) Execute str as a system(shell) command in the
operating system; return integer success value. Output into stdout from
a shell command is put into the console window.

timing(expr) Evaluate expression expr and return the number of
seconds (elapsed time) the evaluation took.

typeOf(variable) Return the type of the variable as a string.

saveModel(str,modelname) Save the model/class with name
modelname in the file given by the string argument str.

val(variable,timePoint) Return the (interpolated) value of the
variable at time timePoint.

help() Print this helptext (returned as a string).

quit() Leave and quit the OpenModelica environment



Running the compiler from command line

The OpenModelica compiler can also be used from command line, in Windows cmd.exe or a Unix shell.
The following examples assume omc is on the PATH; if it is not, you can run C:\OpenModelica 1.16.0\build\bin\omc.exe or similar (depending on where you installed OpenModelica).


Example Session 1 - obtaining information about command line parameters

$ omc --help
OpenModelica Compiler OMCompiler v1.27.0-dev.202+g0e2053de263
Copyright © 2019 Open Source Modelica Consortium (OSMC)
Distributed under OMSC-PL and GPL, see www.openmodelica.org

Usage: omc [Options] (Model.mo | Script.mos) [Libraries | .mo-files]
* Libraries: Fully qualified names of libraries to load before processing Model or Script.
...
Documentation is available in the built-in package OpenModelica.Scripting or
online <https://build.openmodelica.org/Documentation/OpenModelica.Scripting.html>.







Example Session 2 - create an TestModel.mo file and run omc on it

model TestModel
  parameter Real x = 1;
end TestModel;





$ omc TestModel.mo
class TestModel
  parameter Real x = 1.0;
end TestModel;







Example Session 3 - create a mos-script and run omc on it

loadModel(Modelica);
getErrorString();
simulate(Modelica.Mechanics.MultiBody.Examples.Elementary.Pendulum);
getErrorString();





$ omc TestScript.mos
false
"Error: Failed to open file for writing: //.openmodelica/libraries/index.json.tmp1
Error: Failed to download package index https://libraries.openmodelica.org/index/v1/index.json to file //.openmodelica/libraries/index.json.
Error: Failed to open file for writing: //.openmodelica/libraries/index.json.tmp1
Error: Failed to download package index https://libraries.openmodelica.org/index/v1/index.json to file //.openmodelica/libraries/index.json.
Error: Failed to load package Modelica (default) using MODELICAPATH //.openmodelica/libraries/.
"
record SimulationResult
    resultFile = "",
    simulationOptions = "startTime = 0.0, stopTime = 1.0, numberOfIntervals = 500, tolerance = 1e-6, method = 'dassl', fileNamePrefix = 'Modelica.Mechanics.MultiBody.Examples.Elementary.Pendulum', options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = ''",
    messages = "Simulation Failed. Model: Modelica.Mechanics.MultiBody.Examples.Elementary.Pendulum does not exist! Please load it first before simulation.",
    timeFrontend = 0.0,
    timeBackend = 0.0,
    timeSimCode = 0.0,
    timeTemplates = 0.0,
    timeCompile = 0.0,
    timeSimulation = 0.0,
    timeTotal = 0.0
end SimulationResult;
""





In order to obtain more information from the compiler one can use the
command line options --showErrorMessages -d=failtrace when running
the compiler:

$ omc --showErrorMessages -d=failtrace TestScript.mos
InstFunction.getRecordConstructorFunction failed for OpenModelica.Scripting.loadModel
- Static.elabCrefSubs failed on: [top:<Prefix.NOPRE()>].<Prefix.NOPRE()>.Modelica env: <global scope>
- Static.elabCref failed: Modelica in env: <global scope>
- Static.elabCrefSubs failed on: [top:<Prefix.NOPRE()>].<Prefix.NOPRE()>.Modelica env: <global scope>
...
    timeSimulation = 0.0,
    timeTotal = 0.0
end SimulationResult;
""
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Package Management


Overview of Basic Modelica Package Management Concepts

The Modelica language promotes the orderly reuse of component models by means of packages  that contain
structured libraries of reusable models. The most prominent example is the Modelica Standard Library (MSL),
that contains basic models covering many fields of engineering. Other libraries, both open-source and
commercial, are available to cover specific applications domains.

When you start a simulation project using Modelica, it is common practice to collect all related system models
in a project-specific package that you develop. The models in this package are often instantiated (e.g. by drag-and-drop
in OMEdit) from released libraries, which are read-only for your project. This establishes a dependency between your
project package and a certain version of a read-only package (or library), which is the one you have loaded in OMEdit
and that you drag-and-drop components from.

This dependency is automatically marked in your package by adding a uses annotation [https://specification.modelica.org/maint/3.6/annotations.html#version-handling] at the top level. For example, if you
drag and drop components from MSL 4.0.0 into models of your package, the annotation(uses(Modelica(version="4.0.0")));
will be added automatically to it. This information allows OpenModelica to automatically load all the libraries
that are required to compile the models in your own package next time you (or someone else, possibly on a different
computer) loads your package, provided they are installed in places on the computer's file system where OpenModelica
can find them.

The default place where OpenModelica looks for packages is the so-called
MODELICAPATH [https://specification.modelica.org/maint/3.6/packages.html#the-modelica-library-path-modelicapath].
You can check where it is by typing getModelicaPath() in the Interactive Environment (Tools | OpenModelica Compiler CLI in OMEdit),
or by browsing the General group under Tools|Options|Libraries. Installed read-only libraries are all placed by default in the MODELICAPATH.

However, when you open a package directly from the file system, OpenModelica will also look for
packages it depends upon in the same directory that contains the package you just opened. For example, if you open
/home/John/ModelicaPackages/MoonShot/package.mo, and your MoonShot package contains annotation(uses(Rockets));,
OpenModelica will also check /home/John/ModelicaPackages/Rockets/package.mo and /home/John/ModelicaPackages/Rockets.mo.
So, if you are developing several packages with dependencies among them, you can place them in the same common root directory
to make sure that all the dependencies are loaded automatically, without the need of putting them in the MODELICAPATH, or
to change it to include that directory.

Please note that if the uses annotation refers to a specific version of a package, that package will only be loaded
if the name of the directory or of the single file that contains it also indicates the version number, as allowed by
the Modelica Specification, Section 18.8.3 [https://specification.modelica.org/maint/3.6/annotations.html#mapping-of-versions-to-file-system]. For example,
if MoonShot contains annotation(uses(Rockets(version = "2.0.0"));, OpenModelica will try to load
/home/John/ModelicaPackages/Rockets 2.0.0/package.mo or /home/John/ModelicaPackages/Rockets 2.0.0.mo;
in this case, packages without the version number in their root directory, such as
/home/John/ModelicaPackages/Rockets/package.mo, will be ignored. All installed packages in the MODELICAPATH
include version numbers in their directory name, which also allows to install multiple versions of the same library.

When a new version of certain package comes out, conversion annotations [https://specification.modelica.org/maint/3.5/annotations.html#version-handling] in it declare whether your models using
a certain older version of it can be used as they are with the new one, which is then 100% backwards-compatible, or whether
they need to be upgraded by running a conversion script, provided with the new version of the package. The former case
is declared explicitly by a conversion(noneFromVersion) annotation. For example, a conversion(noneFromVersion="3.0.0")
annotation in version 3.1.0 of a certain package means that all packages using version 3.0.0 can use 3.1.0
without any change. Of course it is preferrable to use a newer, backwards-compatible version, as it contains bugfixes
and possibly new features.

Hence, if you install a new version of a library which is 100% backwards-compatible with the previous ones, all your models that
used the old one will automatically load and use the new one, without the need of any further action.

If the new version is not backwards-compatible, instead, you will need to create a new version of
your library that uses it, by running the provided conversion scripts.

OpenModelica has a package manager that can be used to install and update libraries on your computer, and is able to run
conversion scripts. Keep in mind there are three stages in package usage: available packages are indexed on the
OSMC servers and can be downloaded from public repositories;
installed packages are stored in the MODELICAPATH of your computer; loaded packages are loaded in memory
in an active OMC session, either via the Interactive Environment, or via the OMEdit GUI, where they are shown in the
Libraries Browser. When you load a package, OpenModelica tries to load the best possible installed versions of all
the dependencies declared in the uses annotation.



The Package Manager

The Open Source Modelica Consortium (OSMC) maintains a collection of publicly available, open-source Modelica libraries
on its servers, see https://github.com/OpenModelica/OMPackageManager. These libraries are routinely tested with past
released versions of OpenModelica, as well as with the current development version on the master branch, see
the overview report [https://libraries.openmodelica.org/branches/overview-combined.html].
Based on the testing results and on information gathered from the library developers, these packages are classified
in terms of level of support in OpenModelica. Backwards-compatibility information is also collected from the
conversion annotations.

The OpenModelica Package Manager relies on this information to install the best versions of the library dependencies of your
own, locally developed Modelica packages and models. It can be run both from the OMEdit GUI and from the command-line interactive environment. The libraries
and their index.json index file with all the library metadata are installed in the ~/.openmodelica/libraries directory under
Linux and in the %AppData%\.openmodelica\libraries directory on Windows. Note that these directories are user-specific, so if there are
multiple users on the same computer, each of them will install and manage his/her own set of libraries independently from the others.

The Package Manager may install multiple builds of the same library version in your own package manager directory,
if they are indexed on the OSMC servers. When this happens, they are distinguished among each other by means of
semver [https://semver.org/#semantic-versioning-specification-semver]-style pre- or post-release metadata in the
top directory name on the file system. Post-release builds are denoted by a plus sign (e.g. 2.0.0+build.02)
and have higher priority over the corresponding plain release
(e.g. 2.0.0), while pre-release builds are denoted by a minus sign (e.g. 2.0.0-dev.30) and have a lower priority.

When loading a certain version of a library, unless a specific build is explicitly referenced, the one with higher
precedence will always be loaded. For example, if the versions 2.0.0-beta.01, 2.0.0, and 2.0.0+build.01
are installed, the latter is loaded by libraries with uses annotation requiring version 2.0.0. Unless, of course,
there are later backwards-compatible versions installed, e.g., 2.0.1, in which case the one with the highest release
number and priority is installed.

In any case, semver version semantics is only used to order the releases, while backwards-compatibility
is determined exclusively on the basis of noneFromVersion annotations.

When installing OpenModelica, a cached version of the latest versions of the Modelica Standard Library is included in the
installation files. As soon as a user starts any OpenModelica tool (e.g., OMEdit, OMNotebook, OMShell, or direct command-line
invocation of omc), if the user's .openmodelica directory is empty the Modelica Standard Library will be installed
automatically using this cached version. This happens when using OpenModelica for the first time, or if the contents of the
.openmodelica directory have been deleted to get rid of all installed libraries. This automatic installation needs no
Internet connection, so it also works behind firewalls or in set-ups with limited available bandwidth. Therefore, the Modelica
Standard Library is immediately available without the need of using the package manager explicitly. It is then possible
to install and manage other libraries using the package manager, as explained previously.

As a final remark, please note that the version numbers of the various Modelica packages have no relation with the version
numbers of the OpenModelica tool itself. Since version 1.19.0, OpenModelica is no longer shipped with built-in installed
libraries, that are instead managed independently by the user with the online Package Manager. You can install and use old and new
versions of a certain open source Modelica library using the latest released version of OpenModelica, by using the
Package Manager. We strive to make sure that new released versions of OpenModelica are backwards-compatible, meaning that you should
always be able to run the same models/libraries with a new version of OpenModelica if you could with an older version of the
tool. Hence, we strongly advise you to always use the latest released version of OpenModelica, even if you are running old
models; by doing so, you benefit from faster performance, more robust numerical performance, new tool features, and a
lot of bug fixes.

You should never find yourself in a situation where you are forced to stick to an old version of OpenModelica to run your models.
If that happens to you, please open a ticket on the issue tracker [https://github.com/OpenModelica/OpenModelica/issues/new/choose], so we can hopefully fix the problem and allow you to keep using the latest OpenModelica release.


Package Management in OMEdit

Installing a new library in OMEdit.



Running Conversion Scripts in OMEdit

Converting a library in OMEdit.



Automatically Loaded Packages in OMEdit

When you start OMEdit, some packages can be automatically loaded into the environment, and shown in the Libraries
Browser. You can configure which ones are loaded from the Tools|Options|Libraries menu.

Please note that automatically loaded libraries may be in conflict with the dependencies of packages that you may
later load from the File menu. For example, if you automatically load Modelica 4.0.0, and then load a library XYZ that
still uses MSL 3.2.3, you get a conflict, because Modelica 4.0.0 is not backwards-compatible with Modelica 3.2.3,
so XYZ cannot be used.

In this case you have two options:


	Cancel Operation: this means XYZ is not actually loaded, and all previously loaded libraries remain in place.


	Unload all and Reload XYZ: in this case, all previously loaded libraries, that may generate conflicts, are unloaded first;
then XYZ is loaded, and finally the right versions of the libraries XYZ uses, as declared in its uses annotation,
will be loaded automatically.




If you are normally working with only one version of the Modelica standard library, you can set it to be automatically loaded
from the Tools|Options|Libraries menu; in case you need to work with a library that uses a previous, non-backwards compatible
version, the Unload all and Reload option comes handy. Otherwise, you can avoid loading the Modelica library automatically
upon starting OMEdit, and let the right version of the Modelica library be loaded automatically when you open the library you
want to work with. In this case, if you want to get the Modelica library into the Package Browser to start developing a new library,
you can do so easily from the Welcome tab, by clicking on the System Libraries button and selecting the version that you want to load.



Manually Loading Packages

If you want to maintain full control over which library dependencies are loaded, you can use the File | Open Model/Library Files(s)
menu command in OMEdit to open the libraries one by one from specific locations in your file system. Note,
however, that whenever a library is loaded, its dependencies, that are declared in its uses annotation, will automatically
be loaded. If you want to avoid that, you need to load the library dependencies in reverse order, so that the
intended library dependencies are already loaded when you open the library that needs them.

If you are using the Interactive Environment, you can use the loadFile() command to load libraries from
specific locations on the file system, also in reverse dependency order, unless you also set the optional
uses = false input argument to disable the automatic loading of dependencies.



Using the Package Manager from the Interactive Environment

The Package Manager can also be used from the Interactive Environment command line shell. Here is a list
of examples of relevant commands; please type them followed by getErrorString(),
e.g., updatePackageIndex(); getErrorString(), in order to get additional information,
notifications and error messages.


	updatePackageIndex() - this command puts the Package Manager in contact with the OSMC servers and updates
the internally stored list of available packages;


	getAvailablePackageVersions(Building, "") - lists all available versions of the Buildings library on the OSMC server,
starting from the most recent one, in descending order of priority. Note that pre-release versions have lower priority
than all other versions;


	getAvailablePackageVersions(Building, "7.0.0") - lists all available versions of the Buildings library on
the OSMC server that are backwards-compatible with version 7.0.0, in descending order of priority;


	installPackage(Buildings, "") - install the most recent version of the Building libraries, and all its dependencies;


	installPackage(Buildings, "7.0.0") - install the most recent version of the Building libraries which is backwards-compatible
with version 7.0.0, and all its dependencies;


	installPackage(Buildings, "7.0.0", exactMatch = true) - install version 7.0.0 even if there are more recent
backwards-compatible versions available, and all its dependencies;


	upgradeInstalledPackages(installNewestVersions = true) - installs the latest available version of all installed packages.







How the package index works

The package index is generated by OMPackageManager [https://github.com/OpenModelica/OMPackageManager] on an OSMC server,
based on these settings [https://github.com/OpenModelica/OMPackageManager/blob/master/repos.json].
See its documentation to see how to add new packages to the index, change support level, and so on.

The index is generated by scanning git repositories on github.
All tags and optionally some specific branches are scanned.
The tag name is parsed as if it was a semantic version, with prerelease and metadata of the tag added to the version of Modelica packages in the repository.
If the tag name is not a semantic version, it is sorted differently.

Packages are sorted as follows:


	Support level: each package is given a level of support in the index


	Semantic version: according to the semver specification, but build metadata is also considered (sorted the same way as pre-releases)


	Non-semantic versions: alphabetically
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OMEdit - OpenModelica Connection Editor

OMEdit - OpenModelica Connection Editor is the new Graphical User
Interface for graphical model editing in OpenModelica. It is implemented
in C++ using the Qt graphical user interface library and supports
the Modelica Standard Library that is included in the latest
OpenModelica installation. This chapter gives a brief introduction to
OMEdit and also demonstrates how to create a DCMotor model using the
editor.

OMEdit provides several user friendly features for creating, browsing,
editing, and simulating models:


	Modeling - Easy model creation for Modelica models.


	Pre-defined models - Browsing the Modelica Standard library to
access the provided models.


	User defined models - Users can create their own models for
immediate usage and later reuse.


	Component interfaces - Smart connection editing for drawing and
editing connections between model interfaces.


	Simulation - Subsystem for running simulations and specifying
simulation parameters start and stop time, etc.


	Plotting - Interface to plot variables from simulated models.





Starting OMEdit

A splash screen similar to the one shown in Figure 5 will
appear indicating that it is starting OMEdit.
The executable is found in different places depending on the platform
(see below).


[image: _images/omedit_splashscreen.png]

Figure 5 OMEdit Splash Screen.




Microsoft Windows

OMEdit can be launched using the executable placed in
OpenModelicaInstallationDirectory/bin/OMEdit/OMEdit.exe. Alternately,
choose OpenModelica > OpenModelica Connection Editor from the start menu
in Windows.



Linux

Start OMEdit by either selecting the corresponding menu application item
or typing “OMEdit” at the shell or command prompt.



Mac OS X

The default installation is /Application/MacPorts/OMEdit.app.




MainWindow & Browsers

The MainWindow contains several dockable browsers,


	Libraries Browser


	Documentation Browser


	Variables Browser


	Messages Browser




Figure 6 shows the MainWindow and browsers.


[image: _images/omedit-mainwindow-browsers.png]

Figure 6 OMEdit MainWindow and Browsers.



The default location of the browsers are shown in Figure 6.
All browsers except for Message Browser can be docked into left or right
column. The Messages Browser can be docked into top or bottom
areas. If you want OMEdit to remember the new docked position of the
browsers then you must enable Preserve User's GUI Customizations option,
see section General Options.


Filter Classes

To filter a class click Edit > Filter Classes or press keyboard
shortcut Ctrl+Shift+F. The loaded Modelica classes can be filtered by
typing any part of the class name.



Libraries Browser

To view the Libraries Browser click View > Windows > Libraries Browser.
Shows the list of loaded Modelica classes. Each item of the Libraries
Browser has right click menu for easy manipulation and usage of the
class. The classes are shown in a tree structure with name and icon. The
protected classes are not shown by default. If you want to see the
protected classes then you must enable the Show Protected Classes
option, see section General Options.



Documentation Browser

Displays the HTML documentation of Modelica classes. It contains the
navigation buttons for moving forward and backward. It also contains
a WYSIWYG editor which allows writing class documentation in HTML format.
To view the Documentation Browser click View > Windows > Documentation Browser.


[image: _images/omedit-documentation-browser.png]

Figure 7 Documentation Browser.





Variables Browser

The class variables are structured in the form of the tree and are
displayed in the Variables Browser. Each variable has a checkbox.
Ticking the checkbox will plot the variable values. The complete
Variables Browser can be collapsed and expanded using the Collapse All
and Expand All buttons.

There is a find box for filtering the variable in the tree. By clicking
the yellow down arrow you can set all the filtering options. The filtering
can be done using Regular Expression, Wildcard and Fixed String; in all
three cases, all variables whose full name contains a string corresponding
to the filter string will be displayed.

Fixed String: shows all variables whose name contains the string verbatim


	abc shows abc, abc.def, xyz.abc, der(abc) etc.


	a.b shows a.b, a.bcd, a.b.c, x.a.b, x.a.b.c, etc.




Wildcard: same as Fixed String; additionally, asterisks match any number of characters


	der(*) shows all derivatives, e.g. der(x), der(abc), abc.der(xyz), etc.


	a*c shows ac, abc, abdc, xyz.adefc, etc.




Regular expression: shows all variables whose name contain a string that matches the regexp;
if the regexp ends with $, then the name must end with a string matching the regexp


	abc shows abc, abc.def, xyz.abc, der(abc) etc.


	abc$ shows abc, xyz.abc only


	a.c shows abc, abc.def, azc, xyz.adc etc. (. matches any character)


	a.*c shows abc, abc.def, axyc, xyz.axxxxdc etc. (.* matches any number of character)


	body\.a_0\[1\] shows variables containing body.a_0[1]. Note that .,
[, and ] are special regexp characters, so they must be escaped


	der\(.*\) shows all derivatives in the model. Note that ( and ) must be
escaped


	x\[[2-4]\] shows elements 2, 3, and 4 of arrays x[:], abc.x[:], x[:].abc


	x\[.*\] shows all elements of arrays x[:], abc.x[:], x[:].abc


	abc|def shows all variables with names containing either abc or def




The browser allows manipulation of changeable parameters for
Plot Window. It also displays the unit and
description of the variable.

The browser also contains the slider and animation buttons. These controls
are used for variable graphics and schematic animation of models i.e.,
DynamicSelect annotation. They are also used for debugging of state machines.
Open the Diagram Window for animation. It is only possible
to animate one model at a time.


[image: _images/omedit-variables-browser.png]

Figure 8 Variables Browser.





Messages Browser

Shows the list of errors. Following kinds of error can occur,


	Syntax


	Grammar


	Translation


	Symbolic


	Simulation


	Scripting




See section Messages Options for Messages Browser options.




Perspectives

The perspective tabs are located at the bottom right of the Main Window:


	Welcome Perspective


	Modeling Perspective


	Plotting Perspective


	Debugging Perspective





Welcome Perspective


[image: _images/omedit-welcome.png]

Figure 9 OMEdit Welcome Perspective.



The Welcome Perspective shows the list of recent files and the list of
latest news from https://www.openmodelica.org.
See Figure 9. The orientation of recent files and latest news can be
horizontal or vertical. User is allowed to show/hide the latest news.
See section General Options.



Modeling Perspective

The Modeling Perspective provides the interface where user can create and
design their models. See Figure 10.


[image: _images/omedit-modeling-perspective.png]

Figure 10 OMEdit Modeling Perspective.



The Modeling Perspective interface can be viewed in two different modes,
the tabbed view and sub-window view, see section General Options.



Plotting Perspective

The Plotting Perspective shows the simulation results of the models.
Plotting Perspective will automatically become active when the
simulation of the model is finished successfully. It will also become
active when user opens any of the OpenModelica's supported result file.
Similar to Modeling Perspective this perspective can also be viewed in
two different modes, the tabbed view and sub-window view, see section
General Options.


[image: _images/omedit-plotting-perspective.png]

Figure 11 OMEdit Plotting Perspective.





Debugging Perspective

The application automatically switches to Debugging Perspective
when user simulates the class with algorithmic debugger.
The perspective shows the list of stack frames, breakpoints and variables.


[image: _images/omedit-debugging-perspective.png]

Figure 12 OMEdit Debugging Perspective.






File Menu


	New






	New Modelica Class - Creates a new Modelica class.


	New SSP Model - Creates a new SSP model.








	Open Model/Library File(s) - Opens the Modelica file or a library.


	Open/Convert Modelica File(s) With Encoding - Opens the Modelica file or
a library with a specific encoding. It is also possible to convert to UTF-8.


	Load Library - Loads a Modelica library. Allows the user to select the
library path assuming that the path contains a package.mo file.


	Load Encrypted Library - Loads an encrypted library. see OpenModelica Encryption


	Open Result File(s) - Opens a result file.


	Open Transformations File - Opens a transformational debugger file.


	Unload All - Unloads all loaded classes.


	Open Directory - Loads the files of a directory recursively. The files
are loaded as text files.


	Save - Saves the class.


	Save As - Save as the class.


	Save Total - Saves the class and all the classes it uses in a single file.
The class and its dependencies can only be loaded later by using the loadFile() API
function in a script. Allows third parties to reproduce an issue with a class without
worrying about library dependencies.


	Import






	FMU - Imports the FMU.


	FMU Model Description - Imports the FMU model description.


	From OMNotbook - Imports the Modelica models from OMNotebook.


	Ngspice netlist - Imports the ngspice netlist to Modelica code.








	Export






	To Clipboard - Exports the current model to clipboard.


	Image - Exports the current model to image.


	FMU - Exports the current model to FMU.


	Read-only Package - Exports a zipped Modelica library with file extension .mol


	Encrypted Package - Exports an encrypted package. see OpenModelica Encryption


	XML - Exports the current model to a xml file.


	Figaro - Exports the current model to Figaro.


	To OMNotebook - Exports the current model to a OMNotebook file.








	System Libraries - Contains a list of system libraries.


	Manage Libraries






	Install Library - Opens a dialog to select and install a new library,
see Install Library


	Upgrade Installed Libraries - Opens a dialog to upgrade the installed libraries.


	Update Library Index - Updates the library index.








	Recent Files - Contains a list of recent files.


	Clear Recent Files - Clears the list of recent files.


	Print - Prints the current model.


	Quit - Quit the OpenModelica Connection Editor.






Edit Menu


	Undo - Undoes the last change.


	Redo - Redoes the last undone change.


	Filter Classes - Filters the classes in Libraries Browser,
see Filter Classes






View Menu


	Toolbars - Toggle visibility of toolbars.


	Windows - Toggle visibility of windows.






	Close Window - Closes the current model window.


	Close All Windows - Closes all the model windows.


	Close All Windows But This - Closes all the model windows except the current.


	Cascade Windows - Arranges all the child windows in a cascade pattern.


	Tile Windows Horizontally - Arranges all child windows in a horizontally tiled pattern.


	Tile Windows Vertically - Arranges all child windows in a vertically tiled pattern.








	Toggle Tab/SubWindow View - Switches between tab and sub-window view.


	Grid Lines - Toggle grid lines of the current model.


	Reset Zoom - Resets the zoom of the current model.


	Zoom In - Zoom in the current model.


	Zoom Out - Zoom out the current model.


	Fit to Diagram - Fit the current model diagram in the view.






SSP Menu


	Add System - Adds the system to a model.


	Add/Edit Icon - Add/Edit the system/submodel icon.


	Delete Icon - Deletes the system/submodel icon.


	Add Connector - Adds a connector to a system/submodel.


	Add Bus - Adds a bus to a system/submodel.


	Add TLM Bus - Adds a TLM bus to a system/submodel.


	Add SubModel - Adds a submodel to a system.






Simulation Menu


	Check Model - Checks the current model.


	Check All Models - Checks all the models of a library.


	Instantiate Model - Instantiates the current model.


	Simulation Setup - Opens the simulation setup window.


	Simulate - Simulates the current model.


	Simulate with Transformational Debugger - Simulates the current model and
opens the transformational debugger.


	Simulate with Algorithmic Debugger - Simulates the current model and
opens the algorithmic debugger.


	Simulate with Animation - Simulates the current model and open the animation.


	Archived Simulations - Shows the list of simulations already finished or running.
Double clicking on any of them opens the simulation output window.






Data Reconciliation


	Calculate Data Reconciliation - Opens the dialog to run the data reconciliation algorithm.






Sensitivity Optimization Menu


	Run Sensitivity Analysis and Optimization - Runs the sensitivity analysis and optimization.






Debug Menu


	Debug Configurations - Opens the debug configurations window.


	Attach to Running Process - Attaches the algorithmic debugger to a running process.






Tools Menu


	OpenModelica Compiler CLI - Opens the OpenModelica Compiler command line
interface window.


	OpenModelica Command Prompt - Opens the OpenModelica Command Prompt (Only
available on Windows).


	Open Temporary Directory - Opens the current temporary directory.


	Open Working Directory - Opens the current working directory.


	Open Terminal - Runs the terminal command set in General Options.


	Options - Opens the options window.






Help Menu


	OpenModelica User's Guide - Opens the OpenModelica User's Guide.


	OpenModelica User's Guide (PDF) - Opens the OpenModelica User's Guide (PDF).


	OpenModelica System Documentation - Opens the OpenModelica System Documentation.


	OpenModelica Scripting Documentation - Opens the OpenModelica Scripting Documentation.


	Modelica Documentation - Opens the Modelica Documentation.


	OMSimulator User's Guide - Opens the OMSimulator User's Guide.


	About OMEdit - Shows the information about OpenModelica Connection Editor.






Modeling a Model


Creating a New Modelica Class

Creating a new Modelica class in OMEdit is rather straightforward.
Choose any of the following methods,


	Select File > New > New Modelica Class from the menu.


	Click on New Modelica Class toolbar button.


	Click on the Create New Modelica Class button available at the left
bottom of Welcome Perspective.


	Press Ctrl+N.






Opening a Modelica File

Choose any of the following methods to open a Modelica file,


	Select File > Open Model/Library File(s) from the menu.


	Click on Open Model/Library File(s) toolbar button.


	Click on the Open Model/Library File(s) button available at the right
bottom of Welcome Perspective.


	Press Ctrl+O.




(Note, for editing Modelica system files like MSL (not recommended), see Editing Modelica Standard Library)



Opening a Modelica File with Encoding

Select File > Open/Convert Modelica File(s) With Encoding from the menu.
It is also possible to convert files to UTF-8.



Model Widget

For each Modelica class one Model Widget is created. It has a statusbar
and a view area. The statusbar contains buttons for navigation between
the views and labels for information. The view area is used to display
the icon, diagram and text layers of Modelica class. See Figure 13.


[image: _images/omedit-model-widget.png]

Figure 13 Model Widget showing the Diagram View.





Adding Component Models

Drag the models from the Libraries Browser and drop them on either
Diagram or Icon View of Model Widget.



Making Connections

In order to connect one component model to another the user first needs
to enable the connect mode ([image: OMEdit connect mode icon]) from the toolbar.

Move the mouse over the connector. The mouse cursor will change from arrow cursor to cross cursor.
To start the connection press left button and move while keeping the button pressed.
Now release the left button.
Move towards the end connector and click when cursor changes to cross cursor.




Simulating a Model

The simulation process in OMEdit is split into three main phases:


	The Modelica model is translated into C/C++ code. The model is first instantiated by
the frontend, which turns it into a flat set of variables, parameters, equations,
algorithms, and functions. The backend then analyzes the mathematical structure
of the flat model, applies symbolic simplifications and determines how the equations
can be solved efficiently.
Finally, based on this information, model-specific C/C++ code is generated. This part
of the process can be influenced by setting
Translation Flags (a.k.a.
Command Line Options), e.g. deciding which kind of structural simplifications should
be performed during the translation phase.


	The C/C++ code is compiled and linked into an executable simulation code. Additional
C/C++ compiler flags can be given to influence this
part of the process, e.g. by setting compiler optimizations such as -O3.
Since multiple C/C++ source code files are generated for a given model, they are
compiled in parallel by OMEdit, exploiting the power of multi-core CPUs.


	The simulation executable is started and produces the simulation results in a .mat or
.csv file. The runtime behavior can be influenced by Simulation Flags, e.g. by
choosing specific solvers, or changing the output file name. Note that it it possible
to re-simulate a model multiple times, changing parameter values from the Variables
Browser and/or changing some Simulation Flags. In this case, only Phase 3. is repeated,
skipping Phases 1. and 2., which enables much faster iterations.




The simulation options for each model are stored inside the OMEdit data structure.
They are set according to the following sequence,


	Each model has its own translation and simulation options.


	If the model is opened for the first time then the translation and simulation options
are set to defaults, that can be customized in Tools | Options | Simulation.


	experiment,  __OpenModelica_commandLineOptions and __OpenModelica_simulationFlags
annotations are applied if the model contains them.


	After that all the changes done via Simulation Setup window for a certain model are
preserved for the whole session. If you want to use the same settings in
future sessions then you should store them inside experiment,
__OpenModelica_commandLineOptions, and __OpenModelica_simulationFlags
annotations.




The OMEdit Simulation Setup can be launched by,


	Selecting Simulation > Simulation Setup from the menu. (requires a
model to be active in ModelWidget)


	Clicking on the Simulation Setup toolbar button. (requires a model to
be active in ModelWidget)


	Right clicking the model from the Libraries Browser and choosing
Simulation Setup.





General


	Simulation Interval






	Start Time - the simulation start time.


	Stop Time - the simulation stop time.


	Number of Intervals - the simulation number of intervals.


	Interval - the length of one interval (i.e., stepsize)








	Integration






	Method - the simulation solver. See section Integration Methods for solver details.


	Tolerance - the simulation tolerance.


	Jacobian - the jacobian method to use.


	DASSL/IDA Options






	Root Finding - Activates the internal root finding procedure of dassl.


	Restart After Event - Activates the restart of dassl after an event is performed.


	Initial Step Size


	Maximum Step Size


	Maximum Integration Order











	C/C++ Compiler Flags (Optional) - the optional C/C++ compiler flags.


	Number of Processors - the number of processors used to build the simulation.


	Build Only - only builds the class.


	Launch Transformational Debugger - launches the transformational debugger.


	Launch Algorithmic Debugger - launches the algorithmic debugger.


	Launch Animation - launches the 3d animation window.






Interactive Simulation


	Simulate with steps (makes the interactive simulation synchronous; plots nicer curves
at the expense of performance)


	Simulation server port






Translation Flags



Simulation Flags


	Model Setup File (Optional) - specifies a new setup XML file to the generated
simulation code.


	Initialization Method (Optional) - specifies the initialization method.


	Equation System Initialization File (Optional) - specifies an
external file for the initialization of the model.


	Equation System Initialization Time (Optional) - specifies a time
for the initialization of the model.


	Clock (Optional) - the type of clock to use.


	Linear Solver (Optional) - specifies the linear solver method.


	Non Linear Solver (Optional) - specifies the nonlinear solver.


	Linearization Time (Optional) - specifies a time where the
linearization of the model should be performed.


	Output Variables (Optional) - outputs the variables a, b and c at
the end of the simulation to the standard output.


	Profiling - creates a profiling HTML file.


	CPU Time - dumps the cpu-time into the result file.


	Enable All Warnings - outputs all warnings.


	Logging (Optional)






	LOG_STDOUT - standard output stream. This stream is always active, can be disabled
with -lv=-LOG_STDOUT


	LOG_ASSERT - This stream is always active, can be disabled with -lv=-LOG_ASSERT


	LOG_DASSL - additional information about dassl solver.


	LOG_DASSL_STATES - outputs the states at every dassl call.


	LOG_DEBUG - additional debug information.


	LOG_DELAY - Debug information for delay operator.


	LOG_DIVISION - Log division by zero.


	LOG_DSS - outputs information about dynamic state selection.


	LOG_DSS_JAC - outputs jacobian of the dynamic state selection.


	LOG_DT - additional information about dynamic tearing.


	LOG_DT_CONS - additional information about dynamic tearing (local and global constraints).


	LOG_EVENTS - additional information during event iteration.


	LOG_EVENTS_V - verbose logging of event system.


	LOG_GBODE - Information about GBODE solver.


	LOG_GBODE_V - Verbose information about GBODE solver.


	LOG_GBODE_NLS - Log non-linear solver process of GBODE solver.


	LOG_GBODE_NLS_V - Verbose log non-linear solver process of GBODE solver.


	LOG_GBODE_STATES - Output states at every GBODE call.


	LOG_INIT - additional information during initialization.


	LOG_INIT_HOMOTOPY - Log homotopy initialization.


	LOG_INIT_V - Verbose information during initialization.


	LOG_IPOPT - information from Ipopt.


	LOG_IPOPT_FULL - more information from Ipopt.


	LOG_IPOPT_JAC - check jacobian matrix with Ipopt.


	LOG_IPOPT_HESSE - check hessian matrix with Ipopt.


	LOG_IPOPT_ERROR - print max error in the optimization.


	LOG_JAC - Outputs the jacobian matrix used by ODE solvers.


	LOG_LS - logging for linear systems.


	LOG_LS_V - verbose logging of linear systems.


	LOG_NLS - logging for nonlinear systems.


	LOG_NLS_V - verbose logging of nonlinear systems.


	LOG_NLS_HOMOTOPY - logging of homotopy solver for nonlinear systems.


	LOG_NLS_JAC - outputs the jacobian of nonlinear systems.


	LOG_NLS_JAC_TEST - tests the analytical jacobian of nonlinear systems.


	LOG_NLS_NEWTON_DIAGNOSTICS - Log Newton diagnostics. A Diagnostic method to figure out
which individual initial guess values are more likely to be causing the convergence
failure of Newton-type iterative nonlinear solvers.


	LOG_NLS_RES - outputs every evaluation of the residual function.


	LOG_NLS_EXTRAPOLATE - outputs debug information about extrapolate process.


	LOG_RES_INIT - outputs residuals of the initialization.


	LOG_RT - additional information regarding real-time processes.


	LOG_SIMULATION - additional information about simulation process.


	LOG_SOLVER - additional information about solver process.


	LOG_SOLVER_V - verbose information about the integration process.


	LOG_SOLVER_CONTEXT - context information during the solver process.


	LOG_SOTI - final solution of the initialization.


	LOG_SPATIALDISTR - logging of internal operations for spatialDistribution.


	LOG_STATS - additional statistics about timer/events/solver.


	LOG_STATS_V - additional statistics for LOG_STATS.


	LOG_SUCCESS - This stream is always active, can be disabled with -lv=-LOG_SUCCESS.


	LOG_SYNCHRONOUS - Log clocks and sub-clocks for synchronous features.


	LOG_ZEROCROSSINGS - additional information about the zero-crossings.








	Additional Simulation Flags (Optional) - specify any other simulation flag.






Output


	Output Format - the simulation result file output format.


	Single Precision - Output results in single precision (only for mat output format).


	File Name Prefix (Optional) - the name is used as a prefix for the output files.


	Result File (Optional) - the simulation result file name.


	Variable Filter (Optional) - only output variables with names fully matching the
regular expression.


	Protected Variables if not encrypted - adds the protected variables in result file.


	Equidistant Time Grid - output the internal steps given by dassl instead of
interpolating results into an equidistant time grid as given by stepSize or
numberOfIntervals.


	Store Variables at Events - adds the variables at time events.


	Show Generated File - displays the generated files in a dialog box.




The Variable Filter takes a regular expression input and only saves in the simulation
results file those variables whose names fully match it.
Here are some simple examples:


	.* matches any variable (default choice)


	xy.* matches variables starting with xy


	.*yz matches variables ending with yz


	abc\.def.* matches variables starting with abc.def. Note that the .
character is a regex meta-character, so it must be escaped by a \


	.*body\.a_0\[1\] matches variables ending with body.a_0[1]. Note that .,
[, and ] must be escaped


	x\[.*\] matches all elements of array x


	x\[[2-4]\] matches elements 2, 3, and 4 of array x


	abc.*|def.* matches variables starting with abc or def


	.*der\(.*\) matches all derivatives in the model. Note that ( and ) must be
escaped




Please note that all the model variables will still be shown in the Variables Browser
tree; however, only those for which results were actually saved will have a checkbox to
plot them.



CSV-File Data Input

When simulating Modelica models with top-level inputs (input variables or input
connectors), these inputs are assumed to be equal to their start value by default.
However, it is possible to feed them with input signals obtained from CSV (Comma-Separated
Value) input data files, by means of the -csvInput simulation
flag, that can be set in the Additional Simulation Flags (Optional) field of the
Simulation Flags tab. For example, setting -csvInput=myinput.csv causes the runtime
executable to read such input data from the myinput.csv file.

CSV files should contain the names of the input variables in the first row, beginning with
time on the first column, and the values of such variables for each point in time in
subsequent rows, with non-decreasing time values. The variable names should be enclosed by
quotation marks in case they contain spaces, to avoid ambiguities. The default separator
for data items within each row is the comma, but it is also possible to use other
separators, e.g., space, tab, or semi-colon; in this case, the file should start with the
separator specification "sep=x" (including the quotation marks), where x is the
separator character.

For example, assume your model has three top-level inputs named u1, u2, and
u3. These are valid CSV input files:

time, u3, u2, u1
0.0, 0.0, 0.0, 0.0
1.0, 0.0, 0.0, 0.0
2.0, 0.0, 0.0, 1.0

"sep=;" time; u3; u2; u1
0.0; 0.0; 0.0; 0.0
1.0; 0.0; 0.0; 0.0
2.0; 0.0; 0.0; 1.0

"sep= " "time" "u3" "u2" "u1"
0.0 0.0 0.0 0.0
1.0 0.0 0.0 0.0
2.0 0.0 0.0 1.0





Note that input labels need not be lexicographically ordered, the association between the
columns and the inputs is given by the first row.

The CSV-file provides the values of the top level inputs at the specified points in time;
linear interpolation is used to provide intermediate values between any two subsequent
data points. Discontinuous inputs can be obtained by providing two consecutive rows with
the same time value, containing the left limit values and the right limit values.

Unless an absolute pathname is provided for the CSV-files, OMEdit will load it from the
sub-directory of the working directory which has the same name of the model, where all the
other input and output data files are located.



Data Reconciliation


	Algorithm - data reconciliation algorithm.


	Measurement Input File - measurement input file.


	Correlation Matrix Input File - correlation matrix file.


	Epsilon







2D Plotting

Successful simulation of model produces the result file which contains
the instance variables that are candidate for plotting. Variables
Browser will show the list of such instance variables. Each variable has
a checkbox, checking it will plot the variable. See Figure 11.
To get several plot windows tiled horizontally or vertically use the
menu items Tile Windows Horizontally or Tile Windows Vertically under View Menu.


Types of Plotting

The plotting type depends on the active Plot Window. By default the
plotting type is Time Plot.


Time Plot

Plots the variable over the simulation time. You can have multiple Time
Plot windows by clicking on New Plot Window toolbar button ([image: OMEdit New Plot Window Icon]).



Plot Parametric

Draws a two-dimensional parametric diagram, between variables x and y,
with y as a function of x. You can have multiple Plot Parametric
windows by clicking on the New Plot Parametric toolbar button ([image: OMEdit New Parametric Plot Window Icon]).

Select the x-axis variable while holding down the shift key, release the shift key and
then select y-axis variables. One or many y-axis variables can be selected against one
x-axis variable. To select a new x-axis variable press and hold the shift key again.

Unchecking the x-axis variable will uncheck all y-axis variables linked to it.



Array Plot

Plots an array variable so that the array elements' indexes are on the x-axis and corresponding
elements' values are on the y-axis. The time is controlled by the slider above the variable tree.
Right click the result file in variable browser and select Enable Time Controls to enable the slider.
When an array is present in the model, it has a principal array node in the variable tree.
To plot this array as an Array Plot, match the principal node. The principal node may be expanded
into particular array elements. To plot a single element in the Time Plot, match the element.
A new Array Plot window is opened using the New Array Plot Window toolbar button ([image: OMEdit New Array Plot Window Icon]).



Array Parametric Plot

Plots the first array elements' values on the x-axis versus the second array elements'
values on the y-axis. The time is controlled by the slider above the variable tree.
Right click the result file in variable browser and select Enable Time Controls to enable the slider.
To create a new Array Parametric Plot, press the New Array Parametric Plot Window toolbar
button ([image: OMEdit New Array Parametric Plot Window Icon]), then match the principle array node in the
variable tree view to be plotted on the x-axis and match the principle array node to be
plotted on the y-axis.



Diagram Window

Shows the active ModelWidget as a read only diagram. You can only have one
Diagram Window. To show it click on Diagram Window toolbar button ([image: OMEdit Diagram Window Icon]).




Plot Window

A plot window shows the plot curve of instance variables. Several plot curves can be plotted in the
same plot window. See Figure 11.


Plot Window Menu


	Auto Scale - Automatically scales the horizontal and vertical axes.


	Fit in View - Adjusts the plot canvas to according to the size of plot curves.


	Save - Saves the plot to file system as .png, .svg or .bmp.


	Print - Prints the plot.


	Grid - Shows grid lines.


	Detailed Grid - Shows detailed grid lines.


	No Grid - Hides grid lines.


	Log X - Logarithmic scale of the horizontal axis.


	Log Y - Logarithmic scale of the vertical axis.


	Setup - Shows a setup window.






	Variables - List of all plotted variables.






	General - Variable general information.






	Legend - Display name for legend.


	File - File name where variable data is stored.








	Appearance - Visual settings of variable.






	Color - Display color.


	Pattern - Line pattern of curve.


	Thickness - Line thickness of curve.


	Hide - Hide/Show the curve.


	Toggle Sign - Toggles the sign of curve.


	Plot on Right Y-Axis - Display curve on right-side y-axis.











	Titles - Plot, axes and footer titles settings.


	Legend - Sets legend position and font.


	Range - Automatic or manual axes range.






	Auto Scale - Automatically scales the horizontal and vertical axes.


	X-Axis






	Minimum - Minimum value for x-axis.


	Maximum - Maximum value for x-axis.








	Y-Axis






	Minimum - Minimum value for y-axis.


	Maximum - Maximum value for y-axis.








	Prefix Units - Automatically pick the right prefix for units.














Re-simulating a Model

The Variables Browser allows manipulation of changeable
parameters for re-simulation.
After changing the parameter values user can click on the re-simulate
toolbar button ([image: OMEdit Re-simulate button]), or right click the model in Variables Browser and choose
re-simulate from the menu.



3D Visualization

Since OpenModelica 1.11 , OMEdit has built-in 3D visualization,
which replaces third-party libraries (such as Modelica3D [https://github.com/OpenModelica/Modelica3D]) for 3D visualization.


Running a Visualization

The 3d visualization is based on OpenSceneGraph. In order to run the
visualization simply right click the class in Libraries Browser an
choose “Simulate with Animation” as shown in Figure 14.


[image: _images/omedit_simulate_animation.png]

Figure 14 OMEdit Simulate with Animation.



One can also run the visualization via Simulation > Simulate with Animation from the menu.

When simulating a model in animation mode, the flag +d=visxml is set.
Hence, the compiler will generate a scene description file _visual.xml which stores all
information on the multibody shapes.
This scene description references all variables which are needed for the animation of the
multibody system. When simulating with +d=visxml, the compiler will always generate
results for these variables.



Viewing a Visualization

After the successful simulation of the model, the visualization window will
show up automatically as shown in Figure 15.


[image: _images/omedit_visualization.png]

Figure 15 OMEdit 3D Visualization.



The animation starts with pushing the play button. The animation is played until
stopTime or until the pause button is pushed.
By pushing the previous button, the animation jumps to the initial point of time.
Points of time can be selected by moving the time slider or by inserting a simulation
time in the Time-box.
The speed factor of animation in relation to realtime can be set in the Speed-dialog.
Other animations can be opened by using the open file button and selecting a result
file with a corresponding scene description file.

The 3D camera view can be manipulated as follows:



	Operation

	Key

	Mouse Action





	Move Closer/Further

	none

	Wheel



	Move Closer/Further

	Right Mouse Hold

	Up/Down



	Move Up/Down/Left/Right

	Middle Mouse Hold

	Move Mouse



	Move Up/Down/Left/Right

	Left and Right Mouse Hold

	Move Mouse



	Rotate

	Left Mouse Hold

	Move Mouse



	Shape context menu

	Right Mouse + Shift

	





Predefined views (Isometric, Side, Front, Top) can be selected and the scene can be tilted
by 90° either clock or anticlockwise with the rotation buttons.



Additional Visualization Features

The shapes that are displayed in the viewer can be selected with shift + right click.
If a shape is selected, a context menu pops up that offers additional visualization features


[image: _images/pick_shape.png]

The following features can be selected:



	Menu

	Description





	Change Transparency

	The shape becomes either transparent or intransparent.



	Make Shape Invisible

	The shape becomes invisible.



	Change Color

	A color dialog pops up and the color of the shape can be set.



	Apply Check Texture

	A checked texture is applied to the shape.



	Apply Custom Texture

	A file selection dialog pops up and an image file can be selected as a texture.



	Remove Texture

	Removes the current texture of the shape.







[image: _images/visual_features.png]




Animation of Realtime FMUs

Instead of a result file, OMEdit can load Functional Mock-up Units to retrieve the data
for the animation of multibody systems.
Just like opening a mat-file from the animation-plotting view, one can open an FMU-file.
Necessarily, the FMU has to be generated with the +d=visxml flag activated, so that a
scene description file is generated in the same directory as the FMU.
Currently, only FMU 1.0 and FMU 2.0 model exchange are supported.
When choosing an FMU, the simulation settings window pops up to choose solver and step size.
Afterwards, the model initializes and can be simulated by pressing the play button.


Interactive Realtime Animation of FMUs

FMUs can be simulated with realtime user interaction.
A possible solution is to equip the model with an interaction model from the
Modelica_DeviceDrivers library (https://github.com/modelica/Modelica_DeviceDrivers).
The realtime synchronization is done by OMEdit so no additional time synchronization model
is necessary.



[image: _images/interactive_model.png]







Interactive Simulation


Warning

Interactive simulation is an experimental feature.



Interactive simulation is enabled by selecting interactive simulation in the simulation
setup.

There are two main modes of execution: asynchronous and synchronous
(simulate with steps). The difference is that in synchronous (step mode),
OMEdit sends a command to the simulation for each step that the simulation
should take. The asynchronous mode simply tells the simulation to run and
samples variables values in real-time; if the simulation runs very fast,
fewer values will be sampled.

When running in asynchronous mode, it is possible to simulate the model
in real-time (with a scaling factor just like simulation flag
-rt, but with the ability to change the scaling
factor during the interactive simulation). In the synchronous mode, the
speed of the simulation does not directly correspond to real-time.
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2D Plotting

This chapter covers the 2D plotting available in OpenModelica via
OMNotebook, OMShell and command line script. The plotting is based on
OMPlot application. See also OMEdit 2D Plotting.


Example

model HelloWorld
  Real x(start = 1, fixed = true);
  parameter Real a = 1;
equation
  der(x) = - a * x;
end HelloWorld;





To create a simple time plot the above model HelloWorld is simulated. To
reduce the amount of simulation data in this example the number of
intervals is limited with the argument numberOfIntervals=5. The
simulation is started with the command below.

>>> simulate(HelloWorld, outputFormat="csv", startTime=0, stopTime=4, numberOfIntervals=5)
record SimulationResult
    resultFile = "«DOCHOME»/HelloWorld_res.csv",
    simulationOptions = "startTime = 0.0, stopTime = 4.0, numberOfIntervals = 5, tolerance = 1e-6, method = 'dassl', fileNamePrefix = 'HelloWorld', options = '', outputFormat = 'csv', variableFilter = '.*', cflags = '', simflags = ''",
    messages = "LOG_SUCCESS       | info    | The initialization finished successfully without homotopy method.
LOG_SUCCESS       | info    | The simulation finished successfully.
",
    timeFrontend = 0.00180659,
    timeBackend = 0.005094281,
    timeSimCode = 4.97901e-4,
    timeTemplates = 0.001703737,
    timeCompile = 0.21905115300000003,
    timeSimulation = 0.006297242000000001,
    timeTotal = 0.234540834
end SimulationResult;





When the simulation is finished the file HelloWorld_res.csv contains the
simulation data:


Listing 1 HelloWorld_res.csv

"time","x","der(x)"
0,1,-1
0.8,0.4493289092712475,-0.4493289092712475
1.6,0.2018973974273906,-0.2018973974273906
2.4,0.09071896372718975,-0.09071896372718975
3.2,0.04076293845066793,-0.04076293845066793
4,0.01831609502171534,-0.01831609502171534
4,0.01831609502171534,-0.01831609502171534







Use plot(x) to plot the diagram using OMPlot.


[image: _images/helloworld.svg]
Figure 30 Simple 2D plot of the HelloWorld example.



By re-simulating and saving results at many more points, for example using the
default 500 intervals, a much smoother plot can be obtained.
Note that the default solver method dassl has more internal points than the output points in the initial plot.
The results are identical, except the detailed plot has a smoother curve.

>>> 0==system("./HelloWorld -stepSize=0.008")
true
>>> res:=strtok(readFile("HelloWorld_res.csv"), "\n");
>>> res[end]
"4,0.01831609502171534,-0.01831609502171534"






[image: _images/helloworld-detailed.svg]
Figure 31 Simple 2D plot of the HelloWorld example with a larger number of output points.





Plot Command Interface

Plot command have a number of optional arguments to
further customize the the resulting diagram.

>>> list(OpenModelica.Scripting.plot,interfaceOnly=true)
"function plot
  input VariableNames vars \"The variables you want to plot\";
  input Boolean externalWindow = false \"Opens the plot in a new plot window\";
  input String fileName = \"<default>\" \"The filename containing the variables. <default> will read the last simulation result\";
  input String title = \"\" \"This text will be used as the diagram title.\";
  input String grid = \"simple\" \"Sets the grid for the plot i.e simple, detailed, none.\";
  input Boolean logX = false \"Determines whether or not the horizontal axis is logarithmically scaled.\";
  input Boolean logY = false \"Determines whether or not the vertical axis is logarithmically scaled.\";
  input String xLabel = \"time\" \"This text will be used as the horizontal label in the diagram.\";
  input String yLabel = \"\" \"This text will be used as the left vertical label in the diagram.\";
  input Real xRange[2] = {0.0, 0.0} \"Determines the horizontal interval that is visible in the diagram. {0,0} will select a suitable range.\";
  input Real yRange[2] = {0.0, 0.0} \"Determines the left vertical interval that is visible in the diagram. {0,0} will select a suitable range.\";
  input Real curveWidth = 1.0 \"Sets the width of the curve.\";
  input Integer curveStyle = 1 \"Sets the style of the curve. SolidLine=1, DashLine=2, DotLine=3, DashDotLine=4, DashDotDotLine=5, Sticks=6, Steps=7.\";
  input String legendPosition = \"top\" \"Sets the POSITION of the legend i.e left, right, top, bottom, none.\";
  input String footer = \"\" \"This text will be used as the diagram footer.\";
  input Boolean autoScale = true \"Use auto scale while plotting.\";
  input Boolean forceOMPlot = false \"if true launches OMPlot and doesn't call callback function even if it is defined.\";
  input String yAxis = \"L\" \"Sets the variable to be plotted on the left (L) or right (R) y-axis.\";
  input String yLabelRight = \"\" \"This text will be used as the right vertical label in the diagram.\";
  input Real yRangeRight[2] = {0.0, 0.0} \"Determines the right vertical interval that is visible in the diagram. {0,0} will select a suitable range.\";
  output Boolean success \"Returns true on success\";
end plot;"
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OpenModelica Compiler

The OpenModelica Compiler (OMC) consists of a frontend, backend, code generation and the
runtimes.


	Lexical Analysis

Keywords, operators and identifiers are extracted from the model.



	Parsing

An abstract syntax tree represented in Meta-Modelica is created from the operators and
identifiers.



	Semantic Analysis

The abstract syntax tree gets tested for semantic errors.



	Intermediate Representation

Translation of the abstract syntax tree to an intermediate representation called SCode
in MetaModelica.
This is further processed by the frontend producing DAE intermediate representation
code.



	Symbolic Optimization Backend

The intermediate representation gets optimized and preprocessed.



	Code Generation

Executable code gets generated from the low level intermediate representation.





For more details see [FPA+20].
A full list of compiler flags can be found in OpenModelica Compiler Flags.


Frontend Modules



Backend Modules


	Pre-Optimization


	Partitioning


	Alias removal






	Causalization


	Matching


	Sorting


	Index reduction






	Post-Optimization


	Tearing


	Jacobian









Backend DAE Info

With compiler debug flag backenddaeinfo it is
possible to get additional information from the Backend modules.



	Number of equations / variables


	Number of states


	Information about initialization and simulation system


	Equation types


	Equation system details (linear and non-linear)











The output of backenddaeinfo can be expanded by using additional compiler debug flags
stateselection and
discreteinfo.

Example

>>> loadFile(getInstallationDirectoryPath() + "/share/doc/omc/testmodels/BouncingBall.mo")
true
>>> setCommandLineOptions("-d=backenddaeinfo,stateselection,discreteinfo")
true
>>> translateModel(BouncingBall)
true
"Notification: Model statistics after passing the front-end and creating the data structures used by the back-end:
 * Number of equations: 6
 * Number of variables: 6
Notification: Model statistics after passing the back-end for initialization:
 * Number of independent subsystems: 3
 * Number of states: 0 ()
 * Number of discrete variables: 9 (v_new,$PRE.v_new,flying,$PRE.flying,impact,foo,$whenCondition1,$whenCondition2,$whenCondition3)
 * Number of discrete states: 0 ()
 * Number of clocked states: 0 ()
 * Top-level inputs: 0
Notification: Strong component statistics for initialization (13):
 * Single equations (assignments): 13
 * Array equations: 0
 * Algorithm blocks: 0
 * Record equations: 0
 * When equations: 0
 * If-equations: 0
 * Equation systems (not torn): 0
 * Torn equation systems: 0
 * Mixed (continuous/discrete) equation systems: 0
Notification: Model statistics after passing the back-end for simulation:
 * Number of independent subsystems: 1
 * Number of states: 2 (v,h)
 * Number of discrete variables: 7 ($whenCondition3,$whenCondition2,$whenCondition1,foo,v_new,impact,flying)
 * Number of discrete states: 2 (impact,v)
 * Number of clocked states: 0 ()
 * Top-level inputs: 0
Notification: Strong component statistics for simulation (9):
 * Single equations (assignments): 7
 * Array equations: 0
 * Algorithm blocks: 0
 * Record equations: 0
 * When equations: 2
 * If-equations: 0
 * Equation systems (not torn): 0
 * Torn equation systems: 0
 * Mixed (continuous/discrete) equation systems: 0
"








Code generation

From the low level intermediate representation from the backend code will be generated.
The default code generation target is C and offers the largest model coverage.
An alternative is the C++ (Cpp) which can produce significant faster executables in some
cases.

The target language can be changed with compiler flag
--simCodeTarget.

Depending on the target the compiler will write code and compile everything into a single
simulation executable.



Simulation Runtimes

The generated code is linked with the appropriate runtime.


C Runtime

In Solving Modelica Models the methods implemented in the C runtime are described.
In C Runtime Simulation Flags the runtime flags are documented.



C++ Runtime

Solver methods and runtime flags are currently undocumented.
Refer to the source code
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Solving Modelica Models


Integration Methods

By default OpenModelica transforms a Modelica model into an ODE
representation to perform a simulation by using numerical integration
methods. This section contains additional information about the different
integration methods in OpenModelica. They can be selected by the method
parameter of the simulate command or the -s simflag.

The different methods are also called solver and can be distinguished by
their characteristic:


	Method


	Explicit vs. implicit


	Suitability for stiff systems


	Usage of sparse methods to solver underlying equation systems


	Integration order


	Step size control: Fixed vs. adaptive






	Solver

	Method

	Type

	System

	Sparsity

	Order

	Step Size





	DASSL

	BDF

	imp.

	stiff

	sparse /
dense

	adaptive
1-5

	adaptive



	IDA

	BDF

	imp.

	stiff

	sparse /
dense

	adaptive
1-5

	adaptive



	CVODE

	Adams-
Moulton

	imp.

	non-stiff

	dense

	adaptive
1-12

	adaptive



	CVODE

	BDF

	imp.

	stiff

	dense

	adaptive
1-5

	adaptive



	GBODE

	RK

	exp.

	non-stiff

	sparse /
dense

	1-14

	adaptive



	GBODE

	RK

	imp.

	stiff

	sparse /
dense

	1-12

	adaptive



	GBODE

	RK

	imp.

	multi-rate

	sparse /
dense

	1-14

	adaptive



	Euler

	Euler

	exp.

	non-stiff

	dense

	1

	fixed






A good introduction on this topic may be found in [CK06]
and a more mathematical approach can be found in [HNorsettW93].


DASSL

DASSL is the default solver in OpenModelica, because of a severals reasons. It
is an implicit, higher order, multi-step solver with a step-size control and
with these properties it is quite stable for a wide range of models. Furthermore
it has a mature source code, which was originally developed in the eighties an
initial description may be found in [Pet82].

This solver is based on backward differentiation formula (BDF), which is
a family of implicit methods for numerical integration. The used implementation
is called DASPK2.0 (see [1]) and it is translated automatically to C
by f2c (see [2]).

Internal non-linear and linear equation systems are solved using dense methods.
If the target model is known to have a sparse structure one of the sparse
solvers might be a better alternative.

The following simulation flags can be used to adjust the behavior of the
solver for specific simulation problems:
jacobian,
noRootFinding,
noRestart,
initialStepSize,
maxStepSize,
maxIntegrationOrder,
noEquidistantTimeGrid.



IDA

The IDA solver is part of a software family called sundials: SUite of Nonlinear
and DIfferential/ALgebraic equation Solvers [HBG+05]. The
implementation is based on DASPK with an extended linear solver interface, which
includes an interface to the high performance sparse non-lineaer solver KINSOL
[HBG+05] and linear solver KLU [DN10].

The simulation flags of DASSL are also valid for the IDA
solver and furthermore it has the following IDA specific flags:
idaLS,
idaMaxNonLinIters,
idaMaxConvFails,
idaNonLinConvCoef,
idaMaxErrorTestFails.



CVODE

The CVODE solver is part of sundials: SUite of Nonlinear and
DIfferential/ALgebraic equation Solvers [HBG+05].
CVODE solves initial value problems for ordinary differential equation (ODE)
systems with variable-order, variable-step multistep methods.

In OpenModelica, CVODE uses a combination of Backward Differentiation
Formulas (varying order 1 to 5) as linear multi-step method and a modified
Newton iteration with fixed Jacobian as non-linear solver per default.
This setting is advised for stiff problems which are very common for Modelica
models.
For non-stiff problems an combination of an Adams-Moulton formula (varying
order 1 to 12) as linear multi-step method together with a fixed-point
iteration as non-linear solver method can be chosen.

Both non-linear solver methods are internal functions of CVODE and use its
internal direct dense linear solver CVDense.
For the Jacobian of the ODE CVODE will use its internal dense difference
quotient approximation.

CVODE has the following solver specific flags:
cvodeNonlinearSolverIteration,
cvodeLinearMultistepMethod.



GBODE

GBODE stands for Generic Bi-rate ordinary differential equation (ODE) solver
and is a generic implementation for any Runge-Kutta (RK) scheme
[HNorsettW00]. In GBODE there are already many different implicit and
explicit RK methods (e.g. SDIRK, ESDIRK, Gauss, Radau, Lobatto, Fehlberg,
DOPRI45, Merson) with different approximation order configurable and ready to
use. New RK schemes can easily be added, if the corresponding Butcher tableau
is available. By default the solver runs in single-rate mode using the
embedded RK scheme ESDIRK4 [KC19] with variable-step-size
control and efficient event handling.

The bi-rate mode can be utilized using the simulation flag
gbratio. This flag determines the percentage of fast
states with respect to all states. These states will then be automatically
detected during integration based on the estimated approximation error and
afterwards refined using an appropriate inner step-size control and
interpolated values of the slow states.

The solver utilizes by default the sparsity pattern of the ODE Jacobian and
solves the corresponding non-linear system in case of an implicit chosen RK
scheme using sparse solver KINSOL.

GBODE is highly configurable and the following simulation flags can be used to
adjust the behavior of the solver for specific simulation problems:
gbratio,
gbm,
gbctrl,
gbnls,
gbint,
gberr,
gbfm,
gbfctrl,
gbfnls,
gbfint,
gbferr.



Basic Explicit Solvers

The basic explicit solvers Euler uses a fixed step-size based on the
numberOfIntervals, the startTime and stopTime parameters in the
simulate command:
[image: \mbox{stepSize} \approx \cfrac{\mbox{stopTime} - \mbox{startTime}}{\mbox{numberOfIntervals}}]


	euler - Explicit Euler, fixed step size, order 1






Deprecated Solvers

The following solvers are deprecated and will be removed in a future version of
OpenModelica:


	rungekutta - Classic Runge-Kutta method RK4, explicit, fixed step-size, oder 4




old: -s=rungekutta
new: -s=gbode -gbm=rungekutta -gbctrl=const






	symSolver - Symbolic inline solver
(requires --symSolver) - fixed step-size, order 1


	symSolverSsc - Symbolic implicit inline Euler with step-size control
(requires --symSolver) - step-size control, order 1-2


	qss - A QSS solver







DAE Mode Simulation

Beside the default ODE simulation, OpenModelica is able to simulate models in
DAE mode. The DAE mode is enabled by the flag --daeMode.
In general the whole equation system of a model is passed to the DAE integrator,
including all algebraic loops. This reduces the amount of work that needs to be
done in the post optimization phase of the OpenModelica backend.
Thus models with large algebraic loops might compile faster in DAE mode.

Once a model is compiled in DAE mode the simulation can be only performed
with SUNDIALS/IDA integrator and with enabled
-daeMode simulation flag. Both are enabled
automatically by default, when a simulation run is started.



Initialization

To simulate an ODE representation of an Modelica model with one of the methods
shown in Integration Methods a valid initial state is needed.
Equations from an initial equation or initial algorithm block define a desired
initial system.


Choosing start values

Only non-linear iteration variables in non-linear strong components require
start values. All other start values will have no influence on convergence of
the initial system.

Use -d=initialization to show additional information from the initialization
process. In OMEdit Tools->Options->Simulation->OMCFlags, in OMNotebook call
setCommandLineOptions("-d=initialization")


[image: _images/piston.png]

Figure 32 piston.mo



model piston
  Modelica.Mechanics.MultiBody.Parts.Fixed fixed1 annotation(
    Placement(visible = true, transformation(origin = {-80, 70}, extent = {{-10, -10}, {10, 10}}, rotation = 0)));
  Modelica.Mechanics.MultiBody.Parts.Body body1(m = 1)  annotation(
    Placement(visible = true, transformation(origin = {30, 70}, extent = {{-10, -10}, {10, 10}}, rotation = 0)));
  Modelica.Mechanics.MultiBody.Parts.FixedTranslation fixedTranslation1(r = {0.3, 0, 0})  annotation(
    Placement(visible = true, transformation(origin = {-10, 70}, extent = {{-10, -10}, {10, 10}}, rotation = 0)));
  Modelica.Mechanics.MultiBody.Parts.FixedTranslation fixedTranslation2(r = {0.8, 0, 0})  annotation(
    Placement(visible = true, transformation(origin = {10, 20}, extent = {{-10, -10}, {10, 10}}, rotation = -90)));
  Modelica.Mechanics.MultiBody.Parts.Fixed fixed2(animation = false, r = {1.1, 0, 0})  annotation(
    Placement(visible = true, transformation(origin = {70, -60}, extent = {{-10, -10}, {10, 10}}, rotation = 180)));
  Modelica.Mechanics.MultiBody.Parts.Body body2(m = 1)  annotation(
    Placement(visible = true, transformation(origin = {30, -30}, extent = {{-10, -10}, {10, 10}}, rotation = 0)));
  inner Modelica.Mechanics.MultiBody.World world annotation(
    Placement(visible = true, transformation(origin = {-70, -50}, extent = {{-10, -10}, {10, 10}}, rotation = 0)));
  Modelica.Mechanics.MultiBody.Joints.Prismatic prismatic(animation = true)  annotation(
    Placement(visible = true, transformation(origin = {30, -60}, extent = {{-10, -10}, {10, 10}}, rotation = 0)));
  Modelica.Mechanics.MultiBody.Joints.RevolutePlanarLoopConstraint revolutePlanar annotation(
    Placement(visible = true, transformation(origin = {-50, 70}, extent = {{-10, -10}, {10, 10}}, rotation = 0)));
  Modelica.Mechanics.MultiBody.Joints.Revolute revolute1(a(fixed = false),phi(fixed = false), w(fixed = false))  annotation(
    Placement(visible = true, transformation(origin = {10, 48}, extent = {{-10, -10}, {10, 10}}, rotation = -90)));
  Modelica.Mechanics.MultiBody.Joints.Revolute revolute2 annotation(
    Placement(visible = true, transformation(origin = {10, -10}, extent = {{-10, -10}, {10, 10}}, rotation = -90)));
equation
  connect(prismatic.frame_b, fixed2.frame_b) annotation(
    Line(points = {{40, -60}, {60, -60}, {60, -60}, {60, -60}}, color = {95, 95, 95}));
  connect(fixed1.frame_b, revolutePlanar.frame_a) annotation(
    Line(points = {{-70, 70}, {-60, 70}, {-60, 70}, {-60, 70}}));
  connect(revolutePlanar.frame_b, fixedTranslation1.frame_a) annotation(
    Line(points = {{-40, 70}, {-20, 70}, {-20, 70}, {-20, 70}}, color = {95, 95, 95}));
  connect(fixedTranslation1.frame_b, revolute1.frame_a) annotation(
    Line(points = {{0, 70}, {10, 70}, {10, 58}, {10, 58}}, color = {95, 95, 95}));
  connect(revolute1.frame_b, fixedTranslation2.frame_a) annotation(
    Line(points = {{10, 38}, {10, 38}, {10, 30}, {10, 30}}, color = {95, 95, 95}));
  connect(revolute2.frame_b, prismatic.frame_a) annotation(
    Line(points = {{10, -20}, {10, -20}, {10, -60}, {20, -60}, {20, -60}}));
  connect(revolute2.frame_b, body2.frame_a) annotation(
    Line(points = {{10, -20}, {10, -20}, {10, -30}, {20, -30}, {20, -30}}, color = {95, 95, 95}));
  connect(revolute2.frame_a, fixedTranslation2.frame_b) annotation(
    Line(points = {{10, 0}, {10, 0}, {10, 10}, {10, 10}}, color = {95, 95, 95}));
  connect(fixedTranslation1.frame_b, body1.frame_a) annotation(
    Line(points = {{0, 70}, {18, 70}, {18, 70}, {20, 70}}));
end piston;





>>> loadModel(Modelica);
>>> setCommandLineOptions("-d=initialization");
>>> buildModel(piston);
"[/var/lib/jenkins/ws/OpenModelica_PR-15165/build/lib/omlibrary/Modelica 4.1.0+maint.om/Mechanics/MultiBody/Parts/Body.mo:14:3-15:65:writable] Warning: Parameter body1.r_CM has no value, and is fixed during initialization (fixed=true), using available start value (start={0, 0, 0}) as default value.
[/var/lib/jenkins/ws/OpenModelica_PR-15165/build/lib/omlibrary/Modelica 4.1.0+maint.om/Mechanics/MultiBody/Parts/Body.mo:14:3-15:65:writable] Warning: Parameter body2.r_CM has no value, and is fixed during initialization (fixed=true), using available start value (start={0, 0, 0}) as default value.
Warning: Assuming fixed start value for the following 2 variables:
         $STATESET2.x:VARIABLE(start = /*Real*/($STATESET2.A[1]) * $START.revolute1.phi + /*Real*/($STATESET2.A[2]) * $START.revolute2.phi fixed = true )  type: Real
         $STATESET1.x:VARIABLE(start = /*Real*/($STATESET1.A[1]) * $START.revolute1.w + /*Real*/($STATESET1.A[2]) * $START.revolute2.w fixed = true )  type: Real
"





Note how OpenModelica will inform the user about relevant and irrelevant start
values for this model and for which variables a fixed default start value is
assumed.
The model has four joints but only one degree of freedom, so one of the joints
revolutePlanar or prismatic must be initialized.

So, initializing phi and w of revolutePlanar will give a sensible start
system.

model pistonInitialize
  extends piston(revolute1.phi.fixed = true, revolute1.phi.start = -1.221730476396031, revolute1.w.fixed = true, revolute1.w.start = 5);
equation
end pistonInitialize;





>>> setCommandLineOptions("-d=initialization");
>>> simulate(pistonInitialize, stopTime=2.0);
"[/var/lib/jenkins/ws/OpenModelica_PR-15165/build/lib/omlibrary/Modelica 4.1.0+maint.om/Mechanics/MultiBody/Parts/Body.mo:14:3-15:65:writable] Warning: Parameter body1.r_CM has no value, and is fixed during initialization (fixed=true), using available start value (start={0, 0, 0}) as default value.
[/var/lib/jenkins/ws/OpenModelica_PR-15165/build/lib/omlibrary/Modelica 4.1.0+maint.om/Mechanics/MultiBody/Parts/Body.mo:14:3-15:65:writable] Warning: Parameter body2.r_CM has no value, and is fixed during initialization (fixed=true), using available start value (start={0, 0, 0}) as default value.
"






[image: _images/piston.svg]
Figure 33 Vertical movement of mass body2.





Importing initial values from previous simulations

In many use cases it is useful to import initial values from previous simulations, possibly obtained with
another Modelica tool, which are saved in a .mat file. There are two different options to do that.


Using previous simulation results as start values for the initial equations

The first option is to solve the initial equations specified by the Modelica model, using the previous simulation results as
initial guesses for the iterative solvers, in case they are needed. This can be very helpful in case the initialization problem involves the
solution of large nonlinear systems of equations by means of iterative algorithms, whose convergence is sensitive to the selected
initial guess.

Importing a previously found solution allows the OpenModelica solver to pick very good initial guesses for the
unknowns of the iterative solvers, thus achieving convergence with a few iterations. Since the initial equations
are solved in the process, the values of all variables and derivatives, as well as of all parameters with fixed = false attribute,
are re-computed and fully consistent with the selected initial conditions, even in case the previously saved simulation results
refer to a slightly different model configuration. Note that parameters with fixed = true will also get their values from the
imported .mat file, so if you want to change them you need to edit the .mat file accordingly.

This option is activated by selecting the simulation result file name in the OMEdit
Simulation Setup | Simulation Flag | Equation System Initialization File input field, or by setting the additional simulation flag
-iif=resultfile.mat. By activating the checkbox Save simulation flags inside the model i.e., __OpenModelica_simulationFlags annotation,
a custom annotation __OpenModelica_simulationFlags(iif="filename.mat") is added to the model, so this setting is saved with the model and is reused
when loading the model again later on. It is also possible to specify at which point in time of the saved simulation results the initial values
should be picked, by means of the Simulation Setup | Simulation Flags | Equation System Initialization Time input field, or by setting
the simulation flag -iit=initialTimeValue.



Using previous simulation results to directly initialize a simulation

The second option is to skip the solution of the initial equations entirely, directly starting the simulation
with the imported start values. In this case, the initial equations of the model are ignored, and the initial values of
all parameters and state variables are directly set to the values loaded from the .mat file. This option is useful
to restart a simulation from the final state of a previous one, ignoring whatever initial conditions are declared in the
Modelica model by either fixed = true attributes or initial equations.

Note that state variables and parameters will be directly initialized to the imported values, while algebraic variables
will be recomputed with the regular simulation equations, on the basis of the imported initial state and parameter values.
The values of algebraic variables in the imported file will only be used to initialize iteration variables, in case this
computation involves nonlinear implicit equations and iterative solvers, otherwise they will be ignored.

To activate this second option, set Simulation Setup | Simulation Flag | Initialization Method to none in OMEdit,
or set the simulation flag -iim=none. Also in this case, activating the checkbox Save simulation
flags inside model, i.e. __OpenModelica_simulationFlags annotation saves this option in an
__OpenModelica_simulationFlags(iim=none) annotation, so it is retained for future simulations of the same model.



Beware of missing variables in the simulation result file

When importing simulation results to initialize a new simulation, bear in mind that, by default, protected and hidden variables
are not saved to the .mat file, so they will be missing when importing the simulation results for initialization. This is
particularly dangerous when the imported values are used directly, as unsaved protected or hidden variables will not be
initialized and will retain their default zero value, which is likely to cause numerical problems such as division by zero
when the simulation is started.

To avoid this problem, make sure you also save protected and hidden variables in the simulation result file, by setting the
corresponding checkboxes in the Simulation Setup | Output tab of OMEdit, or by setting the simulation flags
-emit_protected and -ignoreHideResult.



Example of use

The following minimal working example demonstrates the use of the initial value import feature. You can create a new package
ImportInitialValues in OMEdit, copy and paste its code from here, and then run the different models in it.

package ImportInitialValues "Test cases for importing initial values in OpenModelica"
  partial model Base "The mother of all models"
    Real v1, v2, x;
    parameter Real p1;
    parameter Real p2 = 2*p1;
    final Real p3 = 3*p1;
  end Base;

  model ResultFileGenerator "Dummy model for generating the initial.mat file"
    extends Base(p1 = 7, p2 = 10);
  equation
    v1 = 2.8;
    v2 = 10;
    der(x) = 0;
  initial equation
    x = 4;
  annotation(
    experiment(StopTime = 1),
    __OpenModelica_simulationFlags(r = "../initial.mat"));
  end ResultFileGenerator;

  model M "Relies on Modelica code only for initialization"
    extends Base(
      v1(start = 14),
      p1 = 1, p2 = 1);
  equation
    (v1 - 3)*(v1 + 10)*(v1 - 15) = 0;
    v2 = time;
    der(x) = -x;
  initial equation
    x = 6;
  end M;

  model M2 "Imports parameters and initial guesses only, solve initial equations"
    extends M;
  annotation(__OpenModelica_simulationFlags(iif = "../initial.mat"));
  end M2;

  model M3 "import parameters, initial guesses and initial states, skip initial equations"
    extends M;
  annotation(__OpenModelica_simulationFlags(iim = "none", iif = "../initial.mat"));
  end M3;
end ImportInitialValues;





Running the ResultFileGenerator model creates an initial.mat file with some initial values in the root OMEdit working directory:
p1 = 7, p2 = 10, p3 = 21, v1 = 2.8, v2 = 10, x = 4, der(x) = 0. Note that the default directory when running simulations
in OMEdit is a sub-directory named as the full model pathname, located in the working directory, so it is necessary to go up one
directory to access the root working directory.

When running model M, the simulation process only relies on the initial and guess values provided by the Modelica source code. Regarding the
parameter values, p1 = 1, p2 = 1, p3 = 3*p1 = 3; regarding v1, the implicit cubic equation is solved iteratively using the start value
14 as an initial guess, thus converging to the nearest solution v1 = 15. The other variable v2 can be computed explicitly, so there is no
need of any guess value for it. Finally, the initial value of the state variable is set to x = 6 by the initial equations.

When running model M2, the values of the initial.mat file are imported to provide values for non-final parameters and guess values for the initial
equations, which are solved starting from there. Hence, the imported parameter values p1 = 7 and p2 = 10 override the model's binding equations,
that would set both to 1; on the other hand, the final parameter p3 is computed based on the final binding equation to p3 = p1*3 = 21. Regarding
v1, the iterative solver converges to the solution closest to the imported start value of 2.8, i.e. v1 = 3, while v2 is computed explicitly,
so it doesn't depend on the imported start value, which is ignored. The initial value of the state x = 6 is obtained by solving the initial equation,
which is explicit and thus ignores the imported guess value x = 4.

Finally, when running model M3, parameters are handled like in the previous case, as well as the algebraic variables v1 and v2. However,
in this case the solution of the initial equations is skipped, so the state variable gets its initial value x = 4 straight from the imported initial.mat file.




Homotopy Method

For complex start conditions OpenModelica can have trouble finding a solution
for the initialization problem with the default Newton method.

Modelica offers the homotopy operator [3] to formulate actual and
simplified expression for equations, with homotopy parameter [image: \lambda] going from 0 to 1:


[image: actual \cdot \lambda + simplified \cdot (1-\lambda).]


OpenModelica has different solvers available for non-linear systems.
Initializing with homotopy on the first try
is default if a homotopy operator is used. It can be switched off with
noHomotopyOnFirstTry. For a general
overview see [SCO+11], [Sie12], for details on the implementation in
OpenModelica see [OB13].

The homotopy methods distinguish between local and global methods meaning, if
[image: \lambda] affects the entire initialization system or only local
strong connected components.
In addition the homotopy methods can use equidistant [image: \lambda] or and
adaptive [image: \lambda] in [0,1].

Default order of methods tried to solve initialization system


	If there is no homotopy in the model
	
	Solve without homotopy method.






	If there is homotopy in the model or solving without homotopy failed
	
	Try global homotopy approach with equidistant [image: \lambda].








The default homotopy method will do three global equidistant steps from 0 to 1
to solve the initialization system.

Several compiler and simulation flags influence initialization with homotopy:
--homotopyApproach,
-homAdaptBend,
-homBacktraceStrategy,
-homHEps,
-homMaxLambdaSteps,
-homMaxNewtonSteps,
-homMaxTries,
-homNegStartDir,
-homotopyOnFirstTry,
-homTauDecFac,
-homTauDecFacPredictor,
-homTauIncFac,
-homTauIncThreshold,
-homTauMax,
-homTauMin,
-homTauStart,
-ils.




Tearing

The size of linear and nonlinear equation systems can be substantially reduced by
means of the Tearing method. Consider a system of [image: N] equations. The Tearing method requires
to pick [image: M < N] variables [image: x_t] as tearing or iteration variables, so that
assuming their values are known, [image: N - M] torn equations can be solved explicitly for the
remaining [image: N - M] torn variables, by sorting them appropriately. Then, the remaining
M equations are put in residual form [image: f(x_t) = 0], where the residuals can ultimately be
computed by explicit computations as a function of the tearing variables [image: x_t] only.
The result is thus an equivalent implicit system of [image: M < N] equations in the [image: M]
tearing variables, with an explicit procedure to compute the residual function [image: f(x_t)].
The Jacobian of that function, which is required by the Newton method, can then be obtained
by either symbolic or numerical differentiation techniques.

The Tearing method has three main advantages:


	the size of the Jacobian matrix to be factorized in order to solve it is greatly reduced;


	for nonlinear systems solved by iterative methods like Newton-Raphson, it is only necessary
to give initial guess values to the much smaller set of variables [image: x_t]; the initial
guess values are set to the start attributes of the tearing variables;


	the method allows to solve mixed systems containing Real and discrete (Boolean or Integer)
variables and equations by means of standard nonlinear equation solvers, as long as the
discrete variables are selected as torn variables and the resulting residual equations have
a continuous dependency on the Real tearing variables.




OpenModelica implements some heuristic algorithms to automatically choose the set of
tearing variables. The tearing algorithm can be selected with the compiler flags:
--tearingMethod,
--tearingHeuristic.
Since the tearing algorithms can be very time-consuming for large systems, they are automatically
disabled for systems above a certain size, see
--maxSizeLinearTearing,
--maxSizeNonlinearTearing.

As of Modelica 3.6, there is no standardized way to influence the choice of tearing variables. OpenModelica
provides a custom __OpenModelica_tearingSelect annotation that can be added to variable declarations to
influence the choice of tearing variables:

Real x annotation(__OpenModelica_tearingSelect = TearingSelect.always);
Real y annotation(__OpenModelica_tearingSelect = TearingSelect.prefer);
Real z annotation(__OpenModelica_tearingSelect = TearingSelect.default);
Real v annotation(__OpenModelica_tearingSelect = TearingSelect.avoid);
Real w annotation(__OpenModelica_tearingSelect = TearingSelect.never);





This feature is currently experimental. There is discussion going on within the MAP-Lang group of the
Modelica Association to standardize features for the selection of tearing variables and residual
equations.



Algebraic Solvers

If the ODE system contains equations that need to be solved together, so called
algebraic loops, OpenModelica can use a variety of different linear and non-linear
methods to solve the equation system during simulation.

For the C runtime the linear solver can be set with -ls and
the non-linear solver with -nls.
There are dense and sparse solver available.


	Linear solvers
	
	default    : Lapack with totalpivot as fallback [ABB+99]


	lapack     : Non-Sparse LU factorization using [ABB+99]


	lis        : Iterative linear solver [Nis10]


	klu        : Sparse LU factorization [Nat05]


	umfpack    : Sparse unsymmetric multifrontal LU factorization [Dav04]


	totalpivot : Total pivoting LU factorization for underdetermined systems






	Non-linear solvers
	
	hybrid     : Modified Powell hybrid method from MINPACK [DJS96]


	kinsol     : Combination of Newton-Krylov, Picard and fixed-point solver [T+98]


	newton     : Newton-Raphson method [CK06]


	mixed      : Homotopy with hybrid as fallback [Kel78] [BBOR15]


	homotopy   : Damped Newton solver with fixed-point solver and Newton homotopy solver as fallbacks








In addition, there are further optional settings for the algebraic solvers available.
A few of them are listed in the following:

General:
-nlsLS

Newton:
-newton
-newtonFTol
-newtonMaxStepFactor
-newtonXTol

Sparse solver:
-nlssMinSize
-nlssMaxDensity

Enable logging:
-lv=LOG_LS
-lv=LOG_LS_V
-lv=LOG_NLS
-lv=LOG_NLS_V
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Debugging

There are two main ways to debug Modelica code, the
transformations browser, which shows the
transformations OpenModelica performs on the equations.
There is also a debugger for debugging of algorithm sections and functions.


The Equation-based Debugger

This section gives a short description how to get started using the equation-based debugger in OMEdit.


Enable Tracing Symbolic Transformations

This enables tracing symbolic transformations of equations. It is
optional but strongly recommended in order to fully use the debugger.
The compilation time overhead from having this tracing on is less than
1%, however, in addition to that, some time is needed for the system to
write the xml file containing the transformation tracing information.

Enable -d=infoXmlOperations in Tools->Options->Simulation (see section
Simulation Options) OR alternatively click on the checkbox Generate operations in
the info xml in Tools->Options->Debugger (see section Debugger Options) which
performs the same thing.

This adds all the transformations performed by OpenModelica on the
equations and variables stored in the model_info.xml file. This is
necessary for the debugger to be able to show the whole path from the
source equation(s) to the position of the bug.



Load a Model to Debug

Load an interesting model. We will use the package Debugging.mo [https://github.com/OpenModelica/OMCompiler/blob/master/Examples/Debugging.mo]
since it contains suitable, broken models to demonstrate common errors.



Simulate and Start the Debugger

Select and simulate the model as usual. For example, if using the
Debugging package, select the model
Debugging.Chattering.ChatteringEvents1. If there is an error, you will
get a clickable link that starts the debugger. If the user interface is
unresponsive or the running simulation uses too much processing power,
click cancel simulation first.


[image: _images/omedit-debug-more.png]

Figure 34 Simulating the model.





Use the Transformation Debugger for Browsing

The debugger opens on the equation where the error was found.
You can browse through the dependencies (variables that
are defined by the equation, or the equation is dependent on), and
similar for variables. The equations and variables form a bipartite
graph that you can walk.

If the -d=infoXmlOperations was used or you clicked the “generate
operations” button, the operations performed on the equations and
variables can be viewed. In the example package, there are not a lot of
operations because the models are small.

Try some larger models, e.g. in the MultiBody library or some other
library, to see more operations with several transformation steps
between different versions of the relevant equation(s). If you do not
trigger any errors in a model, you can still open the debugger, using
File->Open Transformations File (model_info.json).


[image: _images/omedit-transformationsbrowser.png]

Figure 35 Transfomations Browser.






The Algorithmic Debugger

This section gives a short description how to get started using the
algorithmic debugger in OMEdit. See section Simulation Options for further details
of debugger options.


Adding Breakpoints

There are two ways to add the breakpoints,


	Click directly on the line number in Text View, a red circle is
created indicating a breakpoint as shown in Figure 36.


	Open the Algorithmic Debugger window and add a breakpoint using the
right click menu of Breakpoints Browser window.





[image: _images/omedit-add-breakpoint.png]

Figure 36 Adding breakpoint in Text View.





Start the Algorithmic Debugger

You should add breakpoints before starting the debugger because
sometimes the simulation finishes quickly and you won't get any chance
to add the breakpoints.

There are four ways to start the debugger,


	Open the Simulation Setup and click on Launch Algorithmic Debugger
before pressing Simulate.


	Right click the model in Libraries Browser and select Simulate with
Algorithmic Debugger.


	Open the Algorithmic Debugger window and from menu select
Debug-> Debug Configurations.


	Open the Algorithmic Debugger window and from menu select
Debug-> Attach to Running Process.






Debug Configurations

If you already have a simulation executable with debugging symbols
outside of OMEdit then you can use the Debug->Debug Configurations
option to load it.

The debugger also supports MetaModelica data structures so one can debug
omc executable. Select omc executable as program and write the name of
the mos script file in Arguments.


[image: _images/omedit-debug-config.png]

Figure 37 Debug Configurations.





Attach to Running Process

If you already have a running simulation executable with debugging
symbols outside of OMEdit then you can use the Debug->Attach to Running
Process option to attach the debugger with it. Figure 38 shows the
Attach to Running Process dialog. The dialog shows the list of processes
running on the machine. The user selects the program that he/she wish to
debug. OMEdit debugger attaches to the process.


[image: _images/omedit-attach-to-process.png]

Figure 38 Attach to Running Process.





Using the Algorithmic Debugger Window

Figure 39 shows the Algorithmic Debugger window. The window contains
the following browsers,


	Stack Frames Browser - shows the list of frames. It contains the
program context buttons like resume, interrupt, exit, step over,
step in, step return. It also contains a threads drop down which
allows switching between different threads.


	BreakPoints Browser - shows the list of breakpoints. Allows
adding/editing/removing breakpoints.


	Locals Browser - Shows the list of local variables with values.
Select the variable and the value will be shown in the bottom
right window. This is just for convenience because some variables
might have long values.


	Debugger CLI - shows the commands sent to gdb and their responses.
This is for advanced users who want to have more control of the
debugger. It allows sending commands to gdb.


	Output Browser - shows the output of the debugged executable.





[image: _images/omedit-algorithmic-debugger.png]

Figure 39 Algorithmic Debugger.
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Flattening models to BaseModelica


BaseModelica

BaseModelica is an intermediate format to describe hybrid (continuous
and discrete) systems with emphasis on defining the dynamic behavior of systems,
rather than their structure. It is meant to become part of the Modelica
standard, as a subset of the Modelica language that does not include
object-oriented features such as lookup, instantiation, inheritance,
connections, but rather gives a flat representation of a Modelica model
which only contains variable declarations, function declarations,
record declarations, equations, and initial equations.

The main aim of BaseModelica is to provide a much lower barrier of
entry to the Modelica world, since writing a BaseModelica compiler
or interpreter will be a much easier task than writing a full-fledged
Modelica compiler.

BaseModelica is currently described by the
MCP 0031 draft [https://github.com/modelica/ModelicaSpecification/blob/MCP/0031/RationaleMCP/0031/ReadMe.md] ,
and will eventually be incorporated in a future version of the Modelica Language
Specification.



Converting Modelica models in BaseModelica with OpenModelica

The OpenModelica compiler front-end can flatten virtually 100% of Modelica models
that are fully compliant with the Modelica Language Specification, converting them
into a BaseModelica output. This provides a unique opportunity for organizations that
want to enter the Modelica ecosystem, as they can delegate the heavy-lifting of
flattening a Modelica model to the OpenModelica compiler (OMC), developing tools
that only need to be able to parse and compile (or interpret) BaseModelica
input.

Assume you have a package MyPackage contained in a file MyPackage.mo and you
want to get the BaseModelica flattened code of model MyPackage.Examples.MyModel
in the MyModel.mo file. From the command line, this is accomplished by typing

omc --BaseModelica -i=MyPackage.Examples.MyModel MyPackage.mo > MyModel.mo

If the package MyPackage is installed with the Package Manager, you can type

omc --BaseModelica -i=MyPackage.Examples.MyModel MyPackage > MyModel.mo

If you want to use OMEdit for that, you can load MyPackage, go to
Tools | Options | Simulation, add --BaseModelica to the
Additional Translation Flags input field, open MyModel and click on the
Instantiate Model button, to get the BaseModelica flattened model in a separate
window. Don't forget to remove --BaseModelica from the simulation options
when you are done, otherwise regular simulations will be broken.



Array-preserving BaseModelica output

The OMC front-end can flatten models without scalarizing them, i.e., keeping
arrays of variables together as first-class citizens and keeping array equations
together via for loops. This feature is essential to manage models with large
arrays efficiently.

From the command line, you can get array-preserving BaseModelica flat output by adding
some extra debug flags to the previous command line, e.g.,

omc --BaseModelica -d=nonfScalarize,arrayConnect,combineSubscripts,evaluateAllParameters,vectorizeBindings -i=MyPackage.Examples.MyModel MyPackage > MyModel.mo

or by adding them to the Additional Translation Flags option in OMEdit.

Last, but not least, if you have a model with a large number of instances of the
same class with the same modifier structure, the OMC front-end can automatically
collect them into a single array, which can then be flattened efficiently without
scalarization. To get that, replace the debug flags of the previous command line with

-d=nonfScalarize,mergeComponents,combineSubscripts,evaluateAllParameters,vectorizeBindings

In this case, you also get a MyModel_merged_table.json file in the working directory,
which lists the correspondences between the original scalar component names and the
elements of the automatically created arrays.
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Porting Modelica libraries to OpenModelica

One of the goals of OpenModelica is to provide a full, no-compromise implementation
of the latest version of the
Modelica Language Specification [https://specification.modelica.org],
released by the non-profit Modelica Association [https://www.modelica.org].
This means that a main requirement for a Modelica library to work in
OpenModelica is to be fully compliant to the Language Specification.

Libraries and models developed with other Modelica tools may contain some code
which is not valid according to the current language specification, but still accepted
by that tool, e.g. to support legacy code of their customers. In order to use
those libraries and models in OpenModelica, one needs to make sure that such code
is replaced by a valid one. Note that getting rid of invalid Modelica code
does not make the library only usable in OpenModelica; to the contrary, doing that
is the best guarantee that the library will be usable both with the original
tool used for development and with OpenModelica, as well as with any other present
or future Modelica tool that follows the standard strictly.

The first recommendation is to use any flag or option of the tool that was
originally used to develop the library, that allows to check for strict compliance
to the language specification. For example, Dymola features a translation option
'Pedantic mode for checking Modelica semantics' that issues an error if
non-standard constructs are used.

For your convenience, here you can find a list of commonly reported issues.


Mapping of the library on the file system

Packages can be mapped onto individual .mo files or onto hierarchical
directory structures on the file system, according to the rules set forth in
Section 13.4 [https://specification.modelica.org/maint/3.5/packages.html#mapping-package-class-structures-to-a-hierarchical-file-system].
of the language specification.
The file encoding must be UTF-8; the use of a BOM at the beginning of the file
is deprecated and preferably avoided. If there are non-ASCII characters
in the comments or in the documentation of your library, make sure that the
file is encoded as UTF-8.

If a directory-based representation is chosen, each .mo file must start with
a within clause, and each directory should contain a package.order file that lists
all the classes and constants defined as separate files in that directory.

When using revision control systems such as GIT or SVN, if the library is
stored in a directory structure, it is recommended to include the top-level
directory (that must have the same name as the top-level package) in the
repository itself, to avoid problems in case the repository is cloned locally
on a directory that doesn't have the right name.

The top-level directory name, or the single .mo file containing the entire
package, should be named exactly as the package (e.g. Modelica),
possibly followed by a space and by the version number (e.g. Modelica 3.2.3).



Modifiers for arrays

According to the rules set forth in Section 7.2.5 [https://specification.modelica.org/maint/3.5/inheritance-modification-and-redeclaration.html#modifiers-for-array-elements]
of the language specification, when instantiating arrays of components, modifier
values should be arrays of the same size of the component array, unless the each
prefix is introduced, in which case the scalar modifier values is applied to
all the elements of the array. Thus, if MyComponent has a Real parameter p,
these are all valid declarations

parameter Real q = {0, 1, 2};
MyComponent ma[3](p = {10, 20, 30});
MyComponent mb[3](p = q);
MyComponent mb[3](each p = 10);





while these are not

parameter Real r = 4;
MyComponent ma[3](p = r);
MyComponent mb[3](p = 20);





In most cases, the problem is solved by simply adding the each keyword where
appropriate.



Access to conditional components

Up to Modelica 3.6, according to Section 4.4.5 [https://specification.modelica.org/maint/3.6/class-predefined-types-and-declarations.html#conditional-component-declaration]
of the language specification, "A component declared with a condition-attribute
can only be modified and/or used in connections". This required to use the following, slightly
convoluted patterns when dealing, e.g., with conditional input connectors, making use of internal
auxiliary variables or connectors:

model M
  parameter Boolean activateIn1 = true;
  parameter Boolean activateIn2 = true;
  Modelica.Blocks.Interfaces.RealInput u1_in if activateIn1;
  Modelica.Blocks.Interfaces.RealInput u2_in = u2 if activateIn2 "binding equation only holds if activateIn2 = true";
  Real u2 "internal variable corresponding to u2_in";
  Real y;
protected
  Modelica.Blocks.Interfaces.RealInput u1 "internal connector corresponding to u1_in";
equation
  y = u1 + u2;
  connect(u1_in, u1) "automatically disabled if u1_in is deactivated";
  if not activateIn1 then
    u1 = 0 "default value for protected connector value when u1_in is disabled";
  end if;
  if not activateIn2 then
    u2 = 0 "default value for u2 when u2_in is disabled";
  end if;
end M;





where conditional components 'u1_in' and 'u2_in' were only used in connect equations. Other Modelica
tools accepted code that was more straightforward and easier to understand, but actually not compliant
with this restriction, causing compatibility issues, e.g.:

model M
  parameter Boolean activateIn1 = true;
  parameter Boolean activateIn2 = true;
  Modelica.Blocks.Interfaces.RealInput u1_in if activateIn1;
  Modelica.Blocks.Interfaces.RealInput u2_in if activateIn2;
  Real u1;
  Real u2;
  Real y;
equation
  y = u1 + u2;
  if activateIn1 then
    u1 = u1_in;
  else
    u1 = 0 "default value for protected connector value when u1_in is disabled";
  end if;
  if activateIn2 then
    u2 = u2_in;
  else
    u2 = 0 "default value for protected connector value when u2_in is disabled";
  end if;
end M;





Although this restriction makes identifying structurally inconsistent models easier, it requires to
write code that can be pretty obscure when handling use cases that would be very straightforward to handle otherwise.
Hence, this restriction will be removed in Modelica 3.7. In particular, the current
draft of Modelica 3.7 [https://specification.modelica.org/master/class-predefined-types-and-declarations.html#conditional-component-declaration]
explicitly states that if the Boolean expression activating the component is true, there are no
restrictions on the use of such component. Since version 1.26.0, OpenModelica complies with
these new relaxed rules.



Access to classes defined in partial packages

Consider the following example package

package TestPartialPackage
  partial package PartialPackage
    function f
      input Real x;
      output Real y;
    algorithm
      y := 2*x;
    end f;
  end PartialPackage;

  package RegularPackage
    extends PartialPackage;
    model A
      Real x = time;
    end A;
  end RegularPackage;

  model M1
    package P = PartialPackage;
    Real x = P.f(time);
  end M1;

  model M2
    extends M1(redeclare package P = RegularPackage);
  end M2;

  model M3
    encapsulated package LocalPackage
      import TestPartialPackage.PartialPackage;
      extends PartialPackage;
    end LocalPackage;
    package P = LocalPackage;
    Real x = P.f(time);
  end M3;
end TestPartialPackage;





Model M1 references a class (a function, in this case) from a partial
package. This is perfectly fine if one wants to write a generic model, which
is then specialized by redeclaring the package to a non-partial one, as in
M2. However, M1 cannot be compiled for simulation, since, according to
Section 5.3.2 [https://specification.modelica.org/maint/3.5/scoping-name-lookup-and-flattening.html#composite-name-lookup]
of the language specification, the classes that are looked inside during
lookup shall not be partial in a simulation model.

This problem can be fixed by accessing that class (the function f, in this case)
from a non-final package that extends the partial one, either by redeclaring
the partial package to a non-partial one, as in M2, or by locally defining
a non-partial package that extends from the partial one, as in M3. The latter
option is of course viable only if the class being accessed is in itself not a partial
or somehow incomplete one.

This issue is often encountered in models using Modelica.Media, that sometimes
use some class definitions (e.g. unit types) from partial packages such as
Modelica.Media.Interfaces.PartialMedium. The fix in most cases is just to
use the same definition from the actual replaceable Medium package defined
in the model, which will eventually be redeclared to a non-partial one
in the simulation model.



Equality operator in algorithms

The following code is illegal, because it uses the equality '=' operator, which
is reserved for equations, instead of the assignment operator ':=' inside
an algorithm:

function f
  input Real x;
  input Real y = 0;
  output Real z;
algorithm
  z = x + y;
end f;





so, the OpenModelica parser does not accept it. The correct code is:

function f
  input Real x;
  input Real y = 0;
  output Real z;
algorithm
  z := x + y;
end f;





Some tools automatically and silently apply the correction to the code, please
save it in its correct form to make it usable with OpenModelica.

Also note that binding equations with '=' sign are instead required for
default values of function inputs.



Public non-input non-output variables in functions

According to Section 12.2 [https://specification.modelica.org/maint/3.5/functions.html#function-as-a-specialized-class]
of the language specification, only input and output formal parameters are
allowed in the function's public variable section. Hence, the following function
declaration is not valid:

function f
  input Real x;
  output Real y;
  Real z;
algorithm
  z := 2;
  y := x+z;
end f;





and should be fixed by putting the variable z in the protected section:

function f
  input Real x;
  output Real y;
protected
  Real z;
algorithm
  z := 2;
  y := x+z;
end f;







Subscripting of expressions

Some libraries use expression subscripting, e.g.

model M
  Real x[3];
  Real y[3];
  Real z;
equation
  z = (x.*y)[2];
  ...
end M;





This construct is already accepted by some Modelica tools, but is not yet
included in the current Modelica Specification 3.6, so it is not supported
in OpenModelica up to version 1.22.0. It has now been included in the draft
for the 3.7 language specification, so it will be implemented in the future
also by OpenModelica.



Incomplete specification of initial conditions

The simulation of Modelica models of dynamical systems requires the tool to
determine a consistent initial solution for the simulation to start. To do so,
the system equations are augmented by adding one initial condition for each
continuous state variable (after index reduction) and one initial condition for
each discrete state variable. Then, the augmented system is solved upon
initialization.

These initial conditions can be formulated by adding
a start = <expression> and a fixed = true attribute to those variables, e.g.

parameter Real x_start = 10;
parameter Real v_start = 2.5;
Real x(start = x_start, fixed = true);
discrete Real v(start = v_start, fixed = true);
Integer i(start = 2, fixed = true);





or by adding initial equations, e.g.:

  parameter Real x_start = 10;
  parameter Real v_start = 2.5;
  Real x;
  discrete Real v;
  Integer i;
  Real y(start = 3.5);
initial equation
  x = x_start;
  v = v_start;
  i = 2;
  der(y) = 0;





Note that in the latter case, the start attribute on y is not used directly
to set the initial value of that variable, but only potentially used as initial
guess for the solution of the initialization problem, that may require using
an iterative nonlinear solver. Also note that sets of initial equations are
often added to the models taken from reusable component libraries
by selecting certain component parameters, such as initOpt or similar.

If the number of initial conditions matches the number of continuous and
discrete states, then the initialization problem is well-defined. Although
this is per se not a guarantee that all tools will be able to solve it and find
the same solution, this is for sure a prerequisite for across-tool portability.

Conversely, if the number of initial conditions is less than the number of
states, the tool has to add some initial equations, using some heuristics
to change the fixed attribute of some variables from false to true. Consider
for example the following model:

model M
  Real x;
  Real y(start = 1);
  Real z(start = 2);
equation
  der(x) = y + z;
  y = 2*x;
  z = 10*x + 1;
end M;





This model has one state variable x, no variables with fixed = true
attributes and no initial equation, so there is one missing initial condition.
One tool could choose to add the fixed = true attribute to the state variable
x, fixing it to the default value of zero of its start attribute. Or, it
could decide to give more priority to variables that have an explicitly modified
start attribute, hence fix the initial value of y to 1, or the initial value
of z to 2. Three completely different simulations would ensue.

The Modelica Language Specification,
Section 8.6 [https://specification.modelica.org/maint/3.5/equations.html#initialization-initial-equation-and-initial-algorithm]
does not prescribe or recommend any specific choice criterion in this case.
Hence, different tools, or even different versions of the same tool, could add
different initial conditions, leading to completely different simulations.
In order to avoid any ambiguity and achieve good portability, it is thus
recommended to make sure that the initial conditions of all simulation model
are well-specified.

A model with not enough initial conditions causes the OMC to issue the
following translation warning: "The initial conditions are not fully specified".
By activating the Tools | Options | Simulation | Show additional information from
the initialization process option, or the -d=initialization compiler flag,
one can get an explicit list of the additional equations that OpenModelica
automatically adds to get a fully specified initialization problem, which may be
helpful to figure out which initial conditions are missing. In this case, we
recommend to amend the source code of the model by adding suitable extra initial
conditions, until that warning message no longer appears.



Modelica_LinearSystems2 Library

The Modelica_LinearSystem2 library was originally developed in Dymola
with a plan of eventually making it part of the Modelica Standard Library
(thus the underscore in the library name). The library is based on several
functions, e.g. readStringMatrix(), simulateModel(), linearizeModel()
that are built-in Dymola functions but are not part of the Modelica Standard
Library.

In principle, these functions could be standardized and become part of
the ModelicaServices library, which collects standardized interfaces to
tool-specific functionality; then, OpenModelica could easily implement them
based on its internal functionality. However, until this effort is undertaken,
the Modelica_LinearSystem2 library cannot be considered as a full-fledged
Modelica library, but only a Dymola-specific one.

If you are interested in using this library in OpenModelica and are willing to
contribute to get it supported, please contact the development team, e.g. by
opening an ticket on the issue tracker.
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Backwards Compatibility of OpenModelica Released Versions

The development of OpenModelica is guided by two basic principles:


	Follow the Modelica Language Specification [https://specification.modelica.org] (MLS) as strictly as possible.


	Preserve backwards compatibility as much as possible.




The Open Source Modelica Consortium strongly believes in open standards, as enablers of strong
and healthy eco-systems involving software tool developers and software tool users. Strict
compliance with the MLS is the key factor to enable portability of models among different
Modelica tools, which gives a huge added value to the Modelica community, compared to other
communities of users of software using proprietary modelling languages. Compliance to the
standard not only gives you the freedom to switch from one tool to another, avoiding vendor
lock-in and protecting the value of your investment in modelling in the long term, but also
allows you to use different tools simultaneously on the same Modelica code for different purposes,
e.g., simulation, generation of FMUs, sensitivity analysis, parameter optimization, optimal
control, etc. Hence, the development of OpenModelica development strives to implement the
MLS standard as strictly as possible.

The Open Source Modelica Consortium also recognizes the value of the code developed by the
users of OpenModelica. There is hardly anything more annoying than not being able to use legacy
code with up-to-date versions of a software tool. Hence, the Consortium strives to keep
newer versions of OpenModelica fully backwards compatible with older ones and is committed
to releasing patch versions of the latest x.y.0 release of the software, in case regressions
from previously released versions are reported on the
OpenModelica issue tracker [https://github.com/OpenModelica/OpenModelica/issues].

Given this commitment, we strongly recommend OpenModelica users to always use the latest released
version of the software, to benefit from bug fixes, performance improvements and new added
features. If you find any backwards-compatibility issue with new released versions, we strongly
encourage you to report them on the issue tracker [https://github.com/OpenModelica/OpenModelica/issues];
chances are that it can get fixed in the nightly build in a short time, if possible.

Given the first stated principle, compliance to the MLS, there is one exception to the rule of
keeping backwards compatibility: if we find that OpenModelica is not following the MSL for some
reason, we try to fix it as soon as possible. This means that a model or library developed with
older versions of OpenModelica may not work with more recently released version of the software
because the Modelica code was invalid according to the MLS, but the older version of OpenModelica
accepted it anyway. You can check ticket #10386 [https://github.com/OpenModelica/OpenModelica/issues/10386]
for one such example.

In these cases, one may be tempted to stick indefinitely to the latest version of OpenModelica
that handled the invalid Modelica code successfully. Although you are of course free to do so,
we do not recommend this policy because you are going to miss all the improvements to the OpenModelica
software in the future. More importantly, if you then discover bugs that prevent you from using your
Modelica code in new situations, we can't help you in any way, because you are locked to an
old version for which we cannot provide maintenance support.

The ideal solution to handle these cases is to update the Modelica source code of the models to make it
fully compliant with the MLS. This ensures maximum portability and long-term support of your Modelica code.

In case this is not possible for some reason, e.g. lack of time and resources, or the fact that the
legacy code belongs to Modelica libraries you did not develop yourself, we provide a way to cope
with non-standard Modelica code in newer version of OpenModelica: the
--allowNonStandardModelica [https://openmodelica.org/doc/OpenModelicaUsersGuide/latest/omchelptext.html#omcflag-allownonstandardmodelica]
compiler flag allows to disable some Modelica compatibility checks and continue using your legacy
code with newer versions of the compiler. This flag can be set in OMEdit in the
Tools | Options | Simulation | Additional Translation Flags.
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Generating Graph Representations for Models

The system of equations after symbolic transformation is represented by a graph.
OpenModelica can generate graph representations which can be displayed in the graph tool yed (http://www.yworks.com/products/yed).
The graph generation is activated with the debug flag


+d=graphml



Two different graphml- files are generated in the working directory.
TaskGraph_model.graphml, showing the strongly-connected components of the model and BipartiteGraph_CompleteDAE_model.graphml showing all variables and equations.
When loading the graphs with yEd, all nodes are in one place. Please use the various layout algorithms to get a better overview.


[image: _images/taskgraph.png]

Figure 40 A task-graph representation of a model in yEd




[image: _images/bipartit.png]

Figure 41 A biparite graph representation of a model in yEd
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Functional Mock-up Interface - FMI

The Functional Mock-up Interface (FMI) [http://www.fmi-standard.org] Standard
for model exchange and co-simulation allows export, exchange and import of pre-compiled
models between different tools.
The FMI standard is Modelica independent, so import and export works both between
different Modelica or non-Modelica tools.

See also OMSimulator documentation.


FMI Export

To export a FMU use the OpenModelica command buildModelFMU() from
the command line interface, OMShell, OMNotebook or MDT.
The FMU export command is also integrated in OMEdit.
Select File > Export > FMU. Or alternatively, right click a model to obtain the export
command.
The FMU package is generated in the current working directory of OMC or the directory set
in OMEdit > Options > FMI > Move FMU.
You can use the cd() command to see the current location.
The location of the generated FMU is printed in the Messages Browser of OMEdit or on the
command line.

You can set which version of FMI to export through OMEdit settings, see section
FMI Options.


[image: _images/fmiExport.png]

Figure 42 FMI Export.



To export the bouncing ball example to an FMU, use the following commands:

>>> loadFile(getInstallationDirectoryPath() + "/share/doc/omc/testmodels/BouncingBall.mo")
true
>>> buildModelFMU(BouncingBall)
"«DOCHOME»/BouncingBall.fmu"






Note

Notification: Model statistics after passing the front-end and creating the data structures used by the back-end:

 * Number of equations: 6

 * Number of variables: 6

Notification: Model statistics after passing the back-end for initialization:

 * Number of independent subsystems: 3

 * Number of states: 0 ()

 * Number of discrete variables: 9 (v_new,$PRE.v_new,flying,$PRE.flying,impact,foo,$whenCondition1,$whenCondition2,$whenCondition3)

 * Number of discrete states: 0 ()

 * Number of clocked states: 0 ()

 * Top-level inputs: 0

Notification: Strong component statistics for initialization (13):

 * Single equations (assignments): 13

 * Array equations: 0

 * Algorithm blocks: 0

 * Record equations: 0

 * When equations: 0

 * If-equations: 0

 * Equation systems (not torn): 0

 * Torn equation systems: 0

 * Mixed (continuous/discrete) equation systems: 0

Notification: Model statistics after passing the back-end for simulation:

 * Number of independent subsystems: 1

 * Number of states: 2 (v,h)

 * Number of discrete variables: 7 ($whenCondition3,$whenCondition2,$whenCondition1,foo,v_new,impact,flying)

 * Number of discrete states: 2 (impact,v)

 * Number of clocked states: 0 ()

 * Top-level inputs: 0

Notification: Strong component statistics for simulation (9):

 * Single equations (assignments): 7

 * Array equations: 0

 * Algorithm blocks: 0

 * Record equations: 0

 * When equations: 2

 * If-equations: 0

 * Equation systems (not torn): 0

 * Torn equation systems: 0

 * Mixed (continuous/discrete) equation systems: 0





After the command execution is complete you will see that a file BouncingBall.fmu has been
created. Its contents varies depending on the target platform.
On the machine generating this documentation the contents in
Listing 2 are generated (along with the C source code).


Listing 2 BouncingBall FMU contents

binaries/
binaries/linux64/
binaries/linux64/BouncingBall.so
modelDescription.xml







A log file for FMU creation is also generated named ModelName_FMU.log.
If there are some errors while creating the FMU, they will be shown in the command line
window and logged in this log file as well.

By default an FMU that can be used for both Model Exchange and Co-Simulation is generated.
We support FMI 1.0 & FMI 2.0.4 for Model Exchange FMUs and FMI 2.0.4 for Co-Simulation
FMUs.

For the Co-Simulation FMU two integrator methods are available:


	Forward Euler [default]


	SUNDIALS CVODE (see [1])




Forward Euler uses root finding, which does an Euler step of communicationStepSize
in fmi2DoStep. Events are checked for before and after the call to
fmi2GetDerivatives.

If CVODE is chosen as integrator the FMU should also include runtime dependencies
(--fmuRuntimeDepends=modelica) to copy all used dynamic
libraries into the generated FMU to make it exchangeable.

To export a Co-Simulation FMU with CVODE for the bouncing ball example use the
following commands:

>>> loadFile(getInstallationDirectoryPath() + "/share/doc/omc/testmodels/BouncingBall.mo")
true
>>> setCommandLineOptions("--fmiFlags=s:cvode")
true
>>> buildModelFMU(BouncingBall, version = "2.0", fmuType="cs")
"«DOCHOME»/BouncingBall.fmu"






Note

Notification: Model statistics after passing the front-end and creating the data structures used by the back-end:

 * Number of equations: 6

 * Number of variables: 6

Notification: Model statistics after passing the back-end for initialization:

 * Number of independent subsystems: 3

 * Number of states: 0 ()

 * Number of discrete variables: 9 (v_new,$PRE.v_new,flying,$PRE.flying,impact,foo,$whenCondition1,$whenCondition2,$whenCondition3)

 * Number of discrete states: 0 ()

 * Number of clocked states: 0 ()

 * Top-level inputs: 0

Notification: Strong component statistics for initialization (13):

 * Single equations (assignments): 13

 * Array equations: 0

 * Algorithm blocks: 0

 * Record equations: 0

 * When equations: 0

 * If-equations: 0

 * Equation systems (not torn): 0

 * Torn equation systems: 0

 * Mixed (continuous/discrete) equation systems: 0

Notification: Model statistics after passing the back-end for simulation:

 * Number of independent subsystems: 1

 * Number of states: 2 (v,h)

 * Number of discrete variables: 7 ($whenCondition3,$whenCondition2,$whenCondition1,foo,v_new,impact,flying)

 * Number of discrete states: 2 (impact,v)

 * Number of clocked states: 0 ()

 * Top-level inputs: 0

Notification: Strong component statistics for simulation (9):

 * Single equations (assignments): 7

 * Array equations: 0

 * Algorithm blocks: 0

 * Record equations: 0

 * When equations: 2

 * If-equations: 0

 * Equation systems (not torn): 0

 * Torn equation systems: 0

 * Mixed (continuous/discrete) equation systems: 0





The FMU BouncingBall.fmu will have a new file BouncingBall_flags.json in its resources
directory. By manually changing its content users can change the solver method without
recompiling the FMU.

The BouncingBall_flags.json for this example is displayed in
Listing 3.


Listing 3 BouncingBall FMI flags

{
  "s" : "cvode"
}








Compilation Process

OpenModelica can export FMUs that are compiled with CMake (default) or Makefiles. CMake
version v3.21 or newer is recommended, minimum CMake version is v3.5.

The Makefile FMU export will be removed in a future version of OpenModelica.
Set compiler flag --fmuCMakeBuild=false to use the
Makefiles export.

The FMU contains a CMakeLists.txt file in the sources directory that can be used to
re-compile the FMU for a different host and is also used to cross-compile for different
platforms.

The CMake compilation accepts the following settings:


	BUILD_SHARED_LIBS:
Boolean value to switch between dynamic and statically linked binaries.


	ON (default): Compile DLL/Shared Object binary object.


	OFF: Compile static binary object.






	FMI_INTERFACE_HEADER_FILES_DIRECTORY:
String value specifying path to FMI header files containing fmi2Functions.h,
fmi2FunctionTypes.h and fmi2TypesPlatforms.h.


	Defaults to a location inside the OpenModelica installation directory, which was used
to create the FMU. They need to be version 2.0.4 from the FMI Standard.






	RUNTIME_DEPENDENCIES_LEVEL:
String value to specify runtime dependencies set.


	none: Adds no runtime dependencies to FMU. The FMU can't be used on a system if it
doesn't provided all needed dependencies.


	modelica (default): Add Modelica runtime dependencies to FMU, e.g. a external C
library used from a Modelica function. Needs CMake version v3.21 or newer.


	all: Add system and Modelica runtime dependencies. Needs CMake version v3.21 or
newer.






	NEED_CVODE:
Boolean value to integrate CVODE integrator into CoSimulation FMU.


	ON: Link to SUNDIALS CVODE. If CVODE is not in a default location
CVODE_DIRECTORY needs to be set.
Its also recommended to use RUNTIME_DEPENDENCIES_LEVEL=modelica or higher to add
SUNDIALS runtime dependencies into the FMU.


	OFF (default): Don't link to SUNDIALS CVODE.






	CVODE_DIRECTORY:
String value with location of libraries sundials_cvode and sundials_nvecserial
with SUNDIALS version 5.4.0.


	Defaults to a location inside the OpenModelica installation directory, which was
used to create the FMU.








Then use CMake to configure, build and install the FMU.
To repack the FMU after installation use custom target create_fmu.

For example to re-compile the FMU with cmake and runtime dependencies use:

$ unzip BouncingBall.fmu -d BouncingBall_FMU
$ cd BouncingBall_FMU/sources
$ cmake -S . -B build_cmake \
  -D RUNTIME_DEPENDENCIES_LEVEL=modelica \
  -D CMAKE_C_COMPILER=clang -D CMAKE_CXX_COMPILER=clang++
$ cmake --build build_cmake --target create_fmu --parallel







Platforms

The platforms setting specifies for what target system the FMU is compiled:


	Empty: Create a Source-Code-only FMU.


	native:  Create a FMU compiled for the exporting system.


	<cpu>-<vendor>-<os> host triple: OpenModelica searches for programs in PATH matching
pattern <cpu>-<vendor>-<os>cc to compile.
E.g. x86_64-linux-gnu for a 64 bit Linux OS or i686-w64-mingw32 for a 32 bit
Windows OS using MINGW.


	<cpu>-<vendor>-<os> docker run <image> Host triple with Docker image:
OpenModelica will use the specified Docker image to cross-compile for given host triple.
Because privilege escalation is very easy to achieve with Docker OMEdit adds
--pull=never to the Docker calls for the multiarch/crossbuild images. Only use
this option if you understand the security risks associated with Docker images from
unknown sources.
E.g. x86_64-linux-gnu docker run --pull=never multiarch/crossbuild to cross-compile
for a 64 bit Linux OS.
Because system libraries can be different for different versions of the same operating
system, it is advised to use --fmuRuntimeDepends=all.







FMI Import - SSP

If you want to simulate a single, stand-alone FMU, or possibly a connection
of several FMUs, the recommended tool to do that is OMSimulator, see the
OMSimulator documentation and
Graphical Modelling for further information.


FMI Import - Non-Standard Modelica Model

FMI Import allows to use an FMU, generated according to the FMI for Model
Exchange 2.0 standard, as a component in a Modelica model. This can be
useful if the FMU describes the behavior of a component or sub-system in a
structured Modelica model, which is not easily turned into a pure FMI-based
model that can be handled by OMSimulator.

FMI is a computational description of a dynamic model, while a Modelica model is
a declarative description; this means that not all conceivable FMUs can be successfully
imported as Modelica models. Also, the current implementation of FMU import in
OpenModelica is still somewhat experimental and not guaranteed to work in all
cases. However, if the FMU-ME you want to import was exported from a Modelica model
and only represents continuous time dynamic behavior, it should work without problems
when imported as a Modelica block.

Please also note that the current implementation of FMI Import in OpenModelica
is based on a built-in wrapper that uses a reinit() statement in an algorithm
section. This is not allowed by the Modelica Language Specification, so it is
necessary to set the compiler to accept this non-standard construct by setting
the --allowNonStandardModelica=reinitInAlgorithms
compiler flag.
In OMEdit, you can set this option by activating the Enable FMU Import checkbox in the
Tools | Options | Simulation | Translation Flags tab. This will generate a warning during
compilation, as there is no guarantee that the imported model using this feature
can be ported to other Modelica tools; if you want to use a model that contains
imported FMUs in another Modelica tool, you should rely on the other tool's import
feature to generate the Modelica blocks corresponding to the FMUs.

After setting the --allowNonStandardModelica
flag, to import the FMU package use the OpenModelica command importFMU,

>>> list(OpenModelica.Scripting.importFMU, interfaceOnly=true);





The command could be used from command line interface, OMShell,
OMNotebook or MDT. The importFMU command is also integrated with OMEdit
through the File > Import > FMU dialog: the FMU package is extracted in the directory
specified by workdir, or in the current directory of omc if not specified, see
Tools > Open Working Directory.

The imported FMU is then loaded in the Libraries Browser and can be used as any
other regular Modelica block.

Footnotes



[1]
Sundials Webpage [http://computation.llnl.gov/projects/sundials-suite-nonlinear-differential-algebraic-equation-solvers]
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OMSimulator

Version: v2.1.3.post17-g81bd489


Introduction

The OMSimulator project is a FMI-based co-simulation tool that
supports ordinary (i.e., non-delayed) and TLM connections. It supports
large-scale simulation and virtual prototyping using models from
multiple sources utilizing the FMI standard. It is integrated into
OpenModelica but also available stand-alone, i.e., without
dependencies to Modelica specific models or technology. OMSimulator
provides an industrial-strength open-source FMI-based modelling and
simulation tool. Input/output ports of FMUs can be connected, ports
can be grouped to buses, FMUs can be parameterized and composed, and
composite models can be exported according to the (preliminary) SSP
(System Structure and Parameterization) standard. Efficient FMI based
simulation is provided for both model-exchange and co-simulation.
TLM-based tool connection is provided for a range of applications,
e.g., Adams, Simulink, Beast, Dymola, and OpenModelica. Moreover,
optional TLM (Transmission Line Modelling) domain-specific connectors
are also supported, providing additional numerical stability to
co-simulation. An external API is available for use from other tools
and scripting languages such as Python and
Lua.



OMSimulator

OMSimulator is a command line wrapper for the OMSimulatorLib library.


OMSimulator Flags

A brief description of all command line flags will be displayed using
OMSimulator --help:

info:    Usage: OMSimulator [Options] [Lua script] [FMU] [SSP file]
         Options:
           --addParametersToCSV=<arg>      Export parameters to .csv file (true, [false])
           --algLoopSolver=<arg>           Specifies the alg. loop solver method (fixedpoint, [kinsol]) used for algebraic loops spanning over multiple components.
           --clearAllOptions               Reset all flags to default values
           --CVODEMaxErrTestFails=<int>    Maximum number of error test failures for CVODE
           --CVODEMaxNLSFailures=<int>     Maximum number of nonlinear convergence failures for CVODE
           --CVODEMaxNLSIterations=<int>   Maximum number of nonlinear solver iterations for CVODE
           --CVODEMaxSteps=<int>           Maximum number of steps for CVODE
           --CVODEMaxOrder=<int>           Maximum order for CVODE
           --deleteTempFiles=<bool>        Deletes temp files as soon as they are no longer needed ([true], false)
           --directionalDerivatives=<bool>  Specifies whether directional derivatives should be used to calculate the Jacobian for alg. loops or if a numerical approximation should be used instead ([true], false)
           --dumpAlgLoops=<bool>           Dump information for alg loops (true, [false])
           --emitEvents=<bool>             Specifies whether events should be emitted or not ([true], false)
           --fetchAllVars=<arg>            Workaround for certain FMUs that do not update all internal dependencies automatically
           --help [-h]                     Displays the help text
           --ignoreInitialUnknowns=<bool>  Ignore the initial unknowns from the modelDescription.xml (true, [false])
           --inputExtrapolation=<bool>     Enables input extrapolation using derivative information (true, [false])
           --intervals=<int> [-i]          Specifies the number of communication points (arg > 1)
           --logFile=<arg> [-l]            Specifies the logfile (stdout is used if no log file is specified)
           --logLevel=<int>                0 default, 1 debug, 2 debug+trace
           --maxEventIteration=<int>       Specifies the max. number of iterations for handling a single event
           --maxLoopIteration=<int>        Specifies the max. number of iterations for solving algebraic loops between system-level components. Internal algebraic loops of components are not affected.
           --mode=<arg> [-m]               Forces a certain FMI mode iff the FMU provides cs and me (cs, [me])
           --numProcs=<int> [-n]           Specifies the max. number of processors to use (0=auto, 1=default)
           --progressBar=<bool>            Shows a progress bar for the simulation progress in the terminal (true, [false])
           --realTime=<bool>               Experimental feature for (soft) real-time co-simulation (true, [false])
           --resultFile=<arg> [-r]         Specifies the name of the output result file
           --skipCSVHeader=<arg>           Skip exporting the scv delimiter in the header ([true], false), 
           --solver=<arg>                  Specifies the integration method (euler, [cvode])
           --solverStats=<bool>            Adds solver stats to the result file, e.g. step size; not supported for all solvers (true, [false])
           --startTime=<double> [-s]       Specifies the start time
           --stepSize=<arg>                Specifies the step size (<step size> or <init step,min step,max step>)
           --stopTime=<double> [-t]        Specifies the stop time
           --stripRoot=<bool>              Removes the root system prefix from all exported signals (true, [false])
           --suppressPath=<bool>           Supresses path information in info messages; especially useful for testing ([true], false)
           --tempDir=<arg>                 Specifies the temp directory
           --timeout=<int>                 Specifies the maximum allowed time in seconds for running a simulation (0 disables)
           --tolerance=<double>            Specifies the relative tolerance
           --version [-v]                  Displays version information
           --wallTime=<bool>               Add wall time information for to the result file (true, [false])
           --workingDir=<arg>              Specifies the working directory
           --zeroNominal=<bool>            Using this flag, FMUs with invalid nominal values will be accepted and the invalid nominal values will be replaced with 1.0





To use flag logLevel with option debug (--logLevel=1)
or debug+trace (--logLevel=2) one needs to build OMSimulator
with debug configuration enabled. Refer to the OMSimulator README on GitHub [https://github.com/OpenModelica/OMSimulator/blob/master/README.md]
for further instructions.



Examples

OMSimulator --timeout 180 example.lua








OMSimulatorLib

This library is the core of OMSimulator and provides a C interface that can
easily be utilized to handle co-simulation scenarios.



C-API


RunFile

Simulates a single FMU or SSP model.

oms_status_enu_t oms_RunFile(const char* filename);







activateVariant

This API provides support to activate a multi-variant modelling from an ssp file [(e.g). SystemStructure.ssd, VarA.ssd, VarB.ssd ] from a ssp file.
By default when importing a ssp file the default variant will be "SystemStructure.ssd". The users can be able to switch between other variants by
using this API and make changes to that particular variant and simulate them.

oms_status_enu_t oms_activateVariant(const char* crefA, const char* crefB);






An example of activating the number of available variants in a ssp file

oms_newModel("model")
oms_addSystem("model.root", "system_wc")
oms_addSubModel("model.root.A", "A.fmu")
oms_duplicateVariant("model", "varA") // varA will be the current variant
oms_duplicateVariant("varA", "varB") // varB will be the current variant
oms_activateVariant("varB", "varA") // Reactivate the variant varB to varA
oms_activateVariant("varA", "model") // Reactivate the variant varA to model






addBus

Adds a bus to a given component.

oms_status_enu_t oms_addBus(const char* cref);







addConnection

Adds a new connection between connectors A and B. The connectors need to be
specified as fully qualified component references, e.g., "model.system.component.signal".

oms_status_enu_t oms_addConnection(const char* crefA, const char* crefB, bool suppressUnitConversion);





The two arguments crefA and crefB get swapped automatically if necessary. The third argument suppressUnitConversion is
optional and the default value is false which allows automatic unit conversion between connections, if set to true then
automatic unit conversion will be disabled.



addConnector

Adds a connector to a given component.

oms_status_enu_t oms_addConnector(const char* cref, oms_causality_enu_t causality, oms_signal_type_enu_t type);







addConnectorToBus

Adds a connector to a bus.

oms_status_enu_t oms_addConnectorToBus(const char* busCref, const char* connectorCref);







addConnectorToTLMBus

Adds a connector to a TLM bus.

oms_status_enu_t oms_addConnectorToTLMBus(const char* busCref, const char* connectorCref, const char *type);







addExternalModel

Adds an external model to a TLM system.

oms_status_enu_t oms_addExternalModel(const char* cref, const char* path, const char* startscript);







addResources

Adds an external resources to an existing SSP. The external resources should be a ".ssv" or ".ssm" file

oms_status_enu_t oms_addResources(const char* cref_, const char* path)







addSignalsToResults

Add all variables that match the given regex to the result file.

oms_status_enu_t oms_addSignalsToResults(const char* cref, const char* regex);





The second argument, i.e. regex, is considered as a regular expression (C++11).
".*" and "(.)*" can be used to hit all variables.



addSubModel

Adds a component to a system.

oms_status_enu_t oms_addSubModel(const char* cref, const char* fmuPath);







addSystem

Adds a (sub-)system to a model or system.

oms_status_enu_t oms_addSystem(const char* cref, oms_system_enu_t type);







addTLMBus

Adds a TLM bus.

oms_status_enu_t oms_addTLMBus(const char* cref, oms_tlm_domain_t domain, const int dimensions, const oms_tlm_interpolation_t interpolation);







addTLMConnection

Connects two TLM connectors.

oms_status_enu_t oms_addTLMConnection(const char* crefA, const char* crefB, double delay, double alpha, double linearimpedance, double angularimpedance);







compareSimulationResults

This function compares a given signal of two result files within absolute and
relative tolerances.

int oms_compareSimulationResults(const char* filenameA, const char* filenameB, const char* var, double relTol, double absTol);





The following table describes the input values:








	Input

	Type

	Description





	filenameA

	String

	Name of first result file to compare.



	filenameB

	String

	Name of second result file to compare.



	var

	String

	Name of signal to compare.



	relTol

	Number

	Relative tolerance.



	absTol

	Number

	Absolute tolerance.






The following table describes the return values:







	Type

	Description





	Integer

	1 if the signal is considered as equal, 0 otherwise








copySystem

Copies a system.

oms_status_enu_t oms_copySystem(const char* source, const char* target);







delete

Deletes a connector, component, system, or model object.

oms_status_enu_t oms_delete(const char* cref);







deleteConnection

Deletes the connection between connectors crefA and crefB.

oms_status_enu_t oms_deleteConnection(const char* crefA, const char* crefB);





The two arguments crefA and crefB get swapped automatically if necessary.



deleteConnectorFromBus

Deletes a connector from a given bus.

oms_status_enu_t oms_deleteConnectorFromBus(const char* busCref, const char* connectorCref);







deleteConnectorFromTLMBus

Deletes a connector from a given TLM bus.

oms_status_enu_t oms_deleteConnectorFromTLMBus(const char* busCref, const char* connectorCref);







deleteResources

Deletes the reference and resource file in a SSP. Deletion of ".ssv" and ".ssm" files are currently supported. The API can be used in two ways.


	deleting only the reference file in ".ssd".


	deleting both reference and resource files in ".ssp".




To delete only the reference file in ssd, the user should provide the full qualified cref of the ".ssv" file associated with a system or subsystem or component (e.g) "model.root:root1.ssv".

To delete both the reference and resource file in ssp, it is enough to provide only the model cref of the ".ssv" file  (e.g) "model:root1.ssv".

When deleting only the references of a ".ssv" file, if a parameter mapping file ".ssm" is binded to a ".ssv" file then the ".ssm" file will also be deleted.
It is not possible to delete the references of ".ssm" seperately as the ssm file is binded to a ssv file.

The filename of the reference or resource file is provided by the users using colon suffix at the end of cref. (e.g) ":root.ssv"

oms_status_enu_t oms_deleteResources(const char* cref);







doStep

Simulates a macro step of the given composite model. The step size
will be determined by the master algorithm and is limited by the
definied minimal and maximal step sizes.

oms_status_enu_t oms_doStep(const char* cref);







duplicateVariant

This API provides support to develop a multi-variant modelling in OMSimulator [(e.g). SystemStructure.ssd, VarA.ssd, VarB.ssd ].
When duplicating a variant, the new variant becomes the current variant and all the changes made by the users are applied
to the new variants only, and all the ssv and ssm resources associated with the new variant will be given new name based on the variant name provided by the user.
This allows the bundling of multiple variants of a system structure definition referencing a similar set of packaged resources as a single SSP.
However there must still be one SSD file named SystemStructure.ssd at the root of the ZIP archive which will be considered
as default variant.

oms_status_enu_t oms_duplicateVariant(const char* crefA, const char* crefB);





An example of creating a multi-variant modelling is presented below

oms_newModel("model")
oms_addSystem("model.root", "system_wc")
oms_addSubModel("model.root.A", "A.fmu")
oms_setReal("model.root.A.param1", "10")
oms_duplicateVariant("model", "varB")
oms_addSubModel("varB.root.B" ,"B.fmu")
oms_setReal("varB.root.A.param2", "20")
oms_export("varB", "variant.ssp")





The variant.ssp file will have the following structure

Variant.ssp
    SystemStructure.ssd
    varB.ssd
    resources\
        A.fmu
        B.fmu







export

Exports a composite model to a SPP file.

oms_status_enu_t oms_export(const char* cref, const char* filename);







exportDependencyGraphs

Export the dependency graphs of a given model to dot files.

oms_status_enu_t oms_exportDependencyGraphs(const char* cref, const char* initialization, const char* event, const char* simulation);







exportSSMTemplate

Exports all signals that have start values of one or multiple FMUs to a SSM file that are read from modelDescription.xml with a mapping entry. The mapping entry specifies a single mapping between a parameter in the source and a parameter of the system or component being parameterized.
The mapping entry contains two attributes namely source and target. The source attribute will be empty and needs to be manually mapped by the users associated with the parameter name defined in the SSV file, the target contains the name of parameter in the system or component to be parameterized.
The function can be called for a top level model or a certain FMU component. If called for a top level model, start values of all FMUs are exported to the SSM file. If called for a component, start values of just this FMU are exported to the SSM file.

oms_status_enu_t oms_exportSSMTemplate(const char* cref, const char* filename)







exportSSVTemplate

Exports all signals that have start values of one or multiple FMUs to a SSV file that are read from modelDescription.xml. The function can be called for a top level model or a certain FMU component.
If called for a top level model, start values of all FMUs are exported to the SSV file. If called for a component, start values of just this FMU are exported to the SSV file.

oms_status_enu_t oms_exportSSVTemplate(const char* cref, const char* filename)







exportSnapshot

Lists the SSD representation of a given model, system, or component.

Memory is allocated for contents. The caller is responsible to free it using
the C-API. The Lua and Python bindings take care of the memory and the caller
doesn't need to call free.

oms_status_enu_t oms_exportSnapshot(const char* cref, char** contents);







extractFMIKind

Extracts the FMI kind of a given FMU from the file system.

oms_status_enu_t oms_extractFMIKind(const char* filename, oms_fmi_kind_enu_t* kind);







faultInjection

Defines a new fault injection block.

oms_status_enu_t oms_faultInjection(const char* signal, oms_fault_type_enu_t faultType, double faultValue);











	type

	Description"





	oms_fault_type_bias

	y = y.$original + faultValue



	oms_fault_type_gain

	y = y.$original * faultValue



	oms_fault_type_const

	y = faultValue








freeMemory

Free the memory allocated by some other API. Pass the object for which memory
is allocated.

void oms_freeMemory(void* obj);







getBoolean

Get boolean value of given signal.

oms_status_enu_t oms_getBoolean(const char* cref, bool* value);







getBus

Gets the bus object.

oms_status_enu_t oms_getBus(const char* cref, oms_busconnector_t** busConnector);







getComponentType

Gets the type of the given component.

oms_status_enu_t oms_getComponentType(const char* cref, oms_component_enu_t* type);







getConnections

Get list of all connections from a given component.

oms_status_enu_t oms_getConnections(const char* cref, oms_connection_t*** connections);







getConnector

Gets the connector object of the given connector cref.

oms_status_enu_t oms_getConnector(const char* cref, oms_connector_t** connector);







getDirectionalDerivative

This function computes the directional derivatives of an FMU.

oms_status_enu_t oms_getDirectionalDerivative(const char* cref, double* value);







getElement

Get element information of a given component reference.

oms_status_enu_t oms_getElement(const char* cref, oms_element_t** element);







getElements

Get list of all sub-components of a given component reference.

oms_status_enu_t oms_getElements(const char* cref, oms_element_t*** elements);







getFMUInfo

Returns FMU specific information.

oms_status_enu_t oms_getFMUInfo(const char* cref, const oms_fmu_info_t** fmuInfo);







getFixedStepSize

Gets the fixed step size. Can be used for the communication step size of
co-simulation systems and also for the integrator step size in model exchange
systems.

oms_status_enu_t oms_getFixedStepSize(const char* cref, double* stepSize);







getInteger

Get integer value of given signal.

oms_status_enu_t oms_getInteger(const char* cref, int* value);







getModelState

Gets the model state of the given model cref.

oms_status_enu_t oms_getModelState(const char* cref, oms_modelState_enu_t* modelState);







getReal

Get real value.

oms_status_enu_t oms_getReal(const char* cref, double* value);







getResultFile

Gets the result filename and buffer size of the given model cref.

oms_status_enu_t oms_getResultFile(const char* cref, char** filename, int* bufferSize);







getSolver

Gets the selected solver method of the given system.

oms_status_enu_t oms_getSolver(const char* cref, oms_solver_enu_t* solver);







getStartTime

Get the start time from the model.

oms_status_enu_t oms_getStartTime(const char* cref, double* startTime);







getStopTime

Get the stop time from the model.

oms_status_enu_t oms_getStopTime(const char* cref, double* stopTime);







getString

Get string value.

Memory is allocated for value. The caller is responsible to free it
using the C-API. The Lua and Python bindings take care of the memory
and the caller doesn't need to call free.

oms_status_enu_t oms_getString(const char* cref, char** value);







getSubModelPath

Returns the path of a given component.

oms_status_enu_t oms_getSubModelPath(const char* cref, char** path);







getSystemType

Gets the type of the given system.

oms_status_enu_t oms_getSystemType(const char* cref, oms_system_enu_t* type);







getTLMBus

Gets the TLM bus objects of the given TLM bus cref.

oms_status_enu_t oms_getTLMBus(const char* cref, oms_tlmbusconnector_t** tlmBusConnector);







getTLMVariableTypes

Gets the type of an TLM variable.

oms_status_enu_t oms_getTLMVariableTypes(oms_tlm_domain_t domain, const int dimensions, const oms_tlm_interpolation_t interpolation, char ***types, char ***descriptions);







getTime

Get the current simulation time from the model.

oms_status_enu_t oms_getTime(const char* cref, double* time);







getTolerance

Gets the tolerance of a given system or component.

oms_status_enu_t oms_getTolerance(const char* cref, double* absoluteTolerance, double* relativeTolerance);







getVariableStepSize

Gets the step size parameters.

oms_status_enu_t oms_getVariableStepSize(const char* cref, double* initialStepSize, double* minimumStepSize, double* maximumStepSize);







getVersion

Returns the library's version string.

const char* oms_getVersion();







importFile

Imports a composite model from a SSP file.

oms_status_enu_t oms_importFile(const char* filename, char** cref);







importSnapshot

Loads a snapshot to restore a previous model state. The model must be
in virgin model state, which means it must not be instantiated.

oms_status_enu_t oms_importSnapshot(const char* cref, const char* snapshot, char** newCref);







initialize

Initializes a composite model.

oms_status_enu_t oms_initialize(const char* cref);







instantiate

Instantiates a given composite model.

oms_status_enu_t oms_instantiate(const char* cref);







list

Lists the SSD representation of a given model, system, or component.

Memory is allocated for contents. The caller is responsible to free it using
the C-API. The Lua and Python bindings take care of the memory and the caller
doesn't need to call free.

oms_status_enu_t oms_list(const char* cref, char** contents);







listUnconnectedConnectors

Lists all unconnected connectors of a given system.

Memory is allocated for contents. The caller is responsible to free it using
the C-API. The Lua and Python bindings take care of the memory and the caller
doesn't need to call free.

oms_status_enu_t oms_listUnconnectedConnectors(const char* cref, char** contents);







listVariants

This API shows the number of variants available [(e.g). SystemStructure.ssd, VarA.ssd, VarB.ssd ] from a ssp file.

oms_status_enu_t oms_listVariants(const char* cref);





An example for finding the number of available variants in a ssp file

oms_newModel("model")
oms_addSystem("model.root", "system_wc")
oms_addSubModel("model.root.A", "A.fmu")
oms_duplicateVariant("model", "varA")
oms_duplicateVariant("varA", "varB")

oms_listVariants("varB")





The API will list the available variants like below

<oms:Variants>
  <oms:variant name="model" />
  <oms:variant name="varB" />
  <oms:variant name="varA" />
</oms:Variants>







loadSnapshot

Loads a snapshot to restore a previous model state. The model must be in virgin model state, which means it must not be instantiated.

oms_status_enu_t oms_loadSnapshot(const char* cref, const char* snapshot, char** newCref);







newModel

Creates a new and yet empty composite model.

oms_status_enu_t oms_newModel(const char* cref);







newResources

Adds a new empty resources to the SSP. The resource file is a ".ssv" file where the parameter values set by the users using
"oms_setReal()", "oms_setInteger()" and "oms_setReal()" are writtern to the file. Currently only ".ssv" files can be created.

The filename of the resource file is provided by the users using colon suffix at the end of cref. (e.g) ":root.ssv"

oms_status_enu_t oms_newResources(const char* cref)







referenceResources

Switches the references of ".ssv" and ".ssm" in a SSP file. Referencing of ".ssv" and ".ssm" files are currently supported. The API can be used in two ways.


	Referencing only the ".ssv" file.


	Referencing both the ".ssv" along with the ".ssm" file.




This API should be used in combination with "oms_deleteResources".To switch with a new reference, the old reference must be deleted first using "oms_deleteResources" and then reference with new resources.

When deleting only the references of a ".ssv" file, if a parameter mapping file ".ssm" is binded to a ".ssv" file, then the reference of ".ssm" file will also be deleted.
It is not possible to delete the references of ".ssm" seperately as the ssm file is binded to a ssv file. Hence it is not possible to switch the reference of ".ssm" file alone.
So inorder to switch the reference of ".ssm" file, the users need to bind the reference of ".ssm" file along with the ".ssv".

The filename of the reference or resource file is provided by the users using colon suffix at the end of cref (e.g) ":root.ssv",
and the ".ssm" file is optional and is provided by the user as the second argument to the API.

oms_status_enu_t oms_referenceResources(const char* cref, const char* ssmFile);







removeSignalsFromResults

Removes all variables that match the given regex to the result file.

oms_status_enu_t oms_removeSignalsFromResults(const char* cref, const char* regex);





The second argument, i.e. regex, is considered as a regular expression (C++11).
".*" and "(.)*" can be used to hit all variables.



rename

Renames a model, system, or component.

oms_status_enu_t oms_rename(const char* cref, const char* newCref);







replaceSubModel

Replaces an existing fmu component, with a new component provided by the user,
When replacing the fmu checks are made in all ssp concepts like in ssd, ssv and ssm, so that connections and parameter settings
are not lost. It is possible that the namings of inputs and parameters match, but the start values might have been changed,
in such cases new start values will be applied in ssd, ssv and ssm. In case if the Types of inputs and outputs and parameters
differed, then the variables are updated according to the new changes and the connections will be removed with warning messages to user.
In case when replacing a fmu, if the fmu contains parameter mapping associated with the ssv file, then only the ssm file entries
are updated and the start values in the ssv files will not be changed.

oms_status_enu_t oms_replaceSubModel(const char* cref, const char* fmuPath);






It is possible to import an partially developed fmu (i.e contains only modeldescription.xml without any binaries) in OMSimulator, and later can be replaced with a fully develped fmu. An example to use the API,
oms_addSubModel("model.root.A", "../resources/replaceA.fmu")
oms_export("model", "test.ssp")
oms_import("test.ssp")
oms_replaceSubModel("model.root.A", "../resources/replaceA_extended.fmu")






reset

Reset the composite model after a simulation run.

The FMUs go into the same state as after instantiation.

oms_status_enu_t oms_reset(const char* cref);







setActivationRatio

Experimental feature for setting the activation ratio of FMUs for experimenting with multi-rate master algorithms.

oms_status_enu_t experimental_setActivationRatio(const char* cref, int k);







setBoolean

Sets the value of a given boolean signal.

oms_status_enu_t oms_setBoolean(const char* cref, bool value);







setBusGeometry

oms_status_enu_t oms_setBusGeometry(const char* bus, const ssd_connector_geometry_t* geometry);







setCommandLineOption

Sets special flags.

oms_status_enu_t oms_setCommandLineOption(const char* cmd);





Available flags:

info:    Usage: OMSimulator [Options] [Lua script] [FMU] [SSP file]
         Options:
           --addParametersToCSV=<arg>      Export parameters to .csv file (true, [false])
           --algLoopSolver=<arg>           Specifies the alg. loop solver method (fixedpoint, [kinsol]) used for algebraic loops spanning over multiple components.
           --clearAllOptions               Reset all flags to default values
           --CVODEMaxErrTestFails=<int>    Maximum number of error test failures for CVODE
           --CVODEMaxNLSFailures=<int>     Maximum number of nonlinear convergence failures for CVODE
           --CVODEMaxNLSIterations=<int>   Maximum number of nonlinear solver iterations for CVODE
           --CVODEMaxSteps=<int>           Maximum number of steps for CVODE
           --CVODEMaxOrder=<int>           Maximum order for CVODE
           --deleteTempFiles=<bool>        Deletes temp files as soon as they are no longer needed ([true], false)
           --directionalDerivatives=<bool>  Specifies whether directional derivatives should be used to calculate the Jacobian for alg. loops or if a numerical approximation should be used instead ([true], false)
           --dumpAlgLoops=<bool>           Dump information for alg loops (true, [false])
           --emitEvents=<bool>             Specifies whether events should be emitted or not ([true], false)
           --fetchAllVars=<arg>            Workaround for certain FMUs that do not update all internal dependencies automatically
           --help [-h]                     Displays the help text
           --ignoreInitialUnknowns=<bool>  Ignore the initial unknowns from the modelDescription.xml (true, [false])
           --inputExtrapolation=<bool>     Enables input extrapolation using derivative information (true, [false])
           --intervals=<int> [-i]          Specifies the number of communication points (arg > 1)
           --logFile=<arg> [-l]            Specifies the logfile (stdout is used if no log file is specified)
           --logLevel=<int>                0 default, 1 debug, 2 debug+trace
           --maxEventIteration=<int>       Specifies the max. number of iterations for handling a single event
           --maxLoopIteration=<int>        Specifies the max. number of iterations for solving algebraic loops between system-level components. Internal algebraic loops of components are not affected.
           --mode=<arg> [-m]               Forces a certain FMI mode iff the FMU provides cs and me (cs, [me])
           --numProcs=<int> [-n]           Specifies the max. number of processors to use (0=auto, 1=default)
           --progressBar=<bool>            Shows a progress bar for the simulation progress in the terminal (true, [false])
           --realTime=<bool>               Experimental feature for (soft) real-time co-simulation (true, [false])
           --resultFile=<arg> [-r]         Specifies the name of the output result file
           --skipCSVHeader=<arg>           Skip exporting the scv delimiter in the header ([true], false), 
           --solver=<arg>                  Specifies the integration method (euler, [cvode])
           --solverStats=<bool>            Adds solver stats to the result file, e.g. step size; not supported for all solvers (true, [false])
           --startTime=<double> [-s]       Specifies the start time
           --stepSize=<arg>                Specifies the step size (<step size> or <init step,min step,max step>)
           --stopTime=<double> [-t]        Specifies the stop time
           --stripRoot=<bool>              Removes the root system prefix from all exported signals (true, [false])
           --suppressPath=<bool>           Supresses path information in info messages; especially useful for testing ([true], false)
           --tempDir=<arg>                 Specifies the temp directory
           --timeout=<int>                 Specifies the maximum allowed time in seconds for running a simulation (0 disables)
           --tolerance=<double>            Specifies the relative tolerance
           --version [-v]                  Displays version information
           --wallTime=<bool>               Add wall time information for to the result file (true, [false])
           --workingDir=<arg>              Specifies the working directory
           --zeroNominal=<bool>            Using this flag, FMUs with invalid nominal values will be accepted and the invalid nominal values will be replaced with 1.0







setConnectionGeometry

oms_status_enu_t oms_setConnectionGeometry(const char* crefA, const char* crefB, const ssd_connection_geometry_t* geometry);







setConnectorGeometry

Set geometry information to a given connector.

oms_status_enu_t oms_setConnectorGeometry(const char* cref, const ssd_connector_geometry_t* geometry);







setElementGeometry

Set geometry information to a given component.

oms_status_enu_t oms_setElementGeometry(const char* cref, const ssd_element_geometry_t* geometry);







setFixedStepSize

Sets the fixed step size. Can be used for the communication step size of
co-simulation systems and also for the integrator step size in model exchange
systems.

oms_status_enu_t oms_setFixedStepSize(const char* cref, double stepSize);







setInteger

Sets the value of a given integer signal.

oms_status_enu_t oms_setInteger(const char* cref, int value);







setLogFile

Redirects logging output to file or std streams. The warning/error counters are
reset.

filename="" to redirect to std streams and proper filename to redirect to file.

oms_status_enu_t oms_setLogFile(const char* filename);







setLoggingCallback

Sets a callback function for the logging system.

void oms_setLoggingCallback(void (*cb)(oms_message_type_enu_t type, const char* message));







setLoggingInterval

Set the logging interval of the simulation.

oms_status_enu_t oms_setLoggingInterval(const char* cref, double loggingInterval);







setLoggingLevel

Enables/Disables debug logging (logDebug and logTrace).

0 default, 1 default+debug, 2 default+debug+trace

void oms_setLoggingLevel(int logLevel);







setMaxLogFileSize

Sets maximum log file size in MB. If the file exceeds this limit, the logging
will continue on stdout.

void oms_setMaxLogFileSize(const unsigned long size);







setReal

Sets the value of a given real signal.

oms_status_enu_t oms_setReal(const char* cref, double value);





This function can be called in different model states:


	Before instantiation: setReal can be used to set start values or to define
initial unknowns (e.g. parameters, states). The values are not
immediately applied to the simulation unit, since it isn't actually
instantiated.


	After instantiation and before initialization: Same as before instantiation,
but the values are applied immediately to the simulation unit.


	After initialization: Can be used to force external inputs, which might cause
discrete changes of continuous signals.






setRealInputDerivative

Sets the first order derivative of a real input signal.

This can only be used for CS-FMU real input signals.

oms_status_enu_t oms_setRealInputDerivative(const char* cref, double value);







setResultFile

Set the result file of the simulation.

oms_status_enu_t oms_setResultFile(const char* cref, const char* filename, int bufferSize);





The creation of a result file is omitted if the filename is an empty string.



setSolver

Sets the solver method for the given system.

oms_status_enu_t oms_setSolver(const char* cref, oms_solver_enu_t solver);







setStartTime

Set the start time of the simulation.

oms_status_enu_t oms_setStartTime(const char* cref, double startTime);







setStopTime

Set the stop time of the simulation.

oms_status_enu_t oms_setStopTime(const char* cref, double stopTime);







setString

Sets the value of a given string signal.

oms_status_enu_t oms_setString(const char* cref, const char* value);







setTLMBusGeometry

oms_status_enu_t oms_setTLMBusGeometry(const char* bus, const ssd_connector_geometry_t* geometry);







setTLMConnectionParameters

Simulates a composite model in its own thread.

oms_status_enu_t oms_setTLMConnectionParameters(const char* crefA, const char* crefB, const oms_tlm_connection_parameters_t* parameters);







setTLMPositionAndOrientation

Sets initial position and orientation for a TLM 3D interface.

oms_status_enu_t oms_setTLMPositionAndOrientation(cref, x1, x2, x3, A11, A12, A13, A21, A22, A23, A31, A32, A33);







setTLMSocketData

Sets data for TLM socket communication.

oms_status_enu_t oms_setTLMSocketData(const char* cref, const char* address, int managerPort, int monitorPort);







setTempDirectory

Set new temp directory.

oms_status_enu_t oms_setTempDirectory(const char* newTempDir);







setTolerance

Sets the tolerance for a given model or system.

oms_status_enu_t oms_setTolerance(const char* cref, double absoluteTolerance, double relativeTolerance);





Default values are 1e-4 for both relative and absolute tolerances.

A tolerance specified for a model is automatically applied to its root system,
i.e. both calls do exactly the same:

oms_setTolerance("model", absoluteTolerance, relativeTolerance);
oms_setTolerance("model.root", absoluteTolerance, relativeTolerance);





Component, e.g. FMUs, pick up the tolerances from there system. That means
it is not possible to define different tolerances for FMUs in the same system
right now.

In a strongly coupled system (oms_system_sc), the relative tolerance is used
for CVODE and the absolute tolerance is used to solve algebraic loops.

In a weakly coupled system (oms_system_wc), both the relative and absolute
tolerances are used for the adaptive step master algorithms and the absolute
tolerance is used to solve algebraic loops.



setUnit

Sets the unit of a given signal.

oms_status_enu_t oms_setUnit(const char* cref, const char* value);







setVariableStepSize

Sets the step size parameters for methods with stepsize control.

oms_status_enu_t oms_getVariableStepSize(const char* cref, double* initialStepSize, double* minimumStepSize, double* maximumStepSize);







setWorkingDirectory

Set a new working directory.

oms_status_enu_t oms_setWorkingDirectory(const char* newWorkingDir);







simulate

Simulates a composite model.

oms_status_enu_t oms_simulate(const char* cref);







simulate_realtime

Experimental feature for (soft) real-time simulation.

oms_status_enu_t experimental_simulate_realtime(const char* ident);







stepUntil

Simulates a composite model until a given time value.

oms_status_enu_t oms_stepUntil(const char* cref, double stopTime);







terminate

Terminates a given composite model.

oms_status_enu_t oms_terminate(const char* cref);








OMSimulatorLua

This is a shared library that provides a Lua interface for the OMSimulatorLib
library.


Examples

oms_setTempDirectory("./temp/")
oms_newModel("model")
oms_addSystem("model.root", oms_system_sc)

-- instantiate FMUs
oms_addSubModel("model.root.system1", "FMUs/System1.fmu")
oms_addSubModel("model.root.system2", "FMUs/System2.fmu")

-- add connections
oms_addConnection("model.root.system1.y", "model.root.system2.u")
oms_addConnection("model.root.system2.y", "model.root.system1.u")

-- simulation settings
oms_setResultFile("model", "results.mat")
oms_setStopTime("model", 0.1)
oms_setFixedStepSize("model.root", 1e-4)

oms_instantiate("model")
oms_setReal("model.root.system1.x_start", 2.5)

oms_initialize("model")
oms_simulate("model")
oms_terminate("model")
oms_delete("model")






Lua Scripting Commands




activateVariant

This API provides support to activate a multi-variant modelling from an ssp file [(e.g). SystemStructure.ssd, VarA.ssd, VarB.ssd ] from a ssp file.
By default when importing a ssp file the default variant will be "SystemStructure.ssd". The users can be able to switch between other variants by
using this API and make changes to that particular variant and simulate them.

status = oms_activateVariant(crefA, crefB)






An example of activating the number of available variants in a ssp file

oms_newModel("model")
oms_addSystem("model.root", "system_wc")
oms_addSubModel("model.root.A", "A.fmu")
oms_duplicateVariant("model", "varA") // varA will be the current variant
oms_duplicateVariant("varA", "varB") // varB will be the current variant
oms_activateVariant("varB", "varA") // Reactivate the variant varB to varA
oms_activateVariant("varA", "model") // Reactivate the variant varA to model






addBus

Adds a bus to a given component.

status = oms_addBus(cref)







addConnection

Adds a new connection between connectors A and B. The connectors need to be
specified as fully qualified component references, e.g., "model.system.component.signal".

status = oms_addConnection(crefA, crefB, suppressUnitConversion)





The two arguments crefA and crefB get swapped automatically if necessary. The third argument suppressUnitConversion is
optional and the default value is false which allows automatic unit conversion between connections, if set to true then
automatic unit conversion will be disabled.



addConnector

Adds a connector to a given component.

status = oms_addConnector(cref, causality, type)

The second argument "causality", should be any of the following,

oms_causality_input
oms_causality_output
oms_causality_parameter
oms_causality_bidir
oms_causality_undefined

The third argument "type", should be any of the following,

oms_signal_type_real
oms_signal_type_integer
oms_signal_type_boolean
oms_signal_type_string
oms_signal_type_enum
oms_signal_type_bus







addConnectorToBus

Adds a connector to a bus.

status = oms_addConnectorToBus(busCref, connectorCref)







addConnectorToTLMBus

Adds a connector to a TLM bus.

status = oms_addConnectorToTLMBus(busCref, connectorCref, type)







addExternalModel

Adds an external model to a TLM system.

status = oms_addExternalModel(cref, path, startscript)







addResources

Adds an external resources to an existing SSP. The external resources should be a ".ssv" or ".ssm" file

status = oms_addResources(cref, path)

-- Example
oms_importFile("addExternalResources1.ssp")
-- add list of external resources from filesystem to ssp
oms_addResources("addExternalResources", "../../resources/externalRoot.ssv")
oms_addResources("addExternalResources:externalSystem.ssv", "../../resources/externalSystem1.ssv")
oms_addResources("addExternalResources", "../../resources/externalGain.ssv")
-- export the ssp with new resources
oms_export("addExternalResources", "addExternalResources1.ssp")







addSignalsToResults

Add all variables that match the given regex to the result file.

status = oms_addSignalsToResults(cref, regex)





The second argument, i.e. regex, is considered as a regular expression (C++11).
".*" and "(.)*" can be used to hit all variables.



addSubModel

Adds a component to a system.

status = oms_addSubModel(cref, fmuPath)







addSystem

Adds a (sub-)system to a model or system.

status = oms_addSystem(cref, type)







addTLMBus

Adds a TLM bus.

status = oms_addTLMBus(cref, domain, dimensions, interpolation)

The second argument "domain", should be any of the following,

oms_tlm_domain_input
oms_tlm_domain_output
oms_tlm_domain_mechanical
oms_tlm_domain_rotational
oms_tlm_domain_hydraulic
oms_tlm_domain_electric

The fourth argument "interpolation", should be any of the following,

oms_tlm_no_interpolation
oms_tlm_coarse_grained
oms_tlm_fine_grained







addTLMConnection

Connects two TLM connectors.

status = oms_addTLMConnection(crefA, crefB, delay, alpha, linearimpedance, angularimpedance)







compareSimulationResults

This function compares a given signal of two result files within absolute and
relative tolerances.

oms_compareSimulationResults(filenameA, filenameB, var, relTol, absTol)





The following table describes the input values:








	Input

	Type

	Description





	filenameA

	String

	Name of first result file to compare.



	filenameB

	String

	Name of second result file to compare.



	var

	String

	Name of signal to compare.



	relTol

	Number

	Relative tolerance.



	absTol

	Number

	Absolute tolerance.






The following table describes the return values:







	Type

	Description





	Integer

	1 if the signal is considered as equal, 0 otherwise








copySystem

Copies a system.

status = oms_copySystem(source, target)







delete

Deletes a connector, component, system, or model object.

status = oms_delete(cref)







deleteConnection

Deletes the connection between connectors crefA and crefB.

status = oms_deleteConnection(crefA, crefB)





The two arguments crefA and crefB get swapped automatically if necessary.



deleteConnectorFromBus

Deletes a connector from a given bus.

status = oms_deleteConnectorFromBus(busCref, connectorCref)







deleteConnectorFromTLMBus

Deletes a connector from a given TLM bus.

status = oms_deleteConnectorFromTLMBus(busCref, connectorCref)







deleteResources

Deletes the reference and resource file in a SSP. Deletion of ".ssv" and ".ssm" files are currently supported. The API can be used in two ways.


	deleting only the reference file in ".ssd".


	deleting both reference and resource files in ".ssp".




To delete only the reference file in ssd, the user should provide the full qualified cref of the ".ssv" file associated with a system or subsystem or component (e.g) "model.root:root1.ssv".

To delete both the reference and resource file in ssp, it is enough to provide only the model cref of the ".ssv" file  (e.g) "model:root1.ssv".

When deleting only the references of a ".ssv" file, if a parameter mapping file ".ssm" is binded to a ".ssv" file then the ".ssm" file will also be deleted.
It is not possible to delete the references of ".ssm" seperately as the ssm file is binded to a ssv file.

The filename of the reference or resource file is provided by the users using colon suffix at the end of cref. (e.g) ":root.ssv"

status = oms_deleteResources(cref)

-- Example
oms_importFile("deleteResources1.ssp")
-- delete only the references in ".ssd" file
oms_deleteResources("deleteResources.root:root.ssv")
-- delete both references and resources
oms_deleteResources("deleteResources:root.ssv")
oms_export("deleteResources1.ssp")







duplicateVariant

This API provides support to develop a multi-variant modelling in OMSimulator [(e.g). SystemStructure.ssd, VarA.ssd, VarB.ssd ].
When duplicating a variant, the new variant becomes the current variant and all the changes made by the users are applied
to the new variants only, and all the ssv and ssm resources associated with the new variant will be given new name based on the variant name provided by the user.
This allows the bundling of multiple variants of a system structure definition referencing a similar set of packaged resources as a single SSP.
However there must still be one SSD file named SystemStructure.ssd at the root of the ZIP archive which will be considered
as default variant.

status = oms_duplicateVariant(crefA, crefB)





An example of creating a multi-variant modelling is presented below

oms_newModel("model")
oms_addSystem("model.root", "system_wc")
oms_addSubModel("model.root.A", "A.fmu")
oms_setReal("model.root.A.param1", "10")
oms_duplicateVariant("model", "varB")
oms_addSubModel("varB.root.B" ,"B.fmu")
oms_setReal("varB.root.A.param2", "20")
oms_export("varB", "variant.ssp")





The variant.ssp file will have the following structure

Variant.ssp
    SystemStructure.ssd
    varB.ssd
    resources\
        A.fmu
        B.fmu







export

Exports a composite model to a SPP file.

status = oms_export(cref, filename)







exportDependencyGraphs

Export the dependency graphs of a given model to dot files.

status = oms_exportDependencyGraphs(cref, initialization, event, simulation)







exportSSMTemplate

Exports all signals that have start values of one or multiple FMUs to a SSM file that are read from modelDescription.xml with a mapping entry. The mapping entry specifies a single mapping between a parameter in the source and a parameter of the system or component being parameterized.
The mapping entry contains two attributes namely source and target. The source attribute will be empty and needs to be manually mapped by the users associated with the parameter name defined in the SSV file, the target contains the name of parameter in the system or component to be parameterized.
The function can be called for a top level model or a certain FMU component. If called for a top level model, start values of all FMUs are exported to the SSM file. If called for a component, start values of just this FMU are exported to the SSM file.

status = oms_exportSSMTemplate(cref, filename)







exportSSVTemplate

Exports all signals that have start values of one or multiple FMUs to a SSV file that are read from modelDescription.xml. The function can be called for a top level model or a certain FMU component.
If called for a top level model, start values of all FMUs are exported to the SSV file. If called for a component, start values of just this FMU are exported to the SSV file.

status = oms_exportSSVTemplate(cref, filename)







exportSnapshot

Lists the SSD representation of a given model, system, or component.

Memory is allocated for contents. The caller is responsible to free it using
the C-API. The Lua and Python bindings take care of the memory and the caller
doesn't need to call free.

contents, status = oms_exportSnapshot(cref)







faultInjection

Defines a new fault injection block.

status = oms_faultInjection(cref, type, value)











	type

	Description"





	oms_fault_type_bias

	y = y.$original + faultValue



	oms_fault_type_gain

	y = y.$original * faultValue



	oms_fault_type_const

	y = faultValue








freeMemory

Free the memory allocated by some other API. Pass the object for which memory
is allocated.

This function is neither needed nor available from the Lua interface.



getBoolean

Get boolean value of given signal.

value, status = oms_getBoolean(cref)







getDirectionalDerivative

This function computes the directional derivatives of an FMU.

value, status = oms_getDirectionalDerivative(cref)







getFixedStepSize

Gets the fixed step size. Can be used for the communication step size of
co-simulation systems and also for the integrator step size in model exchange
systems.

stepSize, status = oms_setFixedStepSize(cref)







getInteger

Get integer value of given signal.

value, status = oms_getInteger(cref)







getModelState

Gets the model state of the given model cref.

modelState, status = oms_getModelState(cref)







getReal

Get real value.

value, status = oms_getReal(cref)







getSolver

Gets the selected solver method of the given system.

solver, status = oms_getSolver(cref)







getStartTime

Get the start time from the model.

startTime, status = oms_getStartTime(cref)







getStopTime

Get the stop time from the model.

stopTime, status = oms_getStopTime(cref)







getString

Get string value.

Memory is allocated for value. The caller is responsible to free it
using the C-API. The Lua and Python bindings take care of the memory
and the caller doesn't need to call free.

value, status = oms_getString(cref)







getSystemType

Gets the type of the given system.

type, status = oms_getSystemType(cref)







getTime

Get the current simulation time from the model.

time, status = oms_getTime(cref)







getTolerance

Gets the tolerance of a given system or component.

absoluteTolerance, relativeTolerance, status = oms_getTolerance(cref)







getVariableStepSize

Gets the step size parameters.

initialStepSize, minimumStepSize, maximumStepSize, status = oms_getVariableStepSize(cref)







getVersion

Returns the library's version string.

version = oms_getVersion()







importFile

Imports a composite model from a SSP file.

cref, status = oms_importFile(filename)







importSnapshot

Loads a snapshot to restore a previous model state. The model must be
in virgin model state, which means it must not be instantiated.

newCref, status = oms_importSnapshot(cref, snapshot)







initialize

Initializes a composite model.

status = oms_initialize(cref)







instantiate

Instantiates a given composite model.

status = oms_instantiate(cref)







list

Lists the SSD representation of a given model, system, or component.

Memory is allocated for contents. The caller is responsible to free it using
the C-API. The Lua and Python bindings take care of the memory and the caller
doesn't need to call free.

contents, status = oms_list(cref)







listUnconnectedConnectors

Lists all unconnected connectors of a given system.

Memory is allocated for contents. The caller is responsible to free it using
the C-API. The Lua and Python bindings take care of the memory and the caller
doesn't need to call free.

contents, status = oms_listUnconnectedConnectors(cref)







listVariants

This API shows the number of variants available [(e.g). SystemStructure.ssd, VarA.ssd, VarB.ssd ] from a ssp file.

status = oms_listVariants(cref)





An example for finding the number of available variants in a ssp file

oms_newModel("model")
oms_addSystem("model.root", "system_wc")
oms_addSubModel("model.root.A", "A.fmu")
oms_duplicateVariant("model", "varA")
oms_duplicateVariant("varA", "varB")

oms_listVariants("varB")





The API will list the available variants like below

<oms:Variants>
  <oms:variant name="model" />
  <oms:variant name="varB" />
  <oms:variant name="varA" />
</oms:Variants>







loadSnapshot

Loads a snapshot to restore a previous model state. The model must be in virgin model state, which means it must not be instantiated.

newCref, status = oms_loadSnapshot(cref, snapshot)







newModel

Creates a new and yet empty composite model.

status = oms_newModel(cref)







newResources

Adds a new empty resources to the SSP. The resource file is a ".ssv" file where the parameter values set by the users using
"oms_setReal()", "oms_setInteger()" and "oms_setReal()" are writtern to the file. Currently only ".ssv" files can be created.

The filename of the resource file is provided by the users using colon suffix at the end of cref. (e.g) ":root.ssv"

status = oms_newResources(cref)

-- Example
oms_newModel("newResources")

oms_addSystem("newResources.root", oms_system_wc)
oms_addConnector("newResources.root.Input1", oms_causality_input, oms_signal_type_real)
oms_addConnector("newResources.root.Input2", oms_causality_input, oms_signal_type_real)

-- add Top level new resources, the filename is provided using the colon suffix ":root.ssv"
oms_newResources("newResources.root:root.ssv")
oms_setReal("newResources.root.Input1", 10)
-- export the ssp with new resources
oms_export("newResources", "newResources.ssp")







referenceResources

Switches the references of ".ssv" and ".ssm" in a SSP file. Referencing of ".ssv" and ".ssm" files are currently supported. The API can be used in two ways.


	Referencing only the ".ssv" file.


	Referencing both the ".ssv" along with the ".ssm" file.




This API should be used in combination with "oms_deleteResources".To switch with a new reference, the old reference must be deleted first using "oms_deleteResources" and then reference with new resources.

When deleting only the references of a ".ssv" file, if a parameter mapping file ".ssm" is binded to a ".ssv" file, then the reference of ".ssm" file will also be deleted.
It is not possible to delete the references of ".ssm" seperately as the ssm file is binded to a ssv file. Hence it is not possible to switch the reference of ".ssm" file alone.
So inorder to switch the reference of ".ssm" file, the users need to bind the reference of ".ssm" file along with the ".ssv".

The filename of the reference or resource file is provided by the users using colon suffix at the end of cref (e.g) ":root.ssv",
and the ".ssm" file is optional and is provided by the user as the second argument to the API.

status = oms_referenceResources(cref, ssmFile)

-- Example
oms_importFile("referenceResources1.ssp")
-- delete only the references in ".ssd" file
oms_deleteResources("referenceResources1.root:root.ssv")
-- usage-1 switch with new references, only ssv file
oms_referenceResources("referenceResources1.root:Config1.ssv")
-- usage-2 switch with new references, both ssv and ssm file
oms_referenceResources("referenceResources1.root:Config1.ssv", "Config1.ssm")
oms_export("referenceResources1.ssp")







removeSignalsFromResults

Removes all variables that match the given regex to the result file.

status = oms_removeSignalsFromResults(cref, regex)





The second argument, i.e. regex, is considered as a regular expression (C++11).
".*" and "(.)*" can be used to hit all variables.



rename

Renames a model, system, or component.

status = oms_rename(cref, newCref)







replaceSubModel

Replaces an existing fmu component, with a new component provided by the user,
When replacing the fmu checks are made in all ssp concepts like in ssd, ssv and ssm, so that connections and parameter settings
are not lost. It is possible that the namings of inputs and parameters match, but the start values might have been changed,
in such cases new start values will be applied in ssd, ssv and ssm. In case if the Types of inputs and outputs and parameters
differed, then the variables are updated according to the new changes and the connections will be removed with warning messages to user.
In case when replacing a fmu, if the fmu contains parameter mapping associated with the ssv file, then only the ssm file entries
are updated and the start values in the ssv files will not be changed.

status = oms_replaceSubModel(cref, fmuPath)






It is possible to import an partially developed fmu (i.e contains only modeldescription.xml without any binaries) in OMSimulator, and later can be replaced with a fully develped fmu. An example to use the API,
oms_addSubModel("model.root.A", "../resources/replaceA.fmu")
oms_export("model", "test.ssp")
oms_import("test.ssp")
oms_replaceSubModel("model.root.A", "../resources/replaceA_extended.fmu")






reset

Reset the composite model after a simulation run.

The FMUs go into the same state as after instantiation.

status = oms_reset(cref)







setActivationRatio

Experimental feature for setting the activation ratio of FMUs for experimenting with multi-rate master algorithms.

status = experimental_setActivationRatio(cref, k)







setBoolean

Sets the value of a given boolean signal.

status = oms_setBoolean(cref, value)







setCommandLineOption

Sets special flags.

status = oms_setCommandLineOption(cmd)





Available flags:

info:    Usage: OMSimulator [Options] [Lua script] [FMU] [SSP file]
         Options:
           --addParametersToCSV=<arg>      Export parameters to .csv file (true, [false])
           --algLoopSolver=<arg>           Specifies the alg. loop solver method (fixedpoint, [kinsol]) used for algebraic loops spanning over multiple components.
           --clearAllOptions               Reset all flags to default values
           --CVODEMaxErrTestFails=<int>    Maximum number of error test failures for CVODE
           --CVODEMaxNLSFailures=<int>     Maximum number of nonlinear convergence failures for CVODE
           --CVODEMaxNLSIterations=<int>   Maximum number of nonlinear solver iterations for CVODE
           --CVODEMaxSteps=<int>           Maximum number of steps for CVODE
           --CVODEMaxOrder=<int>           Maximum order for CVODE
           --deleteTempFiles=<bool>        Deletes temp files as soon as they are no longer needed ([true], false)
           --directionalDerivatives=<bool>  Specifies whether directional derivatives should be used to calculate the Jacobian for alg. loops or if a numerical approximation should be used instead ([true], false)
           --dumpAlgLoops=<bool>           Dump information for alg loops (true, [false])
           --emitEvents=<bool>             Specifies whether events should be emitted or not ([true], false)
           --fetchAllVars=<arg>            Workaround for certain FMUs that do not update all internal dependencies automatically
           --help [-h]                     Displays the help text
           --ignoreInitialUnknowns=<bool>  Ignore the initial unknowns from the modelDescription.xml (true, [false])
           --inputExtrapolation=<bool>     Enables input extrapolation using derivative information (true, [false])
           --intervals=<int> [-i]          Specifies the number of communication points (arg > 1)
           --logFile=<arg> [-l]            Specifies the logfile (stdout is used if no log file is specified)
           --logLevel=<int>                0 default, 1 debug, 2 debug+trace
           --maxEventIteration=<int>       Specifies the max. number of iterations for handling a single event
           --maxLoopIteration=<int>        Specifies the max. number of iterations for solving algebraic loops between system-level components. Internal algebraic loops of components are not affected.
           --mode=<arg> [-m]               Forces a certain FMI mode iff the FMU provides cs and me (cs, [me])
           --numProcs=<int> [-n]           Specifies the max. number of processors to use (0=auto, 1=default)
           --progressBar=<bool>            Shows a progress bar for the simulation progress in the terminal (true, [false])
           --realTime=<bool>               Experimental feature for (soft) real-time co-simulation (true, [false])
           --resultFile=<arg> [-r]         Specifies the name of the output result file
           --skipCSVHeader=<arg>           Skip exporting the scv delimiter in the header ([true], false), 
           --solver=<arg>                  Specifies the integration method (euler, [cvode])
           --solverStats=<bool>            Adds solver stats to the result file, e.g. step size; not supported for all solvers (true, [false])
           --startTime=<double> [-s]       Specifies the start time
           --stepSize=<arg>                Specifies the step size (<step size> or <init step,min step,max step>)
           --stopTime=<double> [-t]        Specifies the stop time
           --stripRoot=<bool>              Removes the root system prefix from all exported signals (true, [false])
           --suppressPath=<bool>           Supresses path information in info messages; especially useful for testing ([true], false)
           --tempDir=<arg>                 Specifies the temp directory
           --timeout=<int>                 Specifies the maximum allowed time in seconds for running a simulation (0 disables)
           --tolerance=<double>            Specifies the relative tolerance
           --version [-v]                  Displays version information
           --wallTime=<bool>               Add wall time information for to the result file (true, [false])
           --workingDir=<arg>              Specifies the working directory
           --zeroNominal=<bool>            Using this flag, FMUs with invalid nominal values will be accepted and the invalid nominal values will be replaced with 1.0







setFixedStepSize

Sets the fixed step size. Can be used for the communication step size of
co-simulation systems and also for the integrator step size in model exchange
systems.

status = oms_setFixedStepSize(cref, stepSize)







setInteger

Sets the value of a given integer signal.

status = oms_setInteger(cref, value)







setLogFile

Redirects logging output to file or std streams. The warning/error counters are
reset.

filename="" to redirect to std streams and proper filename to redirect to file.

status = oms_setLogFile(filename)







setLoggingInterval

Set the logging interval of the simulation.

status = oms_setLoggingInterval(cref, loggingInterval)







setLoggingLevel

Enables/Disables debug logging (logDebug and logTrace).

0 default, 1 default+debug, 2 default+debug+trace

oms_setLoggingLevel(logLevel)







setMaxLogFileSize

Sets maximum log file size in MB. If the file exceeds this limit, the logging
will continue on stdout.

oms_setMaxLogFileSize(size)







setReal

Sets the value of a given real signal.

status = oms_setReal(cref, value)





This function can be called in different model states:


	Before instantiation: setReal can be used to set start values or to define
initial unknowns (e.g. parameters, states). The values are not
immediately applied to the simulation unit, since it isn't actually
instantiated.


	After instantiation and before initialization: Same as before instantiation,
but the values are applied immediately to the simulation unit.


	After initialization: Can be used to force external inputs, which might cause
discrete changes of continuous signals.






setRealInputDerivative

Sets the first order derivative of a real input signal.

This can only be used for CS-FMU real input signals.

status = oms_setRealInputDerivative(cref, value)







setResultFile

Set the result file of the simulation.

status = oms_setResultFile(cref, filename)
status = oms_setResultFile(cref, filename, bufferSize)





The creation of a result file is omitted if the filename is an empty string.



setSolver

Sets the solver method for the given system.

status = oms_setSolver(cref, solver)












	solver

	Type

	Description





	oms_solver_sc_explicit_euler

	sc-system

	Explicit euler with fixed step size



	oms_solver_sc_cvode

	sc-system

	CVODE with adaptive stepsize



	oms_solver_wc_ma

	wc-system

	default master algorithm with fixed step size



	oms_solver_wc_mav

	wc-system

	master algorithm with adaptive stepsize



	oms_solver_wc_mav2

	wc-system

	master algorithm with adaptive stepsize (double-step)








setStartTime

Set the start time of the simulation.

status = oms_setStartTime(cref, startTime)







setStopTime

Set the stop time of the simulation.

status = oms_setStopTime(cref, stopTime)







setString

Sets the value of a given string signal.

status = oms_setString(cref, value)







setTLMPositionAndOrientation

Sets initial position and orientation for a TLM 3D interface.

status = oms_setTLMPositionAndOrientation(cref, x1, x2, x3, A11, A12, A13, A21, A22, A23, A31, A32, A33)







setTLMSocketData

Sets data for TLM socket communication.

status = oms_setTLMSocketData(cref, address, managerPort, monitorPort)







setTempDirectory

Set new temp directory.

status = oms_setTempDirectory(newTempDir)







setTolerance

Sets the tolerance for a given model or system.

status = oms_setTolerance(const char* cref, double tolerance)
status = oms_setTolerance(const char* cref, double absoluteTolerance, double relativeTolerance)





Default values are 1e-4 for both relative and absolute tolerances.

A tolerance specified for a model is automatically applied to its root system,
i.e. both calls do exactly the same:

oms_setTolerance("model", absoluteTolerance, relativeTolerance);
oms_setTolerance("model.root", absoluteTolerance, relativeTolerance);





Component, e.g. FMUs, pick up the tolerances from there system. That means
it is not possible to define different tolerances for FMUs in the same system
right now.

In a strongly coupled system (oms_system_sc), the relative tolerance is used
for CVODE and the absolute tolerance is used to solve algebraic loops.

In a weakly coupled system (oms_system_wc), both the relative and absolute
tolerances are used for the adaptive step master algorithms and the absolute
tolerance is used to solve algebraic loops.



setUnit

Sets the unit of a given signal.

status = oms_setUnit(cref, value)







setVariableStepSize

Sets the step size parameters for methods with stepsize control.

status = oms_getVariableStepSize(cref, initialStepSize, minimumStepSize, maximumStepSize)







setWorkingDirectory

Set a new working directory.

status = oms_setWorkingDirectory(newWorkingDir)







simulate

Simulates a composite model.

status = oms_simulate(cref)







simulate_realtime

Experimental feature for (soft) real-time simulation.

status = experimental_simulate_realtime(ident)







stepUntil

Simulates a composite model until a given time value.

status = oms_stepUntil(cref, stopTime)







terminate

Terminates a given composite model.

status = oms_terminate(cref)








OMSimulatorPython

This is a shared library that provides a Python interface for the
OMSimulatorLib library.

Installation using pip is recommended:

> pip3 install OMSimulator --upgrade






Examples

from OMSimulator import OMSimulator

oms = OMSimulator()
oms.setTempDirectory("./temp/")
oms.newModel("model")
oms.addSystem("model.root", oms.system_sc)

# instantiate FMUs
oms.addSubModel("model.root.system1", "FMUs/System1.fmu")
oms.addSubModel("model.root.system2", "FMUs/System2.fmu")

# add connections
oms.addConnection("model.root.system1.y", "model.root.system2.u")
oms.addConnection("model.root.system2.y", "model.root.system1.u")

# simulation settings
oms.setResultFile("model", "results.mat")
oms.setStopTime("model", 0.1)
oms.setFixedStepSize("model.root", 1e-4)

oms.instantiate("model")
oms.setReal("model.root.system1.x_start", 2.5)

oms.initialize("model")
oms.simulate("model")
oms.terminate("model")
oms.delete("model")





The python package also provides a more object oriented API. The
following example is equivalent to the previous one:

import OMSimulator as oms

oms.setTempDirectory('./temp/')
model = oms.newModel("model")
root = model.addSystem('root', oms.Types.System.SC)

# instantiate FMUs
root.addSubModel('system1', 'FMUs/System1.fmu')
root.addSubModel('system2', 'FMUs/System2.fmu')

# add connections
root.addConnection('system1.y', 'system2.u')
root.addConnection('system2.y', 'system1.u')

# simulation settings
model.resultFile = 'results.mat'
model.stopTime = 0.1
model.fixedStepSize = 1e-4

model.instantiate()
model.setReal('root.system1.x_start', 2.5)
#or system.setReal('system1.x_start', 2.5)

model.initialize()
model.simulate()
model.terminate()
model.delete()







Python Scripting Commands



activateVariant

This API provides support to activate a multi-variant modelling from an ssp file [(e.g). SystemStructure.ssd, VarA.ssd, VarB.ssd ] from a ssp file.
By default when importing a ssp file the default variant will be "SystemStructure.ssd". The users can be able to switch between other variants by
using this API and make changes to that particular variant and simulate them.

status = oms.activateVariant(crefA, crefB)






An example of activating the number of available variants in a ssp file

oms_newModel("model")
oms_addSystem("model.root", "system_wc")
oms_addSubModel("model.root.A", "A.fmu")
oms_duplicateVariant("model", "varA") // varA will be the current variant
oms_duplicateVariant("varA", "varB") // varB will be the current variant
oms_activateVariant("varB", "varA") // Reactivate the variant varB to varA
oms_activateVariant("varA", "model") // Reactivate the variant varA to model






addBus

Adds a bus to a given component.

status = oms.addBus(cref)







addConnection

Adds a new connection between connectors A and B. The connectors need to be
specified as fully qualified component references, e.g., "model.system.component.signal".

status = oms.addConnection(crefA, crefB, suppressUnitConversion)





The two arguments crefA and crefB get swapped automatically if necessary. The third argument suppressUnitConversion is
optional and the default value is false which allows automatic unit conversion between connections, if set to true then
automatic unit conversion will be disabled.



addConnector

Adds a connector to a given component.

status = oms.addConnector(cref, causality, type)

The second argument "causality", should be any of the following,

oms.input
oms.output
oms.parameter
oms.bidir
oms.undefined

The third argument "type", should be any of the following,

oms.signal_type_real
oms.signal_type_integer
oms.signal_type_boolean
oms.signal_type_string
oms.signal_type_enum
oms.signal_type_bus







addConnectorToBus

Adds a connector to a bus.

status = oms.addConnectorToBus(busCref, connectorCref)







addConnectorToTLMBus

Adds a connector to a TLM bus.

status = oms.addConnectorToTLMBus(busCref, connectorCref, type)







addExternalModel

Adds an external model to a TLM system.

status = oms.addExternalModel(cref, path, startscript)







addResources

Adds an external resources to an existing SSP. The external resources should be a ".ssv" or ".ssm" file

status = oms.addResources(cref, path)

## Example
from OMSimulator import OMSimulator
oms = OMSimulator()
oms.importFile("addExternalResources1.ssp")
## add list of external resources from filesystem to ssp
oms.addResources("addExternalResources", "../../resources/externalRoot.ssv")
oms.addResources("addExternalResources:externalSystem.ssv", "../../resources/externalSystem1.ssv")
oms.addResources("addExternalResources", "../../resources/externalGain.ssv")
## export the ssp with new resources
oms_export("addExternalResources", "addExternalResources1.ssp")







addSignalsToResults

Add all variables that match the given regex to the result file.

status = oms.addSignalsToResults(cref, regex)





The second argument, i.e. regex, is considered as a regular expression (C++11).
".*" and "(.)*" can be used to hit all variables.



addSubModel

Adds a component to a system.

status = oms.addSubModel(cref, fmuPath)







addSystem

Adds a (sub-)system to a model or system.

status = oms.addSystem(cref, type)







addTLMBus

Adds a TLM bus.

status = oms.addTLMBus(cref, domain, dimensions, interpolation)

The second argument "domain", should be any of the following,

oms.tlm_domain_input
oms.tlm_domain_output
oms.tlm_domain_mechanical
oms.tlm_domain_rotational
oms.tlm_domain_hydraulic
oms.tlm_domain_electric

The fourth argument "interpolation", should be any of the following,

oms.default
oms.coarsegrained
oms.finegrained







addTLMConnection

Connects two TLM connectors.

status = oms.addTLMConnection(crefA, crefB, delay, alpha, linearimpedance, angularimpedance)







compareSimulationResults

This function compares a given signal of two result files within absolute and
relative tolerances.

oms.compareSimulationResults(filenameA, filenameB, var, relTol, absTol)





The following table describes the input values:








	Input

	Type

	Description





	filenameA

	String

	Name of first result file to compare.



	filenameB

	String

	Name of second result file to compare.



	var

	String

	Name of signal to compare.



	relTol

	Number

	Relative tolerance.



	absTol

	Number

	Absolute tolerance.






The following table describes the return values:







	Type

	Description





	Integer

	1 if the signal is considered as equal, 0 otherwise








copySystem

Copies a system.

status = oms.copySystem(source, target)







delete

Deletes a connector, component, system, or model object.

status = oms.delete(cref)







deleteConnection

Deletes the connection between connectors crefA and crefB.

status = oms.deleteConnection(crefA, crefB)





The two arguments crefA and crefB get swapped automatically if necessary.



deleteConnectorFromBus

Deletes a connector from a given bus.

status = oms.deleteConnectorFromBus(busCref, connectorCref)







deleteConnectorFromTLMBus

Deletes a connector from a given TLM bus.

status = oms.deleteConnectorFromTLMBus(busCref, connectorCref)







deleteResources

Deletes the reference and resource file in a SSP. Deletion of ".ssv" and ".ssm" files are currently supported. The API can be used in two ways.


	deleting only the reference file in ".ssd".


	deleting both reference and resource files in ".ssp".




To delete only the reference file in ssd, the user should provide the full qualified cref of the ".ssv" file associated with a system or subsystem or component (e.g) "model.root:root1.ssv".

To delete both the reference and resource file in ssp, it is enough to provide only the model cref of the ".ssv" file  (e.g) "model:root1.ssv".

When deleting only the references of a ".ssv" file, if a parameter mapping file ".ssm" is binded to a ".ssv" file then the ".ssm" file will also be deleted.
It is not possible to delete the references of ".ssm" seperately as the ssm file is binded to a ssv file.

The filename of the reference or resource file is provided by the users using colon suffix at the end of cref. (e.g) ":root.ssv"

status = oms.deleteResources(cref))

## Example
from OMSimulator import OMSimulator
oms = OMSimulator()
oms.importFile("deleteResources1.ssp")
## delete only the references in ".ssd" file
oms.deleteResources("deleteResources.root:root.ssv")
## delete both references and resources
oms.deleteResources("deleteResources:root.ssv")
oms.export("deleteResources1.ssp")







doStep

Simulates a macro step of the given composite model. The step size
will be determined by the master algorithm and is limited by the
definied minimal and maximal step sizes.

status = oms.doStep(cref)







duplicateVariant

This API provides support to develop a multi-variant modelling in OMSimulator [(e.g). SystemStructure.ssd, VarA.ssd, VarB.ssd ].
When duplicating a variant, the new variant becomes the current variant and all the changes made by the users are applied
to the new variants only, and all the ssv and ssm resources associated with the new variant will be given new name based on the variant name provided by the user.
This allows the bundling of multiple variants of a system structure definition referencing a similar set of packaged resources as a single SSP.
However there must still be one SSD file named SystemStructure.ssd at the root of the ZIP archive which will be considered
as default variant.

status = oms.duplicateVariant(crefA, crefB)





An example of creating a multi-variant modelling is presented below

oms_newModel("model")
oms_addSystem("model.root", "system_wc")
oms_addSubModel("model.root.A", "A.fmu")
oms_setReal("model.root.A.param1", "10")
oms_duplicateVariant("model", "varB")
oms_addSubModel("varB.root.B" ,"B.fmu")
oms_setReal("varB.root.A.param2", "20")
oms_export("varB", "variant.ssp")





The variant.ssp file will have the following structure

Variant.ssp
    SystemStructure.ssd
    varB.ssd
    resources\
        A.fmu
        B.fmu







export

Exports a composite model to a SPP file.

status = oms.export(cref, filename)







exportDependencyGraphs

Export the dependency graphs of a given model to dot files.

status = oms.exportDependencyGraphs(cref, initialization, event, simulation)







exportSSMTemplate

Exports all signals that have start values of one or multiple FMUs to a SSM file that are read from modelDescription.xml with a mapping entry. The mapping entry specifies a single mapping between a parameter in the source and a parameter of the system or component being parameterized.
The mapping entry contains two attributes namely source and target. The source attribute will be empty and needs to be manually mapped by the users associated with the parameter name defined in the SSV file, the target contains the name of parameter in the system or component to be parameterized.
The function can be called for a top level model or a certain FMU component. If called for a top level model, start values of all FMUs are exported to the SSM file. If called for a component, start values of just this FMU are exported to the SSM file.

status = oms.exportSSMTemplate(cref, filename)







exportSSVTemplate

Exports all signals that have start values of one or multiple FMUs to a SSV file that are read from modelDescription.xml. The function can be called for a top level model or a certain FMU component.
If called for a top level model, start values of all FMUs are exported to the SSV file. If called for a component, start values of just this FMU are exported to the SSV file.

status = oms.exportSSVTemplate(cref, filename)







exportSnapshot

Lists the SSD representation of a given model, system, or component.

Memory is allocated for contents. The caller is responsible to free it using
the C-API. The Lua and Python bindings take care of the memory and the caller
doesn't need to call free.

contents, status = oms.exportSnapshot(cref)







faultInjection

Defines a new fault injection block.

status = oms.faultInjection(cref, type, value)











	type

	Description"





	oms_fault_type_bias

	y = y.$original + faultValue



	oms_fault_type_gain

	y = y.$original * faultValue



	oms_fault_type_const

	y = faultValue








freeMemory

Free the memory allocated by some other API. Pass the object for which memory
is allocated.

oms.freeMemory(obj)







getBoolean

Get boolean value of given signal.

value, status = oms.getBoolean(cref)







getDirectionalDerivative

This function computes the directional derivatives of an FMU.

value, status = oms.getDirectionalDerivative(cref)







getFixedStepSize

Gets the fixed step size. Can be used for the communication step size of
co-simulation systems and also for the integrator step size in model exchange
systems.

stepSize, status = oms.getFixedStepSize(cref)







getInteger

Get integer value of given signal.

value, status = oms.getInteger(cref)







getReal

Get real value.

value, status = oms.getReal(cref)







getResultFile

Gets the result filename and buffer size of the given model cref.

filename, bufferSize, status = oms.getResultFile(cref)







getSolver

Gets the selected solver method of the given system.

solver, status = oms.getSolver(cref)







getStartTime

Get the start time from the model.

startTime, status = oms.getStartTime(cref)







getStopTime

Get the stop time from the model.

stopTime, status = oms.getStopTime(cref)







getString

Get string value.

Memory is allocated for value. The caller is responsible to free it
using the C-API. The Lua and Python bindings take care of the memory
and the caller doesn't need to call free.

value, status = oms.getString(cref)







getSubModelPath

Returns the path of a given component.

path, status = oms.getSubModelPath(cref)







getSystemType

Gets the type of the given system.

type, status = oms.getSystemType(cref)







getTime

Get the current simulation time from the model.

time, status = oms.getTime(cref)







getTolerance

Gets the tolerance of a given system or component.

absoluteTolerance, relativeTolerance, status = oms.getTolerance(cref)







getVariableStepSize

Gets the step size parameters.

initialStepSize, minimumStepSize, maximumStepSize, status = oms.getVariableStepSize(cref)







getVersion

Returns the library's version string.

oms = OMSimulator()
oms.getVersion()







importFile

Imports a composite model from a SSP file.

cref, status = oms.importFile(filename)







importSnapshot

Loads a snapshot to restore a previous model state. The model must be
in virgin model state, which means it must not be instantiated.

newCref, status = oms.importSnapshot(cref, snapshot)







initialize

Initializes a composite model.

status = oms.initialize(cref)







instantiate

Instantiates a given composite model.

status = oms.instantiate(cref)







list

Lists the SSD representation of a given model, system, or component.

Memory is allocated for contents. The caller is responsible to free it using
the C-API. The Lua and Python bindings take care of the memory and the caller
doesn't need to call free.

contents, status = oms.list(cref)







listUnconnectedConnectors

Lists all unconnected connectors of a given system.

Memory is allocated for contents. The caller is responsible to free it using
the C-API. The Lua and Python bindings take care of the memory and the caller
doesn't need to call free.

contents, status = oms.listUnconnectedConnectors(cref)







listVariants

This API shows the number of variants available [(e.g). SystemStructure.ssd, VarA.ssd, VarB.ssd ] from a ssp file.

status = oms.listVariants(cref)





An example for finding the number of available variants in a ssp file

oms_newModel("model")
oms_addSystem("model.root", "system_wc")
oms_addSubModel("model.root.A", "A.fmu")
oms_duplicateVariant("model", "varA")
oms_duplicateVariant("varA", "varB")

oms_listVariants("varB")





The API will list the available variants like below

<oms:Variants>
  <oms:variant name="model" />
  <oms:variant name="varB" />
  <oms:variant name="varA" />
</oms:Variants>







loadSnapshot

Loads a snapshot to restore a previous model state. The model must be in virgin model state, which means it must not be instantiated.

newCref, status = oms.loadSnapshot(cref, snapshot)







newModel

Creates a new and yet empty composite model.

status = oms.newModel(cref)







newResources

Adds a new empty resources to the SSP. The resource file is a ".ssv" file where the parameter values set by the users using
"oms_setReal()", "oms_setInteger()" and "oms_setReal()" are writtern to the file. Currently only ".ssv" files can be created.

The filename of the resource file is provided by the users using colon suffix at the end of cref. (e.g) ":root.ssv"

status = oms.newResources(cref)

## Example
from OMSimulator import OMSimulator
oms = OMSimulator()
oms.newModel("newResources")

oms.addSystem("newResources.root", oms_system_wc)
oms.addConnector("newResources.root.Input1", oms.input, oms_signal_type_real)
oms.addConnector("newResources.root.Input2", oms.input, oms_signal_type_real)

## add Top level resources, the filename is provided using the colon suffix ":root.ssv"
oms.newResources("newResources.root:root.ssv")
oms.setReal("newResources.root.Input1", 10)
## export the ssp with new resources
oms.export("newResources", "newResources.ssp")







referenceResources

Switches the references of ".ssv" and ".ssm" in a SSP file. Referencing of ".ssv" and ".ssm" files are currently supported. The API can be used in two ways.


	Referencing only the ".ssv" file.


	Referencing both the ".ssv" along with the ".ssm" file.




This API should be used in combination with "oms_deleteResources".To switch with a new reference, the old reference must be deleted first using "oms_deleteResources" and then reference with new resources.

When deleting only the references of a ".ssv" file, if a parameter mapping file ".ssm" is binded to a ".ssv" file, then the reference of ".ssm" file will also be deleted.
It is not possible to delete the references of ".ssm" seperately as the ssm file is binded to a ssv file. Hence it is not possible to switch the reference of ".ssm" file alone.
So inorder to switch the reference of ".ssm" file, the users need to bind the reference of ".ssm" file along with the ".ssv".

The filename of the reference or resource file is provided by the users using colon suffix at the end of cref (e.g) ":root.ssv",
and the ".ssm" file is optional and is provided by the user as the second argument to the API.

status = oms.referenceResources(cref, ssmFile)

## Example
from OMSimulator import OMSimulator
oms = OMSimulator()
oms.importFile("referenceResources1.ssp")
## delete only the references in ".ssd" file
oms.deleteResources("referenceResources1.root:root.ssv")
## usage-1 switch with new references, only ssv file
oms.referenceResources("referenceResources1.root:Config1.ssv")
## usage-2 switch with new references, both ssv and ssm file
oms.referenceResources("referenceResources1.root:Config1.ssv", "Config1.ssm")







removeSignalsFromResults

Removes all variables that match the given regex to the result file.

status = oms.removeSignalsFromResults(cref, regex)





The second argument, i.e. regex, is considered as a regular expression (C++11).
".*" and "(.)*" can be used to hit all variables.



rename

Renames a model, system, or component.

status = oms.rename(cref, newCref)







replaceSubModel

Replaces an existing fmu component, with a new component provided by the user,
When replacing the fmu checks are made in all ssp concepts like in ssd, ssv and ssm, so that connections and parameter settings
are not lost. It is possible that the namings of inputs and parameters match, but the start values might have been changed,
in such cases new start values will be applied in ssd, ssv and ssm. In case if the Types of inputs and outputs and parameters
differed, then the variables are updated according to the new changes and the connections will be removed with warning messages to user.
In case when replacing a fmu, if the fmu contains parameter mapping associated with the ssv file, then only the ssm file entries
are updated and the start values in the ssv files will not be changed.

status = oms.replaceSubModel(cref, fmuPath)






It is possible to import an partially developed fmu (i.e contains only modeldescription.xml without any binaries) in OMSimulator, and later can be replaced with a fully develped fmu. An example to use the API,
oms_addSubModel("model.root.A", "../resources/replaceA.fmu")
oms_export("model", "test.ssp")
oms_import("test.ssp")
oms_replaceSubModel("model.root.A", "../resources/replaceA_extended.fmu")






reset

Reset the composite model after a simulation run.

The FMUs go into the same state as after instantiation.

status = oms.reset(cref)







setBoolean

Sets the value of a given boolean signal.

status = oms.setBoolean(cref, value)







setCommandLineOption

Sets special flags.

status = oms.setCommandLineOption(cmd)





Available flags:

info:    Usage: OMSimulator [Options] [Lua script] [FMU] [SSP file]
         Options:
           --addParametersToCSV=<arg>      Export parameters to .csv file (true, [false])
           --algLoopSolver=<arg>           Specifies the alg. loop solver method (fixedpoint, [kinsol]) used for algebraic loops spanning over multiple components.
           --clearAllOptions               Reset all flags to default values
           --CVODEMaxErrTestFails=<int>    Maximum number of error test failures for CVODE
           --CVODEMaxNLSFailures=<int>     Maximum number of nonlinear convergence failures for CVODE
           --CVODEMaxNLSIterations=<int>   Maximum number of nonlinear solver iterations for CVODE
           --CVODEMaxSteps=<int>           Maximum number of steps for CVODE
           --CVODEMaxOrder=<int>           Maximum order for CVODE
           --deleteTempFiles=<bool>        Deletes temp files as soon as they are no longer needed ([true], false)
           --directionalDerivatives=<bool>  Specifies whether directional derivatives should be used to calculate the Jacobian for alg. loops or if a numerical approximation should be used instead ([true], false)
           --dumpAlgLoops=<bool>           Dump information for alg loops (true, [false])
           --emitEvents=<bool>             Specifies whether events should be emitted or not ([true], false)
           --fetchAllVars=<arg>            Workaround for certain FMUs that do not update all internal dependencies automatically
           --help [-h]                     Displays the help text
           --ignoreInitialUnknowns=<bool>  Ignore the initial unknowns from the modelDescription.xml (true, [false])
           --inputExtrapolation=<bool>     Enables input extrapolation using derivative information (true, [false])
           --intervals=<int> [-i]          Specifies the number of communication points (arg > 1)
           --logFile=<arg> [-l]            Specifies the logfile (stdout is used if no log file is specified)
           --logLevel=<int>                0 default, 1 debug, 2 debug+trace
           --maxEventIteration=<int>       Specifies the max. number of iterations for handling a single event
           --maxLoopIteration=<int>        Specifies the max. number of iterations for solving algebraic loops between system-level components. Internal algebraic loops of components are not affected.
           --mode=<arg> [-m]               Forces a certain FMI mode iff the FMU provides cs and me (cs, [me])
           --numProcs=<int> [-n]           Specifies the max. number of processors to use (0=auto, 1=default)
           --progressBar=<bool>            Shows a progress bar for the simulation progress in the terminal (true, [false])
           --realTime=<bool>               Experimental feature for (soft) real-time co-simulation (true, [false])
           --resultFile=<arg> [-r]         Specifies the name of the output result file
           --skipCSVHeader=<arg>           Skip exporting the scv delimiter in the header ([true], false), 
           --solver=<arg>                  Specifies the integration method (euler, [cvode])
           --solverStats=<bool>            Adds solver stats to the result file, e.g. step size; not supported for all solvers (true, [false])
           --startTime=<double> [-s]       Specifies the start time
           --stepSize=<arg>                Specifies the step size (<step size> or <init step,min step,max step>)
           --stopTime=<double> [-t]        Specifies the stop time
           --stripRoot=<bool>              Removes the root system prefix from all exported signals (true, [false])
           --suppressPath=<bool>           Supresses path information in info messages; especially useful for testing ([true], false)
           --tempDir=<arg>                 Specifies the temp directory
           --timeout=<int>                 Specifies the maximum allowed time in seconds for running a simulation (0 disables)
           --tolerance=<double>            Specifies the relative tolerance
           --version [-v]                  Displays version information
           --wallTime=<bool>               Add wall time information for to the result file (true, [false])
           --workingDir=<arg>              Specifies the working directory
           --zeroNominal=<bool>            Using this flag, FMUs with invalid nominal values will be accepted and the invalid nominal values will be replaced with 1.0







setFixedStepSize

Sets the fixed step size. Can be used for the communication step size of
co-simulation systems and also for the integrator step size in model exchange
systems.

status = oms.setFixedStepSize(cref, stepSize)







setInteger

Sets the value of a given integer signal.

status = oms.setInteger(cref, value)







setLogFile

Redirects logging output to file or std streams. The warning/error counters are
reset.

filename="" to redirect to std streams and proper filename to redirect to file.

status = oms.setLogFile(filename)







setLoggingInterval

Set the logging interval of the simulation.

status = oms.setLoggingInterval(cref, loggingInterval)







setLoggingLevel

Enables/Disables debug logging (logDebug and logTrace).

0 default, 1 default+debug, 2 default+debug+trace

oms.setLoggingLevel(logLevel)







setMaxLogFileSize

Sets maximum log file size in MB. If the file exceeds this limit, the logging
will continue on stdout.

oms.setMaxLogFileSize(size)







setReal

Sets the value of a given real signal.

status = oms.setReal(cref, value)





This function can be called in different model states:


	Before instantiation: setReal can be used to set start values or to define
initial unknowns (e.g. parameters, states). The values are not
immediately applied to the simulation unit, since it isn't actually
instantiated.


	After instantiation and before initialization: Same as before instantiation,
but the values are applied immediately to the simulation unit.


	After initialization: Can be used to force external inputs, which might cause
discrete changes of continuous signals.






setRealInputDerivative

Sets the first order derivative of a real input signal.

This can only be used for CS-FMU real input signals.

status = oms.setRealInputDerivative(cref, value)







setResultFile

Set the result file of the simulation.

status = oms.setResultFile(cref, filename)
status = oms.setResultFile(cref, filename, bufferSize)





The creation of a result file is omitted if the filename is an empty string.



setSolver

Sets the solver method for the given system.

status = oms.setSolver(cref, solver)












	solver

	Type

	Description





	oms.solver_sc_explicit_euler

	sc-system

	Explicit euler with fixed step size



	oms.solver_sc_cvode

	sc-system

	CVODE with adaptive stepsize



	oms.solver_wc_ma

	wc-system

	default master algorithm with fixed step size



	oms.solver_wc_mav

	wc-system

	master algorithm with adaptive stepsize



	oms.solver_wc_mav2

	wc-system

	master algorithm with adaptive stepsize (double-step)








setStartTime

Set the start time of the simulation.

status = oms.setStartTime(cref, startTime)







setStopTime

Set the stop time of the simulation.

status = oms.setStopTime(cref, stopTime)







setString

Sets the value of a given string signal.

status = oms.setString(cref, value)







setTempDirectory

Set new temp directory.

status = oms.setTempDirectory(newTempDir)







setTolerance

Sets the tolerance for a given model or system.

status = oms.setTolerance(const char* cref, double tolerance)
status = oms.setTolerance(const char* cref, double absoluteTolerance, double relativeTolerance)





Default values are 1e-4 for both relative and absolute tolerances.

A tolerance specified for a model is automatically applied to its root system,
i.e. both calls do exactly the same:

oms_setTolerance("model", absoluteTolerance, relativeTolerance);
oms_setTolerance("model.root", absoluteTolerance, relativeTolerance);





Component, e.g. FMUs, pick up the tolerances from there system. That means
it is not possible to define different tolerances for FMUs in the same system
right now.

In a strongly coupled system (oms_system_sc), the relative tolerance is used
for CVODE and the absolute tolerance is used to solve algebraic loops.

In a weakly coupled system (oms_system_wc), both the relative and absolute
tolerances are used for the adaptive step master algorithms and the absolute
tolerance is used to solve algebraic loops.



setUnit

Sets the unit of a given signal.

status = oms.setUnit(cref, value)







setVariableStepSize

Sets the step size parameters for methods with stepsize control.

status = oms.getVariableStepSize(cref, initialStepSize, minimumStepSize, maximumStepSize)







setWorkingDirectory

Set a new working directory.

status = oms.setWorkingDirectory(newWorkingDir)







simulate

Simulates a composite model.

status = oms.simulate(cref)







stepUntil

Simulates a composite model until a given time value.

status = oms.stepUntil(cref, stopTime)







terminate

Terminates a given composite model.

status = oms.terminate(cref)





This example uses a simple Modelica model and FMI-based batch
simulation to approximate the value of pi.

A Modelica model is used to calculate two uniform distributed
pseudo-random numbers between 0 and 1 based on a seed value and
evaluates if the resulting coordinate is inside the unit circle or
not.

model Circle
  parameter Integer globalSeed = 30020 "global seed to initialize random number generator";
  parameter Integer localSeed = 614657 "local seed to initialize random number generator";
  Real x;
  Real y;
  Boolean inside = x*x + y*y < 1.0;
protected
  Integer state128[4];
algorithm
  when initial() then
    state128 := Modelica.Math.Random.Generators.Xorshift128plus.initialState(localSeed, globalSeed);
    (x, state128) := Modelica.Math.Random.Generators.Xorshift128plus.random(state128);
    (y, state128) := Modelica.Math.Random.Generators.Xorshift128plus.random(state128);
  end when;
  annotation(uses(Modelica(version="4.0.0")));
end Circle;





The model is then exported using the FMI interface and the generated
FMU can then be used to run a million simulations in just a few
seconds.


Listing 4 Batch simulation of the simple Cirlce model with different seed values. All OMSimulator-related comands are highlighted for convenience.

 1import math
 2import matplotlib.pyplot as plt
 3import OMSimulator as oms
 4
 5# redirect logging to file and limit the file size to 65MB
 6oms.setLogFile('pi.log', 65)
 7
 8model = oms.newModel('pi')
 9root = model.addSystem('root', oms.Types.System.SC)
10root.addSubModel('circle', 'Circle.fmu')
11
12model.resultFile = '' # no result file
13model.instantiate()
14
15results = list()
16inside = 0
17
18MIN = 100
19MAX = 1000000
20for i in range(0, MAX+1):
21  if i > 0:
22    model.reset()
23  model.setInteger('root.circle.globalSeed', i)
24  model.initialize()
25  if model.getBoolean("root.circle.inside"):
26    inside = inside + 1
27  if i >= MIN:
28    results.append(4.0*inside/i)
29model.terminate()
30model.delete()
31
32plt.plot([MIN, MAX], [math.pi, math.pi], 'r--', range(MIN, MAX+1), results)
33plt.xscale('log')
34plt.ylabel('Approximation of pi')
35plt.savefig('pi.png')







The following figure shows the approximation of pi in relation to the
number of samples.


[image: _images/pi.png]

Figure 43 Results of the above batch simulation which approximates the value of pi






OpenModelicaScripting

This is a shared library that provides a OpenModelica Scripting interface for the
OMSimulatorLib library.


Examples

loadOMSimulator();
oms_setTempDirectory("./temp/");
oms_newModel("model");
oms_addSystem("model.root", OpenModelica.Scripting.oms_system.oms_system_sc);

// instantiate FMUs
oms_addSubModel("model.root.system1", "FMUs/System1.fmu");
oms_addSubModel("model.root.system2", "FMUs/System2.fmu");

// add connections
oms_addConnection("model.root.system1.y", "model.root.system2.u");
oms_addConnection("model.root.system2.y", "model.root.system1.u");

// simulation settings
oms_setResultFile("model", "results.mat");
oms_setStopTime("model", 0.1);
oms_setFixedStepSize("model.root", 1e-4);

oms_instantiate("model");
oms_setReal("model.root.system1.x_start", 2.5);

oms_initialize("model");
oms_simulate("model");
oms_terminate("model");
oms_delete("model");
unloadOMSimulator();







OpenModelica Scripting Commands



addBus

Adds a bus to a given component.

status := oms_addBus(cref);







addConnection

Adds a new connection between connectors A and B. The connectors need to be
specified as fully qualified component references, e.g., "model.system.component.signal".

status := oms_addConnection(crefA, crefB, suppressUnitConversion);





The two arguments crefA and crefB get swapped automatically if necessary. The third argument suppressUnitConversion is
optional and the default value is false which allows automatic unit conversion between connections, if set to true then
automatic unit conversion will be disabled.



addConnector

Adds a connector to a given component.

status := oms_addConnector(cref, causality, type);

The second argument "causality", should be any of the following,

"OpenModelica.Scripting.oms_causality.oms_causality_input"
"OpenModelica.Scripting.oms_causality.oms_causality_output"
"OpenModelica.Scripting.oms_causality.oms_causality_parameter"
"OpenModelica.Scripting.oms_causality.oms_causality_bidir"
"OpenModelica.Scripting.oms_causality.oms_causality_undefined"

The third argument type, should be any of the following,

"OpenModelica.Scripting.oms_signal_type.oms_signal_type_real"
"OpenModelica.Scripting.oms_signal_type.oms_signal_type_integer"
"OpenModelica.Scripting.oms_signal_type.oms_signal_type_boolean"
"OpenModelica.Scripting.oms_signal_type.oms_signal_type_string"
"OpenModelica.Scripting.oms_signal_type.oms_signal_type_enum"
"OpenModelica.Scripting.oms_signal_type.oms_signal_type_bus"







addConnectorToBus

Adds a connector to a bus.

status := oms_addConnectorToBus(busCref, connectorCref);







addConnectorToTLMBus

Adds a connector to a TLM bus.

status := oms_addConnectorToTLMBus(busCref, connectorCref, type);







addExternalModel

Adds an external model to a TLM system.

status := oms_addExternalModel(cref, path, startscript);







addSignalsToResults

Add all variables that match the given regex to the result file.

status := oms_addSignalsToResults(cref, regex);





The second argument, i.e. regex, is considered as a regular expression (C++11).
".*" and "(.)*" can be used to hit all variables.



addSubModel

Adds a component to a system.

status := oms_addSubModel(cref, fmuPath);







addSystem

Adds a (sub-)system to a model or system.

status := oms_addSystem(cref, type);

The second argument type, should be any of the following,

"OpenModelica.Scripting.oms_system.oms_system_none"
"OpenModelica.Scripting.oms_system.oms_system_tlm"
"OpenModelica.Scripting.oms_system.oms_system_sc"
"OpenModelica.Scripting.oms_system.oms_system_wc"







addTLMBus

Adds a TLM bus.

status := oms_addTLMBus(cref, domain, dimensions, interpolation);

The second argument "domain", should be any of the following,

"OpenModelica.Scripting.oms_tlm_domain.oms_tlm_domain_input"
"OpenModelica.Scripting.oms_tlm_domain.oms_tlm_domain_output"
"OpenModelica.Scripting.oms_tlm_domain.oms_tlm_domain_mechanical"
"OpenModelica.Scripting.oms_tlm_domain.oms_tlm_domain_rotational"
"OpenModelica.Scripting.oms_tlm_domain.oms_tlm_domain_hydraulic"
"OpenModelica.Scripting.oms_tlm_domain.oms_tlm_domain_electric"

The fourth argument "interpolation", should be any of the following,

"OpenModelica.Scripting.oms_tlm_interpolation.oms_tlm_no_interpolation"
"OpenModelica.Scripting.oms_tlm_interpolation.oms_tlm_coarse_grained"
"OpenModelica.Scripting.oms_tlm_interpolation.oms_tlm_fine_grained"







addTLMConnection

Connects two TLM connectors.

status := oms_addTLMConnection(crefA, crefB, delay, alpha, linearimpedance, angularimpedance);







compareSimulationResults

This function compares a given signal of two result files within absolute and
relative tolerances.

status := oms_compareSimulationResults(filenameA, filenameB, var, relTol, absTol);





The following table describes the input values:








	Input

	Type

	Description





	filenameA

	String

	Name of first result file to compare.



	filenameB

	String

	Name of second result file to compare.



	var

	String

	Name of signal to compare.



	relTol

	Number

	Relative tolerance.



	absTol

	Number

	Absolute tolerance.






The following table describes the return values:







	Type

	Description





	Integer

	1 if the signal is considered as equal, 0 otherwise








copySystem

Copies a system.

status := oms_copySystem(source, target);







delete

Deletes a connector, component, system, or model object.

status := oms_delete(cref);







deleteConnection

Deletes the connection between connectors crefA and crefB.

status := oms_deleteConnection(crefA, crefB);





The two arguments crefA and crefB get swapped automatically if necessary.



deleteConnectorFromBus

Deletes a connector from a given bus.

status := oms_deleteConnectorFromBus(busCref, connectorCref);







deleteConnectorFromTLMBus

Deletes a connector from a given TLM bus.

status := oms_deleteConnectorFromTLMBus(busCref, connectorCref);







export

Exports a composite model to a SPP file.

status := oms_export(cref, filename);







exportDependencyGraphs

Export the dependency graphs of a given model to dot files.

status := oms_exportDependencyGraphs(cref, initialization, event, simulation);







exportSnapshot

Lists the SSD representation of a given model, system, or component.

Memory is allocated for contents. The caller is responsible to free it using
the C-API. The Lua and Python bindings take care of the memory and the caller
doesn't need to call free.

(contents, status) := oms_exportSnapshot(cref);







extractFMIKind

Extracts the FMI kind of a given FMU from the file system.

(kind,status) := oms_extractFMIKind(filename);







faultInjection

Defines a new fault injection block.

status := oms_faultInjection(cref, type, value);
The second argument type, can be any of the following described below

"OpenModelica.Scripting.oms_fault_type.oms_fault_type_bias"
"OpenModelica.Scripting.oms_fault_type.oms_fault_type_gain"
"OpenModelica.Scripting.oms_fault_type.oms_fault_type_const"











	type

	Description"





	oms_fault_type_bias

	y = y.$original + faultValue



	oms_fault_type_gain

	y = y.$original * faultValue



	oms_fault_type_const

	y = faultValue








freeMemory

Free the memory allocated by some other API. Pass the object for which memory
is allocated.

This function is not needed for OpenModelicaScripting Interface



getBoolean

Get boolean value of given signal.

(value, status) := oms_getBoolean(cref);







getFixedStepSize

Gets the fixed step size. Can be used for the communication step size of
co-simulation systems and also for the integrator step size in model exchange
systems.

(stepSize, status) := oms_setFixedStepSize(cref);







getInteger

Get integer value of given signal.

(value, status) := oms_getInteger(cref);







getModelState

Gets the model state of the given model cref.

(modelState, status) := oms_getModelState(cref);







getReal

Get real value.

(value, status) := oms_getReal(cref);







getSolver

Gets the selected solver method of the given system.

(solver, status) := oms_getSolver(cref);







getStartTime

Get the start time from the model.

(startTime, status) := oms_getStartTime(cref);







getStopTime

Get the stop time from the model.

(stopTime, status) := oms_getStopTime(cref);







getSubModelPath

Returns the path of a given component.

(path, status) := oms_getSubModelPath(cref);







getSystemType

Gets the type of the given system.

(type, status) := oms_getSystemType(cref);







getTime

Get the current simulation time from the model.

(time, status) := oms_getTime(cref);







getTolerance

Gets the tolerance of a given system or component.

(absoluteTolerance, relativeTolerance, status) := oms_getTolerance(cref);







getVariableStepSize

Gets the step size parameters.

(initialStepSize, minimumStepSize, maximumStepSize, status) := oms_getVariableStepSize(cref);







getVersion

Returns the library's version string.

version := oms_getVersion();







importFile

Imports a composite model from a SSP file.

(cref, status) := oms_importFile(filename);







importSnapshot

Loads a snapshot to restore a previous model state. The model must be
in virgin model state, which means it must not be instantiated.

status := oms_importSnapshot(cref, snapshot);







initialize

Initializes a composite model.

status := oms_initialize(cref);







instantiate

Instantiates a given composite model.

status := oms_instantiate(cref);







list

Lists the SSD representation of a given model, system, or component.

Memory is allocated for contents. The caller is responsible to free it using
the C-API. The Lua and Python bindings take care of the memory and the caller
doesn't need to call free.

(contents, status) := oms_list(cref);







listUnconnectedConnectors

Lists all unconnected connectors of a given system.

Memory is allocated for contents. The caller is responsible to free it using
the C-API. The Lua and Python bindings take care of the memory and the caller
doesn't need to call free.

(contents, status) := oms_listUnconnectedConnectors(cref);







loadSnapshot

Loads a snapshot to restore a previous model state. The model must be in virgin model state, which means it must not be instantiated.

status := oms_loadSnapshot(cref, snapshot);







newModel

Creates a new and yet empty composite model.

status := oms_newModel(cref);







removeSignalsFromResults

Removes all variables that match the given regex to the result file.

status := oms_removeSignalsFromResults(cref, regex);





The second argument, i.e. regex, is considered as a regular expression (C++11).
".*" and "(.)*" can be used to hit all variables.



rename

Renames a model, system, or component.

status := oms_rename(cref, newCref);







reset

Reset the composite model after a simulation run.

The FMUs go into the same state as after instantiation.

status := oms_reset(cref);







setBoolean

Sets the value of a given boolean signal.

status := oms_setBoolean(cref, value);







setCommandLineOption

Sets special flags.

status := oms_setCommandLineOption(cmd);





Available flags:

info:    Usage: OMSimulator [Options] [Lua script] [FMU] [SSP file]
         Options:
           --addParametersToCSV=<arg>      Export parameters to .csv file (true, [false])
           --algLoopSolver=<arg>           Specifies the alg. loop solver method (fixedpoint, [kinsol]) used for algebraic loops spanning over multiple components.
           --clearAllOptions               Reset all flags to default values
           --CVODEMaxErrTestFails=<int>    Maximum number of error test failures for CVODE
           --CVODEMaxNLSFailures=<int>     Maximum number of nonlinear convergence failures for CVODE
           --CVODEMaxNLSIterations=<int>   Maximum number of nonlinear solver iterations for CVODE
           --CVODEMaxSteps=<int>           Maximum number of steps for CVODE
           --CVODEMaxOrder=<int>           Maximum order for CVODE
           --deleteTempFiles=<bool>        Deletes temp files as soon as they are no longer needed ([true], false)
           --directionalDerivatives=<bool>  Specifies whether directional derivatives should be used to calculate the Jacobian for alg. loops or if a numerical approximation should be used instead ([true], false)
           --dumpAlgLoops=<bool>           Dump information for alg loops (true, [false])
           --emitEvents=<bool>             Specifies whether events should be emitted or not ([true], false)
           --fetchAllVars=<arg>            Workaround for certain FMUs that do not update all internal dependencies automatically
           --help [-h]                     Displays the help text
           --ignoreInitialUnknowns=<bool>  Ignore the initial unknowns from the modelDescription.xml (true, [false])
           --inputExtrapolation=<bool>     Enables input extrapolation using derivative information (true, [false])
           --intervals=<int> [-i]          Specifies the number of communication points (arg > 1)
           --logFile=<arg> [-l]            Specifies the logfile (stdout is used if no log file is specified)
           --logLevel=<int>                0 default, 1 debug, 2 debug+trace
           --maxEventIteration=<int>       Specifies the max. number of iterations for handling a single event
           --maxLoopIteration=<int>        Specifies the max. number of iterations for solving algebraic loops between system-level components. Internal algebraic loops of components are not affected.
           --mode=<arg> [-m]               Forces a certain FMI mode iff the FMU provides cs and me (cs, [me])
           --numProcs=<int> [-n]           Specifies the max. number of processors to use (0=auto, 1=default)
           --progressBar=<bool>            Shows a progress bar for the simulation progress in the terminal (true, [false])
           --realTime=<bool>               Experimental feature for (soft) real-time co-simulation (true, [false])
           --resultFile=<arg> [-r]         Specifies the name of the output result file
           --skipCSVHeader=<arg>           Skip exporting the scv delimiter in the header ([true], false), 
           --solver=<arg>                  Specifies the integration method (euler, [cvode])
           --solverStats=<bool>            Adds solver stats to the result file, e.g. step size; not supported for all solvers (true, [false])
           --startTime=<double> [-s]       Specifies the start time
           --stepSize=<arg>                Specifies the step size (<step size> or <init step,min step,max step>)
           --stopTime=<double> [-t]        Specifies the stop time
           --stripRoot=<bool>              Removes the root system prefix from all exported signals (true, [false])
           --suppressPath=<bool>           Supresses path information in info messages; especially useful for testing ([true], false)
           --tempDir=<arg>                 Specifies the temp directory
           --timeout=<int>                 Specifies the maximum allowed time in seconds for running a simulation (0 disables)
           --tolerance=<double>            Specifies the relative tolerance
           --version [-v]                  Displays version information
           --wallTime=<bool>               Add wall time information for to the result file (true, [false])
           --workingDir=<arg>              Specifies the working directory
           --zeroNominal=<bool>            Using this flag, FMUs with invalid nominal values will be accepted and the invalid nominal values will be replaced with 1.0







setFixedStepSize

Sets the fixed step size. Can be used for the communication step size of
co-simulation systems and also for the integrator step size in model exchange
systems.

status := oms_setFixedStepSize(cref, stepSize);







setInteger

Sets the value of a given integer signal.

status := oms_setInteger(cref, value);







setLogFile

Redirects logging output to file or std streams. The warning/error counters are
reset.

filename="" to redirect to std streams and proper filename to redirect to file.

status := oms_setLogFile(filename);







setLoggingInterval

Set the logging interval of the simulation.

status := oms_setLoggingInterval(cref, loggingInterval);







setLoggingLevel

Enables/Disables debug logging (logDebug and logTrace).

0 default, 1 default+debug, 2 default+debug+trace

oms_setLoggingLevel(logLevel);







setReal

Sets the value of a given real signal.

status := oms_setReal(cref, value);





This function can be called in different model states:


	Before instantiation: setReal can be used to set start values or to define
initial unknowns (e.g. parameters, states). The values are not
immediately applied to the simulation unit, since it isn't actually
instantiated.


	After instantiation and before initialization: Same as before instantiation,
but the values are applied immediately to the simulation unit.


	After initialization: Can be used to force external inputs, which might cause
discrete changes of continuous signals.






setRealInputDerivative

Sets the first order derivative of a real input signal.

This can only be used for CS-FMU real input signals.

status := oms_setRealInputDerivative(cref, value);







setResultFile

Set the result file of the simulation.

status := oms_setResultFile(cref, filename);
status := oms_setResultFile(cref, filename, bufferSize);





The creation of a result file is omitted if the filename is an empty string.



setSolver

Sets the solver method for the given system.

status := oms_setSolver(cref, solver);

The second argument "solver" should be any of the following,

"OpenModelica.Scripting.oms_solver.oms_solver_none"
"OpenModelica.Scripting.oms_solver.oms_solver_sc_min"
"OpenModelica.Scripting.oms_solver.oms_solver_sc_explicit_euler"
"OpenModelica.Scripting.oms_solver.oms_solver_sc_cvode"
"OpenModelica.Scripting.oms_solver.oms_solver_sc_max"
"OpenModelica.Scripting.oms_solver.oms_solver_wc_min"
"OpenModelica.Scripting.oms_solver.oms_solver_wc_ma"
"OpenModelica.Scripting.oms_solver.oms_solver_wc_mav"
"OpenModelica.Scripting.oms_solver.oms_solver_wc_assc"
"OpenModelica.Scripting.oms_solver.oms_solver_wc_mav2"
"OpenModelica.Scripting.oms_solver.oms_solver_wc_max"







setStartTime

Set the start time of the simulation.

status := oms_setStartTime(cref, startTime);







setStopTime

Set the stop time of the simulation.

status := oms_setStopTime(cref, stopTime);







setTLMPositionAndOrientation

Sets initial position and orientation for a TLM 3D interface.

status := oms_setTLMPositionAndOrientation(cref, x1, x2, x3, A11, A12, A13, A21, A22, A23, A31, A32, A33);







setTLMSocketData

Sets data for TLM socket communication.

status := oms_setTLMSocketData(cref, address, managerPort, monitorPort);







setTempDirectory

Set new temp directory.

status := oms_setTempDirectory(newTempDir);







setTolerance

Sets the tolerance for a given model or system.

status := oms_setTolerance(const char* cref, double tolerance);
status := oms_setTolerance(const char* cref, double absoluteTolerance, double relativeTolerance);





Default values are 1e-4 for both relative and absolute tolerances.

A tolerance specified for a model is automatically applied to its root system,
i.e. both calls do exactly the same:

oms_setTolerance("model", absoluteTolerance, relativeTolerance);
oms_setTolerance("model.root", absoluteTolerance, relativeTolerance);





Component, e.g. FMUs, pick up the tolerances from there system. That means
it is not possible to define different tolerances for FMUs in the same system
right now.

In a strongly coupled system (oms_system_sc), the relative tolerance is used
for CVODE and the absolute tolerance is used to solve algebraic loops.

In a weakly coupled system (oms_system_wc), both the relative and absolute
tolerances are used for the adaptive step master algorithms and the absolute
tolerance is used to solve algebraic loops.



setVariableStepSize

Sets the step size parameters for methods with stepsize control.

status := oms_getVariableStepSize(cref, initialStepSize, minimumStepSize, maximumStepSize);







setWorkingDirectory

Set a new working directory.

status := oms_setWorkingDirectory(newWorkingDir);







simulate

Simulates a composite model.

status := oms_simulate(cref);







stepUntil

Simulates a composite model until a given time value.

status := oms_stepUntil(cref, stopTime);







terminate

Terminates a given composite model.

status := oms_terminate(cref);








Graphical Modelling

OMSimulator has an optional dependency to OpenModelica in order to
utilize the graphical modelling editor OMEdit. This feature requires
to install the full OpenModelica tool suite, which includes
OMSimulator. The independent stand-alone version doesn't provide any
graphical modelling editor.

Composite models are imported and exported in the System Structure Description (SSD) format,
which is part of the System Structure and Parameterization (SSP) standard.

See also FMI documentation [https://openmodelica.org/doc/OpenModelicaUsersGuide/latest/fmitlm.html]
and SSP documentation [https://ssp-standard.org/].
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Figure 44 OMEdit MainWindow and Browsers.




New SSP Model

A new and empty SSP model can be created from File->New->SSP menu item.
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Figure 45 OMEdit: New SSP Model



That will open a dialog to enter the names of the model and the root
system and to choose the root systems type.


	There are three types available:
	
	TLM - Transmission Line Modeling System


	Weakly Coupled - Connected Co-Simulation FMUs System


	Strongly Coupled - Connected Model-Exchange FMUs System
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Figure 46 OMEdit: New SSP Model Dialog
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Figure 47 OMEdit: Newly created empty root system of SSP model





Add System

When a new model is created a root system is always generated.
If you need to have another system in your root system you can
add it with SSP->Add System.

For example only a weakly coupled system (Co-Simulation) can integrate strongly coupled
system (Model Exchange). Therefore, the weakly coupled system must
be selected from the Libraries Browser and the respective menu item
can be selected:
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Figure 48 OMEdit: Add System



That will pop-up a dialog to enter the names of the new system.
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Figure 49 OMEdit: Add System Dialog





Add SubModel

A sub-model is typically an FMU, but it also can be result file. In
order to import a sub-model, the respective system must be selected
and the action can be selected from the menu bar:
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Figure 50 OMEdit: Add SubModel



The file browser will open to select an FMU (.fmu) or result file
(.csv) as a subsmodel.
Then a dialog opens to choose the name of the new sub-model.
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Figure 51 OMEdit: Add SubModel Dialog




[image: _images/omedit_09.png]

Figure 52 OMEdit: Root system with added FMU.





Simulate

Select the simulate button (symbol with green arrow) or select
Simulation->Simulate from the menu in OMEdit to simulate the
SSP model.



Dual Mass Oscillator Example

The dual mass oscillator example from our testsuite is
a simple example one can recreate using components from the
Modelica Standard Library.
After splitting the model into two models and exporting each
as an Model-Exchange and Co-Simulation FMU.


[image: _images/DualMassOscillator.png]

Figure 53 Dual mass oscillator Modelica model (diagramm view) and FMUs
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Figure 54 OMEdit: Simulate Dual Mass Oscillator SSP model






SSP Support

Composite models are imported and exported in the System Structure Description (SSD) format, which is part of the System Structure and Parameterization (SSP) standard.


Bus Connections

Bus connections are saved as annotations to the SSD file. Bus connectors are only allowed in weakly coupled and strongly coupled systems. Bus connections can exist in any system type. Bus connectors are used to hide SSD connectors and bus connections are used to hide existing SSD connections in the graphical user interface. It is not required that all connectors referenced in a bus are connected. One bus may be connected to multiple other buses, and also to SSD connectors.

The example below contains a root system with two subsystems, WC1 and WC2. Bus connector WC1.bus1 is connected to WC2.bus2. Bus connector WC2.bus2 is also connected to SSD connector WC1.C3.

<?xml version="1.0" encoding="UTF-8"?>
<ssd:SystemStructureDescription name="Test" version="Draft20180219">
  <ssd:System name="Root">
    <ssd:Elements>
      <ssd:System name="WC2">
        <ssd:Connectors>
          <ssd:Connector name="C1" kind="input" type="Real"/>
          <ssd:Connector name="C2" kind="output" type="Real"/>
        </ssd:Connectors>
        <ssd:Annotations>
          <ssc:Annotation type="org.openmodelica">
            <oms:Bus name="bus2">
              <oms:Signals>
                <oms:Signal name="C1"/>
                <oms:Signal name="C2"/>
              </oms:Signals>
            </oms:Bus>
          </ssc:Annotation>
        </ssd:Annotations>
      </ssd:System>
      <ssd:System name="WC1">
        <ssd:Connectors>
          <ssd:Connector name="C1" kind="output" type="Real"/>
          <ssd:Connector name="C2" kind="input" type="Real"/>
          <ssd:Connector name="C3" kind="input" type="Real"/>
        </ssd:Connectors>
        <ssd:Annotations>
          <ssc:Annotation type="org.openmodelica">
            <oms:Bus name="bus1">
              <oms:Signals>
                <oms:Signal name="C1"/>
                <oms:Signal name="C2"/>
              </oms:Signals>
            </oms:Bus>
          </ssc:Annotation>
        </ssd:Annotations>
      </ssd:System>
    </ssd:Elements>
    <ssd:Connections>
      <ssd:Connection startElement="WC2" startConnector="C1"
                      endElement="WC1" endConnector="C1"/>
      <ssd:Connection startElement="WC2" startConnector="C2"
                      endElement="WC1" endConnector="C2"/>
      <ssd:Connection startElement="WC2" startConnector="C2"
                      endElement="WC1" endConnector="C3"/>
    </ssd:Connections>
    <ssd:Annotations>
      <ssc:Annotation type="org.openmodelica">
        <oms:Connections>
          <oms:Connection startElement="WC1" startConnector="bus1"
                          endElement="WC2" endConnector="bus2"/>
          <oms:Connection startElement="WC2" startConnector="bus2"
                          endElement="WC1" endConnector="C3"/>
        </oms:Connections>
      </ssc:Annotation>
    </ssd:Annotations>
  </ssd:System>
</ssd:SystemStructureDescription>







TLM Systems

TLM systems are only allowed on top-level. SSD annotations are used to specify the system type inside the ssd:SimulationInformation tag, as shown in the example below. Attributes ip, managerport and monitorport defines the socket communication, used both to exchange data with external tools and with internal simulation threads.

<?xml version="1.0"?>
<ssd:System name="tlm">
  <ssd:SimulationInformation>
   <ssd:Annotations>
      <ssd:Annotation type="org.openmodelica">
        <oms:TlmMaster ip="127.0.1.1" managerport="11111" monitorport="11121"/>
      </ssd:Annotation>
   </ssd:Annotations>
  </ssd:SimulationInformation>
  <ssd:Elements>
    <ssd:System name="weaklycoupled">
      <ssd:SimulationInformation>
        <ssd:FixedStepMaster description="oms-ma" stepSize="1e-1" />
      </ssd:SimulationInformation>
    </ssd:System>
  </ssd:Elements>
</ssd:System>







TLM Connections

TLM connections are implemented without regular SSD connections. TLM connections are only allowed in TLM systems. TLM connectors are only allowed in weakly coupled or strongly coupled systems. Both connectors and connections are implemented as SSD annotations in the System tag.

The example below shows a TLM system containing two weakly coupled systems, wc1 and wc2. System wc1 contains two TLM connectors, one of type 1D signal and one of type 1D mechanical. System wc2 contains only a 1D signal type connector. The two 1D signal connectors are connected to each other in the TLM top-level system.

<?xml version="1.0"?>
<ssd:System name="tlm">
  <ssd:Elements>
    <ssd:System name="wc2">
      <ssd:Connectors>
        <ssd:Connector name="y" kind="input" type="Real" />
      </ssd:Connectors>
      <ssd:Annotations>
        <ssd:Annotation type="org.openmodelica">
          <oms:Bus name="bus2" type="tlm" domain="signal"
                   dimension="1" interpolation="none">
            <oms:Signals>
              <oms:Signal name="y" tlmType="value" />
            </oms:Signals>
          </oms:Bus>
        </ssd:Annotation>
      </ssd:Annotations>
    </ssd:System>
    <ssd:System name="wc1">
      <ssd:Connectors>
        <ssd:Connector name="y" kind="output" type="Real" />
        <ssd:Connector name="x" kind="output" type="Real" />
        <ssd:Connector name="v" kind="output" type="Real" />
        <ssd:Connector name="f" kind="input" type="Real" />
      </ssd:Connectors>
      <ssd:Annotations>
        <ssd:Annotation type="org.openmodelica">
          <oms:Bus name="bus1" type="tlm" domain="signal"
                   dimension="1" interpolation="none">
            <oms:Signals>
              <oms:Signal name="y" tlmType="value" />
            </oms:Signals>
          </oms:Bus>
          <oms:Bus name="bus2" type="tlm" domain="mechanical"
                   dimension="1" interpolation="none">
            <oms:Signals>
              <oms:Signal name="x" tlmType="state" />
              <oms:Signal name="v" tlmType="flow" />
              <oms:Signal name="f" tlmType="effort" />
            </oms:Signals>
          </oms:Bus>
        </ssd:Annotation>
      </ssd:Annotations>
    </ssd:System>
  </ssd:Elements>
  <ssd:Annotations>
    <ssd:Annotation type="org.openmodelica">
      <oms:Connections>
        <oms:Connection startElement="wc1" startConnector="bus1"
                        endElement="wc2" endConnector="bus2"
                        delay="0.001000" alpha="0.300000"
                        linearimpedance="100.000000"
                        angularimpedance="0.000000" />
      </oms:Connections>
    </ssd:Annotation>
  </ssd:Annotations>
</ssd:System>





Depending on the type of TLM bus connector (dimension, domain and interpolation), connectors need to be assigned to different tlm variable types. Below is the complete list of supported TLM bus types and their respective connectors.

1D signal



	tlmType

	causality





	"value"

	input/output






1D physical (no interpolation)



	tlmType

	causality





	"state"

	output



	"flow"

	output



	"effort"

	input






1D physical (coarse-grained interpolation)



	tlmType

	causality





	"state"

	output



	"flow"

	output



	"wave"

	input



	"impedance"

	input






1D physical (fine-grained interpolation)



	tlmType

	causality





	"state"

	output



	"flow"

	output



	"wave1"

	input



	"wave2"

	input



	"wave3"

	input



	"wave4"

	input



	"wave5"

	input



	"wave6"

	input



	"wave7"

	input



	"wave8"

	input



	"wave9"

	input



	"wave10"

	input



	"time1"

	input



	"time2"

	input



	"time3"

	input



	"time4"

	input



	"time5"

	input



	"time6"

	input



	"time7"

	input



	"time8"

	input



	"time9"

	input



	"time10"

	input



	"impedance"

	input






3D physical (no interpolation)



	tlmType

	causality





	"state1"

	output



	"state2"

	output



	"state3"

	output



	"A11"

	output



	"A12"

	output



	"A13"

	output



	"A21"

	output



	"A22"

	output



	"A23"

	output



	"A31"

	output



	"A32"

	output



	"A33"

	output



	"flow1"

	output



	"flow2"

	output



	"flow3"

	output



	"flow4"

	output



	"flow5"

	output



	"flow6"

	output



	"effort1"

	input



	"effort2"

	input



	"effort3"

	input



	"effort4"

	input



	"effort5"

	input



	"effort6"

	input






3D physical (coarse-grained interpolation)



	tlmType

	causality





	"state1"

	output



	"state2"

	output



	"state3"

	output



	"A11"

	output



	"A12"

	output



	"A13"

	output



	"A21"

	output



	"A22"

	output



	"A23"

	output



	"A31"

	output



	"A32"

	output



	"A33"

	output



	"flow1"

	output



	"flow2"

	output



	"flow3"

	output



	"flow4"

	output



	"flow5"

	output



	"flow6"

	output



	"wave1"

	input



	"wave2"

	input



	"wave3"

	input



	"wave4"

	input



	"wave5"

	input



	"wave6"

	input



	"linearimpedance"

	input



	"angularimpedance"

	input






3D physical (fine-grained interpolation)



	tlmType

	causality





	"state1"

	output



	"state2"

	output



	"state3"

	output



	"A11"

	output



	"A12"

	output



	"A13"

	output



	"A21"

	output



	"A22"

	output



	"A23"

	output



	"A31"

	output



	"A32"

	output



	"A33"

	output



	"flow1"

	output



	"flow2"

	output



	"flow3"

	output



	"flow4"

	output



	"flow5"

	output



	"flow6"

	output



	"wave1_1"

	input



	"wave1_2"

	input



	"wave1_3"

	input



	"wave1_4"

	input



	"wave1_5"

	input



	"wave1_6"

	input



	"wave2_1"

	input



	"wave2_2"

	input



	"wave2_3"

	input



	"wave2_4"

	input



	"wave2_5"

	input



	"wave2_6"

	input



	"wave3_1"

	input



	"wave3_2"

	input



	"wave3_3"

	input



	"wave3_4"

	input



	"wave3_5"

	input



	"wave3_6"

	input



	"wave4_1"

	input



	"wave4_2"

	input



	"wave4_3"

	input



	"wave4_4"

	input



	"wave4_5"

	input



	"wave4_6"

	input



	"wave5_1"

	input



	"wave5_2"

	input



	"wave5_3"

	input



	"wave5_4"

	input



	"wave5_5"

	input



	"wave5_6"

	input



	"wave6_1"

	input



	"wave6_2"

	input



	"wave6_3"

	input



	"wave6_4"

	input



	"wave6_5"

	input



	"wave6_6"

	input



	"wave7_1"

	input



	"wave7_2"

	input



	"wave7_3"

	input



	"wave7_4"

	input



	"wave7_5"

	input



	"wave7_6"

	input



	"wave8_1"

	input



	"wave8_2"

	input



	"wave8_3"

	input



	"wave8_4"

	input



	"wave8_5"

	input



	"wave8_6"

	input



	"wave9_1"

	input



	"wave9_2"

	input



	"wave9_3"

	input



	"wave9_4"

	input



	"wave9_5"

	input



	"wave9_6"

	input



	"wave10_1"

	input



	"wave10_2"

	input



	"wave10_3"

	input



	"wave10_4"

	input



	"wave10_5"

	input



	"wave10_6"

	input



	"time1"

	input



	"time2"

	input



	"time3"

	input



	"time4"

	input



	"time5"

	input



	"time6"

	input



	"time7"

	input



	"time8"

	input



	"time9"

	input



	"time10"

	input



	"linearimpedance"

	input



	"angularimpedance"

	input
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System Identification

System Identification (OMSysIdent) [https://github.com/OpenModelica/OMSysident]
is part of the OpenModelica tool suite, but not bundled together with the main
OpenModelica distribution and thus must be fetched separately from its project site.

OMSysIdent is a module for the parameter estimation for linear and nonlinear
parametric dynamic models (wrapped as FMUs) on top of the OMSimulator API.
It uses the Ceres solver (http://ceres-solver.org/) for the optimization task.
The module provides a Python scripting API as well as an C API.


Note

Notice that this module was previously part of OMSimulator. It has been extracted
out of the OMSimulator project and reorganized as a separate project in September 2020.
As of 2020-10-07 the project is working on Linux but some more efforts are needed
for migrating the Windows build and make the build and usage of the module
more convenient.



Version: a65a0ed [https://github.com/OpenModelica/OMSysIdent/tree/a65a0edc3bdeebb1341fb3af8d3f100a4c86507a]


Examples

There are examples in the testsuite which use the scripting API, as well as
examples which directly use the C API.

Below is a basic example from the testsuite (HelloWorld_cs_Fit.py) which
uses the Python scripting API. It determines the parameters for the following
"hello world" style Modelica model:

model HelloWorld
  parameter Real a = -1;
  parameter Real x_start = 1;
  Real x(start=x_start, fixed=true);
equation
  der(x) = a*x;
end HelloWorld;





The goal is to estimate the value of the coefficent a and the initial value
x_start of the state variable x. Instead of real measurements, the script
simply uses simulation data generated from the HelloWorld examples as
measurement data. The array data_time contains the time instants at which a
sample is taken and the array data_x contains the value of x that
corresponds to the respective time instant.

The estimation parameters are defined by calls to function
simodel.addParameter(..) in which the name of the parameter and a first guess
for the parameter's value is stated.


Listing 5 HelloWorld_cs_Fit.py

from OMSimulator import OMSimulator
from OMSysIdent import OMSysIdent
import numpy as np

oms = OMSimulator()

oms.setLogFile("HelloWorld_cs_Fit_py.log")
oms.setTempDirectory("./HelloWorld_cs_Fit_py/")
oms.newModel("HelloWorld_cs_Fit")
oms.addSystem("HelloWorld_cs_Fit.root", oms.system_wc)
# oms.setTolerance("HelloWorld_cs_Fit.root", 1e-5)

# add FMU
oms.addSubModel("HelloWorld_cs_Fit.root.HelloWorld", "../resources/HelloWorld.fmu")

# create simodel for model
simodel = OMSysIdent("HelloWorld_cs_Fit")
# simodel.describe()

# Data generated from simulating HelloWorld.mo for 1.0s with Euler and 0.1s step size
kNumSeries = 1
kNumObservations = 11
data_time = np.array([0.0, 0.1, 0.2, 0.3, 0.4, 0.5, 0.6, 0.7, 0.8, 0.9, 1])
inputvars = []
measurementvars = ["root.HelloWorld.x"]
data_x = np.array([1, 0.9, 0.8100000000000001, 0.7290000000000001, 0.6561, 0.5904900000000001, 0.5314410000000001, 0.4782969000000001, 0.43046721, 0.387420489, 0.3486784401])

simodel.initialize(kNumSeries, data_time, inputvars, measurementvars)
# simodel.describe()

simodel.addParameter("root.HelloWorld.x_start", 0.5)
simodel.addParameter("root.HelloWorld.a", -0.5)
simodel.addMeasurement(0, "root.HelloWorld.x", data_x)
# simodel.describe()

simodel.setOptions_max_num_iterations(25)
simodel.solve("BriefReport")

status, state = simodel.getState()
# print('status: {0}; state: {1}').format(OMSysIdent.status_str(status), OMSysIdent.omsi_simodelstate_str(state))

status, startvalue1, estimatedvalue1 = simodel.getParameter("root.HelloWorld.a")
status, startvalue2, estimatedvalue2 = simodel.getParameter("root.HelloWorld.x_start")
# print('HelloWorld.a startvalue1: {0}; estimatedvalue1: {1}'.format(startvalue1, estimatedvalue1))
# print('HelloWorld.x_start startvalue2: {0}; estimatedvalue2: {1}'.format(startvalue2, estimatedvalue2))
is_OK1 = estimatedvalue1 > -1.1 and estimatedvalue1 < -0.9
is_OK2 = estimatedvalue2 > 0.9 and estimatedvalue2 < 1.1
print('HelloWorld.a estimation is OK: {0}'.format(is_OK1))
print('HelloWorld.x_start estimation is OK: {0}'.format(is_OK2))

# del simodel
oms.terminate("HelloWorld_cs_Fit")
oms.delete("HelloWorld_cs_Fit")







Running the script generates the following console output:

iter      cost      cost_change  |gradient|   |step|    tr_ratio  tr_radius  ls_iter  iter_time  total_time
 0  4.069192e-01    0.00e+00    2.20e+00   0.00e+00   0.00e+00  1.00e+04        0    7.91e-03    7.93e-03
 1  4.463938e-02    3.62e-01    4.35e-01   9.43e-01   8.91e-01  1.92e+04        1    7.36e-03    1.53e-02
 2  7.231043e-04    4.39e-02    5.16e-02   3.52e-01   9.85e-01  5.75e+04        1    7.26e-03    2.26e-02
 3  1.046555e-07    7.23e-04    4.74e-04   4.40e-02   1.00e+00  1.73e+05        1    7.31e-03    3.00e-02
 4  2.192358e-15    1.05e-07    5.77e-08   6.05e-04   1.00e+00  5.18e+05        1    7.15e-03    3.71e-02
 5  7.377320e-26    2.19e-15    2.05e-13   9.59e-08   1.00e+00  1.55e+06        1    7.42e-03    4.46e-02
Ceres Solver Report: Iterations: 6, Initial cost: 4.069192e-01, Final cost: 7.377320e-26, Termination: CONVERGENCE

=====================================
Total duration for parameter estimation: 44msec.
Result of parameter estimation (check 'Termination' status above whether solver converged):

HelloWorld_cs_Fit.root.HelloWorld.a(start=-0.5, *estimate*=-1)
HelloWorld_cs_Fit.root.HelloWorld.x_start(start=0.5, *estimate*=1)

=====================================
HelloWorld.a estimation is OK: True
HelloWorld.x_start estimation is OK: True
info:    Logging information has been saved to "HelloWorld_cs_Fit_py.log"







Python and C API


addInput

Add input values for external model inputs.

If there are several measurement series, all series need to be conducted
with the same external inputs!


Python


	Args:
	
	var:

	(str) Name of variable..



	values:

	(np.array) Array of input values for respective time instants in simodel.initialize().







	Returns:
	
	status:

	(int) The C-API status code (oms_status_enu_t).









status = simodel.addInput(var, values)







C

oms_status_enu_t omsi_addInput(void* simodel, const char* var, const double* values, size_t nValues);








addMeasurement

Add measurement values for a fitting variable.


Python


	Args:
	
	iSeries:

	(int) Index of measurement series.



	var:

	(str) Name of variable..



	values:

	(np.array) Array of measured values for respective time instants in simodel.initialize().







	Returns:
	
	status:

	(int) The C-API status code (oms_status_enu_t).









status = simodel.addMeasurement(iSeries, var, values)







C

oms_status_enu_t omsi_addMeasurement(void* simodel, size_t iSeries, const char* var, const double* values, size_t nValues);








addParameter

Add parameter that should be estimated.


PYTHON


	Args:
	
	var:

	(str) Name of parameter.



	startvalue:

	(float) Start value of parameter.







	Returns:
	
	status:

	(int) The C-API status code (oms_status_enu_t).









status = simodel.addParameter(var, startvalue)







C

oms_status_enu_t omsi_addParameter(void* simodel, size_t iSeries, const char* var, const double* values, size_t nValues);








describe

Print summary of SysIdent model.


PYTHON

status = simodel.describe()







C

oms_status_enu_t omsi_describe(void* simodel);








freeSysIdentModel

Unloads a model.


PYTHON

Not available in Python. Related external C function called by class destructor.



C

void omsi_freeSysIdentModel(void* simodel);








getParameter

Get parameter that should be estimated.


PYTHON


	Args:
	
	var:

	(str) Name of parameter.







	Returns:
	
	status:

	(int) The C-API status code (oms_status_enu_t).



	startvalue:

	(float) Start value of parameter.



	estimatedvalue:

	(float) Estimated value of parameter.









status, startvalue, estimatedvalue = simodel.getParameter(var)







C

oms_status_enu_t omsi_getParameter(void* simodel, const char* var, double* startvalue, double* estimatedvalue);








getState

Get state of SysIdent model object.


PYTHON


	Returns:
	
	status:

	(int) The C-API status code (oms_status_enu_t).



	state:

	(int) State of SysIdent model (omsi_simodelstate_t).









status, state = simodel.getState()







C

oms_status_enu_t omsi_getState(void* simodel, omsi_simodelstate_t* state);








initialize

This function initializes a given composite model. After this call, the model is in simulation mode.


PYTHON


	Args:
	
	nSeries:

	(int) Number of measurement series.



	time:

	(numpy.array) Array of measurement/input time instants.



	inputvars:

	(list of str) List of names of input variables (empty list if none).



	measurementvars:

	(list of str) List of names of observed measurement variables.







	Returns:
	
	status:

	(int) The C-API status code (oms_status_enu_t).









status = simodel.initalize(nSeries, time, inputvars, measurementvars)







C

oms_status_enu_t omsi_initialize(void* simodel, size_t nSeries, const double* time, size_t nTime, char const* const* inputvars, size_t nInputvars, char const* const* measurementvars, size_t nMeasurementvars);








newSysIdentModel

Creates an empty model for parameter estimation.


PYTHON

The corresponding Python function is the class constructor.


	Args:
	
	ident:

	(str) Name of the model instance.







	Returns:
	
	simodel:

	SysIdent model instance.









simodel = OMSysIdent(ident)







C

void* omsi_newSysIdentModel(const char* ident);








oms_status_str

Mapping of enum C-API status code (oms_status_enu_t) to string.

The C enum is reproduced below for convenience.

typedef enum {
  oms_status_ok,
  oms_status_warning,
  oms_status_discard,
  oms_status_error,
  oms_status_fatal,
  oms_status_pending
} oms_status_enu_t;






PYTHON


	Args:
	
	status:

	(int) The C-API status code.







	Returns:
	
	status_str:

	(str) String representation of status code.









The range of values of status corresponds to the C enum (by implicit conversion).
This is a static Python method (@staticmethod).

status_str = oms_status_str(status)







C

Not available.




omsi_simodelstate_str

Mapping of enum C-API state code (omsi_simodelstate_t) to string.

The C enum is reproduced below for convenience.

typedef enum {
  omsi_simodelstate_constructed,    //!< After omsi_newSysIdentModel
  omsi_simodelstate_initialized,    //!< After omsi_initialize
  omsi_simodelstate_convergence,    //!< After omsi_solve if Ceres minimizer returned with ceres::TerminationType::CONVERGENCE
  omsi_simodelstate_no_convergence, //!< After omsi_solve if Ceres minimizer returned with ceres::TerminationType::NO_CONVERGENCE
  omsi_simodelstate_failure         //!< After omsi_solve if Ceres minimizer returned with ceres::TerminationType::FAILURE
} omsi_simodelstate_t;






PYTHON


	Args:
	
	state:

	(int) State of SysIdent model.







	Returns:
	
	simodelstate_str:

	(str) String representation of state code.









The range of values of state corresponds to the C enum (by implicit conversion).
This is a static Python method (@staticmethod).

simodelstate_str = omsi_simodelstate_str(state)







C

Not available.




setOptions_max_num_iterations

Set Ceres solver option Solver::Options::max_num_iterations.


PYTHON


	Args:
	
	max_num_iterations:

	(int) Maximum number of iterations for which the solver should run (default: 25).







	Returns:
	
	status:

	(int) The C-API status code (oms_status_enu_t).









status = simodel.setOptions_max_num_iterations(max_num_iterations)







C

oms_status_enu_t omsi_setOptions_max_num_iterations(void* simodel, size_t max_num_iterations);








solve

Solve parameter estimation problem.


PYTHON


	Args:
	
	reporttype:

	(str) Print report and progress information after call to Ceres solver.
Supported report types: "", "BriefReport", "FullReport", where "" denotes no output.







	Returns:
	
	status:

	(int) The C-API status code (oms_status_enu_t).









status = simodel.solve(reporttype)







C

oms_status_enu_t omsi_solve(void* simodel, const char* reporttype);
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OpenModelica Encryption

The encryption module allows the library developers to encrypt their libraries
for different platforms. Note that you need a special version of OpenModelica
with encryption support to do that, which is only released in binary form. This
version contains an OpenModelica-specific private key that is used internally
to decrypt the encrypted libraries for code generation only, not for display
purposes.

If you are a library developer and are interested in distributing your library
in encrypted form for use with OpenModelica, please contact us for further
information. Please note that distributing the special version of OpenModelica
with encryption support to the users of your library requires you to be a Level
2 member of the Open Source Modelica Consortium.

If you are a user of an encrypted library that is supported by OpenModelica,
please contact your library supplier for information on how to get the special
version of OpenModelica that runs it.


Encrypting the Library

In order to encrypt the Modelica package call buildEncryptedPackage(TopLevelPackageName)
from mos script or from OMEdit right click the package in Libraries Browser and
select Export Encrypted Package or select Export > Export Encrypted Package
from the menu.

All the Modelica files are encrypted and the whole library is zipped into a
single file i.e., PackageName.mol. Note that you can only encrypt Modelica
packages saved in a folder structure. The complete folder structure remains
as it is. No encryption is done on the resource files.



Loading an Encrypted Library

To load the encrypted package call loadEncryptedPackage(EncryptedPackage.mol)
from the mos script or from OMEdit File > Load Encrypted Package.



Notes


	Encryption support in OpenModelica does not include any license management,
i.e., restricting the usage of a certain libraries based on some conditions,
e.g., having paid a fee. It is only meant to prevent end users from seeing
the Modelica source code of the encrypted parts of the libraries, for reasons
of confidentiality or IP protection.


	The parts of the library that are protected by encryption are specified
by the access control annotations defined by the Modelica Language Specification,
Section 18.9 [https://specification.modelica.org/maint/3.6/annotations.html#access-control-to-protect-intellectual-property].


	The generated C code corresponding to the encrypted parts of the library is
obfuscated: all comments are removed, and all component names are replaced by
generic names such as n1, n2, n3, etc. This prevents easy reverse-engineering
of the encrypted library starting from generated simulation code.


	Encryption in OpenModelica is based on the
SEMLA (Standardized Encryption of Modelica Libraries and Artifacts) [https://github.com/modelon-community/SEMLA]
module from Modelon AB, which provides a tool-independent framework for Modelica
library encryption.
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OMNotebook with DrModelica and DrControl

This chapter covers the OpenModelica electronic notebook subsystem,
called OMNotebook, together with the DrModelica tutoring system for
teaching Modelica, and DrControl for teaching control together with
Modelica. Both are using such notebooks.


Interactive Notebooks with Literate Programming

Interactive Electronic Notebooks are active documents that may contain
technical computations and text, as well as graphics. Hence, these
documents are suitable to be used for teaching and experimentation,
simulation scripting, model documentation and storage, etc.


Mathematica Notebooks

Literate Programming [Knu84] is a form of
programming where programs are integrated with documentation in the same
document. Mathematica notebooks [Wol96] is one of the first
WYSIWYG systems that support Literate
Programming. Such notebooks are used, e.g., in the MathModelica modeling
and simulation environment, see e.g. Figure 55 below
and Chapter 19 in [Fri04].



OMNotebook

The OMNotebook software [Axe05, Fernstrom06]
is a new open source free software that gives an
interactive WYSIWYG realization of
Literate Programming, a form of programming where programs are
integrated with documentation in the same document.

The OMNotebook facility is actually an interactive WYSIWYG
realization of Literate Programming, a form of programming where programs are
integrated with documentation in the same document.
OMNotebook is a simple open-source software tool for an electronic notebook supporting Modelica.

A more advanced electronic notebook tool, also supporting mathematical
typesetting and many other facilities, is provided by Mathematica
notebooks in the MathModelica environment, see Figure 55.


[image: _images/mathematica-notebooks.svg]
Figure 55 Examples of Mathematica notebooks in the MathModelica modeling and
simulation environment.



Traditional documents, e.g. books and reports, essentially always have a
hierarchical structure. They are divided into sections, subsections,
paragraphs, etc. Both the document itself and its sections usually have
headings as labels for easier navigation. This kind of structure is also
reflected in electronic notebooks. Every notebook corresponds to one
document (one file) and contains a tree structure of cells. A cell can
have different kinds of contents, and can even contain other cells. The
notebook hierarchy of cells thus reflects the hierarchy of sections and
subsections in a traditional document such as a book.




DrModelica Tutoring System - an Application of OMNotebook

Understanding programs is hard, especially code written by someone else.
For educational purposes it is essential to be able to show the source
code and to give an explanation of it at the same time.

Moreover, it is important to show the result of the source code's
execution. In modeling and simulation it is also important to have the
source code, the documentation about the source code, the execution
results of the simulation model, and the documentation of the simulation
results in the same document. The reason is that the problem solving
process in computational simulation is an iterative process that often
requires a modification of the original mathematical model and its
software implementation after the interpretation and validation of the
computed results corresponding to an initial model.

Most of the environments associated with equation-based modeling
languages focus more on providing efficient numerical algorithms rather
than giving attention to the aspects that should facilitate the learning
and teaching of the language. There is a need for an environment
facilitating the learning and understanding of Modelica. These are the
reasons for developing the DrModelica teaching material for Modelica and
for teaching modeling and simulation.

An earlier version of DrModelica was developed using the MathModelica
(now Wolfram SystemModeler) environment. The rest of this chapter is
concerned with the OMNotebook version of DrModelica and on the
OMNotebook tool itself.

DrModelica has a hierarchical structure represented as notebooks. The
front-page notebook is similar to a table of contents that holds all
other notebooks together by providing links to them. This particular
notebook is the first page the user will see (Figure 56).


[image: _images/omnotebook-drmodelica.png]

Figure 56 The front-page notebook of the OMNotebook version of the DrModelica
tutoring system.



In each chapter of DrModelica the user is presented a short summary of
the corresponding chapter of the Modelica book [Fri04]. The
summary introduces some keywords, being hyperlinks that will lead the
user to other notebooks describing the keywords in detail.


[image: _images/omnotebook-helloworld.png]

Figure 57 The HelloWorld class simulated and plotted using the OMNotebook version of DrModelica.



Now, let us consider that the link “HelloWorld” in DrModelica
Section is clicked by the user. The new HelloWorld notebook (see Figure 57),
to which the user is being linked, is not only a textual
description but also contains one or more examples explaining the
specific keyword. In this class, HelloWorld, a differential equation is
specified.

No information in a notebook is fixed, which implies that the user can
add, change, or remove anything in a notebook. Alternatively, the user
can create an entirely new notebook in order to write his/her own
programs or copy examples from other notebooks. This new notebook can be
linked from existing notebooks.


[image: _images/omnotebook-drmodelica-ch9.png]

Figure 58 DrModelica Chapter on Algorithms and Functions in the main page of the
OMNotebook version of DrModelica.



When a class has been successfully evaluated the user can simulate and
plot the result, as previously depicted in Figure 57 for the simple
HelloWorld example model.

After reading a chapter in DrModelica the user can immediately practice
the newly acquired information by doing the exercises that concern the
specific chapter. Exercises have been written in order to elucidate
language constructs step by step based on the pedagogical assumption
that a student learns better “using the strategy of learning by
doing”. The exercises consist of either theoretical questions or
practical programming assignments. All exercises provide answers in
order to give the user immediate feedback.

Figure 58 shows part of Chapter 9 of the
DrModelica teaching material.
Here the user can read about language constructs, like algorithm sections,
when-statements, and reinit equations, and then practice these constructs
by solving the exercises corresponding to the recently studied section.


[image: _images/omnotebook-drmodelica-ex1.png]

Figure 59 Exercise 1 in Chapter 9 of DrModelica.



Exercise 1 from Chapter 9 is shown in Figure 59.
In this exercise the user has the opportunity to practice different
language constructs and then compare the solution to the answer for the exercise.
Notice that the answer is not visible until the Answer section is expanded.
The answer is shown in Figure 60.


[image: _images/omnotebook-drmodelica-ex1-answer.png]

Figure 60 The answer section to Exercise 1 in Chapter 9 of DrModelica.





DrControl Tutorial for Teaching Control Theory

DrControl is an interactive OMNotebook document aimed at teaching
control theory. It is included in the OpenModelica distribution and
appears under the directory:

>>> getInstallationDirectoryPath() + "/share/omnotebook/drcontrol"
"«OPENMODELICAHOME»/share/omnotebook/drcontrol"





The front-page of DrControl resembles a linked table of content that can
be used as a navigation center. The content list contains topics like:


	Getting started


	The control problem in ordinary life


	Feedback loop


	Mathematical modeling


	Transfer function


	Stability


	Example of controlling a DC-motor


	Feedforward compensation


	State-space form


	State observation


	Closed loop control system.


	Reconstructed system


	Linear quadratic optimization


	Linearization




Each entry in this list leads to a new notebook page where either the
theory is explained with Modelica examples or an exercise with a
solution is provided to illustrate the background theory. Below we show
a few sections of DrControl.


Feedback Loop

One of the basic concepts of control theory is using feedback loops
either for neutralizing the disturbances from the surroundings or a
desire for a smoother output.

In Figure 61, control of a simple car model is illustrated where the
car velocity on a road is controlled, first with an open loop control,
and then compared to a closed loop system with a feedback loop. The car
has a mass m, velocity y, and aerodynamic coefficient α. The θ is the
road slope, which in this case can be regarded as noise.


[image: _images/omnotebook-feedback.png]

Figure 61 Feedback loop.



Lets look at the Modelica model for the open loop controlled car:


[image: m \dot y = u - \alpha y - m g * sin(\theta)]


model noFeedback
  import SI = Modelica.SIunits;
  SI.Velocity y;                              // output signal without noise, theta = 0 -> v(t) = 0
  SI.Velocity yNoise;                         // output signal with noise,    theta <> 0 -> v(t) <> 0
  parameter SI.Mass m = 1500;
  parameter Real alpha = 200;
  parameter SI.Angle theta = 5*3.141592/180;
  parameter SI.Acceleration g = 9.82;
  SI.Force u;
  SI.Velocity r=20;
equation
  m*der(y)=u-alpha*y;                          // signal without noise
  m*der(yNoise)=u-alpha*yNoise-m*g*sin(theta); // with noise
  u = 250*r;
end noFeedback;





By applying a road slope angle different from zero the car velocity is
influenced which can be regarded as noise in this model. The output
signal in Figure 62 is stable but an overshoot can be observed
compared to the reference signal. Naturally the overshoot is not desired
and the student will in the next exercise learn how to get rid of this
undesired behavior of the system.

>>> loadModel(Modelica, {"3.2.3"})
true
>>> simulate(noFeedback, stopTime=100)
record SimulationResult
    resultFile = "«DOCHOME»/noFeedback_res.mat",
    simulationOptions = "startTime = 0.0, stopTime = 100.0, numberOfIntervals = 500, tolerance = 1e-6, method = 'dassl', fileNamePrefix = 'noFeedback', options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = ''",
    messages = "LOG_SUCCESS       | info    | The initialization finished successfully without homotopy method.
LOG_SUCCESS       | info    | The simulation finished successfully.
",
    timeFrontend = 0.21650071199999998,
    timeBackend = 0.002348324,
    timeSimCode = 8.374270000000001e-4,
    timeTemplates = 0.001860361,
    timeCompile = 0.228420543,
    timeSimulation = 0.006149215,
    timeTotal = 0.456199025
end SimulationResult;






Warning

Warning: The initial conditions are not fully specified. For more information set -d=initialization. In OMEdit Tools->Options->Simulation->Show additional information from the initialization process, in OMNotebook call setCommandLineOptions("-d=initialization").






[image: _images/omnotebook-open-loop.svg]
Figure 62 Open loop control example.



The closed car model with a proportional regulator is shown below:


[image: u = K*(r-y)]


model withFeedback
  import SI = Modelica.SIunits;
  SI.Velocity y;                                // output signal with feedback link and without noise, theta = 0 -> v(t) = 0
  SI.Velocity yNoise;                           // output signal with feedback link and noise,    theta <> 0 -> v(t) <> 0
  parameter SI.Mass m = 1500;
  parameter Real alpha = 250;
  parameter SI.Angle theta = 5*3.141592/180;
  parameter SI.Acceleration g = 9.82;
  SI.Force u;
  SI.Force uNoise;
  SI.Velocity r=20;
equation
  m*der(y)=u-alpha*y;
  m*der(yNoise)=uNoise-alpha*yNoise-m*g*sin(theta);
  u = 5000*(r-y);
  uNoise = 5000*(r-yNoise);
end withFeedback;





By using the information about the current level of the output signal
and re-tune the regulator the output quantity can be controlled towards
the reference signal smoothly and without an overshoot, as shown in
Figure 63.

In the above simple example the flat modeling approach was adopted since
it was the fastest one to quickly obtain a working model. However, one
could use the object oriented approach and encapsulate the car and
regulator models in separate classes with the Modelica connector
mechanism in between.

>>> loadModel(Modelica, {"3.2.3"})
true
>>> simulate(withFeedback, stopTime=10)
record SimulationResult
    resultFile = "«DOCHOME»/withFeedback_res.mat",
    simulationOptions = "startTime = 0.0, stopTime = 10.0, numberOfIntervals = 500, tolerance = 1e-6, method = 'dassl', fileNamePrefix = 'withFeedback', options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = ''",
    messages = "LOG_SUCCESS       | info    | The initialization finished successfully without homotopy method.
LOG_SUCCESS       | info    | The simulation finished successfully.
",
    timeFrontend = 0.158781565,
    timeBackend = 0.001591788,
    timeSimCode = 4.7200300000000003e-4,
    timeTemplates = 0.0013008240000000001,
    timeCompile = 0.23021048199999994,
    timeSimulation = 0.006503708,
    timeTotal = 0.398920041
end SimulationResult;






Warning

Warning: The initial conditions are not fully specified. For more information set -d=initialization. In OMEdit Tools->Options->Simulation->Show additional information from the initialization process, in OMNotebook call setCommandLineOptions("-d=initialization").






[image: _images/omnotebook-closed-loop.svg]
Figure 63 Closed loop control example.





Mathematical Modeling with Characteristic Equations

In most systems the relation between the inputs and outputs can be
described by a linear differential equation. Tearing apart the solution
of the differential equation into homogenous and particular parts is an
important technique taught to the students in engineering courses, also
illustrated in Figure 64.


[image: {{\partial ^{n}y}\over{\partial t^n}} + a_1 {{\partial ^{n-1}y}\over{\partial t^{n-1}}} + \ldots + a_n y = b_0 {{\partial ^{m}u} \over {\partial t^m}} + \ldots + b_{m-1} {{\partial u}\over{\partial t}} + b_m u]


Now let us examine a second order system:


[image: \ddot y + a_1 \dot y + a_2 y = 1]


model NegRoots
  Real y;
  Real der_y;
  parameter Real a1 = 3;
  parameter Real a2 = 2;
equation
  der_y = der(y);
  der(der_y) + a1*der_y + a2*y = 1;
end NegRoots;





Choosing different values for a1 and a2 leads to
different behavior as shown in Figure 65 and Figure 66.


[image: _images/omnotebook-mathematical-modeling-with-characteristic-equation.png]

Figure 64 Mathematical modeling with characteristic equation.



In the first example the values of a1 and a2 are
chosen in such way that the characteristic equation has negative real
roots and thereby a stable output response, see Figure 65.

>>> simulate(NegRoots, stopTime=10)
record SimulationResult
    resultFile = "«DOCHOME»/NegRoots_res.mat",
    simulationOptions = "startTime = 0.0, stopTime = 10.0, numberOfIntervals = 500, tolerance = 1e-6, method = 'dassl', fileNamePrefix = 'NegRoots', options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = ''",
    messages = "LOG_SUCCESS       | info    | The initialization finished successfully without homotopy method.
LOG_SUCCESS       | info    | The simulation finished successfully.
",
    timeFrontend = 0.065061374,
    timeBackend = 0.0011932730000000001,
    timeSimCode = 2.92067e-4,
    timeTemplates = 0.001499646,
    timeCompile = 0.223792484,
    timeSimulation = 0.0065700920000000005,
    timeTotal = 0.298476421
end SimulationResult;






Warning

Warning: The initial conditions are not fully specified. For more information set -d=initialization. In OMEdit Tools->Options->Simulation->Show additional information from the initialization process, in OMNotebook call setCommandLineOptions("-d=initialization").






[image: _images/omnotebook-drcontrol-negroots.svg]
Figure 65 Characteristic equation with real negative roots.



The importance of the sign of the roots in the characteristic equation
is illustrated in Figure 65 and
Figure 66, e.g., a stable system
with negative real roots and an unstable system with positive imaginary
roots resulting in oscillations.

model ImgPosRoots
  Real y;
  Real der_y;
  parameter Real a1 = -2;
  parameter Real a2 = 10;
equation
  der_y = der(y);
  der(der_y) + a1*der_y + a2*y = 1;
end ImgPosRoots;





>>> simulate(ImgPosRoots, stopTime=10)
record SimulationResult
    resultFile = "«DOCHOME»/ImgPosRoots_res.mat",
    simulationOptions = "startTime = 0.0, stopTime = 10.0, numberOfIntervals = 500, tolerance = 1e-6, method = 'dassl', fileNamePrefix = 'ImgPosRoots', options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = ''",
    messages = "LOG_SUCCESS       | info    | The initialization finished successfully without homotopy method.
LOG_SUCCESS       | info    | The simulation finished successfully.
",
    timeFrontend = 0.18635642500000002,
    timeBackend = 9.84112e-4,
    timeSimCode = 2.6163900000000003e-4,
    timeTemplates = 0.001446947,
    timeCompile = 0.20111943499999996,
    timeSimulation = 0.006595629,
    timeTotal = 0.39682358799999995
end SimulationResult;






Warning

Warning: The initial conditions are not fully specified. For more information set -d=initialization. In OMEdit Tools->Options->Simulation->Show additional information from the initialization process, in OMNotebook call setCommandLineOptions("-d=initialization").






[image: _images/omnotebook-drcontrol-imgposroots.svg]
Figure 66 Characteristic equation with imaginary roots with positive real part.




[image: _images/omnotebook-step-pulse.png]

Figure 67 Step and pulse (weight function) response.



The theory and application of Kalman filters is also explained in the
interactive course material.


[image: _images/omnotebook-theory-kalman.png]

Figure 68 Theory background about Kalman filter.



In reality noise is present in almost every physical system under study
and therefore the concept of noise is also introduced in the course
material, which is purely Modelica based.


[image: _images/omnotebook-kalman-noisy-feedback.png]

Figure 69 Comparison of a noisy system with feedback link in DrControl.






OpenModelica Notebook Commands

OMNotebook currently supports the commands and concepts that are
described in this section.


Cells

Everything inside an OMNotebook document is made out of cells. A cell
basically contains a chunk of data. That data can be text, images, or
other cells. OMNotebook has four types of cells: headercell, textcell,
inputcell, and groupcell. Cells are ordered in a tree structure, where
one cell can be a parent to one or more additional cells. A tree view is
available close to the right border in the notebook window to display
the relation between the cells.


	
	Textcell - This cell type is used to display ordinary text and
	images. Each textcell has a style that specifies how text is
displayed. The cell´s style can be changed in the menu
Format->Styles, example of different styles are: Text, Title, and
Subtitle. The Textcell type also has support for following links
to other notebook documents.







	
	Inputcell - This cell type has support for syntax highlighting and
	evaluation. It is intended to be used for writing program code,
e.g. Modelica code. Evaluation is done by pressing the key
combination Shift+Return or Shift+Enter. All the text in the cell
is sent to OMC (OpenModelica Compiler/interpreter), where the
text is evaluated and the result is displayed below the
inputcell. By double-clicking on the cell marker in the tree
view, the inputcell can be collapsed causing the result to be
hidden.







	
	Latexcell - This cell type has support for evaluation of latex scripts.
	It is intended to be mainly used for writing mathematical equations and
formulas for advanced documentation in OMNotebook. Each Latexcell supports
a maximum of one page document output.To evaluate this cell, latex must be
installed in your system.The users can copy and paste the latex scripts and
start the evaluation.Evaluation is done by pressing the key
combination Shift+Return or Shift+Enter or the green color eval button
present in the toolbar. The script in the cell is sent to latex compiler, where it
is evaluated and the output is displayed hiding the latex source. By double-clicking
on the cell marker in the tree view,the latex source is displayed for further modification.







	
	Groupcell - This cell type is used to group together other cell. A
	groupcell can be opened or closed. When a groupcell is opened all
the cells inside the groupcell are visible, but when the
groupcell is closed only the first cell inside the groupcell is
visible. The state of the groupcell is changed by the user
double-clicking on the cell marker in the tree view. When the
groupcell is closed the marker is changed and the marker has an
arrow at the bottom.











Cursors

An OMNotebook document contains cells which in turn contain text. Thus,
two kinds of cursors are needed for positioning, text cursor and cell
cursor:


	
	Textcursor - A cursor between characters in a cell, appearing as a
	small vertical line. Position the cursor by clicking on the text
or using the arrow buttons.







	
	Cellcursor - This cursor shows which cell currently has the input
	focus. It consists of two parts. The main cellcursor is basically
just a thin black horizontal line below the cell with input
focus. The cellcursor is positioned by clicking on a cell,
clicking between cells, or using the menu item Cell->Next Cell or
Cell->Previous Cell. The cursor can also be moved with the key
combination Ctrl+Up or Ctrl+Down. The dynamic cellcursor is a
short blinking horizontal line. To make this visible, you must
click once more on the main cellcursor (the long horizontal
line). NOTE: In order to paste cells at the cellcursor, the
dynamic cellcursor must be made active by clicking on the main
cellcursor (the horizontal line).











Selection of Text or Cells

To perform operations on text or cells we often need to select a range
of characters or cells.


	
	Select characters - There are several ways of selecting characters,
	e.g. double-clicking on a word, clicking and dragging the mouse,
or click followed by a shift-click at an adjacent positioin
selects the text between the previous click and the position of
the most recent shift-click.







	
	Select cells - Cells can be selected by clicking on them. Holding
	down Ctrl and clicking on the cell markers in the tree view
allows several cells to be selected, one at a time. Several cells
can be selected at once in the tree view by holding down the
Shift key. Holding down Shift selects all cells between last
selected cell and the cell clicked on. This only works if both
cells belong to the same groupcell.











File Menu

The following file related operations are available in the file menu:


	
	Create a new notebook - A new notebook can be created using the
	menu File->New or the key combination Ctrl+N. A new document
window will then open, with a new document inside.







	
	Open a notebook - To open a notebook use File->Open in the menu or
	the key combination Ctrl+O. Only files of the type .onb or .nb
can be opened. If a file does not follow the OMNotebook format or
the FullForm Mathematica Notebook format, a message box is
displayed telling the user what is wrong. Mathematica Notebooks
must be converted to fullform before they can be opened in
OMNotebook.







	
	Save a notebook - To save a notebook use the menu item File->Save
	or File->Save As. If the notebook has not been saved before the
save as dialog is shown and a filename can be selected.
OMNotebook can only save in xml format and the saved file is not
compatible with Mathematica. Key combination for save is Ctrl+S
and for save as Ctrl+Shift+S. The saved file by default obtains
the file extension .onb.







	
	Print - Printing a document to a printer is done by pressing the
	key combination Ctrl+P or using the menu item File->Print. A
normal print dialog is displayed where the usually properties can
be changed.







	
	Import old document - Old documents, saved with the old version of
	OMNotebook where a different file format was used, can be opened
using the menu item File->Import->Old OMNotebook file. Old
documents have the extension .xml.







	
	Export text - The text inside a document can be exported to a text
	document. The text is exported to this document without almost
any structure saved. The only structure that is saved is the cell
structure. Each paragraph in the text document will contain text
from one cell. To use the export function, use menu item
File->Export->Pure Text.







	
	Close a notebook window - A notebook window can be closed using the
	menu item File->Close or the key combination Ctrl+F4. Any unsaved
changes in the document are lost when the notebook window is
closed.







	
	Quitting OMNotebook - To quit OMNotebook, use menu item File->Quit
	or the key combination Crtl+Q. This closes all notebook windows;
users will have the option of closing OMC also. OMC will not
automatically shutdown because other programs may still use it.
Evaluating the command quit() has the same result as exiting
OMNotebook.











Edit Menu


	
	Editing cell text - Cells have a set of of basic editing functions.
	The key combination for these are: Undo (Ctrl+Z), Redo (Ctrl+Y),
Cut (Ctrl+X), Copy (Ctrl+C) and Paste (Ctrl+V). These functions
can also be accessed from the edit menu; Undo (Edit->Undo), Redo
(Edit->Redo), Cut (Edit->Cut), Copy (Edit->Copy) and Paste
(Edit->Paste). Selection of text is done in the usual way by
double-clicking, triple-clicking (select a paragraph), dragging
the mouse, or using (Ctrl+A) to select all text within the cell.







	
	Cut cell - Cells can be cut from a document with the menu item
	Edit->Cut or the key combination Ctrl+X. The cut function will
always cut cells if cells have been selected in the tree view,
otherwise the cut function cuts text.







	
	Copy cell - Cells can be copied from a document with the menu item
	Edit->Copy or the key combination Ctrl+C. The copy function will
always copy cells if cells have been selected in the tree view,
otherwise the copy function copy text.







	
	Paste cell - To paste copied or cut cells the cell cursor must be
	selected in the location where the cells should be pasted. This
is done by clicking on the cell cursor. Pasteing cells is done
from the menu Edit->Paste or the key combination Ctrl+V. If the
cell cursor is selected the paste function will always paste
cells. OMNotebook share the same application-wide clipboard.
Therefore cells that have been copied from one document can be
pasted into another document. Only pointers to the copied or cut
cells are added to the clipboard, thus the cell that should be
pasted must still exist. Consequently a cell can not be pasted
from a document that has been closed.







	
	Find - Find text string in the current notebook, with the options
	match full word, match cell, search within closed cells. Short
command Ctrl+F.







	
	Replace - Find and replace text string in the current notebook,
	with the options match full word, match cell, search+replace
within closed cells. Short command Ctrl+H.







	
	View expression - Text in a cell is stored internally as a subset
	of HTML code and the menu item Edit->View Expression let the user
switch between viewing the text or the internal HTML
representation. Changes made to the HTML code will affect how the
text is displayed.











Cell Menu


	
	Add textcell - A new textcell is added with the menu item Cell->Add
	Cell (previous cell style) or the key combination Alt+Enter. The
new textcell gets the same style as the previous selected cell
had.







	
	Add inputcell - A new inputcell is added with the menu item
	Cell->Add Inputcell or the key combination Ctrl+Shift+I.







	
	Add latexcell - A new latexcell is added with the menu item
	Cell->Add Latexcell or the key combination Ctrl+Shift+E.







	
	Add groupcell - A new groupcell is inserted with the menu item
	Cell->Groupcell or the key combination Ctrl+Shift+G. The selected
cell will then become the first cell inside the groupcell.







	
	Ungroup groupcell - A groupcell can be ungrouped by selecting it in
	the tree view and using the menu item Cell->Ungroup Groupcell or
by using the key combination Ctrl+Shift+U. Only one groupcell at
a time can be ungrouped.







	
	Split cell - Spliting a cell is done with the menu item Cell->Split
	cell or the key combination Ctrl+Shift+P. The cell is splited at
the position of the text cursor.







	
	Delete cell - The menu item Cell->Delete Cell will delete all cells
	that have been selected in the tree view. If no cell is selected
this action will delete the cell that have been selected by the
cellcursor. This action can also be called with the key
combination Ctrl+Shift+D or the key Del (only works when cells
have been selected in the tree view).







	
	Cellcursor - This cell type is a special type that shows which cell
	that currently has the focus. The cell is basically just a thin
black line. The cellcursor is moved by clicking on a cell or
using the menu item Cell->Next Cell or Cell->Previous Cell. The
cursor can also be moved with the key combination Ctrl+Up or
Ctrl+Down.











Format Menu


	
	Textcell - This cell type is used to display ordinary text and
	images. Each textcell has a style that specifies how text is
displayed. The cells style can be changed in the menu
Format->Styles, examples of different styles are: Text, Title,
and Subtitle. The Textcell type also have support for following
links to other notebook documents.







	
	Text manipulation - There are a number of different text
	manipulations that can be done to change the appearance of the
text. These manipulations include operations like: changing font,
changing color and make text bold, but also operations like:
changing the alignment of the text and the margin inside the
cell. All text manipulations inside a cell can be done on single
letters, words or the entire text. Text settings are found in the
Format menu. The following text manipulations are available in
OMNotebook:









> Font family

> Font face (Plain, Bold, Italic, Underline)

> Font size

> Font stretch

> Font color

> Text horizontal alignment

> Text vertical alignment

> Border thickness

> Margin (outside the border)

> Padding (inside the border)



Insert Menu


	
	Insert image - Images are added to a document with the menu item
	Insert->Image or the key combination Ctrl+Shift+M. After an image
has been selected a dialog appears, where the size of the image
can be chosen. The images actual size is the default value of the
image. OMNotebook stretches the image accordantly to the selected
size. All images are saved in the same file as the rest of the
document.







	
	Insert link - A document can contain links to other OMNotebook file
	or Mathematica notebook and to add a new link a piece of text
must first be selected. The selected text make up the part of the
link that the user can click on. Inserting a link is done from
the menu Insert->Link or with the key combination Ctrl+Shift+L. A
dialog window, much like the one used to open documents, allows
the user to choose the file that the link refers to. All links
are saved in the document with a relative file path so documents
that belong together easily can be moved from one place to
another without the links failing.











Window Menu


	
	Change window - Each opened document has its own document window.
	To switch between those use the Window menu. The window menu
lists all titles of the open documents, in the same order as they
were opened. To switch to another document, simple click on the
title of that document.











Help Menu


	
	About OMNotebook - Accessing the about message box for OMNotebook
	is done from the menu Help->About OMNotebook.







	
	About Qt - To access the message box for Qt, use the menu
	Help->About Qt.







	
	Help Text - Opening the help text (document OMNotebookHelp.onb) for
	OMNotebook can be done in the same way as any OMNotebook document
is opened or with the menu Help->Help Text. The menu item can
also be triggered with the key F1.











Additional Features


	
	Links - By clicking on a link, OMNotebook will open the document
	that is referred to in the link.







	
	Update link - All links are stored with relative file path.
	Therefore OMNotebook has functions that automatically updating
links if a document is resaved in another folder. Every time a
document is saved, OMNotebook checks if the document is saved in
the same folder as last time. If the folder has changed, the
links are updated.







	
	Evaluate whole Notebook - All the cells present in the Notebook can
	be evaluated in one step by pressing the red color evalall button
in the toolbar. The cells are evaluated in the same order as they
are in the Notebook.However the latexcells cannot be evaluated by
this feature.







	
	Evaluate several cells - Several inputcells can be evaluated at
	the same time by selecting them in the treeview and then pressing
the key combination Shift+Enter or Shift+Return. The cells are
evaluated in the same order as they have been selected. If a
groupcell is selected all inputcells in that groupcell are
evaluated, in the order they are located in the groupcell.







	
	Moving and Reordering cells in a Notebook - It is possible to shift cells
	to a new position and change the hierarchical order of the document.This can
be done by clicking the cell and press the Up and Down arrow button in
the tool bar to move either Up or Down. The cells are moved one cell
above or below.It is also possible to move a cell directly to a new
position with one single click by pressing the red color bidirectional
UpDown arrow button in the toolbar. To do this the user has to place
the cell cursor to a position where the selected cells must be moved.
After selecting the cell cursor position, select the cells you want to
shift and press the bidirectional UpDown arrow button. The cells are
shifted in the same order as they are selected.This is especially very
useful when shifting a group cell.







	
	Command completion - Inputcells have command completion support,
	which checks if the user is typing a command (or any keyword
defined in the file commands.xml) and finish the command. If the
user types the first two or three letters in a command, the
command completion function fills in the rest. To use command
completion, press the key combination Ctrl+Space or Shift+Tab.
The first command that matches the letters written will then
appear. Holding down Shift and pressing Tab (alternative holding
down Ctrl and pressing Space) again will display the second
command that matches. Repeated request to use command completion
will loop through all commands that match the letters written.
When a command is displayed by the command completion
functionality any field inside the command that should be edited
by the user is automatically selected. Some commands can have
several of these fields and by pressing the key combination
Ctrl+Tab, the next field will be selected inside the command. >
Active Command completion: Ctrl+Space / Shift+Tab > Next command:
Ctrl+Space / Shift+Tab > Next field in command: Ctrl+Tab'







	
	Generated plot - When plotting a simulation result, OMC uses the
	program Ptplot to create a plot. From Ptplot OMNotebook gets an
image of the plot and automatically adds that image to the output
part of an inputcell. Like all other images in a document, the
plot is saved in the document file when the document is saved.







	
	Stylesheet -OMNotebook follows the style settings defined in
	stylesheet.xml and the correct style is applied to a cell when
the cell is created.







	
	Automatic Chapter Numbering - OMNotebook automatically numbers
	different chapter, subchapter, section and other styles. The user
can specify which styles should have chapter numbers and which
level the style should have. This is done in the stylesheet.xml
file. Every style can have a <chapterLevel> tag that specifies
the chapter level. Level 0 or no tag at all, means that the style
should not have any chapter numbering.







	
	Scrollarea - Scrolling through a document can be done by using the
	mouse wheel. A document can also be scrolled by moving the cell
cursor up or down.







	
	Syntax highlighter - The syntax highlighter runs in a separated
	thread which speeds up the loading of large document that
contains many Modelica code cells. The syntax highlighter only
highlights when letters are added, not when they are removed. The
color settings for the different types of keywords are stored in
the file modelicacolors.xml. Besides defining the text color and
background color of keywords, whether or not the keywords should
be bold or/and italic can be defined.







	
	Change indicator - A star (*) will appear behind the filename in
	the title of notebook window if the document has been changed and
needs saving. When the user closes a document that has some
unsaved change, OMNotebook asks the user if he/she wants to save
the document before closing. If the document never has been saved
before, the save-as dialog appears so that a filename can be
choosen for the new document.







	
	Update menus - All menus are constantly updated so that only menu
	items that are linked to actions that can be performed on the
currently selected cell is enabled. All other menu items will be
disabled. When a textcell is selected the Format menu is updated
so that it indicates the text settings for the text, in the
current cursor position.
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Optimization with OpenModelica

The following facilities for model-based optimization are provided with
OpenModelica:


	Built-in Dynamic Optimization using Annotations using dynamic optimization is the recommended way
of performing dynamic optimization with OpenModelica.


	Dynamic Optimization with OpenModelica and CasADi. Use this if you want to employ the CasADi tool for
dynamic optimization.


	Classical Parameter Sweep Optimization using OMOptim. Use this if you have a
static optimization problem.





Built-in Dynamic Optimization using Annotations

This part of the OM manual is a contribution by Massimo Ceraolo and
Vitalij Ruge.


Foreword

Dynamic optimization using Annotations is the most user-friendly way to
perform Dynamic Optimization(DO) in OpenModelica, since it allows the OMEdit
graphical user interface to be used.

It is also more powerful that the Built-in Dynamic Optimization using
Optimica language extensions, since it allows final constraints.



Formulation limitations and algorithm

We can formulate the optimization problem as follows:


[image: \begin{eqnarray}    \min_{u(t)}{\ \left\lbrack M\left( \mathbf{x}\left( t_{f} \right), \mathbf{u}\left( t_{f} \right),t_{f} \right) + \int_{t_{0}}^{t_{f}}{L\left( \mathbf{x}(t), \mathbf{u}(t),t \right)\text{dt}} \right\rbrack}    &&    \begin{array}[t]{l}       \mbox{optimization purpose} \\       (M \mbox{ \textit{is the Mayer Term}} \\       L \mbox{  \textit{is the Lagrange Term}})    \end{array}    \\    \mathbf{0} = \mathbf{f}\left( \mathbf{x}(t),\dot{\mathbf{x}}(t),\mathbf{u}(t),t \right)    &&    \begin{array}[t]{l}       \mbox{dynamical description} \\       \mbox{of the system}    \end{array}    \\    \mathbf{0} \leq \mathbf{g}\left( \mathbf{x}(t),\mathbf{u}(t),t \right)    &&    \begin{array}[t]{l}       \mbox{path constraints} \\       \mbox{e.g. physical limits of components}    \end{array}    \\    \mathbf{0} = \mathbf{r}_{0}\left( \mathbf{x}\left(t_{0} \right),t_{0} \right)    &&    \mbox{Initial constraint}    \\    \mathbf{0} = \mathbf{r}_{f}(\mathbf{x}\left( t_{f} \right)\mathbf{u}\left( t_{f} \right),t_{f})    &&    \mbox{Final constraint} \end{eqnarray}]


Where u(t) is the vector of input variables, on which DO works
to try to get the desired minimum, and x(t) is the vector of
state variables.

The equations above can be implemented in OpenModelica using the full
power of Modelica language, and therefore there is a good freedom and
flexibility, under the obvious constraint that the system must be
regular enough for the convergence to take place.

However, there are limitations in the possibility operational limits can
be set.

The formulation of operational limits in (3) is general, since it allows
to use non-boxed constrains. Consider for instance a battery. The energy
the battery can deliver is a function of the power we use to charge or
discharge it. Therefore, the actual limit should be described as:


[image: E_{\min}(P) \leq E_{\text{bat}} \leq E_{\max}(P)]


Moreover, (3) is time-variant (the third argument of function g).

The OpenModelica optimization through annotations accepts as path
constraints only time-invariant box constraints, so eq (3) is expressed
in the simpler form:


[image: \mathbf{x}_{\min} \leq \mathbf{x}(t) \leq \mathbf{x}_{\max}]



[image: \mathbf{u}_{\min} \leq \mathbf{u}(t) \leq \mathbf{u}_{\max}]



[image: g_{\min} \leq g(\mathbf{x}(t),\mathbf{u}(t)) \leq g_{\max}]


OpenModelica uses the Radau IIA discretization scheme of order 1 or 5
depending on user input.

Using the first order the Radau IIA is equivalent to implicit Euler and
to compute states, output and cost function only the values at the end
of each interval are evaluated. E.g., if we have StopTime=1 and
Interval=0.25, only values for t=0.25, t=0.5, t=0.75, t=1 will be
considered. Therefore, the resulting value of the control variable at
t=0 may be even totally wrong, since it has no influence on the result.



Syntax

OpenModelica provides specific annotations to allow the optimization
problem to be described, as an alternative to the use of Optimica
language. They are listed and commented below.


	Request for an optimization. We must use two simulation flags and a
command line option. These can conveniently be inserted into the
code, to avoid selecting them manually all the time, as follows:

__OpenModelica_simulationFlags(s = "optimization", optimizerNP="1"),
__OpenModelica_commandLineOptions = "+g=Optimica",





OptimizerNP gives the number of colloction points and can be only 1
or 3. As already said the RadauIIA order is 2*OptimizerNP-1.

The user is recommended to use as a first attempt optimizerNP=1. In
case of questionable results, they can try optimizerNP=3.

For the simulation, it is known that the stability ranges are
different. At the same time, we lose stability with higher order (see [1]).

Note that Optimica command-line option is added even if we do not use
Optimica specific language constructs; this it is required for the
use of optimization-related annotations.



	Select optimization parameters. We must specify StartTime,
StopTime, Interval, and Tolerance. The first two have the same
meaning as in time simulations. Interval not only defines the output
interval (as in time simulations), but has a more specific meaning:
it defines the interval between two successive collocation points.
I.e., optimization is done splitting the whole timespan in sparts
having interval as length. Therefore this value may have a huge
effects on the simulation output. For typical runs, number of
intervals values from 100 to 1000-2000 could be adequate. These
values are obviously set through the experiment annotation, e.g.:

experiment(StartTime = 0, StopTime = 20, Tolerance = 1e-07, Interval = 0.02),





the default tolerance is 1e-6. The user is warned that enlarging this
value may affect the output quality adversely by large amounts (an
example will be provided later). Going up to 1e-8 may be advisable in
some cases.



	Define the variable(s) to be determined by DO.
The variables the DO must determine must have the input attribute.
They can have (with parameter variability) min and max attributes, which are interpreted as boxed path constraints on input.
It is recommended to also define a start value for them, since it is used for initialization (see sect. DO Initialization).
Here's an example:

input Real u1(start=0.5, min=0.0, max = 100/par1);
input Real u2(start=0.5, min=0.0, max = 1.0);







	Indicate the minimisation goal. We can indicate whether we must
just minimise a quantity, or the integral of a quantity (see (1)., as
follows:

Real totalCost = xxx annotation(isMayer = true); //minimize totalCost(tf)
Real specificCost = xxx annotation(isLagrange = true); //minimize integral of specificCost (tf)





Several isMayer and isLagrange goals can be set. The actual goal will
be the sum of all goals (isMayer goals as they are, isLagrange goals
first integrated between t0 and tf).

Obviously, it is possible in Modelica to use just isMayer=true also
for Lagrange terms, integrating the Laplace integrand inside the
model, but the internal numeric treatment will be different.



	Describe the system. This is done in the usual Modelica way. Here
we can exploit the huge power of modelica language and tools to
automatically convert a system described in physical (and possibly
graphical) terms into DAE equations


	Define path constraints. As we said previously, they must be boxed
and time-invariant. They are expressed using annotations as in the
following example (taken from the full example described in the next
section):

Real energyConstr(min = 0, max = energyMax) = storage.energy annotation(isConstraint = true); //timespan constraint on storage energy





Here, we see that the constraints are described through min and max
values.



	Define initial constraints. These are set using the existing
modelica syntax to indicate initial values


	Define final constraints. These are set using a specific
annotation, as in the following example (taken from the full example
described in the next section):

annotation(isFinalConstraint = true);





Some special care must be taken when dealing with final constraints.
We must be sure that OM front-end does not do alias elimination of
the constrained variable, since in that case it could pass on bounds
from final constraints to the merged variable, and these final
constraints would become path constraints. To avoid this potentially
harmful alias elimination we must add to the final constrant an
auxiliary parameter, as follows.

parameter Real p = 1 "Auxiliary parameter for energy final constraint";
Real energyConstr(min = 0, max = energyMax) = storage.energy annotation(isConstraint = true); //timespan constraint on storage energy
Real energyFinConstr(min = energyIni, max = energyIni) = p * storage.energy annotation(isFinalConstraint = true); //final time constraint on storage energy





The auxiliary parameter can also be used for scaling the constrained
variable, so that it is roughly around one, so easing convergence.
This could be done for instance as follows:

parameter Real p = 1e-3 "Auxiliary parameter for energy final constraint";
Real energyConstr(min = 0, max = energyMax) = storage.energy annotation(isConstraint = true); //timespan constraint on storage energy
Real energyFinConstr(min = p*energyIni, max = p*energyIni) = p * storage.energy annotation(isFinalConstraint = true); //final time constraint on storage energy











Preparing the system

To allow DO to operate in good conditions it is very important that the
system has continuous derivatives.

Here we just give two examples:


	In case of a combiTimeTable is used to describe non-linear algebraic
functions, it is highly recommended to use Continuous derivative for
the smoothness parameter


	If we need to use the absolute value of a variable, we have
derivative discontinuity around zero. This can be avoided, with
negligible loss of precision, substituting [image: abs(x)] with [image: sqrt(x^2+\varepsilon)],
where eps is very low in comparison with the values [image: x] usually assumes
during the simulation.


	Carefully consider having in the code asserts that cause simulation to stop. If for instance we have
an assert that stops simulation when a variable gets outside its limiting value, it may happen that
during the optimisation cycle the limit is hit and simulation is stopped, which may not be desirable.
Asserts can still be left in place, adding a boolean variable, e.g.:

parameter Boolean insideDynOpt=true; // "true asks skipping the next assert inside dyn. optimization";
assert(SOC <= SOCmax or insideDynOpt, "\n****\n" + "Battery is fully charged:\n"
+ "State of charge reached maximum limit (=" + String(SOCmax) + ")" + "\n****\n");











Initialization

DO algorithm requires initialization. This is controlled through the simulation flag ipopt_init. This flag
has three options: SIM, CONST, FILE. The preferred option can be selected adding the model the system
annotation __OpenModelica_simulationFlags. For instance, the following example requires optimisation
with SIM` initialisation:


__OpenModelica_simulationFlags(s = "optimization", optimizerNP = "1", ipopt_init= "SIM")








The three options operate as follows:


	SIM (the default). With this option, OM first makes an ordinary simulation; the simulation result is




the initial “point” for the optimization. During this simulation the input is constantly kept at its
value “start”.
* CONST. With this option, the initial "point" for optimization is with all the quantities being
constant, and equal to their "start" values
* FILE. In this case the initial point for optimization is taken from a file, created by a previous
simulation, usually with a non-constant input (otherwise it would be simpler to use SIM).
OpenModelica maps the variables between file and optimization via their name. The syntax is as in
the following example:


__OpenModelica_simulationFlags(ipopt_init="FILE" -iif "simModel_res.mat"),










Example 1: minimum time to destination

This example refers to a car, which is requested to cover the max
possible distance using power from an engine which has a torque
limitation and a power limitation.

The torque limitation is transformed in a maximum force that the wheels
can transfer to the road to pus the car.

This is a very easy dynamic optimization problem, whose solution is the
so-called bang-bang control: accelerate at the maximum possible degree,
then, when half of the road is reached, decelerate with the maximum
possible degree.

The code is very simple and it is as follows:

model BangBang2021 "Model to verify that optimization gives bang-bang optimal control"

   parameter Real m = 1;
   parameter Real p = 1 "needed for final constraints";

   Real a;
   Real v(start = 0);
   Real pos(start = 0);
   Real pow(min = -30, max = 30) = f * v annotation(isConstraint = true);

   input Real f(min = -10, max = 10);

   Real costPos(nominal = 1) = -pos "minimize -pos(tf)" annotation(isMayer=true);

   Real conSpeed(min = 0, max = 0) = p * v " 0<= p*v(tf) <=0" annotation(isFinalConstraint = true);

equation

   der(pos) = v;
   der(v) = a;
   f = m * a;

annotation(experiment(StartTime = 0, StopTime = 1, Tolerance = 1e-07, Interval = 0.01),
__OpenModelica_simulationFlags(s="optimization", optimizerNP="1"),
__OpenModelica_commandLineOptions="+g=Optimica");

end BangBang2021;





The constraint on power is especially worth considering. Above, we
stated that path constraints can be
[image: g_{\min} \leq g(\mathbf{x}(t),\mathbf{u}(t), t) \leq g_{\max}]. Here we have box limits on
pow, which are expressed as limits on g(v,f) = f*v = pow


[image: - 30 \leq v*f = f*v \leq 30]


This usage of constraints allows implementing variable (non-boxed) constraints, which are not allowed
explicitly. Doing this the above code implements through g(.) a variable (so non-boxed) limit on force f.

The results can be expressed in terms of force and power applied to the
vehicle. They are as follows:

[image: image1] [image: image2]

and they are as expected.

In this model we don't use the Modelica capability to automatically
determine the system equations from the graphical description of a
system. In other words, the above general formulation
[image: 0 = f\left( \mathbf{x}(t),\dot{\mathbf{x}}(t),\mathbf{u}(t),t \right)]
is explicitly written as follows:

der(pos) = v;
der(v) = a;





In the following example, we will use this capability extensively.



Example 2: hybrid vehicle minimum consumption

This example refers to the electricity generation of a hybrid vehicle.
These vehicles can choose at any time which amount of the propulsion
power must be taken from a battery and which from the Internal
combustion engine.

In this example the engine can be switched ON and off without penalty,
so the DO can choose both when the ICE must be ON /OFF; and the power it
must deliver when it is ON.

Objective of the control is to minimise the fuel consumption. This must
be done keeping the energy inside the storage at the final time, equal
to the one at t=0 (otherwise it is easy to have zero consumption: just
keep the Internal Combustion Engine OFF all the time!)

For simplicity's sake, the propulsion power, in this simple example is
taken as being a sine wave plus an offset (needed to make the average
positive). When the power is positive the wheels transfer power to the
road, when negative they recover it (storing it into the battery).

To find the optimum, a fuel consumption curve is added, as follows:

[image: _images/image5.png]
The minimum is 210 g/kWh, and occurs when the ICE power is at the 76.8 %
of the nominal power

The system diagram is as follows

[image: _images/image7.png]
The DO algorithm is required to determine the battery power outBatPower
(positive when the battery delivers power) so that to minimise the fuel
consumption toGrams. Block toGperkWh is normalised, so that it can be
used for different engines, adapting the horizontal scale through gain,
and the vertical's through gain1.

This diagram defines the system, whose equations will be automatically
determined by OpenModelica, through model flattening. However, some code
must be manually written to perform DO.

Here the code is as follows:

//*** DO-related rows

input Real outBatPow;

//
Real totalCost = toGrams.y "minimize totalCost(tf)" annotation( isMayer=true);
//

Real energyConstr(min = 0, max = energyMax) = storage.energy annotation(isConstraint = true); //timespan constraint on storage energy

parameter Real fecp = 1 "final energy constraint parameter";

Real energyFinConstr(min = energyIni, max = energyIni) = fecp * storage.energy annotation(isFinalConstraint = true);//final time constraint on storage energy

Real icePowerConstr(min = 0) = itoIcePow.y annotation(isConstraint=true); //timespan constraint on Ice power

//*** End of DO-related rows





A few comments:


	The choice isMayer=true on the objective function totalCost requires
its final value to be actually minimised, not its integral (as would
have been in case of the keyword isLaplace=true)


	We have two different constraints on the storage energy: the storage
energy must all the time be between 0 and the maximum allowed, and at
the end of the simulation must be brought back to its initial value.


	ICE can only deliver power, not absorb; so, we expect all the
(regenerative) braking power and energy to be sent into the storage






Ideal storage

Here we consider the storage to be ideal: the flow of power in and out
causes no losses to occur

In this case the solution of our optimization problem is trivial:


	The Ice must supply the average power requested by the load, and when
it does this it must do it at the optimal point which, as seen above
is when its power is at the 76.8% of its nominal value


	The battery supplies the load power minus ICE power.




Using iceNominalPower=60 kW we get the following output:

[image: _images/image8.png]
We see, as expected that the ICE is switched ON and OFF; and when it is
ON it delivers at its 76.8 % of nominal power, i.e. at 46.1 kW. The
battery delivers the difference, and when the load is negative absorbs
all the power from it. The control is such that the energy at the end of
the transient is the same as the one at t=0.

This result is good and confirms what we expected.


Effects of tolerance

We mentioned that reduction of tolerance may affect the result adversely
by large, especially when the minimum, as in this case is very flat
(since the specific fuel consumption curve used for our example is very
flat).

In the following picture we see the result of the previous section as it
appears when we release tolerance by changing it from 1e-7 to and 1e-6.
Now the result is badly wrong (and the total cost has changed from to
25.6g 29.9g).

[image: _images/image9.png]


More realistic storage

To the DO to be useful, it must obviously go beyond what is exactly
expected. Therefore, we repeat the simulation adding the simulation of
some losses inside the battery. According to scientific literature,
losses here are modelled through the following formula:


[image: L(t) = 0.03{|P}_{\text{batt}}(t)| + 0.04\frac{P_{\text{batt}}^{2}(t)}{P_{batt,nom}}]


Which reflects that they in part are proportional to the absolute value
of battery current, partly to its square. The coefficients are typical
for power electronic converters interfacing a battery.

Inside the code, however, the formula introduced is structurally
different, since it has been transformed to avoid the derivative
discontinuity of the absolute value of a quantity around zero, using a
trick like the one reported in sect. 1.4.

[image: _images/image10.png]
We see that now the optimiser changes the Ice power when in ON state, to
reduce the battery power at its peak, since the losses formula pushes
towards lower powers.



Adding storage power limitation

As a last case for example 2, we ass tome limitation on the power that
can be exchanged by the battery. This can be physically due to
limitations of either the battery or the inverter connected to it.

To show better the effect, we first rise the ICE power to 100 kW, so
that the interval of ICE operation is smaller:

[image: _images/image11.png]
Then we change the following row of code:

input Real outBatPow;





into:

input Real outBatPow(min = -maxBatPower, max = maxBatPower);





where

parameter Modelica.SIunits.Power maxBatPower = 30e3;





giving rise to the following results (with a much longer computation
time than in the previous cases):

[image: _images/image13.png]



Example 3: Acausal vehicle

As a last example, we replicate the optimization of Example 2, but the
power to be delivered directly deriving from simulation of a vehicle,
modelled through its physical elements.

The considered diagram is as follows:

[image: _images/image14.png]
The upper part contains a vehicle model. The model follows a speed
profile defined by the drive cycle driveCyc, through a simple
proportional controller (simulating the driver). The power is applied to
a mass; the drag force dragF sis the force against the movement due to
friction (independent on speed) and air resistance (proportional to the
square of vehicle speed).

The lower part contains the management of the storage, and the
optimization algorithm, already discussed in example 2.

The results are shown in the following picture, where the obtained cost
(red curve) is compared to what obtainable in case the ICE is
continuously kept ON (blue curve), at a power (blue curve) that allows
the battery energy at the end of the simulation to be equal to the one
as t=0, as in the case of the optimised solution.

[image: _images/image15.png]
This example shows that the optimizer can find an ON/OFF strategy that
more than halves the hybrid vehicle fuel consumption.

The following plot shows the ICE power in comparison with total power
needed to cover the given trip profile mass.v. The rest is supplied by
the battery.

[image: _images/image16.png]


[1]
Hairer, Ernst and Wanner, Gerhard, Radau Methods, 2015, pp 1213-1216,
DOI 10.1007/978-3-540-70529-1_139.






Built-in Dynamic Optimization using Optimica language extensions

Note: this is a very short preliminary description which soon will be
considerably improved.

OpenModelica provides builtin dynamic optimization of models by using
the powerful symbolic machinery of the OpenModelica compiler for more
efficient and automatic solution of dynamic optimization problems.

The builtin dynamic optimization allows users to define optimal control
problems (OCP) using the Modelica language for the model and the
optimization language extension called Optimica (currently partially
supported) for the optimization part of the problem. This is used to
solve the underlying dynamic optimization model formulation using
collocation methods, using a single execution instead of multiple
simulations as in the parameter-sweep optimization described in section
Parameter Sweep Optimization using OMOptim.

For more detailed information regarding background and methods, see
[BOR+12, RBB+14]

Before starting the optimization the model should be symbolically
instantiated by the compiler in order to get a single flat system of
equations. The model variables should also be scalarized. The compiler
frontend performs this, including syntax checking, semantics and type
checking, simplification and constant evaluation etc. are applied. Then
the complete flattened model can be used for initialization, simulation
and last but not least for model-based dynamic optimization.

The OpenModelica command optimize(ModelName) from OMShell, OMNotebook or
MDT runs immediately the optimization. The generated result file can be
read in and visualized with OMEdit or within OMNotebook.


An Example

In this section, a simple optimal control problem will be solved. When
formulating the optimization problems, models are expressed in the
Modelica language and optimization specifications. The optimization
language specification allows users to formulate dynamic optimization
problems to be solved by a numerical algorithm. It includes several
constructs including a new specialized class optimization, a constraint
section, startTime, finalTime etc. See the optimal control problem for
batch reactor model below.

Create a new file named BatchReactor.mo and save it in you working
directory. Notice that this model contains both the dynamic system to be
optimized and the optimization specification.

Once we have formulated the undelying optimal control problems, we can
run the optimization by using OMShell, OMNotebook, MDT, OMEdit using
command line terminals similar to the options described below:

>>> setCommandLineOptions("-g=Optimica");






Listing 6 BatchReactor.mo

model BatchReactor
  Real x1(start =1, fixed=true, min=0, max=1);
  Real x2(start =0, fixed=true, min=0, max=1);
  input Real u(min=0, max=5);
equation
  der(x1) = -(u+u^2/2)*x1;
  der(x2) = u*x1;
end BatchReactor;







optimization nmpcBatchReactor(objective=-x2)
  extends BatchReactor;
end nmpcBatchReactor;





>>> optimize(nmpcBatchReactor, numberOfIntervals=16, stopTime=1, tolerance=1e-8)
record SimulationResult
    resultFile = "«DOCHOME»/nmpcBatchReactor_res.mat",
    simulationOptions = "startTime = 0.0, stopTime = 1.0, numberOfIntervals = 16, tolerance = 1e-8, method = 'optimization', fileNamePrefix = 'nmpcBatchReactor', options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = ''",
    messages = "LOG_SUCCESS       | info    | The initialization finished successfully without homotopy method.

Optimizer Variables
========================================================
State[0]:x1(start = 1, nominal = 1, min = 0, max = 1, init = 1)
State[1]:x2(start = 0, nominal = 1, min = 0, max = 1, init = 0)
Input[2]:u(start = 0, nominal = 5, min = 0, max = 5)
--------------------------------------------------------
number of nonlinear constraints: 0
========================================================

******************************************************************************
This program contains Ipopt, a library for large-scale nonlinear optimization.
 Ipopt is released as open source code under the Eclipse Public License (EPL).
         For more information visit https://github.com/coin-or/Ipopt
******************************************************************************

LOG_SUCCESS       | info    | The simulation finished successfully.
",
    timeFrontend = 0.019689237000000002,
    timeBackend = 0.0032297830000000004,
    timeSimCode = 6.585120000000001e-4,
    timeTemplates = 0.002350217,
    timeCompile = 0.21845456700000002,
    timeSimulation = 0.010642391000000001,
    timeTotal = 0.25510361400000003
end SimulationResult;





The control and state trajectories of the optimization results:


[image: _images/nmpc-input.svg]
Figure 70 Optimization results for Batch Reactor model - input variables.




[image: _images/nmpc-states.svg]
Figure 71 Optimization results for Batch Reactor model - state variables.




Table 1 New meanings of the usual simualtion options for Ipopt.

	numberOfIntervals

	
	collocation intervals



	startTime, stopTime

	
	time horizon



	tolerance = 1e-8

	e.g. 1e-8

	solver tolerance



	simflags

	all run/debug options

	












Table 2 New simulation options for Ipopt.

	-lv

	LOG_IPOPT

	console output



	-ipopt_hesse

	CONST,BFGS,NUM

	hessian approximation



	-ipopt_max_iter

	number e.g. 10

	maximal number of iteration for ipopt



	externalInput.csv

	
	input guess









Dynamic Optimization with OpenModelica and CasADi

OpenModelica coupling with CasADi supports dynamic optimization of
models by OpenModelica exporting the optimization problem to CasADi
which performs the optimization. In order to convey the dynamic system
model information between Modelica and CasADi, we use an XML-based model
exchange format for differential-algebraic equations (DAE). OpenModelica
supports export of models written in Modelica and the Optimization
language extension using this XML format, while CasADi supports import
of models represented in this format. This allows users to define
optimal control problems (OCP) using Modelica and Optimization language
specifications, and solve the underlying model formulation using a range
of optimization methods, including direct collocation and direct
multiple shooting.

Before exporting a model to XML, the model should be symbolically
instantiated by the compiler in order to get a single flat system of
equations. The model variables should also be scalarized. The compiler
frontend performs this, including syntax checking, semantics and type
checking, simplification and constant evaluation etc. are applied. Then
the complete flattened model is exported to XML code. The exported XML
document can then be imported to CasADi for model-based dynamic
optimization.

The OpenModelica command translateModelXML(ModelName) from OMShell,
OMNotebook or MDT exports the XML. The export XML command is also
integrated with OMEdit. Select XML > Export XML the XML document is
generated in the current directory of omc. You can use the cd() command
to see the current location. After the command execution is complete you
will see that a file ModelName.xml has been exported.

Assuming that the model is defined in the modelName.mo, the model can
also be exported to an XML code using the following steps from the
terminal window:


	Go to the path where your model file found


	Run command omc -g=Optimica --simCodeTarget=XML Model.mo




In this section, a simple optimal control problem will be solved. When
formulating the optimization problems, models are expressed in the
Modelica language and optimization specifications. The optimization
language specification allows users to formulate dynamic optimization
problems to be solved by a numerical algorithm. It includes several
constructs including a new specialized class optimization, a constraint
section, startTime, finalTime etc. See the optimal control problem for
batch reactor model below.

Create a new file named BatchReactor.mo and save it in you working
directory. Notice that this model contains both the dynamic system to be
optimized and the optimization specification.

>>> list(BatchReactor)
model BatchReactor
  Real x1(start = 1, fixed = true, min = 0, max = 1);
  Real x2(start = 0, fixed = true, min = 0, max = 1);
  input Real u(min = 0, max = 5);
equation
  der(x1) = -(u + u^2/2)*x1;
  der(x2) = u*x1;
end BatchReactor;





One we have formulated the underlying optimal control problems, we can
export the XML by using OMShell, OMNotebook, MDT, OMEdit or command
line terminals which are described in Section xml-import-to-casadi.

To export XML, we set the simulation target to XML:

>>> translateModelXML(BatchReactor)
"«DOCHOME»/BatchReactor.xml"





This will generate an XML file named BatchReactor.xml (Listing 7)
that contains a symbolic representation of the optimal control problem
and can be inspected in a standard XML editor.


Listing 7 BatchReactor.xml

<?xml version="1.0" encoding="UTF-8"?>
<OpenModelicaModelDescription
  xmlns:exp="https://github.com/JModelica/JModelica/tree/master/XML/daeExpressions.xsd"
  xmlns:equ="https://github.com/JModelica/JModelica/tree/master/XML/daeEquations.xsd"
  xmlns:fun="https://github.com/JModelica/JModelica/tree/master/XML/daeFunctions.xsd"
  xmlns:opt="https://github.com/JModelica/JModelica/tree/master/XML/daeOptimization.xsd"
  xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
  fmiVersion="1.0"
  modelName="BatchReactor"
  modelIdentifier="BatchReactor"
  guid="{5a2e6a11-523b-4387-bbaf-b05da0d488ea}"
  generationDateAndTime="2026-03-06T08:29:39"
  variableNamingConvention="structured"
  numberOfContinuousStates="2"
  numberOfEventIndicators="0"
  >
  
  <VendorAnnotations>
    <Tool name="OpenModelica Compiler OMCompiler v1.27.0-dev.202+g0e2053de263"> </Tool>
  </VendorAnnotations>


  <ModelVariables>
    <ScalarVariable name="x1"  valueReference="0" variability="continuous" causality="local" alias="noAlias">
      <Real start="1.0" fixed="true" min="0.0" max="1.0"  />
      <QualifiedName>
        <exp:QualifiedNamePart name="x1"/>
      </QualifiedName>
    <isLinearTimedVariables>
      <TimePoint index="0" isLinear="true"/>
    </isLinearTimedVariables>
      <VariableCategory>state</VariableCategory>
    </ScalarVariable>

    <ScalarVariable name="x2"  valueReference="1" variability="continuous" causality="local" alias="noAlias">
      <Real start="0.0" fixed="true" min="0.0" max="1.0"  />
      <QualifiedName>
        <exp:QualifiedNamePart name="x2"/>
      </QualifiedName>
    <isLinearTimedVariables>
      <TimePoint index="0" isLinear="true"/>
    </isLinearTimedVariables>
      <VariableCategory>state</VariableCategory>
    </ScalarVariable>
    <ScalarVariable name="der(x1)"  valueReference="2" variability="continuous" causality="local" alias="noAlias">
      <Real     />
      <QualifiedName>
        <exp:QualifiedNamePart name="x1"/>
      </QualifiedName>
    <isLinearTimedVariables>
      <TimePoint index="0" isLinear="true"/>
    </isLinearTimedVariables>
      <VariableCategory>derivative</VariableCategory>
    </ScalarVariable>

    <ScalarVariable name="der(x2)"  valueReference="3" variability="continuous" causality="local" alias="noAlias">
      <Real     />
      <QualifiedName>
        <exp:QualifiedNamePart name="x2"/>
      </QualifiedName>
    <isLinearTimedVariables>
      <TimePoint index="0" isLinear="true"/>
    </isLinearTimedVariables>
      <VariableCategory>derivative</VariableCategory>
    </ScalarVariable>
    <ScalarVariable name="u"  valueReference="4" variability="continuous" causality="input" alias="noAlias">
      <Real  min="0.0" max="5.0"  />
      <QualifiedName>
        <exp:QualifiedNamePart name="u"/>
      </QualifiedName>
    <isLinearTimedVariables>
      <TimePoint index="0" isLinear="true"/>
    </isLinearTimedVariables>
      <VariableCategory>algebraic</VariableCategory>
    </ScalarVariable>
  </ModelVariables>

  <equ:BindingEquations>
  </equ:BindingEquations>

  <equ:DynamicEquations>
    <equ:Equation>
      <exp:Sub>
        <exp:Der>
          <exp:Identifier>
            <exp:QualifiedNamePart name="x2"/>
          </exp:Identifier>
        </exp:Der>
        <exp:Mul>
          <exp:Identifier>
            <exp:QualifiedNamePart name="u"/>
          </exp:Identifier>
          <exp:Identifier>
            <exp:QualifiedNamePart name="x1"/>
          </exp:Identifier>
        </exp:Mul>
      </exp:Sub>
    </equ:Equation>
    <equ:Equation>
      <exp:Sub>
        <exp:Der>
          <exp:Identifier>
            <exp:QualifiedNamePart name="x1"/>
          </exp:Identifier>
        </exp:Der>
        <exp:Mul>
          <exp:Sub>
            <exp:Mul>
              <exp:RealLiteral>-0.5</exp:RealLiteral>
              <exp:Pow>
                <exp:Identifier>
                  <exp:QualifiedNamePart name="u"/>
                </exp:Identifier>
                <exp:RealLiteral>2.0</exp:RealLiteral>
              </exp:Pow>
            </exp:Mul>
            <exp:Identifier>
              <exp:QualifiedNamePart name="u"/>
            </exp:Identifier>
          </exp:Sub>
          <exp:Identifier>
            <exp:QualifiedNamePart name="x1"/>
          </exp:Identifier>
        </exp:Mul>
      </exp:Sub>
    </equ:Equation>
  </equ:DynamicEquations>

  <equ:InitialEquations>
    <equ:Equation>
      <exp:Sub>
        <exp:Identifier>
          <exp:QualifiedNamePart name="x1"/>
        </exp:Identifier>
        <exp:RealLiteral>1.0</exp:RealLiteral>
      </exp:Sub>
    </equ:Equation>

    <equ:Equation>
      <exp:Sub>
        <exp:Identifier>
          <exp:QualifiedNamePart name="x2"/>
        </exp:Identifier>
        <exp:RealLiteral>0.0</exp:RealLiteral>
      </exp:Sub>
    </equ:Equation>
    <equ:Equation>
      <exp:Sub>
        <exp:Identifier>
          <exp:QualifiedNamePart name="x1"/>
        </exp:Identifier>
        <exp:Identifier>
          <exp:QualifiedNamePart name="$START"/>
          <exp:QualifiedNamePart name="x1"/>
        </exp:Identifier>
      </exp:Sub>
    </equ:Equation>
    <equ:Equation>
      <exp:Sub>
         
      </exp:Sub>
    </equ:Equation>
    <equ:Equation>
      <exp:Sub>
         
      </exp:Sub>
    </equ:Equation>
    <equ:Equation>
      <exp:Sub>
        <exp:Identifier>
          <exp:QualifiedNamePart name="x2"/>
        </exp:Identifier>
        <exp:Identifier>
          <exp:QualifiedNamePart name="$START"/>
          <exp:QualifiedNamePart name="x2"/>
        </exp:Identifier>
      </exp:Sub>
    </equ:Equation>
  </equ:InitialEquations>

  <fun:Algorithm>
  </fun:Algorithm>

  <fun:RecordsList>
  </fun:RecordsList>

  <fun:FunctionsList>
  </fun:FunctionsList>

  <opt:Optimization>
    <opt:TimePoints>
      <opt:TimePoint  >
      </opt:TimePoint>
    </opt:TimePoints>
    <opt:PathConstraints>
    </opt:PathConstraints>
  </opt:Optimization>

</OpenModelicaModelDescription>







The symbolic optimal control problem representation (or just model
description) contained in BatchReactor.xml can be imported into CasADi
in the form of the SymbolicOCP class via OpenModelica python script.

The SymbolicOCP class contains symbolic representation of the optimal
control problem designed to be general and allow manipulation. For a
more detailed description of this class and its functionalities, we
refer to the API documentation of CasADi.

The following step compiles the model to an XML format, imports to
CasADi and solves an optimization problem in windows PowerShell:


	Create a new file named BatchReactor.mo and save it in you working
directory.


E.g. C:\OpenModelica1.9.2\share\casadi\testmodel






	Perform compilation and generate the XML file


	Go to your working directory





E.g. cd C:\OpenModelica1.9.2\share\casadi\testmodel









	Go to omc path from working directory and run the following command


E.g. ..\..\..\bin\omc +s -g=Optimica --simCodeTarget=XML
BatchReactor.mo








3. Run defaultStart.py python script from OpenModelica optimization
directory

E.g. Python.exe ..\share\casadi\scripts defaultStart.py
BatchReactor.xml

The control and state trajectories of the optimization results are shown
below:

[image: casadi-input] [image: casadi-state]



Parameter Sweep Optimization using OMOptim

OMOptim is a tool for parameter sweep design optimization of Modelica
models. By optimization, one should understand a procedure which
minimizes/maximizes one or more objective functions by adjusting one or
more parameters. This is done by the optimization algorithm performing a
parameter swep, i.e., systematically adjusting values of selected
parameters and running a number of simulations for different parameter
combinations to find a parameter setting that gives an optimal value of
the goal function.

OMOptim 0.9 contains meta-heuristic optimization algorithms which allow
optimizing all sorts of models with following functionalities:


	One or several objectives optimized simultaneously


	One or several parameters (integer or real variables)




However, the user must be aware of the large number of simulations an
optimization might require.

Before launching OMOptim, one must prepare the model in order to
optimize it.

An optimization parameter is picked up from all model variables. The
choice of parameters can be done using the OMOptim interface.

For all intended parameters, please note that:


	
	The corresponding variable is constant during all simulations.
	The OMOptim optimization in version 0.9 only concerns static
parameters' optimization i.e. values found for these parameters
will be constant during all simulation time.







	
	The corresponding variable should play an input role in the model
	i.e. its modification influences model simulation results.










Constraints

If some constraints should be respected during optimization, they must
be defined in the Modelica model itself.

For instance, if mechanical stress must be less than 5 N.m-2,
one should write in the model:

assert(mechanicalStress < 5, "Mechanical stress too high");





If during simulation, the variable mechanicalStress exceeds 5
N.m-2, the simulation will stop and be considered as a failure.



Objectives

As parameters, objectives are picked up from model variables.
Objectives' values are considered by the optimizer at the final time.


Set problem in OMOptim




Launch OMOptim

OMOptim can be launched using the executable placed in
OpenModelicaInstallationDirectory/bin/ OMOptim/OMOptim.exe. Alternately,
choose OpenModelica > OMOptim from the start menu.



Create a new project

To create a new project, click on menu File -> New project

Then set a name to the project and save it in a dedicated folder. The
created file created has a .min extension. It will contain information
regarding model, problems, and results loaded.



Load models

First, you need to load the model(s) you want to optimize. To do so,
click on Add .mo button on main window or select menu Model -> Load
Mo file…

When selecting a model, the file will be loaded in OpenModelica which
runs in the background.

While OpenModelica is loading the model, you could have a frozen
interface. This is due to multi-threading limitation but the delay
should be short (few seconds).

You can load as many models as you want.

If an error occurs (indicated in log window), this might be because:


	Dependencies have not been loaded before (e.g. modelica library)


	Model use syntax incompatible with OpenModelica.




OMOptim should detect dependencies and load corresponding files.
However, it some errors occur, please load by yourself dependencies. You
can also load Modelica library using Model->Load Modelica library.

When the model correctly loaded, you should see a window similar to Figure 72.


[image: _images/omoptim-loaded.png]

Figure 72 OMOptim window after having loaded model.





Create a new optimization problem

Problem->Add Problem->Optimization

A dialog should appear. Select the model you want to optimize. Only
Model can be selected (no Package, Component, Block…).

A new form will be displayed. This form has two tabs. One is called
Variables, the other is called Optimization.


[image: _images/omoptim-define-new-problem.png]

Figure 73 Forms for defining a new optimization problem.



If variables are not displayed, right click on model name in model
hierarchy, and select Read variables.


[image: _images/omoptim-setup-model.png]

Figure 74 Selecting read variables, set parameters, and selecting simulator.





Select Optimized Variables

To set optimization, we first have to define the variables the optimizer
will consider as free i.e. those that it should find best values of.
To do this, select in the left list, the variables concerned. Then, add
them to Optimized variables by clicking on corresponding button
([image: omoptim-blue-cross]).

For each variable, you must set minimum and maximum values it can take.
This can be done in the Optimized variables table.



Select objectives

Objectives correspond to the final values of chosen variables. To select
these last, select in left list variables concerned and click [image: omoptim-blue-cross]
button of Optimization objectives table.

For each objective, you must:


	
	Set minimum and maximum values it can take. If a configuration does
	not respect these values, this configuration won't be considered.
You also can set minimum and maximum equals to “-“ : it will then







	Define whether objective should be minimized or maximized.




This can be done in the Optimized variables table.



Select and configure algorithm

After having selected variables and objectives, you should now select
and configure optimization algorithm. To do this, click on
Optimization tab.

Here, you can select optimization algorithm you want to use. In version
0.9, OMOptim offers three different genetic algorithms. Let's for
example choose SPEA2Adapt which is an auto-adaptative genetic algorithm.

By clicking on parameters… button, a dialog is opened allowing
defining parameters. These are:


	
	Population size: this is the number of configurations kept after a
	generation. If it is set to 50, your final result can't contain
more than 50 different points.







	
	Off spring rate: this is the number of children per adult obtained
	after combination process. If it is set to 3, each generation
will contain 150 individual (considering population size is 50).







	
	Max generations: this number defines the number of generations
	after which optimization should stop. In our case, each
generation corresponds to 150 simulations. Note that you can
still stop optimization while it is running by clicking on stop
button (which will appear once optimization is launched).
Therefore, you can set a really high number and still stop
optimization when you want without losing results obtained until
there.







	
	Save frequency: during optimization, best configurations can be
	regularly saved. It allows to analyze evolution of best
configurations but also to restart an optimization from
previously obtained results. A Save Frequency parameter set to 3
means that after three generations, a file is automatically
created containing best configurations. These files are named
iteraion1.sav, iteration2.sav and are store in Temp directory,
and moved to SolvedProblems directory when optimization is
finished.







	
	ReinitStdDev: this is a specific parameter of EAAdapt1. It defines
	whether standard deviation of variables should be reinitialized.
It is used only if you start optimization from previously
obtained configurations (using Use start file option). Setting
it to yes (1) will, in most of cases, lead to a spread research
of optimized configurations, forgetting parameters' variations'
reduction obtained in previous optimization.









As indicated before, it is possible to pursue an optimization finished
or stopped. To do this, you must enable Use start file option and
select file from which optimization should be started. This file is an
iteration_.sav file created in previous optimization. It is stored in
corresponding SolvedProblems folder (iteration10.sav corresponds to
the tenth generation of previous optimization).

*Note that this functionality can only work with same variables and
objectives*. However, minimum, maximum of variables and objectives can
be changed before pursuing an optimization.



Launch

You can now launch Optimization by clicking Launch button.



Stopping Optimization

Optimization will be stopped when the generation counter will reach the
generation number defined in parameters. However, you can still stop the
optimization while it is running without loosing obtained results. To do
this, click on Stop button. Note that this will not immediately stop
optimization: it will first finish the current generation.

This stop function is especially useful when optimum points do not vary
any more between generations. This can be easily observed since at each
generation, the optimum objectives values and corresponding parameters
are displayed in log window.


Results

The result tab appear when the optimization is finished. It consists of
two parts: a table where variables are displayed and a plot region.




Obtaining all Variable Values

During optimization, the values of optimized variables and objectives
are memorized. The others are not. To get these last, you must
recomputed corresponding points. To achieve this, select one or several
points in point's list region and click on recompute.

For each point, it will simulate model setting input parameters to point
corresponding values. All values of this point (including those which
are not optimization parameters neither objectives).


[image: _images/omoptim-window-regions.png]

Figure 75 Window regions in OMOptim GUI.
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Parameter Sensitivities with OpenModelica

This section describes the use of OpenModelica to compute parameter
sensitivities using forward sensitivity analysis together with the
Sundials/IDA solver.


Single Parameter sensitivities with IDA/Sundials


Background

Parameter sensitivity analysis aims at analyzing the behavior of the
corresponding model states w.r.t. model parameters.

Formally, consider a Modelica model as a DAE system:


[image: F(x, \dot x, y, p, t) = 0 \; x(t_0) = x_0(p)]


where
[image: x(t) \in \mathbf{R}^n] represent state variables,
[image: \dot x(t) \in \mathbf{R}^n] represent state derivatives,
[image: y(t) \in \mathbf{R}^k] represent algebraic variables,
[image: p \in \mathbf{R}^m] model parameters.

For parameter sensitivity analysis the derivatives


[image: \frac{\partial x}{ \partial p}]


are required which quantify, according to their mathematical definition,
the impact of parameters [image: p] on states [image: x].
In the Sundials/IDA implementation the derivatives are used to evolve the
solution over the time by:


[image: \dot s_i = \frac{\partial x}{ \partial p_i}]




An Example

This section demonstrates the usage of the sensitivities analysis in
OpenModelica on an example. This module is enabled by the following
OpenModelica compiler flag:

>>> setCommandLineOptions("--calculateSensitivities")
true






Listing 8 LotkaVolterra.mo

model LotkaVolterra
  Real x(start=5, fixed=true),y(start=3, fixed=true);
  parameter Real mu1=5,mu2=2;
  parameter Real lambda1=3,lambda2=1;
equation
  0 = x*(mu1-lambda1*y) - der(x);
  0 = -y* (mu2 -lambda2*x) - der(y);
end LotkaVolterra;







Also for the simulation it is needed to set IDA as solver integration
method and add a further simulation flag -idaSensitivity to calculate
the parameter sensitivities during the normal simulation.

>>> simulate(LotkaVolterra, method="ida", simflags="-idaSensitivity")
record SimulationResult
    resultFile = "«DOCHOME»/LotkaVolterra_res.mat",
    simulationOptions = "startTime = 0.0, stopTime = 1.0, numberOfIntervals = 500, tolerance = 1e-6, method = 'ida', fileNamePrefix = 'LotkaVolterra', options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = '-idaSensitivity'",
    messages = "LOG_SUCCESS       | info    | The initialization finished successfully without homotopy method.
LOG_SUCCESS       | info    | The simulation finished successfully.
",
    timeFrontend = 0.001768639,
    timeBackend = 0.00219685,
    timeSimCode = 6.50697e-4,
    timeTemplates = 0.001815156,
    timeCompile = 0.220323555,
    timeSimulation = 0.0069511550000000005,
    timeTotal = 0.23379121100000003
end SimulationResult;





Now all calculated sensitivities are stored into the results mat file under
the $Sensitivities block, where all currently every
top-level parameter of the Real type is used to calculate the
sensitivities w.r.t. every state.


[image: _images/LotkaVolterraSensitivities.svg]
Figure 76 Results of the sensitivities calculated by IDA solver.




[image: _images/LotkaVolterraResults.svg]
Figure 77 Results of the LotkaVolterra equations.






Single and Multi-parameter sensitivities with OMSens

OMSens is an OpenModelica sensitivity analysis and optimization module.


Installation

Follow the install instructions described on the OMSens github page [https://github.com/OpenModelica/OMSens].



Usage

OMSens offers 3 flavors for parameter sensitivity analysis.


	Individual Sensitivity Analysis






	Used to analyze how a parameter affects a variable when perturbed on its own








	Multi-parameter Sweep






	Exploratory experimentation that sweeps the space of a set of parameters








	Vectorial Sensitivity Analysis






	Used to find the combination of parameters that maximizes/minimizes a state variable







As an example, we choose the Lotka-Volterra model that consists of a second-order nonlinear set of ordinary
differential equations. The system models the relationship between the populations of predators
and preys in a closed ecosystem.

model LotkaVolterra "This is the typical equation-oriented model"
  parameter Real alpha=0.1 "Reproduction rate of prey";
  parameter Real beta=0.02 "Mortality rate of predator per prey";
  parameter Real gamma=0.4 "Mortality rate of predator";
  parameter Real delta=0.02 "Reproduction rate of predator per prey";
  parameter Real prey_pop_init=10 "Initial prey population";
  parameter Real pred_pop_init=10 "Initial predator population";
  Real prey_pop(start=prey_pop_init) "Prey population";
  Real pred_pop(start=pred_pop_init) "Predator population";
initial equation
  prey_pop = prey_pop_init;
  pred_pop = pred_pop_init;
equation
  der(prey_pop) = prey_pop*(alpha-beta*pred_pop);
  der(pred_pop) = pred_pop*(delta*prey_pop-gamma);
end LotkaVolterra;





Let's say we need to investigate the influence of model parameters on the predator population
at 40 units of time. We assume a +/-5% uncertainty on model parameters.

We can use OMSens to study the sensitivity model to each parameter, one at a time.

Open the Lotka-Volterra model using OMEdit.


Individual Sensitivity Analysis


	Select Sensitivity Optimization > Run Sensitivity Analysis and Optimization from the menu.
A window like the one below should appear. Windows users should use the default python executable
that comes with OpenModelica installation i.e., they don't need to change the proposed python
executable path. If you want to use some other python installation then make sure that all the
python dependencies are installed for that python installation.





[image: _images/omsens-window.png]

Figure 78 OMSens window.




	Choose Individual Parameter Based Sensitivity Analysis and set up the simulation settings.





[image: _images/omsens-individual-analysis.png]

Figure 79 Run individual sensitivity analysis.




	Select variables.





[image: _images/omsens-individual-analysis-variables.png]

Figure 80 Individual sensitivity analysis variables.




	Select parameters.





[image: _images/omsens-individual-analysis-parameters.png]

Figure 81 Individual sensitivity analysis parameters.




	Choose the perturbation percentage and direction. Run the analysis.





[image: _images/omsens-individual-analysis-perturbation.png]

Figure 82 Individual sensitivity analysis perturbation.




	After the analysis a dialog with results is shown.
Open the heatmap corresponding to the relative sensitivity index.





[image: _images/omsens-individual-analysis-results.png]

Figure 83 Individual sensitivity analysis results.




	The heatmap shows the effect of each parameter on each variable in the form of
(parameter,variable) cells. As we can see, pred_pop was affected by the perturbation on every
parameter but prey_pop presents a negligible sensitivity to delta (P.3).
Recall that this heatmap shows the effect on the variables at time 40
for each perturbation imposed at time 0.





[image: _images/omsens-individual-analysis-heatmap.png]

Figure 84 Individual sensitivity analysis heatmap.





Multi-parameter Sweep

Now we would like to see what happens to pred_pop when the top 3 most influencing parameters are
perturbed at the same time. Repeat the first three steps from Individual Sensitivity Analysis
but this time select Multi-parameter Sweep.


	Choose to sweep alpha, gamma and pred_pop_init in a range of ±5% from its default value
and with 3 iterations (#iter) distributed equidistantly within that range. Run the sweep analysis.





[image: _images/omsens-multi-sweep-parameters.png]

Figure 85 Multi-parameter sweep parameters.




	The backend is invoked and when it completes the analysis the following results dialog is
shown. Open the plot for pred_pop.





[image: _images/omsens-multi-sweep-results.png]

Figure 86 Multi-parameter sweep results.




	At time 40 the parameters perturbations with a higher predator population are all blue,
but it's not clear which one. We need something more precise.





[image: _images/omsens-multi-sweep-plot.png]

Figure 87 Multi-parameter sweep plot.



These results can be very informative but clearly the exhaustive exploration approach doesn't
scale for more parameters (#p) and more perturbation values (#v) (#v^#p simulations required).










Vectorial Sensitivity Analysis

Using the Vectorial optimization-based analysis (see below) we can request OMSens to find a
combination of parameters that perturbs the most (i.e. minimize or maximize) the value of the
target variable at a desired simulation time.

For Vectorial Sensitivity Analysis repeat the first two steps from
Individual Sensitivity Analysis but choose Vectorial Parameter Based Sensitivity Analysis.


	Choose only alpha, delta and pred_pop_init to perturb.





[image: _images/omsens-vectorial-analysis-parameters.png]

Figure 88 Vectorial sensitivity analysis parameters.




	Setup the optimization settings and run the analysis.





[image: _images/omsens-vectorial-analysis-optimization.png]

Figure 89 Vectorial sensitivity analysis optimization.




	The Parameters tab in the results window shows the values found by the optimization
routine that maximize pred_pop at t=40 s.





[image: _images/omsens-vectorial-analysis-results.png]

Figure 90 Vectorial sensitivity analysis parameters result.




	The State Variable tab shows the comparison between the values of the variable in the
standard run vs the perturbed run at simulation time 40s.





[image: _images/omsens-vectorial-analysis-state-variables.png]

Figure 91 Vectorial sensitivity analysis state variables.




	If we simulate using the optimum values and compare it to the standard (unperturbed) run,
we see that it delays the bell described by the variable.





[image: _images/omsens-vectorial-analysis-plot.png]

Figure 92 Vectorial sensitivity analysis plot.




	So far, we have only perturbed the top 3 parameters detected by the Individual Sensitivity
method. Maybe we can find a greater effect on the variable if we perturb all 6 parameters.
Running a Sweep is not an option as perturbing 6 parameters with 3 iterations each results in
3⁶=729 simulations. We run another Vectorial Sensitivity Analysis instead but now choose to
perturb all 6 parameters.





[image: _images/omsens-vectorial-analysis-parameters-all.png]

Figure 93 Vectorial sensitivity analysis parameters.




	The parameters tab shows that the optimum value is found by perturbing all of the
parameters to their boundaries.





[image: _images/omsens-vectorial-analysis-results-all.png]

Figure 94 Vectorial sensitivity analysis parameters result.




	The State Variable tab shows that pred_pop can be increased by 98% when perturbing the
6 parameters as opposed to 68% when perturbing the top 3 influencing parameters.





[image: _images/omsens-vectorial-analysis-state-variables.png]

Figure 95 Vectorial sensitivity analysis state variables.




	The plot shows again that the parameters found delay the bell-shaped curve, but with a
stronger impact than before.





[image: _images/omsens-vectorial-analysis-plot-all.png]

Figure 96 Vectorial sensitivity analysis plot.
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PDEModelica1

PDEModelica1 is nonstandardised experimental Modelica language extension for 1-dimensional partial differential extensions (PDE).

It is enabled using compiler flag --grammar=PDEModelica. Compiler flags may be set e.g. in OMEdit (globally in Tools->Options->Simulation->Translation Flags or in Simulation Setup->Translation Flags for specific models) or in an OpenModelica script using setCommandLineOptions. Note that PDEModelica does now work yet with the current frontend so you need to also use the flag -d=-newInst or check "Enable old frontend for code generation" in OMEdit under Translation Flags.


PDEModelica1 language elements

Let us introduce new PDEModelica1 language elements by an advection equation example model:

model Advection "advection equation"
  parameter Real pi = Modelica.Constants.pi;
  parameter DomainLineSegment1D omega(L = 1, N = 100)  "domain";
  field Real u(domain = omega)                         "field";
initial equation
  u = sin(2*pi*omega.x)                                "IC";
equation
  der(u) + pder(u,x) = 0   indomain omega              "PDE";
  u = 0                    indomain omega.left         "BC";
  u = extrapolateField(u)  indomain omega.right        "extrapolation";
end Advection;





The domain omega represents the geometrical domain where the PDE holds. The domain is
defined using the built-in record DomainLineSegment1D. This   record contains among
others L - the length of the domain, N - the number of grid points, x -
the coordinate variable and the regions left, right and interior, representing
the left and right boundaries and the interior of the domain.

The field variable u is defined using a new keyword field. The domain
is a mandatory attribute to specify the domain of the field.

The indomain operator specifies where the equation containing the field variable holds. It
is utilised in the initial conditions (IC) of the fields, in the PDE and in the boundary
conditions (BC). The syntax is


anEquation indomain aDomain.aRegion;



If the region is omitted, interior is the default (e.g. the PDE in the example above).

The IC of the field variable u is written using an expression containing the coordinate
variable omega.x.

The PDE contains a partial space derivative written using the pder operator. Also
the second derivative is allowed (not in this example), the syntax is e.g. pder(u,x,x).
It is not necessary to specify the domain of coordinate in pder (to write e.g. pder(u,omega.x), even though x is a member of omega.



Limitations

BCs may be written only in terms of variables that are spatially differentiated currently.

All fields that are spatially differentiated must have either BC or extrapolation at each
boundary. This extrapolation should be done automatically by the compiler, but this has
not been implemented yet. The current workaround is the usage of the extrapolateField()
operator directly in the model.

If-equations are not spported yet, if-expressions must be used instead.



Viewing results

During translation field variables are replaced with arrays. These arrays may be plotted using array-plot or even better using Array Parametric Plot (to plot x-coordinate versus a field).
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MDT - The OpenModelica Development Tooling Eclipse Plugin


Introduction

The Modelica Development Tooling (MDT) Eclipse Plugin as part of OMDev -
The OpenModelica Development Environment integrates the OpenModelica
compiler with Eclipse. MDT, together with the OpenModelica compiler,
provides an environment for working with Modelica and MetaModelica
development projects. This plugin is primarily intended for tool
developers rather than application Modelica modelers.

The following features are available:


	Browsing support for Modelica projects, packages, and classes


	Wizards for creating Modelica projects, packages, and classes


	Syntax color highlighting


	Syntax checking


	Browsing of the Modelica Standard Library or other libraries


	Code completion for class names and function argument lists


	Goto definition for classes, types, and functions


	Displaying type information when hovering the mouse over an
identifier.






Installation

The installation of MDT is accomplished by following the below
installation instructions. These instructions assume that you have
successfully downloaded and installed Eclipse (http://www.eclipse.org).

The latest installation instructions are available through the OpenModelica Trac [https://trac.openmodelica.org/MDT].


	Start Eclipse


	Select Help->Software Updates->Find and Install... from the
menu


	Select 'Search for new features to install' and click 'Next'


	Select 'New Remote Site...'


	Enter 'MDT' as name and
http://www.ida.liu.se/labs/pelab/modelica/OpenModelica/MDT
as URL and click 'OK'


	Make sure 'MDT' is selected and click 'Finish'


	In the updates dialog select the 'MDT' feature and click 'Next'


	Read through the license agreement, select 'I accept...' and click
'Next'


	Click 'Finish' to install MDT






Getting Started


Configuring the OpenModelica Compiler

MDT needs to be able to locate the binary of the compiler. It uses the
environment variable OPENMODELICAHOME to do so.

If you have problems using MDT, make sure that OPENMODELICAHOME is
pointing to the folder where the OpenModelica Compiler is installed. In
other words, OPENMODELICAHOME must point to the folder that contains the
Open Modelica Compiler (OMC) binary. On the Windows platform it's called
omc.exe and on Unix platforms it's called omc.



Using the Modelica Perspective

The most convenient way to work with Modelica projects is to use to the
Modelica perspective. To switch to the Modelica perspective, choose the
Window menu item, pick Open Perspective followed by Other...
Select the Modelica option from the dialog presented and click OK..



Selecting a Workspace Folder

Eclipse stores your projects in a folder called a workspace. You need to
choose a workspace folder for this session, see Figure 97.


[image: _images/mdt-switch-workspace.png]

Figure 97 Eclipse Setup - Switching Workspace.





Creating one or more Modelica Projects

To start a new project, use the New Modelica Project Wizard. It is
accessible through File->New-> Modelica Project or by right-clicking in
the Modelica Projects view and selecting New->Modelica Project.


[image: _images/mdt-create-project.png]

Figure 98 Eclipse Setup - creating a Modelica project in the workspace.



You need to disable automatic build for the project(s) (Figure 99).


[image: _images/mdt-disable-automatic-build.png]

Figure 99 Eclipse Setup - disable automatic build for the projects.



Repeat the procedure for all the projects you need, e.g. for the
exercises described in the MetaModelica users guide: 01_experiment,
02a_exp1, 02b_exp2, 03_assignment, 04a_assigntwotype, etc.

NOTE: Leave open only the projects you are working on! Close all the
others!



Building and Running a Project

After having created a project, you eventually need to build the project
(Figure 100).


[image: _images/mdt-build-project.png]

Figure 100 Eclipse MDT - Building a project.



The build options are the same as the make targets: you can build,
build from scratch (clean), or run simulations depending on how the
project is setup. See Figure 101 for an example of how omc
can be compiled (make omc builds OMC).


[image: _images/mdt-build-prompt.png]

Figure 101 Eclipse - building a project.




[image: _images/mdt-build-log.png]

Figure 102 Eclipse - building a project, resulting log.





Switching to Another Perspective

If you need, you can (temporarily) switch to another perspective, e.g.
to the Java perspective for working with an OpenModelica Java client as
in Figure 103.


[image: _images/mdt-switch-perspective.png]

Figure 103 Eclipse - Switching to another perspective - e.g. the Java Perspective.





Creating a Package

To create a new package inside a Modelica project, select
File->New->Modelica Package. Enter the desired name of the package
and a description of what it contains. Note: for the exercises we
already have existing packages.


[image: _images/mdt-create-package.png]

Figure 104 Creating a new Modelica package.





Creating a Class

To create a new Modelica class, select where in the hierarchy that you
want to add your new class and select File->New->Modelica Class. When
creating a Modelica class you can add different restrictions on what the
class can contain. These can for example be model, connector, block,
record, or function. When you have selected your desired class type, you
can select modifiers that add code blocks to the generated code.
'Include initial code block' will for example add the line 'initial
equation' to the class.


[image: _images/mdt-create-class.png]

Figure 105 Creating a new Modelica class.





Syntax Checking

Whenever a build command is given to the MDT environment, modified and
saved Modelica (.mo) files are checked for syntactical errors. Any
errors that are found are added to the Problems view and also marked in
the source code editor. Errors are marked in the editor as a red circle
with a white cross, a squiggly red line under the problematic construct,
and as a red marker in the right-hand side of the editor. If you want to
reach the problem, you can either click the item in the Problems view or
select the red box in the right-hand side of the editor.


[image: _images/mdt-syntax-checking.png]

Figure 106 Syntax checking.





Automatic Indentation Support

MDT currently has support for automatic indentation. When typing the
Return (Enter) key, the next line is indented correctly. You can also
correct indentation of the current line or a range selection using
CTRL+I or “Correct Indentation” action on the toolbar or in the Edit
menu.



Code Completion

MDT supports Code Completion in two variants. The first variant, code
completion when typing a dot after a class (package) name, shows
alternatives in a menu. Besides the alternatives, Modelica documentation
from comments is shown if is available. This makes the selection easyer.


[image: _images/mdt-code-completion.png]

Figure 107 Code completion when typing a dot.



The second variant is useful when typing a call to a function. It shows
the function signature (formal parameter names and types) in a popup
when typing the parenthesis after the function name, here the signature
Real sin(SI.Angle u) of the sin function:


[image: _images/mdt-code-completion-call.png]

Figure 108 Code completion at a function call when typing left parenthesis.





Code Assistance on Identifiers when Hovering

When hovering with the mouse over an identifier a popup with information
about the identifier is displayed. If the text is too long, the user can
press F2 to focus the popup dialog and scroll up and down to examine all
the text. As one can see the information in the popup dialog is
syntax-highlighted.


[image: _images/mdt-info-on-hover.png]

Figure 109 Displaying information for identifiers on hovering.





Go to Definition Support

Besides hovering information the user can press CTRL+click to go to the
definition of the identifier. When pressing CTRL the identifier will be
presented as a link and when pressing mouse click the editor will go to
the definition of the identifier.



Code Assistance on Writing Records

When writing records, the same functionality as for function calls is
used. This is useful especially in MetaModelica when writing cases in
match constructs.


[image: _images/mdt-assist-mm-record.png]

Figure 110 Code assistance when writing cases with records in MetaModelica.





Using the MDT Console for Plotting


[image: _images/mdt-console.png]

Figure 111 Activate the MDT Console.




[image: _images/mdt-console-simulate.png]

Figure 112 Simulation from MDT Console.
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MDT Debugger for Algorithmic Modelica

The algorithmic code debugger, used for the algorithmic subset of the
Modelica language as well as the MetaModelica language is described in
Section The Eclipse-based Debugger for Algorithmic Modelica.
Using this debugger replaces debugging of algorithmic code
by primitive means such as print statements or asserts which is complex,
time-consuming and error- prone. The usual debugging functionality found
in debuggers for procedural or traditional object-oriented languages is
supported, such as setting and removing breakpoints, stepping,
inspecting variables, etc. The debugger is integrated with Eclipse.


The Eclipse-based Debugger for Algorithmic Modelica

The debugging framework for the algorithmic subset of Modelica and
MetaModelica is based on the Eclipse environment and is implemented as a
set of plugins which are available from Modelica Development Tooling
(MDT) environment. Some of the debugger functionality is presented
below. In the right part a variable value is explored. In the top-left
part the stack trace is presented. In the middle-left part the execution
point is presented.

The debugger provides the following general functionalities:


	Adding/Removing breakpoints.


	Step Over - moves to the next line, skipping the function calls.


	Step In - takes the user into the function call.


	
	Step Return - complete the execution of the function and takes the
	user back to the point from where the function is called.







	Suspend - interrupts the running program.





[image: _images/mdt-debugger-overview.png]

Figure 113 Debugging functionality.




Starting the Modelica Debugging Perspective

To be able to run in debug mode, one has to go through the following
steps:


	create a mos file


	setting the debug configuration


	setting breakpoints


	running the debug configuration




All these steps are presented below using images.


Create mos file

In order to debug Modelica code we need to load the Modelica files into
the OpenModelica Compiler. For this we can write a small script file
like this:

function HelloWorld
  input Real r;
  output Real o;
algorithm
  o := 2 * r;
end HelloWorld;





>>> setCommandLineOptions({"-d=rml,noevalfunc","-g=MetaModelica"})
{true, true}
>>> setCFlags(getCFlags() + " -g")
true
>>> HelloWorld(120.0)





So lets say that we want to debug HelloWorld.mo. For that we must load
it into the compiler using the script file. Put all the Modelica files
there in the script file to be loaded. We should also initiate the
debugger by calling the starting function, in the above code
HelloWorld(120.0);



Setting the debug configuration

While the Modelica perspective is activated the user should click on the
bug icon on the toolbar and select Debug in order to access the dialog
for building debug configurations.


[image: _images/mdt-debugger-config-1.png]

Figure 114 Accessing the debug configuration dialog.



To create the debug configuration, right click on the classification
Modelica Development Tooling (MDT) GDB and select New as in figure
below. Then give a name to the configuration, select the debugging
executable to be executed and give it command line parameters. There are
several tabs in which the user can select additional debug configuration
settings like the environment in which the executable should be run.

Note that we require Gnu Debugger (GDB) for debugging session. We must
specify the GDB location, also we must pass our script file as an
argument to OMC.


[image: _images/mdt-debugger-config-2.png]

Figure 115 Creating the Debug Configuration.





Setting/Deleting Breakpoints

The Eclipse interface allows to add/remove breakpoints. At the moment
only line number based breakpoints are supported. Other alternative to
set the breakpoints is; function breakpoints.


[image: _images/mdt-debugger-breakpoint.png]

Figure 116 Setting/deleting breakpoints.





Starting the debugging session and enabling the debug perspective


[image: _images/mdt-debugger-start-1.png]

Figure 117 Starting the debugging session.




[image: _images/mdt-debugger-start-2.png]

Figure 118 Eclipse will ask if the user wants to switch to the debugging perspective.






The Debugging Perspective

The debug view primarily consists of two main views:


	Stack Frames View


	Variables View




The stack frame view, shown in the figure below, shows a list of frames
that indicates how the flow had moved from one function to another or
from one file to another. This allows backtracing of the code. It is
very much possible to select the previous frame in the stack and inspect
the values of the variables in that frame. However, it is not possible
to select any of the previous frame and start debugging from there. Each
frame is shown as <function_name at file_name:line_number>.

The Variables view shows the list of variables at a certain point in the
program, containing four colums:


	Name - the variable name.


	Declared Type - the Modelica type of the variable.


	Value - the variable value.


	Actual Type - the mapped C type.




By preserving the stack frames and variables it is possible to keep
track of the variables values. If the value of any variable is changed
while stepping then that variable will be highlighted yellow (the
standard Eclipse way of showing the change).


[image: _images/mdt-debugger-perspective.png]

Figure 119 The debugging perspective.




[image: _images/mdt-debugger-switch-perspective.png]

Figure 120 Switching between perspectives.
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Modelica Performance Analyzer

A common problem when simulating models in an equation-based language
like Modelica is that the model may contain non-linear equation systems.
These are solved in each time-step by extrapolating an initial guess and
running a non-linear system solver. If the simulation takes too long to
simulate, it is useful to run the performance analysis tool. The tool
has around 5~25% overhead, which is very low compared to
instruction-level profilers (30x-100x overhead). Due to being based on a
single simulation run, the report may contain spikes in the charts.

When running a simulation for performance analysis, execution times of
user-defined functions as well as linear, non-linear and mixed equation
systems are recorded.

To start a simulation in this mode, turn on profiling with the following
command line flag
>>> setCommandLineOptions("--profiling=all")

The generated report is in HTML format (with images in the SVG format),
stored in a file modelname_prof.html, but the XML database and measured
times that generated the report and graphs are also available if you
want to customize the report for comparison with other tools.

Below we use the performance profiler on the simple model A:

model ProfilingTest
  function f
    input Real r;
    output Real o = sin(r);
  end f;
  String s = "abc";
  Real x = f(x) "This is x";
  Real y(start=1);
  Real z1 = cos(z2);
  Real z2 = sin(z1);
equation
  der(y) = time;
end ProfilingTest;





We simulate as usual, after setting the profiling flag:

>>> setCommandLineOptions("--profiling=blocks+html")
true
>>> simulate(ProfilingTest)
record SimulationResult
    resultFile = "«DOCHOME»/ProfilingTest_res.mat",
    simulationOptions = "startTime = 0.0, stopTime = 1.0, numberOfIntervals = 500, tolerance = 1e-6, method = 'dassl', fileNamePrefix = 'ProfilingTest', options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = ''",
    messages = "LOG_SUCCESS       | info    | The initialization finished successfully without homotopy method.
LOG_SUCCESS       | info    | The simulation finished successfully.
Warning: empty y range [1:1], adjusting to [0.99:1.01]
Warning: empty y range [1:1], adjusting to [0.99:1.01]
Warning: empty y range [1:1], adjusting to [0.99:1.01]
Warning: empty y range [1:1], adjusting to [0.99:1.01]
Warning: empty y range [1:1], adjusting to [0.99:1.01]
Warning: empty y range [1:1], adjusting to [0.99:1.01]
LOG_STDOUT        | info    | Time measurements are stored in ProfilingTest_prof.html (human-readable) and ProfilingTest_prof.xml (for XSL transforms or more details)
",
    timeFrontend = 8.34642e-4,
    timeBackend = 0.002458439,
    timeSimCode = 5.77351e-4,
    timeTemplates = 0.0045743779999999346,
    timeCompile = 0.22094602900000002,
    timeSimulation = 0.020689969000000002,
    timeTotal = 0.250142573
end SimulationResult;
"Warning: There are nonlinear iteration variables with default zero start attribute found in NLSJac0. For more information set -d=initialization. In OMEdit Tools->Options->Simulation->Show additional information from the initialization process, in OMNotebook call setCommandLineOptions(\"-d=initialization\").
Warning: The initial conditions are not fully specified. For more information set -d=initialization. In OMEdit Tools->Options->Simulation->Show additional information from the initialization process, in OMNotebook call setCommandLineOptions(\"-d=initialization\").
"






Profiling information for ProfilingTest


Information

All times are measured using a real-time wall clock. This means context
switching produces bad worst-case execution times (max times) for
blocks. If you want better results, use a CPU-time clock or run the
command using real-time priviliges (avoiding context switches).

Note that for blocks where the individual execution time is close to the
accuracy of the real-time clock, the maximum measured time may deviate a
lot from the average.

For more details, see
ProfilingTest_prof.xml.



Settings



	Name

	Value





	Integration method

	dassl



	Output format

	mat



	Output name

	ProfilingTest_res.mat



	Output size

	24.0 kB



	Profiling data

	ProfilingTest_prof.data



	Profiling size

	0 B








Summary



	Task

	Time

	Fraction





	Pre-Initialization

	0.000084

	9.47%



	Initialization

	0.000082

	9.24%



	Event-handling

	0.000000

	0.00%



	Creating output file

	0.000081

	9.13%



	Linearization

	
	NaN%



	Time steps

	0.000470

	52.99%



	Overhead

	0.000052

	5.86%



	Unknown

	NaN

	NaN%



	Total simulation time

	0.000887

	100.00%








Global Steps



	
	Steps

	Total
Time

	F
raction

	Average
Time

	Max
Time

	De
viation





	|Graph
th
umbnail
999|

	499

	0
.000470

	52.99%

	9.418
8376753
507e-07

	0.00
0032601

	33.61x








Measured Function Calls



	
	Name

	Calls

	Time

	F
raction

	Max
Time

	De
viation





	|Graph
th
umbnail
f
unction
fun0|


|Graph




th
umbnail
count
f
unction
fun0|


	`
Profili
ngTest.
f <#lin
e=0>`__

	506

	0.00
0005436

	0.61%

	0.00
0000080

	6.45x








Measured Blocks



	
	Name

	Calls

	Time

	F
raction

	Max
Time

	De
viation





	|Graph
th
umbnail
eq0|


|Graph




th
umbnail
count
eq0|


	` <#
eq0>`__

	8

	0.00
0050134

	5.65%

	0.00
0050204

	7.01x



	|Graph
th
umbnail
eq11|


|Graph




th
umbnail
count
eq11|


	` <#e
q11>`__

	2

	0.00
0000701

	0.08%

	0.00
0000711

	1.03x



	|Graph
th
umbnail
eq19|


|Graph




th
umbnail
count
eq19|


	` <#e
q19>`__

	504

	0.00
0138229

	15.58%

	0.00
0010520

	37.36x



	|Graph
th
umbnail
eq21|


|Graph




th
umbnail
count
eq21|


	` <#e
q21>`__

	504

	0.00
0129768

	14.63%

	0.00
0010981

	41.65x







Equations



	Name

	Variables





	eq0

	


	eq1

	y



	eq2

	s



	eq3

	z1



	eq4

	


	eq5

	` <#var0>`__



	eq6

	` <#var0>`__



	eq7

	` <#var0>`__



	eq8

	` <#var0>`__



	eq9

	z2



	eq10

	


	eq11

	x



	eq12

	


	eq13

	z2



	eq14

	


	eq15

	` <#var0>`__



	eq16

	` <#var0>`__



	eq17

	` <#var0>`__



	eq18

	` <#var0>`__



	eq19

	z1



	eq20

	


	eq21

	x



	eq22

	der(y)



	eq23

	







Variables



	Name

	Comment





	y

	


	der(y)

	


	x

	This is x



	z1

	


	z2

	


	s

	







This report was generated by OpenModelica [http://openmodelica.org]
on 2026-03-06 08:29:42.





Genenerated JSON for the Example


Listing 9 ProfilingTest_prof.json

{
"name":"ProfilingTest",
"prefix":"ProfilingTest",
"date":"2026-03-06 08:29:42",
"method":"dassl",
"outputFormat":"mat",
"outputFilename":"ProfilingTest_res.mat",
"outputFilesize":24581,
"overheadTime":5.1936e-05,
"preinitTime":8.3907e-05,
"initTime":8.2244e-05,
"eventTime":2.32e-07,
"outputTime":8.1113e-05,
"jacobianTime":3.035e-06,
"totalTime":0.000886692,
"totalStepsTime":8.31e-07,
"totalTimeProfileBlocks":0.000318832,
"numStep":499,
"maxTime":3.2601e-05,
"functions":[
{"name":"ProfilingTest.f","ncall":506,"time":0.000005436,"maxTime":0.000000080}
],
"profileBlocks":[
{"id":0,"ncall":8,"time":0.000050134,"maxTime":0.000050204},
{"id":11,"ncall":2,"time":0.000000701,"maxTime":0.000000711},
{"id":19,"ncall":504,"time":0.000138229,"maxTime":0.000010520},
{"id":21,"ncall":504,"time":0.000129768,"maxTime":0.000010981}
]
}









Using the Profiler from OMEdit

When running a simulation from OMEdit, it is possible to enable profiling
information, which can be combined with the transformations browser.


[image: Profiling setup]

Figure 121 Setting up the profiler from OMEdit.



When profiling the DoublePendulum example from MSL, the following output in Figure 122 is a typical result.
This information clearly shows which system takes longest to simulate (a linear system, where most of the time overhead probably comes from initializing LAPACK [http://www.netlib.org/lapack/] over and over).


[image: Profiling results]

Figure 122 Profiling results of the Modelica standard library DoublePendulum example, sorted by execution time.
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Simulation in Web Browser

OpenModelica can simulate in a web browser on a client computer by model
code being compiled to efficient Javacript code.

For more information, see https://github.com/tshort/openmodelica-javascript

Below used on the MSL MultiBody RobotR3.fullRobot example model.

[image: _images/emscripten-model.png]
[image: _images/emscripten-result.png]
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Interoperability - C and Python

Below is information and examples about the OpenModelica external C
interfaces, as well as examples of Python interoperability.


Calling External C functions

The following is a small example (ExternalLibraries.mo) to show the use
of external C functions:

model ExternalLibraries

  function ExternalFunc1
    input Real x;
    output Real y;
  external y=ExternalFunc1_ext(x) annotation(Library="ExternalFunc1.o", LibraryDirectory="modelica://ExternalLibraries", Include="#include \"ExternalFunc1.h\"");
  end ExternalFunc1;

  function ExternalFunc2
    input Real x;
    output Real y;
  external "C" annotation(Library="ExternalFunc2", LibraryDirectory="modelica://ExternalLibraries");
  end ExternalFunc2;

  Real x(start=1.0, fixed=true), y(start=2.0, fixed=true);
equation
  der(x)=-ExternalFunc1(x);
  der(y)=-ExternalFunc2(y);
end ExternalLibraries;





These C (.c) files and header files (.h) are needed (note that the headers are not needed since OpenModelica will generate the correct definition if it is not present; using the headers it is possible to write C-code directly in the Modelica source code or declare non-standard calling conventions):


Listing 10 ExternalFunc1.c

double ExternalFunc1_ext(double x)
{
  double res;
  res = x+2.0*x*x;
  return res;
}








Listing 11 ExternalFunc1.h

double ExternalFunc1_ext(double);








Listing 12 ExternalFunc2.c

double ExternalFunc2(double x)
{
  double res;
  res = (x-1.0)*(x+2.0);
  return res;
}







The following script file ExternalLibraries.mos will perform everything
that is needed, provided you have gcc installed in your path:

>>> system(getCompiler() + " -c -o ExternalFunc1.o ExternalFunc1.c")
0
>>> system(getCompiler() + " -c -o ExternalFunc2.o ExternalFunc2.c")
0
>>> system("ar rcs libExternalFunc2.a ExternalFunc2.o")
0
>>> simulate(ExternalLibraries)
record SimulationResult
    resultFile = "«DOCHOME»/ExternalLibraries_res.mat",
    simulationOptions = "startTime = 0.0, stopTime = 1.0, numberOfIntervals = 500, tolerance = 1e-6, method = 'dassl', fileNamePrefix = 'ExternalLibraries', options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = ''",
    messages = "LOG_SUCCESS       | info    | The initialization finished successfully without homotopy method.
LOG_SUCCESS       | info    | The simulation finished successfully.
",
    timeFrontend = 8.340000000000001e-4,
    timeBackend = 9.02178e-4,
    timeSimCode = 3.16322e-4,
    timeTemplates = 0.001478406,
    timeCompile = 0.22403360600000002,
    timeSimulation = 0.007099633,
    timeTotal = 0.234735788
end SimulationResult;






Note

Notification: Model statistics after passing the front-end and creating the data structures used by the back-end:

 * Number of equations: 2

 * Number of variables: 2

Notification: Model statistics after passing the back-end for initialization:

 * Number of independent subsystems: 2

 * Number of states: 0 ()

 * Number of discrete variables: 0 ()

 * Number of discrete states: 0 ()

 * Number of clocked states: 0 ()

 * Top-level inputs: 0

Notification: Strong component statistics for initialization (4):

 * Single equations (assignments): 4

 * Array equations: 0

 * Algorithm blocks: 0

 * Record equations: 0

 * When equations: 0

 * If-equations: 0

 * Equation systems (not torn): 0

 * Torn equation systems: 0

 * Mixed (continuous/discrete) equation systems: 0

Notification: Model statistics after passing the back-end for simulation:

 * Number of independent subsystems: 2

 * Number of states: 2 (y,x)

 * Number of discrete variables: 0 ()

 * Number of discrete states: 0 ()

 * Number of clocked states: 0 ()

 * Top-level inputs: 0

Notification: Strong component statistics for simulation (2):

 * Single equations (assignments): 2

 * Array equations: 0

 * Algorithm blocks: 0

 * Record equations: 0

 * When equations: 0

 * If-equations: 0

 * Equation systems (not torn): 0

 * Torn equation systems: 0

 * Mixed (continuous/discrete) equation systems: 0





And plot the results:


[image: _images/externallibraries.svg]
Figure 123 Plot generated by OpenModelica+gnuplot





Calling external Python Code from a Modelica model

The following calls external Python code through a very simplistic
external function (no data is retrieved from the Python code).
By making it a dynamically linked library, you might get the code to
work without changing the linker settings.

function pyRunString
  input String s;
external "C" annotation(Include="
#include <Python.h>

void pyRunString(const char *str)
{
  Py_SetProgramName(\"pyRunString\");  /* optional but recommended */
  Py_Initialize();
  PyRun_SimpleString(str);
  Py_Finalize();
}
");
end pyRunString;

model CallExternalPython
algorithm
  pyRunString("
print 'Python says: simulation time',"+String(time)+"
");
end CallExternalPython;





>>> system("python-config --cflags > pycflags")
127
>>> system("python-config --ldflags > pyldflags")
127
>>> pycflags := stringReplace(readFile("pycflags"),"\n","");
>>> pyldflags := stringReplace(readFile("pyldflags"),"\n","");
>>> setCFlags(getCFlags()+pycflags)
true
>>> setLinkerFlags(getLinkerFlags()+pyldflags)
true
>>> simulate(CallExternalPython, stopTime=2)
record SimulationResult
    resultFile = "",
    simulationOptions = "startTime = 0.0, stopTime = 2.0, numberOfIntervals = 500, tolerance = 1e-6, method = 'dassl', fileNamePrefix = 'CallExternalPython', options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = ''",
    messages = "Failed to build model: CallExternalPython",
    timeFrontend = 7.64751e-4,
    timeBackend = 0.003477846,
    timeSimCode = 2.4909600000000003e-4,
    timeTemplates = 0.0013212520000000002,
    timeCompile = 0.15504373200000002,
    timeSimulation = 0.0,
    timeTotal = 0.16086760800000002
end SimulationResult;






Error

Notification: Model statistics after passing the front-end and creating the data structures used by the back-end:

 * Number of equations: 0

 * Number of variables: 0

Notification: Model statistics after passing the back-end for initialization:

 * Number of independent subsystems: 1

 * Number of states: 0 ()

 * Number of discrete variables: 0 ()

 * Number of discrete states: 0 ()

 * Number of clocked states: 0 ()

 * Top-level inputs: 0

Notification: Strong component statistics for initialization (0):

 * Single equations (assignments): 0

 * Array equations: 0

 * Algorithm blocks: 0

 * Record equations: 0

 * When equations: 0

 * If-equations: 0

 * Equation systems (not torn): 0

 * Torn equation systems: 0

 * Mixed (continuous/discrete) equation systems: 0

Notification: Model statistics after passing the back-end for simulation:

 * Number of independent subsystems: 1

 * Number of states: 0 ()

 * Number of discrete variables: 0 ()

 * Number of discrete states: 0 ()

 * Number of clocked states: 0 ()

 * Top-level inputs: 0

Notification: Strong component statistics for simulation (0):

 * Single equations (assignments): 0

 * Array equations: 0

 * Algorithm blocks: 0

 * Record equations: 0

 * When equations: 0

 * If-equations: 0

 * Equation systems (not torn): 0

 * Torn equation systems: 0

 * Mixed (continuous/discrete) equation systems: 0

Error: Error building simulator. Build log: make[1]: Entering directory '«DOCHOME»'

clang  -Os -DOM_HAVE_PTHREADS -fPIC -falign-functions -mfpmath=sse -fno-dollars-in-identifiers -Wno-parentheses-equality     -I"«OPENMODELICAHOME»/include/omc/c" -I"«OPENMODELICAHOME»/include/omc" -I. -DOPENMODELICA_XML_FROM_FILE_AT_RUNTIME -DOMC_MODEL_PREFIX=CallExternalPython -DOMC_NUM_MIXED_SYSTEMS=0 -DOMC_NUM_LINEAR_SYSTEMS=0 -DOMC_NUM_NONLINEAR_SYSTEMS=0 -DOMC_NDELAY_EXPRESSIONS=0 -DOMC_NVAR_STRING=0  -c -o CallExternalPython.o CallExternalPython.c

clang  -Os -DOM_HAVE_PTHREADS -fPIC -falign-functions -mfpmath=sse -fno-dollars-in-identifiers -Wno-parentheses-equality     -I"«OPENMODELICAHOME»/include/omc/c" -I"«OPENMODELICAHOME»/include/omc" -I. -DOPENMODELICA_XML_FROM_FILE_AT_RUNTIME -DOMC_MODEL_PREFIX=CallExternalPython -DOMC_NUM_MIXED_SYSTEMS=0 -DOMC_NUM_LINEAR_SYSTEMS=0 -DOMC_NUM_NONLINEAR_SYSTEMS=0 -DOMC_NDELAY_EXPRESSIONS=0 -DOMC_NVAR_STRING=0  -c -o CallExternalPython_functions.o CallExternalPython_functions.c

clang  -Os -DOM_HAVE_PTHREADS -fPIC -falign-functions -mfpmath=sse -fno-dollars-in-identifiers -Wno-parentheses-equality     -I"«OPENMODELICAHOME»/include/omc/c" -I"«OPENMODELICAHOME»/include/omc" -I. -DOPENMODELICA_XML_FROM_FILE_AT_RUNTIME -DOMC_MODEL_PREFIX=CallExternalPython -DOMC_NUM_MIXED_SYSTEMS=0 -DOMC_NUM_LINEAR_SYSTEMS=0 -DOMC_NUM_NONLINEAR_SYSTEMS=0 -DOMC_NDELAY_EXPRESSIONS=0 -DOMC_NVAR_STRING=0  -c -o CallExternalPython_records.o CallExternalPython_records.c

clang  -Os -DOM_HAVE_PTHREADS -fPIC -falign-functions -mfpmath=sse -fno-dollars-in-identifiers -Wno-parentheses-equality     -I"«OPENMODELICAHOME»/include/omc/c" -I"«OPENMODELICAHOME»/include/omc" -I. -DOPENMODELICA_XML_FROM_FILE_AT_RUNTIME -DOMC_MODEL_PREFIX=CallExternalPython -DOMC_NUM_MIXED_SYSTEMS=0 -DOMC_NUM_LINEAR_SYSTEMS=0 -DOMC_NUM_NONLINEAR_SYSTEMS=0 -DOMC_NDELAY_EXPRESSIONS=0 -DOMC_NVAR_STRING=0  -c -o CallExternalPython_01exo.o CallExternalPython_01exo.c

clang  -Os -DOM_HAVE_PTHREADS -fPIC -falign-functions -mfpmath=sse -fno-dollars-in-identifiers -Wno-parentheses-equality     -I"«OPENMODELICAHOME»/include/omc/c" -I"«OPENMODELICAHOME»/include/omc" -I. -DOPENMODELICA_XML_FROM_FILE_AT_RUNTIME -DOMC_MODEL_PREFIX=CallExternalPython -DOMC_NUM_MIXED_SYSTEMS=0 -DOMC_NUM_LINEAR_SYSTEMS=0 -DOMC_NUM_NONLINEAR_SYSTEMS=0 -DOMC_NDELAY_EXPRESSIONS=0 -DOMC_NVAR_STRING=0  -c -o CallExternalPython_02nls.o CallExternalPython_02nls.c

clang  -Os -DOM_HAVE_PTHREADS -fPIC -falign-functions -mfpmath=sse -fno-dollars-in-identifiers -Wno-parentheses-equality     -I"«OPENMODELICAHOME»/include/omc/c" -I"«OPENMODELICAHOME»/include/omc" -I. -DOPENMODELICA_XML_FROM_FILE_AT_RUNTIME -DOMC_MODEL_PREFIX=CallExternalPython -DOMC_NUM_MIXED_SYSTEMS=0 -DOMC_NUM_LINEAR_SYSTEMS=0 -DOMC_NUM_NONLINEAR_SYSTEMS=0 -DOMC_NDELAY_EXPRESSIONS=0 -DOMC_NVAR_STRING=0  -c -o CallExternalPython_03lsy.o CallExternalPython_03lsy.c

clang  -Os -DOM_HAVE_PTHREADS -fPIC -falign-functions -mfpmath=sse -fno-dollars-in-identifiers -Wno-parentheses-equality     -I"«OPENMODELICAHOME»/include/omc/c" -I"«OPENMODELICAHOME»/include/omc" -I. -DOPENMODELICA_XML_FROM_FILE_AT_RUNTIME -DOMC_MODEL_PREFIX=CallExternalPython -DOMC_NUM_MIXED_SYSTEMS=0 -DOMC_NUM_LINEAR_SYSTEMS=0 -DOMC_NUM_NONLINEAR_SYSTEMS=0 -DOMC_NDELAY_EXPRESSIONS=0 -DOMC_NVAR_STRING=0  -c -o CallExternalPython_04set.o CallExternalPython_04set.c

clang  -Os -DOM_HAVE_PTHREADS -fPIC -falign-functions -mfpmath=sse -fno-dollars-in-identifiers -Wno-parentheses-equality     -I"«OPENMODELICAHOME»/include/omc/c" -I"«OPENMODELICAHOME»/include/omc" -I. -DOPENMODELICA_XML_FROM_FILE_AT_RUNTIME -DOMC_MODEL_PREFIX=CallExternalPython -DOMC_NUM_MIXED_SYSTEMS=0 -DOMC_NUM_LINEAR_SYSTEMS=0 -DOMC_NUM_NONLINEAR_SYSTEMS=0 -DOMC_NDELAY_EXPRESSIONS=0 -DOMC_NVAR_STRING=0  -c -o CallExternalPython_05evt.o CallExternalPython_05evt.c

clang  -Os -DOM_HAVE_PTHREADS -fPIC -falign-functions -mfpmath=sse -fno-dollars-in-identifiers -Wno-parentheses-equality     -I"«OPENMODELICAHOME»/include/omc/c" -I"«OPENMODELICAHOME»/include/omc" -I. -DOPENMODELICA_XML_FROM_FILE_AT_RUNTIME -DOMC_MODEL_PREFIX=CallExternalPython -DOMC_NUM_MIXED_SYSTEMS=0 -DOMC_NUM_LINEAR_SYSTEMS=0 -DOMC_NUM_NONLINEAR_SYSTEMS=0 -DOMC_NDELAY_EXPRESSIONS=0 -DOMC_NVAR_STRING=0  -c -o CallExternalPython_06inz.o CallExternalPython_06inz.c

clang  -Os -DOM_HAVE_PTHREADS -fPIC -falign-functions -mfpmath=sse -fno-dollars-in-identifiers -Wno-parentheses-equality     -I"«OPENMODELICAHOME»/include/omc/c" -I"«OPENMODELICAHOME»/include/omc" -I. -DOPENMODELICA_XML_FROM_FILE_AT_RUNTIME -DOMC_MODEL_PREFIX=CallExternalPython -DOMC_NUM_MIXED_SYSTEMS=0 -DOMC_NUM_LINEAR_SYSTEMS=0 -DOMC_NUM_NONLINEAR_SYSTEMS=0 -DOMC_NDELAY_EXPRESSIONS=0 -DOMC_NVAR_STRING=0  -c -o CallExternalPython_07dly.o CallExternalPython_07dly.c

clang  -Os -DOM_HAVE_PTHREADS -fPIC -falign-functions -mfpmath=sse -fno-dollars-in-identifiers -Wno-parentheses-equality     -I"«OPENMODELICAHOME»/include/omc/c" -I"«OPENMODELICAHOME»/include/omc" -I. -DOPENMODELICA_XML_FROM_FILE_AT_RUNTIME -DOMC_MODEL_PREFIX=CallExternalPython -DOMC_NUM_MIXED_SYSTEMS=0 -DOMC_NUM_LINEAR_SYSTEMS=0 -DOMC_NUM_NONLINEAR_SYSTEMS=0 -DOMC_NDELAY_EXPRESSIONS=0 -DOMC_NVAR_STRING=0  -c -o CallExternalPython_08bnd.o CallExternalPython_08bnd.c

clang  -Os -DOM_HAVE_PTHREADS -fPIC -falign-functions -mfpmath=sse -fno-dollars-in-identifiers -Wno-parentheses-equality     -I"«OPENMODELICAHOME»/include/omc/c" -I"«OPENMODELICAHOME»/include/omc" -I. -DOPENMODELICA_XML_FROM_FILE_AT_RUNTIME -DOMC_MODEL_PREFIX=CallExternalPython -DOMC_NUM_MIXED_SYSTEMS=0 -DOMC_NUM_LINEAR_SYSTEMS=0 -DOMC_NUM_NONLINEAR_SYSTEMS=0 -DOMC_NDELAY_EXPRESSIONS=0 -DOMC_NVAR_STRING=0  -c -o CallExternalPython_09alg.o CallExternalPython_09alg.c

clang  -Os -DOM_HAVE_PTHREADS -fPIC -falign-functions -mfpmath=sse -fno-dollars-in-identifiers -Wno-parentheses-equality     -I"«OPENMODELICAHOME»/include/omc/c" -I"«OPENMODELICAHOME»/include/omc" -I. -DOPENMODELICA_XML_FROM_FILE_AT_RUNTIME -DOMC_MODEL_PREFIX=CallExternalPython -DOMC_NUM_MIXED_SYSTEMS=0 -DOMC_NUM_LINEAR_SYSTEMS=0 -DOMC_NUM_NONLINEAR_SYSTEMS=0 -DOMC_NDELAY_EXPRESSIONS=0 -DOMC_NVAR_STRING=0  -c -o CallExternalPython_10asr.o CallExternalPython_10asr.c

clang  -Os -DOM_HAVE_PTHREADS -fPIC -falign-functions -mfpmath=sse -fno-dollars-in-identifiers -Wno-parentheses-equality     -I"«OPENMODELICAHOME»/include/omc/c" -I"«OPENMODELICAHOME»/include/omc" -I. -DOPENMODELICA_XML_FROM_FILE_AT_RUNTIME -DOMC_MODEL_PREFIX=CallExternalPython -DOMC_NUM_MIXED_SYSTEMS=0 -DOMC_NUM_LINEAR_SYSTEMS=0 -DOMC_NUM_NONLINEAR_SYSTEMS=0 -DOMC_NDELAY_EXPRESSIONS=0 -DOMC_NVAR_STRING=0  -c -o CallExternalPython_11mix.o CallExternalPython_11mix.c

clang  -Os -DOM_HAVE_PTHREADS -fPIC -falign-functions -mfpmath=sse -fno-dollars-in-identifiers -Wno-parentheses-equality     -I"«OPENMODELICAHOME»/include/omc/c" -I"«OPENMODELICAHOME»/include/omc" -I. -DOPENMODELICA_XML_FROM_FILE_AT_RUNTIME -DOMC_MODEL_PREFIX=CallExternalPython -DOMC_NUM_MIXED_SYSTEMS=0 -DOMC_NUM_LINEAR_SYSTEMS=0 -DOMC_NUM_NONLINEAR_SYSTEMS=0 -DOMC_NDELAY_EXPRESSIONS=0 -DOMC_NVAR_STRING=0  -c -o CallExternalPython_12jac.o CallExternalPython_12jac.c

clang  -Os -DOM_HAVE_PTHREADS -fPIC -falign-functions -mfpmath=sse -fno-dollars-in-identifiers -Wno-parentheses-equality     -I"«OPENMODELICAHOME»/include/omc/c" -I"«OPENMODELICAHOME»/include/omc" -I. -DOPENMODELICA_XML_FROM_FILE_AT_RUNTIME -DOMC_MODEL_PREFIX=CallExternalPython -DOMC_NUM_MIXED_SYSTEMS=0 -DOMC_NUM_LINEAR_SYSTEMS=0 -DOMC_NUM_NONLINEAR_SYSTEMS=0 -DOMC_NDELAY_EXPRESSIONS=0 -DOMC_NVAR_STRING=0  -c -o CallExternalPython_13opt.o CallExternalPython_13opt.c

clang  -Os -DOM_HAVE_PTHREADS -fPIC -falign-functions -mfpmath=sse -fno-dollars-in-identifiers -Wno-parentheses-equality     -I"«OPENMODELICAHOME»/include/omc/c" -I"«OPENMODELICAHOME»/include/omc" -I. -DOPENMODELICA_XML_FROM_FILE_AT_RUNTIME -DOMC_MODEL_PREFIX=CallExternalPython -DOMC_NUM_MIXED_SYSTEMS=0 -DOMC_NUM_LINEAR_SYSTEMS=0 -DOMC_NUM_NONLINEAR_SYSTEMS=0 -DOMC_NDELAY_EXPRESSIONS=0 -DOMC_NVAR_STRING=0  -c -o CallExternalPython_14lnz.o CallExternalPython_14lnz.c

clang  -Os -DOM_HAVE_PTHREADS -fPIC -falign-functions -mfpmath=sse -fno-dollars-in-identifiers -Wno-parentheses-equality     -I"«OPENMODELICAHOME»/include/omc/c" -I"«OPENMODELICAHOME»/include/omc" -I. -DOPENMODELICA_XML_FROM_FILE_AT_RUNTIME -DOMC_MODEL_PREFIX=CallExternalPython -DOMC_NUM_MIXED_SYSTEMS=0 -DOMC_NUM_LINEAR_SYSTEMS=0 -DOMC_NUM_NONLINEAR_SYSTEMS=0 -DOMC_NDELAY_EXPRESSIONS=0 -DOMC_NVAR_STRING=0  -c -o CallExternalPython_15syn.o CallExternalPython_15syn.c

clang  -Os -DOM_HAVE_PTHREADS -fPIC -falign-functions -mfpmath=sse -fno-dollars-in-identifiers -Wno-parentheses-equality     -I"«OPENMODELICAHOME»/include/omc/c" -I"«OPENMODELICAHOME»/include/omc" -I. -DOPENMODELICA_XML_FROM_FILE_AT_RUNTIME -DOMC_MODEL_PREFIX=CallExternalPython -DOMC_NUM_MIXED_SYSTEMS=0 -DOMC_NUM_LINEAR_SYSTEMS=0 -DOMC_NUM_NONLINEAR_SYSTEMS=0 -DOMC_NDELAY_EXPRESSIONS=0 -DOMC_NVAR_STRING=0  -c -o CallExternalPython_16dae.o CallExternalPython_16dae.c

clang  -Os -DOM_HAVE_PTHREADS -fPIC -falign-functions -mfpmath=sse -fno-dollars-in-identifiers -Wno-parentheses-equality     -I"«OPENMODELICAHOME»/include/omc/c" -I"«OPENMODELICAHOME»/include/omc" -I. -DOPENMODELICA_XML_FROM_FILE_AT_RUNTIME -DOMC_MODEL_PREFIX=CallExternalPython -DOMC_NUM_MIXED_SYSTEMS=0 -DOMC_NUM_LINEAR_SYSTEMS=0 -DOMC_NUM_NONLINEAR_SYSTEMS=0 -DOMC_NDELAY_EXPRESSIONS=0 -DOMC_NVAR_STRING=0  -c -o CallExternalPython_17inl.o CallExternalPython_17inl.c

clang  -Os -DOM_HAVE_PTHREADS -fPIC -falign-functions -mfpmath=sse -fno-dollars-in-identifiers -Wno-parentheses-equality     -I"«OPENMODELICAHOME»/include/omc/c" -I"«OPENMODELICAHOME»/include/omc" -I. -DOPENMODELICA_XML_FROM_FILE_AT_RUNTIME -DOMC_MODEL_PREFIX=CallExternalPython -DOMC_NUM_MIXED_SYSTEMS=0 -DOMC_NUM_LINEAR_SYSTEMS=0 -DOMC_NUM_NONLINEAR_SYSTEMS=0 -DOMC_NDELAY_EXPRESSIONS=0 -DOMC_NVAR_STRING=0  -c -o CallExternalPython_18spd.o CallExternalPython_18spd.c

In file included from CallExternalPython_functions.c:7:

./CallExternalPython_includes.h:8:10: fatal error: 'Python.h' file not found

#include <Python.h>

         ^~~~~~~~~~

1 error generated.

make[1]: *** [<builtin>: CallExternalPython_functions.o] Error 1

make[1]: *** Waiting for unfinished jobs....

make[1]: Leaving directory '«DOCHOME»'







Calling OpenModelica from Python Code

This section describes a simple-minded approach to calling Python code
from OpenModelica. For a description of Python scripting with
OpenModelica, see OMPython - OpenModelica Python Interface.

The interaction with Python can be perfomed in four different ways
whereas one is illustrated below. Assume that we have the following
Modelica code:


Listing 13 CalledbyPython.mo

model CalledbyPython
  Real x(start=1.0), y(start=2.0);
  parameter Real b = 2.0;
equation
  der(x) = -b*y;
  der(y) = x;
end CalledbyPython;







In the following Python (.py) files the above Modelica model is
simulated via the OpenModelica scripting interface:


Listing 14 PythonCaller.py

#!/usr/bin/python
import sys,os
global newb = 0.5
execfile('CreateMosFile.py')
os.popen(r"omc CalledbyPython.mos").read()
execfile('RetrResult.py')








Listing 15 CreateMosFile.py

#!/usr/bin/python
mos_file = open('CalledbyPython.mos','w', 1)
mos_file.write('loadFile("CalledbyPython.mo");\n')
mos_file.write('setComponentModifierValue(CalledbyPython,b,$Code(="+str(newb)+"));\n')
mos_file.write('simulate(CalledbyPython,stopTime=10);\n')
mos_file.close()








Listing 16 RetrResult.py

#!/usr/bin/python
def zeros(n): #
  vec = [0.0]
  for i in range(int(n)-1): vec = vec + [0.0]
  return vec
res_file = open("CalledbyPython_res.plt",'r',1)
line = res_file.readline()
size = int(res_file.readline().split('=')[1])
time = zeros(size)
y = zeros(size)
while line != ['DataSet: time\\n']:
  line = res_file.readline().split(',')[0:1]
for j in range(int(size)):
  time[j]=float(res\_file.readline().split(',')[0])
while line != ['DataSet: y\\n']:
  line=res_file.readline().split(',')[0:1]
for j in range(int(size)):
  y[j]=float(res\_file.readline().split(',')[1])
res_file.close()







A second option of simulating the above Modelica model is to use the
command buildModel instead of the simulate command and setting the
parameter value in the initial parameter file, CalledbyPython_init.txt
instead of using the command setComponentModifierValue. Then the file
CalledbyPython.exe is just executed.

The third option is to use the Corba interface for invoking the compiler
and then just use the scripting interface to send commands to the
compiler via this interface.

The fourth variant is to use external function calls to directly
communicate with the executing simulation process.
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OpenModelica Python Interface

This chapter describes the OpenModelica Python integration facilities.


	OMPython - the OpenModelica Python scripting interface, see OMPython - OpenModelica Python Interface.


	EnhancedOMPython - Enhanced OMPython scripting interface, see Enhanced OMPython Features.





OMPython - OpenModelica Python Interface

OMPython - OpenModelica Python API is a free, open source, highly
portable Python based interactive session handler for Modelica
scripting. It provides the modeler with components for creating a
complete Modelica modeling, compilation and simulation environment based
on the latest OpenModelica library standard available. OMPython is
architectured to combine both the solving strategy and model building.
So domain experts (people writing the models) and computational
engineers (people writing the solver code) can work on one unified tool
that is industrially viable for optimization of Modelica models, while
offering a flexible platform for algorithm development and research.
OMPython is not a standalone package, it depends upon the
OpenModelica installation.

OMPython is implemented in Python and depends on ZeroMQ - high performance asynchronous
messaging library.

To install OMPython follow the instructions at https://github.com/OpenModelica/OMPython


Features of OMPython

OMPython provides user friendly features like:


	Interactive session handling, parsing, interpretation of commands and
Modelica expressions for evaluation, simulation, plotting, etc.


	Interface to the latest OpenModelica API calls.


	Optimized parser results that give control over every element of the output.


	Helper functions to allow manipulation on Nested dictionaries.


	Easy access to the library and testing of OpenModelica commands.






Test Commands

OMPython provides a OMCSessionZMQ class that uses ZeroMQ to communicate with OpenModelica.

To test the command outputs, simply create an OMCSessionZMQ object by
importing from the OMPython library within Python interepreter. The
module allows you to interactively send commands to the OMC server and
display their output.

To get started, create an OMCSessionZMQ object:

>>> from OMPython import OMCSessionZMQ
>>> omc = OMCSessionZMQ()





>>> omc.sendExpression("getVersion()")
OMCompiler v1.27.0-dev.202+g0e2053de263
>>> omc.sendExpression("cd()")
«DOCHOME»
>>> omc.sendExpression("loadModel(Modelica)")
True
>>> omc.sendExpression("loadFile(getInstallationDirectoryPath() + \"/share/doc/omc/testmodels/BouncingBall.mo\")")
True
>>> omc.sendExpression("instantiateModel(BouncingBall)")
class BouncingBall
  parameter Real e = 0.7 "coefficient of restitution";
  parameter Real g = 9.81 "gravity acceleration";
  Real h(start = 1.0, fixed = true) "height of ball";
  Real v(fixed = true) "velocity of ball";
  Boolean flying(start = true, fixed = true) "true, if ball is flying";
  Boolean impact;
  Real v_new(fixed = true);
  Integer foo;
equation
  impact = h <= 0.0;
  foo = if impact then 1 else 2;
  der(v) = if flying then -g else 0.0;
  der(h) = v;
  when {h <= 0.0 and v <= 0.0, impact} then
    v_new = if edge(impact) then -e * pre(v) else 0.0;
    flying = v_new > 0.0;
    reinit(v, v_new);
  end when;
end BouncingBall;





We get the name and other properties of a class:

>>> omc.sendExpression("getClassNames()")
('BouncingBall', 'ModelicaServices', 'Complex', 'Modelica')
>>> omc.sendExpression("isPartial(BouncingBall)")
False
>>> omc.sendExpression("isPackage(BouncingBall)")
False
>>> omc.sendExpression("isModel(BouncingBall)")
True
>>> omc.sendExpression("checkModel(BouncingBall)")
Check of BouncingBall completed successfully.
Class BouncingBall has 6 equation(s) and 6 variable(s).
1 of these are trivial equation(s).
>>> omc.sendExpression("getClassRestriction(BouncingBall)")
model
>>> omc.sendExpression("getClassInformation(BouncingBall)")
('model', '', False, False, False, '/var/lib/jenkins/ws/OpenModelica_PR-15165/build/share/doc/omc/testmodels/BouncingBall.mo', False, 1, 1, 23, 17, (), False, False, '', '', False, '', '', '', '', '')
>>> omc.sendExpression("getConnectionCount(BouncingBall)")
0
>>> omc.sendExpression("getInheritanceCount(BouncingBall)")
0
>>> omc.sendExpression("getComponentModifierValue(BouncingBall,e)")
0.7
>>> omc.sendExpression("checkSettings()")
{'OPENMODELICAHOME': '«OPENMODELICAHOME»', 'OPENMODELICALIBRARY': '«OPENMODELICAHOME»/lib/omlibrary', 'OMC_PATH': '«OPENMODELICAHOME»/bin/omc', 'SYSTEM_PATH': '/var/lib/jenkins/ws/OpenModelica_PR-15165/build/bin:/usr/local/sbin:/usr/local/bin:/usr/sbin:/usr/bin:/sbin:/bin', 'OMDEV_PATH': '', 'OMC_FOUND': True, 'MODELICAUSERCFLAGS': '', 'WORKING_DIRECTORY': '«DOCHOME»', 'CREATE_FILE_WORKS': True, 'REMOVE_FILE_WORKS': True, 'OS': 'linux', 'SYSTEM_INFO': 'Linux 57a3ee987845 5.15.0-91-generic #101-Ubuntu SMP Tue Nov 14 13:30:08 UTC 2023 x86_64 x86_64 x86_64 GNU/Linux\n', 'RTLIBS': ' -Wl,--no-as-needed -Wl,--disable-new-dtags -lOpenModelicaRuntimeC -llapack -lblas -lm -lomcgc -lryu -lpthread -rdynamic', 'C_COMPILER': 'clang', 'C_COMPILER_VERSION': 'Ubuntu clang version 14.0.0-1ubuntu1.1\nTarget: x86_64-pc-linux-gnu\nThread model: posix\nInstalledDir: /usr/bin\n', 'C_COMPILER_RESPONDING': True, 'HAVE_CORBA': True, 'CONFIGURE_CMDLINE': "Configured 2026-03-06 08:15:12 using arguments:  '--disable-option-checking' '--prefix=/var/lib/jenkins1/ws/OpenModelica_PR-15165/install' 'CC=clang' 'CXX=clang++' 'FC=gfortran' 'CFLAGS=-Os' '--with-cppruntime' '--without-omc' '--without-omlibrary' '--with-omniORB' '--enable-modelica3d' '--without-hwloc' '--with-ombuilddir=/var/lib/jenkins1/ws/OpenModelica_PR-15165/build' '--cache-file=/dev/null' '--srcdir=.'"}





The common combination of a simulation followed by getting a value and
doing a plot:

>>> omc.sendExpression("simulate(BouncingBall, stopTime=3.0)")
{'resultFile': '«DOCHOME»/BouncingBall_res.mat', 'simulationOptions': "startTime = 0.0, stopTime = 3.0, numberOfIntervals = 500, tolerance = 1e-6, method = 'dassl', fileNamePrefix = 'BouncingBall', options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = ''", 'messages': 'LOG_SUCCESS       | info    | The initialization finished successfully without homotopy method.\nLOG_SUCCESS       | info    | The simulation finished successfully.\n', 'timeFrontend': 0.058502993, 'timeBackend': 0.0021702310000000003, 'timeSimCode': 0.000634798, 'timeTemplates': 0.0017710730000000002, 'timeCompile': 0.22949438200000002, 'timeSimulation': 0.007563511, 'timeTotal': 0.300225834}
>>> omc.sendExpression("val(h , 2.0)")
0.04239430772884106






Import As Library

To use the module from within another python program, simply import
OMCSessionZMQ from within the using program.

For example:

# test.py
from OMPython import OMCSessionZMQ
omc = OMCSessionZMQ()
cmds = [
  'loadFile(getInstallationDirectoryPath() + "/share/doc/omc/testmodels/BouncingBall.mo")',
  "simulate(BouncingBall)",
  "plot(h)"
  ]
for cmd in cmds:
  answer = omc.sendExpression(cmd)
  print("\n{}:\n{}".format(cmd, answer))








Implementation


Client Implementation

The OpenModelica Python API Interface - OMPython, attempts to mimic the
OMShell's style of operations.

OMPython is designed to,


	Initialize the ZeroMQ communication.


	Send commands to the OMC server via the ZeroMQ interface.


	Receive the string results.


	Use the Parser module to format the results.


	Return or display the results.








Enhanced OMPython Features

Some more improvements are added to OMPython functionality for querying more information about the models
and simulate them. A list of new user friendly API functionality allows user to extract information about models using python
objects. A list of API functionality is described below.

To get started, create a ModelicaSystem object:

>>> from OMPython import OMCSessionZMQ
>>> omc = OMCSessionZMQ()
>>> model_path=omc.sendExpression("getInstallationDirectoryPath()") + "/share/doc/omc/testmodels/"
>>> from OMPython import ModelicaSystem
>>> mod=ModelicaSystem(model_path + "BouncingBall.mo","BouncingBall")





The object constructor requires a minimum of 2 input arguments which are strings, and may need a third string input argument.


	The first input argument must be a string with the file name of the Modelica code, with Modelica file extension ".mo".
If the Modelica file is not in the current directory of Python, then the file path must also be included.


	The second input argument must be a string with the name of the Modelica model
including the namespace if the model is wrapped within a Modelica package.


	The third input argument (optional) is used to specify the list of dependent libraries or dependent Modelica files e.g.,




>>> mod=ModelicaSystem(model_path + "BouncingBall.mo","BouncingBall",["Modelica"])






	The fourth input argument (optional), is a keyword argument which is used to set the command line options e.g.,




>>> mod=ModelicaSystem(model_path + "BouncingBall.mo","BouncingBall",commandLineOptions="-d=newInst")






BuildModel

The buildModel API can be used after ModelicaSystem(), in case the model needs to be updated or additional simulationflags needs to be set using sendExpression()

>>> mod.buildModel()







Standard get methods


	getQuantities()


	getContinuous()


	getInputs()


	getOutputs()


	getParameters()


	getSimulationOptions()


	getSolutions()




Three calling possibilities are accepted using getXXX() where "XXX" can be any of the above functions (eg:) getParameters().


	getXXX() without input argument, returns a dictionary with names as keys and values as values.


	getXXX(S), where S is a string of names.


	getXXX(["S1","S2"]) where S1 and S1 are list of string elements






Usage of getMethods

>>> mod.getQuantities() // method-1, list of all variables from xml file
[{'aliasvariable': None, 'Name': 'height', 'Variability': 'continuous', 'Value': '1.0', 'alias': 'noAlias', 'Changeable': 'true', 'Description': None}, {'aliasvariable': None, 'Name': 'c', 'Variability': 'parameter', 'Value': '0.9', 'alias': 'noAlias', 'Changeable': 'true', 'Description': None}]





>>> mod.getQuantities("height") // method-2, to query information about single quantity
[{'aliasvariable': None, 'Name': 'height', 'Variability': 'continuous', 'Value': '1.0', 'alias': 'noAlias', 'Changeable': 'true', 'Description': None}]





>>> mod.getQuantities(["c","radius"]) // method-3, to query information about list of quantity
[{'aliasvariable': None, 'Name': 'c', 'Variability': 'parameter', 'Value': '0.9', 'alias': 'noAlias', 'Changeable': 'true', 'Description': None}, {'aliasvariable': None, 'Name': 'radius', 'Variability': 'parameter', 'Value': '0.1', 'alias': 'noAlias', 'Changeable': 'true', 'Description': None}]





>>> mod.getContinuous() // method-1, list of continuous variable
{'velocity': -1.825929609047952, 'der(velocity)': -9.8100000000000005, 'der(height)': -1.825929609047952, 'height': 0.65907039052943617}





>>> mod.getContinuous(["velocity","height"]) // method-2, get specific variable value information
(-1.825929609047952, 0.65907039052943617)





>>> mod.getInputs()
{}





>>>  mod.getOutputs()
{}





>>> mod.getParameters()  // method-1
{'c': 0.9, 'radius': 0.1}





>>> mod.getParameters(["c","radius"]) // method-2
[0.9, 0.1]





>>> mod.getSimulationOptions()  // method-1
{'stepSize': 0.002, 'stopTime': 1.0, 'tolerance': 1e-06, 'startTime': 0.0, 'solver': 'dassl'}





>>> mod.getSimulationOptions(["stepSize","tolerance"]) // method-2
[0.002, 1e-06]






	The getSolution method can be used in two different ways.
	
	using default result filename


	use the result filenames provided by user








This provides a way to compare simulation results and perform regression testing

>>> mod.getSolutions() // method-1 returns list of simulation variables for which results are available
['time', 'height', 'velocity', 'der(height)', 'der(velocity)', 'c', 'radius']





>>> mod.getSolutions(["time","height"])  // return list of numpy arrays





>>> mod.getSolutions(resultfile="c:/tmpbouncingBall.mat") // method-2 returns list of simulation variables for which results are available , the resulfile location is provided by user





>>> mod.getSolutions(["time","height"],resultfile="c:/tmpbouncingBall.mat") // return list of array







Standard set methods


	setInputs()


	setParameters()


	setSimulationOptions()




Two setting possibilities are accepted using setXXXs(),where "XXX" can be any of above functions.


	setXXX("Name=value") string of keyword assignments


	setXXX(["Name1=value1","Name2=value2","Name3=value3"])  list of string of keyword assignments






Usage of setMethods

>>> mod.setInputs(["cAi=1","Ti=2"]) // method-2





>>> mod.setParameters("radius=14") // method-1 setting parameter value





>>> mod.setParameters(["radius=14","c=0.5"]) // method-2 setting parameter value using second option





>>> mod.setSimulationOptions(["stopTime=2.0","tolerance=1e-08"]) // method-2







Simulation

An example of how to get parameter names and change the value of parameters using set methods and finally simulate the  "BouncingBall.mo" model is given below.

>>>  mod.getParameters()
{'c': 0.9, 'radius': 0.1}





>>>  mod.setParameters(["radius=14","c=0.5"]) //setting parameter value





To check whether new values are updated to model , we can again query the getParameters().

>>> mod.getParameters()
{'c': 0.5, 'radius': 14}






	The model can be simulated using the simulate API in the following ways,
	
	without any arguments


	resultfile (keyword argument) - (only filename is allowed and not the location)


	simargs (keyword argument) - runtime simulationflags supported by OpenModelica








>>> mod.simulate() // method-1 default result file name will be used
>>> mod.simulate(resultfile="tmpbouncingBall.mat")  // method-2 resultfile name provided by users
>>> mod.simulate(simargs={"noEventEmit": None, "noRestart": None, "override": {"e": 0.3, "g": 10}}) // method-3 simulationflags provided by users







Linearization

The following methods are proposed for linearization.


	linearize()


	getLinearizationOptions()


	setLinearizationOptions()


	getLinearInputs()


	getLinearOutputs()


	getLinearStates()






Usage of Linearization methods

>>> mod.getLinearizationOptions()  // method-1
{'simflags': ' ', 'stepSize': 0.002, 'stopTime': 1.0, 'startTime': 0.0, 'numberOfIntervals': 500.0, 'tolerance': 1e-08}





>>> mod.getLinearizationOptions("startTime","stopTime") // method-2
[0.0, 1.0]





>>> mod.setLinearizationOptions(["stopTime=2.0","tolerance=1e-06"])





>>> mod.linearize()  //returns a tuple of 2D numpy arrays (matrices) A, B, C and D.





>>> mod.getLinearInputs()  //returns a list of strings of names of inputs used when forming matrices.





>>> mod.getLinearOutputs() //returns a list of strings of names of outputs used when forming matrices





>>> mod.getLinearStates() // returns a list of strings of names of states used when forming matrices.
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OMMatlab - OpenModelica Matlab Interface

OMMatlab - the OpenModelica Matlab API is a free, open source, highly
portable Matlab-based interactive session handler for Modelica
scripting. It provides the modeler with components for creating a
complete Modelica modeling, compilation and simulation environment based
on the latest OpenModelica library standard available. OMMatlab is
architectured to combine both the solving strategy and model building.
So domain experts (people writing the models) and computational
engineers (people writing the solver code) can work on one unified tool
that is industrially viable for optimization of Modelica models, while
offering a flexible platform for algorithm development and research.
OMMatlab is not a standalone package, it depends upon the
OpenModelica installation.

OMMatlab is implemented in Matlab and depends on
ZeroMQ - high performance asynchronous
messaging library and it supports the Modelica
Standard Library version 3.2 that is included in starting with
OpenModelica 1.9.2.

To install OMMatlab follow the instructions at https://github.com/OpenModelica/OMMatlab


Features of OMMatlab

The OMMatlab package contains the following features:


	Import the OMMatlab package in Matlab


	Connect with the OpenModelica compiler through zmq sockets


	Able to interact with the OpenModelica compiler through the available API


	All the API calls are communicated with the help of the sendExpression method implemented in a Matlab pacakge


	The results are returned as strings






Test Commands

To get started, create a OMMatlab session object:

>>> import OMMatlab.*
>>> omc= OMMatlab()
>>> omc.sendExpression("getVersion()")
'v1.13.0-dev-531-gde26b558a (64-bit)'
>>> omc.sendExpression("loadModel(Modelica)")
'true'
>>> omc.sendExpression("model a Real s; equation s=sin(10*time); end a;")
'{a}'
>>> omc.sendExpression("simulate(a)")
>>> omc.sendExpression("plot(s)")
'true'






[image: _images/sineplot.png]


Advanced OMMatlab Features

OMMatlab package has advanced functionality for querying more information about the models
and simulate them. A list of new user friendly API functionality allows user to extract information about models using matlab
objects. A list of API functionality is described below.

To get started, create a ModelicaSystem object:

>>> import OMMatlab.*
>>> omc= OMMatlab()
>>> omc.ModelicaSystem("BouncingBall.mo","BouncingBall")





The object constructor requires a minimum of 2 input arguments which are strings, and third input argument which is optional .


	The first input argument must be a string with the file name of the Modelica code, with Modelica file extension ".mo".
If the Modelica file is not in the current directory, then the file path must also be included.


	The second input argument must be a string with the name of the Modelica model
including the namespace if the model is wrapped within a Modelica package.


	The third input argument (optional) is used to specify the list of dependent libraries or dependent Modelica files
The argument can be passed as a string or array of strings e.g.,




>>> omc.ModelicaSystem("BouncingBall.mo","BouncingBall",["Modelica", "SystemDynamics", "dcmotor.mo"])






	The fourth input argument (optional), which is used to set the command line options e.g.,




>>> omc.ModelicaSystem("BouncingBall.mo","BouncingBall",["Modelica", "SystemDynamics", "dcmotor.mo"],"-d=newInst")





Matlab does not support keyword arguments, and hence inorder to skip an argument, empty list should be used "[]" e.g.,

>>> omc.ModelicaSystem("BouncingBall.mo","BouncingBall",[],"-d=newInst")








WorkDirectory

For each Matlab session a temporary work directory is created and the results are published in that working directory, Inorder to get the workdirectory the users can
use the following API

>>> omc.getWorkDirectory()
'C:/Users/arupa54/AppData/Local/Temp/tp7dd648e5_5de6_4f66_b3d6_90bce1fe1d58'







BuildModel

The buildModel API can be used after ModelicaSystem(), in case the model needs to be updated or additional simulationflags needs to be set using sendExpression()

>>> omc.buildModel()







Standard get methods


	getQuantities()


	showQuantities()


	getContinuous()


	getInputs()


	getOutputs()


	getParameters()


	getSimulationOptions()


	getSolutions()




Three calling possibilities are accepted using getXXX() where "XXX" can be any of the above functions (eg:) getParameters().


	getXXX() without input argument, returns a dictionary with names as keys and values as values.


	getXXX(S), where S is a string of names.


	getXXX(["S1","S2"]) where S1 and S1 are array of string elements






Usage of getMethods

>>> omc.getQuantities() // method-1, list of all variables from xml file
+----------+------------+-------------------------+--------------+------------+-----------+---------------+-------+
| name     | changeable | description             | variability  | causality  | alias     | aliasVariable | value |
+----------+------------+-------------------------+--------------+------------+-----------+---------------+-------+
| 'h'      | 'true'     | 'height of ball'        | 'continuous' | 'internal' | 'noAlias' | ''            | '1.0' |
+----------+------------+-------------------------+--------------+------------+-----------+---------------+-------+
| 'v'      | 'true'     | 'velocity of ball'      | 'continuous' | 'internal' | 'noAlias' | ''            | ''    |
+----------+------------+-------------------------+--------------+------------+-----------+---------------+-------+
| 'der(h)' | 'false'    | 'der(height of ball)'   | 'continuous' | 'internal' | 'noAlias' | ''            | ''    |
+----------+------------+-------------------------+--------------+------------+-----------+---------------+-------+
| 'der(v)' | 'false'    | 'der(velocity of ball)' | 'continuous' | 'internal' | 'noAlias' | ''            | ''    |
+----------+------------+-------------------------+--------------+------------+-----------+---------------+-------+





>>> omc.getQuantities("h") // method-2, to query information about single quantity
+----------+------------+-------------------------+--------------+------------+-----------+---------------+-------+
| name     | changeable | description             | variability  | causality  | alias     | aliasVariable | value |
+----------+------------+-------------------------+--------------+------------+-----------+---------------+-------+
| 'h'      | 'true'     | 'height of ball'        | 'continuous' | 'internal' | 'noAlias' | ''            | '1.0' |
+----------+------------+-------------------------+--------------+------------+-----------+---------------+-------+





>>> omc.getQuantities(["h","v"]) // method-3, to query information about list of quantity
+----------+------------+-------------------------+--------------+------------+-----------+---------------+-------+
| name     | changeable | description             | variability  | causality  | alias     | aliasVariable | value |
+----------+------------+-------------------------+--------------+------------+-----------+---------------+-------+
| 'h'      | 'true'     | 'height of ball'        | 'continuous' | 'internal' | 'noAlias' | ''            | '1.0' |
+----------+------------+-------------------------+--------------+------------+-----------+---------------+-------+
| 'v'      | 'true'     | 'velocity of ball'      | 'continuous' | 'internal' | 'noAlias' | ''            | ''    |
+----------+------------+-------------------------+--------------+------------+-----------+---------------+-------+





>>> omc.getContinuous() // method-1, returns struct of continuous variable
struct with fields:
  h     : '1.0'
  v     : ''
  der_h_: ''
  der_v_: ''





>>> omc.getContinuous(["h","v"])   // method-2, returns string array
"1.0"    ""





>>> omc.getInputs()
struct with no fields





>>> omc.getOutputs()
struct with no fields





>>> omc.getParameters()  // method-1
struct with fields:
        e: '0.7'
        g: '9.810000000000001'





>>> omc.getParameters(["c","radius"]) // method-2
"0.7"  "9.810000000000001"





>>> omc.getSimulationOptions()  // method-1
struct with fields:
        startTime: '0'
         stopTime: '1'
         stepSize: '0.002'
        tolerance: '1e-006'
           solver: 'dassl'





>>> omc.getSimulationOptions(["stepSize","tolerance"]) // method-2
"0.002", "1e-006"






	The getSolution method can be used in two different ways.
	
	using default result filename


	use the result filenames provided by user








This provides a way to compare simulation results and perform regression testing

>>> omc.getSolutions() // method-1 returns string arrays of simulation variables for which results are available, the default result filename is taken
"time", "height", ""velocity", "der(height)", "der(velocity)", "c", "radius"





>>> omc.getSolutions(["time","h"])  // return list of cell arrays
1×2 cell array
{1×506 double}    {1×506 double}





>>> omc.getSolutions([],"c:/tmpbouncingBall.mat") // method-2 returns string arrays of simulation variables for which results are available , the resulfile location is provided by user
"time", "height", "velocity", "der(height)", "der(velocity)", "c", "radius"





>>> omc.getSolutions(["time","h"],"c:/tmpbouncingBall.mat") // return list of cell arrays
1×2 cell array
{1×506 double}    {1×506 double}







Standard set methods


	setInputs()


	setParameters()


	setSimulationOptions()




Two setting possibilities are accepted using setXXXs(),where "XXX" can be any of above functions.


	setXXX("Name=value") string of keyword assignments


	setXXX(["Name1=value1","Name2=value2","Name3=value3"])  array of string of keyword assignments






Usage of setMethods

>>> omc.setInputs("cAi=1") // method-1





>>> omc.setInputs(["cAi=1","Ti=2"]) // method-2





>>> omc.setParameters("e=14") // method-1





>>> omc.setParameters(["e=14","g=10.8"]) // method-2 setting parameter value using array of string





>>> omc.setSimulationOptions(["stopTime=2.0","tolerance=1e-08"])







Advanced Simulation

An example of how to do advanced simulation to set parameter values using set methods and finally simulate the  "BouncingBall.mo" model is given below .

>>> omc.getParameters()
struct with fields:
        e: '0.7'
        g: '9.810000000000001'





>>> omc.setParameters(["e=0.9","g=9.83"])





To check whether new values are updated to model , we can again query the getParameters().

>>> omc.getParameters()
struct with fields:
    e: "0.9"
    g: "9.83"





Similary we can also use setInputs() to set a value for the inputs during various time interval can also be done using the following.

>>> omc.setInputs("cAi=1")






	The model can be simulated using the simulate API in the following ways,
	
	without any arguments


	resultfile names provided by user (only filename is allowed and not the location)


	simflags - runtime simulationflags supported by OpenModelica








>>> omc.simulate() // method-1 default result file name will be used
>>> omc.simulate("tmpbouncingBall.mat") // method-2 resultfile name provided by users
>>> omc.simulate([],"-noEventEmit -noRestart -override=e=0.3,g=9.71") // method-3 simulationflags provided by users, since matlab does not support keyword argument we skip argument1 result file with empty list







Linearization

The following methods are available for linearization of a modelica model


	linearize()


	getLinearizationOptions()


	setLinearizationOptions()


	getLinearInputs()


	getLinearOutputs()


	getLinearStates()






Usage of Linearization methods

>>> omc.getLinearizationOptions()  // method-1





>>> omc.getLinearizationOptions(["startTime","stopTime"]) // method-2
"0.0", "1.0"





>>> omc.setLinearizationOptions(["stopTime=2.0","tolerance=1e-08"])





>>> omc.linearize()  //returns a list 2D arrays (matrices) A, B, C and D.





>>> omc.getLinearInputs()  //returns a list of strings of names of inputs used when forming matrices.





>>> omc.getLinearOutputs() //returns a list of strings of names of outputs used when forming matrices.





>>> omc.getLinearStates() // returns a list of strings of names of states used when forming matrices.
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OMJulia - OpenModelica Julia Scripting

OMJulia - the OpenModelica Julia API is a free, open source,
highly portable Julia based interactive session handler for
Julia scripting of OpenModelica API functionality. It provides the modeler
with components for creating a complete Julia-Modelica modeling, compilation
and simulation environment based on the latest OpenModelica implementation
and Modelica library standard available. OMJulia is architectured to
combine both the solving strategy and model building.
Thus, domain experts (people writing the models) and computational
engineers (people writing the solver code) can work on one unified tool
that is industrially viable for optimization of Modelica models, while
offering a flexible platform for algorithm development and research.
OMJulia is not a standalone package, it depends upon the
OpenModelica installation.

OMJulia.jl is implemented in Julia and depends on
ZeroMQ